Contents

Chapter 1  
Introduction .............................................................................. 9  
About the RightFax System ............................................................ 9  
RightFax Server Options ................................................................. 9  
Using This Guide ........................................................................ 10  
Getting Help Online .................................................................... 10  
RightFax Training Services ............................................................ 11  
OpenText Professional Services .................................................. 11  
Customer Support ...................................................................... 11

Chapter 2  
How RightFax Works .................................................................. 13  
RightFax Components ................................................................. 13  
The RightFax Queues ................................................................... 15  
RightFax Client Programs ............................................................ 15  
Installing the RightFax Server ..................................................... 15

Chapter 3  
Configuring the RightFax Server Module .............................. 17  
Configuring the General Settings ............................................. 17  
Configuring the Advanced Settings ......................................... 20  
Configuring Feature Activation ............................................... 21  
Configuring Custom Messages ............................................... 22  
Configuring User Messages ...................................................... 24  
Configuring Admin Messages ................................................... 25  
Configuring Data Sharing ......................................................... 27  
Configuring eTransport ............................................................ 28  
Starting and Stopping the RightFax Server ............................ 29

Chapter 4  
Configuring the WorkServer Modules ............................... 31  
Selecting a Service Account ....................................................... 36  
Adding and Deleting WorkServers .......................................... 38  
Printing a Time Strip on Faxes ................................................. 38  
Configuring Kofax NetScan ....................................................... 39  
Configuring PeopleSoft ............................................................. 40  
Installing WorkServers on Remote Computers .................... 41  
Requirements ............................................................................ 41
Chapter 15  Creating Library Documents .......................................................... 139
   Creating a New Library Document .............................................................. 139
   Editing Library Document Properties .......................................................... 140
   Managing Library Documents ...................................................................... 141

Chapter 16  Text Messaging Using the Push Proxy Gateway .............................. 143
   Understanding Message Types ...................................................................... 143
   Understanding Connectors ............................................................................ 144
   Understanding Two-Way SMS Support ........................................................ 144
   Understanding Log Files ................................................................................ 144
   Configuring the Push Proxy Gateway ............................................................ 145

Chapter 17  Adding SMS and Pager Services ..................................................... 153
   Managing SMS and Pager Services ............................................................... 154
   Editing SMS and Pager Service Properties .................................................. 154
   Logging SMS and Pager Alerts .................................................................... 157

Chapter 18  Using the Alerting and Monitoring Service ..................................... 159
   Installing the Alerting and Monitoring Service .......................................... 159
   Configuring the RightFax Alerting Service ............................................... 159
   Defining the Statistics to Monitor and their Alert Thresholds ....................... 162
   Editing Alert Properties ................................................................................ 163

Chapter 19  Using SNMP Alerting ................................................................. 167
   Configuring the SNMP Service on the RightFax Server .............................. 167
   Configuring the Network Monitor Application ......................................... 168
   Receiving RightFax Alerts in Your Network Monitor ..................................... 168
   Querying RightFax Status Variables ............................................................ 170
   Controlling RightFax Services From Your Network Monitor ....................... 176
   Troubleshooting the RightFax Alerts ............................................................ 176

Chapter 20  Creating Dialing Rules and Least-Cost Routing Plans ..................... 179
   Managing Dialing Rules .............................................................................. 179
   Editing Dialing Rules .................................................................................... 180
   Load Balancing ............................................................................................. 188
   Managing Destination Tables ....................................................................... 188
   Testing Dialing Rules and Fax Routes ......................................................... 191
   Call Blocking ................................................................................................ 193
   Least-Cost Routing Examples ..................................................................... 194

Chapter 21  Creating Fax Cover Sheets ............................................................ 197
   Creating an HTML Cover Sheet ................................................................... 197
   Creating a Microsoft Word Cover Sheet ....................................................... 198
   Creating a PCL Cover Sheet ...................................................................... 199
   Cover Sheet Codes ....................................................................................... 200
   Importing Cover Sheets ............................................................................... 202
   Selecting a Cover Sheet File ....................................................................... 203
   Setting default cover sheets ......................................................................... 204

Chapter 22  Using Optical Character Recognition ............................................ 207
   Enabling OCR Processing on the WorkServers .......................................... 207
   Configuring the Conversion Engine for OCR ............................................. 208
   Configuring RightFax Users for OCR Conversion ....................................... 208
   Using OCR to Route Received Faxes ........................................................... 210
   Creating and Managing OCR Text Files ..................................................... 211

Chapter 23  Routing Inbound Faxes ................................................................. 213
   Configuring DID/DNIS Routing .................................................................. 213
   Configuring DTMF Routing .......................................................................... 214
   Configuring Channel Routing ...................................................................... 214
   Configuring ANI Routing .......................................................................... 215
   Configuring CSID Routing .......................................................................... 216
   Configuring Delivery Methods for Users ..................................................... 216
   Distributing Faxes to a Group of Users ......................................................... 218
   Assigning Unique ID Numbers to Fax File Names and Routing to a Network Folder .................................................. 218
<table>
<thead>
<tr>
<th>Chapter 24</th>
<th><strong>Responding to Inbound Faxes with AutoReply</strong></th>
<th>Chapter 29</th>
<th><strong>Inbound Faxing with Microsoft Exchange 2010 Unified Messaging</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Requirements</td>
<td></td>
<td>Overview</td>
</tr>
<tr>
<td></td>
<td>Installing and Configuring AutoReply</td>
<td></td>
<td>Requirements</td>
</tr>
<tr>
<td></td>
<td>Managing AutoReply from a Remote Computer</td>
<td></td>
<td>Configuring Exchange 2010 UM for Faxing</td>
</tr>
<tr>
<td></td>
<td>Customizing the Reply Fax</td>
<td></td>
<td>Configuring OpenText RightFax for Exchange 2010 UM</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting the AutoReply Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 25</td>
<td><strong>Creating, Sending, and Managing Faxes</strong></td>
<td>Chapter 30</td>
<td><strong>Using TeleConnect to Access Faxes by Phone</strong></td>
</tr>
<tr>
<td></td>
<td>Creating and Sending a Fax</td>
<td></td>
<td>Configuring TeleConnect</td>
</tr>
<tr>
<td></td>
<td>Using Embedded Codes</td>
<td></td>
<td>Retrieving Faxes Via TeleConnect</td>
</tr>
<tr>
<td></td>
<td>Viewing Received Faxes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Managing Faxes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 26</td>
<td><strong>Working with PDF Files</strong></td>
<td>Chapter 31</td>
<td><strong>RightFax Dashboard</strong></td>
</tr>
<tr>
<td></td>
<td>Converting Received Faxes to PDF</td>
<td></td>
<td>Configuring the RightFax Dashboard</td>
</tr>
<tr>
<td></td>
<td>Creating and Sending a PDF by Email</td>
<td></td>
<td>Viewing the RightFax Dashboard</td>
</tr>
<tr>
<td></td>
<td>Using the PDF Module to Convert PDF Files for Faxing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter 27</td>
<td><strong>Creating Phonebooks and Broadcasting Faxes</strong></td>
<td>Chapter 32</td>
<td><strong>RightFax Internet Connector</strong></td>
</tr>
<tr>
<td></td>
<td>Using the RightFax Phonebook</td>
<td></td>
<td>Creating a RightFax Internet Connector Account</td>
</tr>
<tr>
<td></td>
<td>Importing Entries Into the RightFax Phonebook</td>
<td></td>
<td>Configuring RightFax Internet Connector in the RightFax Sync Module</td>
</tr>
<tr>
<td></td>
<td>Using MAPI Phonebooks</td>
<td></td>
<td>Registering the Fax System</td>
</tr>
<tr>
<td></td>
<td>Using ODBC Phonebooks</td>
<td></td>
<td>Configuring the RightFax Internet Connector Transport</td>
</tr>
<tr>
<td></td>
<td>LDAP Phonebooks</td>
<td></td>
<td>Enabling the Dialing Rule</td>
</tr>
<tr>
<td></td>
<td>Fax Broadcasting</td>
<td></td>
<td>Configuring the RightFax Internet Connector Receiver</td>
</tr>
<tr>
<td>Chapter 28</td>
<td><strong>Using RightFax Email Gateways</strong></td>
<td>Chapter 33</td>
<td><strong>Backing Up and Maintaining the RightFax Software and Database</strong></td>
</tr>
<tr>
<td></td>
<td>Installing the Email Gateway Software</td>
<td></td>
<td>Changing the Connection to the SQL Server</td>
</tr>
<tr>
<td></td>
<td>Adding and Configuring Email Gateways</td>
<td></td>
<td>Enabling RightFax to Use SQL Server Database Mirroring</td>
</tr>
<tr>
<td></td>
<td>Sending a Fax via SMTP/POP3</td>
<td></td>
<td>Backing Up and Restoring</td>
</tr>
<tr>
<td></td>
<td>Configuring Users to Receive Faxes via Email</td>
<td></td>
<td>the RightFax Server and Database</td>
</tr>
<tr>
<td></td>
<td>Email Notification of Faxes</td>
<td></td>
<td>Purging Deleted Fax Records from the Database</td>
</tr>
<tr>
<td></td>
<td>Embedded Codes in Mail Messages</td>
<td></td>
<td>Purging Fax Records using DBPurge</td>
</tr>
<tr>
<td></td>
<td>Running the Email Gateway Remotely</td>
<td></td>
<td>Purging Faxes from Users’ Fax Mailboxes</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting the Email Gateways</td>
<td></td>
<td>Removing Orphaned Faxes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Supported Database Collation</td>
</tr>
</tbody>
</table>
## Contents

**Appendix A**  
RightFax Embedded Codes 305

**Appendix B**  
File Formats that Convert to Fax Format 317

**Appendix C**  
Error and Status Messages 319

**Appendix D**  
Alerting and Monitoring Statistics 325  
Fax Server Statistics .............................................................. 325  
Database Statistics ............................................................... 326  
Workserver Statistics ........................................................... 328  
Gateway Statistics ............................................................... 329  
Local BoardServer Statistics ................................................. 330  
All BoardServers Statistics .................................................. 333  
RPC Server Statistics .......................................................... 334  
Paging Server Statistics ....................................................... 335  
Local Document Transport Server Statistics ......................... 336

**Appendix E**  
Registry Keywords 339  
DocTransport Registry Entries .............................................. 340  
FaxServer Registry Entries .................................................. 344  
Gateway Registry Entries .................................................... 346  
RightFax Registry Entries .................................................... 347  
WorkServer Registry Entries ............................................... 349

**Appendix F**  
Web Services API 353  
Starting the Web Services ................................................... 353  
Sample Web.config ............................................................ 355  
Sample Default.aspx .......................................................... 359

**Index** ................................................................................. 361
Chapter 1
Introduction

About the RightFax System

The RightFax system is a comprehensive network fax solution for creating, sending, receiving, and managing faxes directly from a user’s desktop computer. RightFax features and intuitive design make faxing as easy as printing to a network printer.

A user can enhance the fax by adding a cover page, overlaying a form, attaching documents, and inserting graphics.

FaxUtil is the RightFax mailbox where users create, view, print, and manage faxes. With FaxUtil, users can forward, route, and delete faxes.

The RightFax server manages network print queues assigned to faxing, converts outgoing faxes, schedules outgoing faxes, and routes incoming faxes. Routing can be optimized with Intelligent Least-cost Routing™ rules. The server consists of several services that run on one server computer or several networked computers to distribute heavy workloads.

Similarly, RightFax fax board services can be installed on remote servers to distribute the workload across several computers and to provide expanded channel capacity and system redundancy.

A RightFax email gateway acts as a communication link between the RightFax server and an email server. With an email gateway, the user’s customary email client software can serve as the fax client.

RightFax includes email gateway for SMTP/POP3. Advanced gateways for Microsoft Exchange and Lotus Notes are available as separate modules.

RightFax Server Options

RightFax offers the following versions of its fax server software:

- RightFax Business Server
- RightFax Enterprise Server and Enterprise Suite
- RightFax Enterprise or Business Server with the Integration Module
- RightFax Branch Office Server

RightFax Business Server

The RightFax Business Server supports unlimited user accounts. It includes one fax channel, but is expandable to up to 30 fax channels.
RightFax Enterprise Server and Enterprise Suite

The RightFax Enterprise Server supports unlimited user accounts. It includes three WorkServers and one fax channel, expandable to support unlimited fax channels. This server includes the RightFax Web Client™ and the OCR Router™, OCR Converter™, Docs-on-Demand™, and TeleConnect™ modules.

The Enterprise server is also available as a product suite that includes the RightFax Enterprise server, plus the Gateway for Microsoft® Exchange, the Gateway for Lotus Notes®, the Document Management Connector™, the SNMP Alerting™, and the PDF modules.

RightFax Server with the Integration Module

The RightFax server and the RightFax Integration Module enable applications for information exchange. The Integration Module integrates RightFax with applications on mainframe, mid-range, and local area network host systems.

- The RightFax Small Business Integration Module can be installed on the RightFax Business and Enterprise servers.
- The RightFax Enterprise Integration Module can be installed on the Enterprise server.

RightFax Branch Office Server

This RightFax Branch Office server supports up to 100 user accounts. It includes three WorkServers and two fax channels, and can be updated for a total of four fax channels.

Using This Guide

The OpenText RightFax Administrator’s Guide is designed for RightFax administrators who will be installing and configuring the RightFax software on both client and server computers. This guide assumes you have knowledge of the Windows operating systems as well as knowledge of networking systems and your own organization’s network.

Getting Help Online

The OpenText web site offers the latest product information. Updated documentation, a searchable customer support knowledgebase, software downloads, are available on the OpenText Knowledge Center at knowledge.opentext.com.

Editing Contact Information in FaxUtil

In the FaxUtil Help menu, users can select Contact Information, and a dialog box opens that lists OpenText Customer Support contact information.

Figure 1.1 The Contact Information Dialog Box

This contact information appears in English with OpenText contact information, but you can edit the text to provide customized information. To do so, edit the text file Contact.txt located in the \RightFax\Bin folder on the RightFax server. You can enter 24 lines of text and up to 59 characters per line.
RightFax Training Services

RightFax training from OpenText facilitates successful deployment and saves time installing, configuring and maintaining Fax Servers. Regularly scheduled courses are delivered virtually, and in classrooms in Tucson, Arizona and Hooppdorf in the Netherlands. Onsite and custom training are also available. Please visit our Web site to get more information and register for RightFax training: http://www.opentext.com/2/global/services-home/ls-learning-services-home/ls-offering-captaris.htm. Or email us at FDDG-learning@opentext.com and let us help you develop a customized training plan for your organization.

OpenText Professional Services

Experienced OpenText implementation engineers can help you quickly and efficiently deploy RightFax in your production environment.

OpenText Professional Services engineers and consultants are experts in the implementation, deployment and integration of RightFax solutions. Services include basic installation and configuration, upgrades and migrations, configuration review, systems assessment and health check, and other advanced integration services. Services can be performed remotely, on-site, or a combination of both.

OpenText Professional Services provides a cost effective alternative for organizations in need of getting their enterprise fax infrastructure up and running quickly, particularly with limited resources or expertise. Please contact FaxSolutions@opentext.com for more information.

Customer Support

OpenText Customer Support maximizes the value of your RightFax server by providing access to a wide variety of resources and support tools. Through the OpenText Knowledge Center (http://knowledge.opentext.com), customers have access to:

- OpenText's team of Technical Support Engineers and Product Specialists
- System upgrades and maintenance
- An extensive product knowledgebase
- Product documentation
- Product discussion groups

More information on OpenText's complete line of Customer Support offerings can be found at http://www.opentext.com/2/global/services-home/services-support.htm.

Contacting OpenText Customer Support:

For complete OpenText Customer Support contact information, visit www.opentext.com/2/global/services-home/services-support-contact.htm
Chapter 2
How RightFax Works

RightFax Components

RightFax is comprised of these basic components:
- Fax image files
- Fax database (SQL)
- RightFax services
- Fax client programs

Before configuring RightFax for your particular network installation, you should understand the function of each component.

Fax image files

All sent and received faxes are stored as compressed graphic image files (CCITT Group III format) in the RightFax\Image folder. Fax image files are assigned file names by the RightFax server and these file names are directly referenced by the RightFax SQL database.

Each individual page of a fax is saved as a separate file. All files associated with a single fax will have the same file name, but different file extensions will indicate the page number. File extensions for RightFax image files are numeric, starting with number 301, indicating the first page of the fax. The file extension increments by 1 for each subsequent page of the fax.

Warning If you re-name RightFax image files, they will not be recognized by the RightFax server.

A typical fax consumes 35 Kb, though some can be as large as 150 Kb or as small as 5 Kb per page. Because fax images can consume a large amount of disk space, you should dedicate at least 500 Mb of storage to your RightFax server. More space may be required depending on the number of faxes sent and received, and how frequently old faxes are deleted.

Note RightFax monitors the amount of free disk space on the server and will shut down certain processing elements when available disk space falls below 50 Mb. When sufficient disk space is restored, fax processing continues automatically.

Fax database

RightFax uses a SQL database to manage RightFax system objects (such as users, groups, and printers) and to organize, track, and route faxes. RightFax provides some database management and diagnostic utilities. Third-party and custom SQL utilities can also be applied to the RightFax database. For more information on
the RightFax database and applicable SQL database management tools, see Chapter 33, “Backing Up and Maintaining the RightFax Software and Database”.

**RightFax services**

The RightFax server consists of several services:

- RightFax Server module
- RightFax WorkServer modules
- RightFax DocTransport module
- RightFax Database module
- RightFax RPC Server module
- RightFax Queue Handler
- Email gateway modules (optional)
- Integration modules (optional)

In most cases, all the services run on the same machine so that the Server module can automatically start and stop the programs as necessary. However, the RightFax WorkServer and DocTransport modules can run on different computers to redistribute heavy workloads.

**The RightFax Server Module**

The RightFax Server Module manages the network print queues assigned to faxing, controls the conversion of outgoing faxes, and works with the DocTransport module to schedule outgoing faxes and route incoming faxes.

**The RightFax WorkServer Module**

The RightFax WorkServer module performs one or more functions on behalf of the RightFax Server module. It periodically asks the RightFax database if its services have been requested, executes requested tasks, and notifies the database when tasks are complete. You can configure multiple WorkServer modules to handle processor-intensive tasks such as print-to-fax file conversions. For example, one WorkServer can convert PCL-5 print files into fax images, while another WorkServer separately handles automatic printing of incoming faxes.

**The RightFax DocTransport Module**

The RightFax DocTransport module acts as an interpreter between the fax boards and the Server module. It handles requests to schedule outgoing faxes for transmission and informs the Server module when a new fax has been received and needs to be processed. Multiple DocTransport modules can be installed on remote servers to distribute the workload across several machines and provide expanded channel capacity and system redundancy.

The RightFax DocTransport module lets you configure the methods by which RightFax will be able to transmit documents. You can configure fax boards for conventional fax transmission or Fax-over-IP boards as well as set up RightFax for SMS messaging.

**The RightFax Database Module**

The RightFax Database module accesses the SQL fax database to provide client programs with the information used in fax transactions including deleting, forwarding, creating, viewing, and printing faxes.

**The RightFax RPC Module**

The RightFax RPC module acts as an interpreter between the RightFax client programs and the fax database on the server.
The RightFax Queues

RightFax Internal Event Queue
The RightFax Server Module is responsible for queueing and monitoring each of the fax server internal processes, which are collectively called the “Event Queue.” The status of the Event Queue is measured as a percentage of server resources that are occupied with Server Module functions (such as sending and routing faxes).

The Event Queue is represented as the ratio of fax traffic volume to server resources. The higher the traffic volume, the higher this number will be. The Event Queue status is displayed in Enterprise Fax Manager when you open and select a RightFax server.

When the Event Queue of a RightFax server reaches 90 percent, the server will suspend certain functions. At 90 percent, all new outbound and inbound faxes will be held (temporarily set aside) while the server processes the existing workload. After the Event Queue falls to 75 percent, these held faxes will be scheduled for processing along with all new fax traffic.

This internal workload regulation is handled by the Server Module and cannot be overridden. If the fax server is consistently reaching the 90 percent capacity level, you should consider upgrading the fax server’s system resources and/or fax channels.

Microsoft Message Queue
RightFax uses the Microsoft Message Queue (MSMQ) protocol to communicate with the RightFax DocTransport service. MSMQ is installed with RightFax 10.5 and later and can be viewed by running Server Manager. The queues that relate to RightFax are Private Queues in the Message Queuing Feature.

RightFax Queue Handler
RightFax Queue Handler monitors the HPFAX print queue for inbound jobs and directs them to RightFax for processing.

RightFax Client Programs

FaxUtil
FaxUtil is RightFax’s Windows-based client application. With FaxUtil, users can view, print, and manage their faxes. Version 10.5 servers support versions 9.4 SR4 or higher of the FaxUtil client.

RightFax Web Access
RightFax Web Access is RightFax’s browser-based client application. It includes all the functionality of FaxUtil, but can be accessed by users from any compatible Web browser.

Enterprise Fax Manager
Enterprise Fax Manager is the primary RightFax administrator application. With Enterprise Fax Manager, the RightFax administrator can manage users, groups, printers, least-cost routing, and the general functions of the fax system.

Enterprise Fax Manager Web Edition
Enterprise Fax Manager Web Edition is a browser-based RightFax management tool. It includes all the functionality of Enterprise Fax manager, but can be accessed from any compatible Web browser.

Installing the RightFax Server
For information and instructions on installing the RightFax server software, refer to the RightFax Installation Guide.
The RightFax Server module manages the network print queues assigned to faxing, controls the conversion of outgoing faxes, and works with the RightFax DocTransport module to schedule outgoing faxes and route inbound faxes. You can configure the RightFax Server module to customize global fax settings, inbound fax routing, and notifications about document processing and server status.

**To configure the RightFax Server module**

1. On the RightFax server, select **Start > Programs > Open Text > RightFax Enterprise Fax Manager**. This runs Enterprise Fax Manager, the RightFax server administration tool. For more information on Enterprise Fax Manager, see Chapter 8, “Managing Fax Servers with Enterprise Fax Manager”.

2. Click the name of the RightFax server to configure in the tree in the left pane of the Enterprise Fax Manager window. A list of services appears at the lower-right pane of the window.

3. In the **Service Name** list, double-click **RightFax Server Module**. The **Server Configuration** dialog box opens.

The rest of this chapter explains each of the options in this dialog box.
Enable CSID Routing  Enables automatic inbound routing using CSID (caller subscriber identification). CSID data is information about the calling party sent to the fax board by the phone company. The CSID is different for each caller, and can be anything from a phone number to a company name.

For CSID routing to work, you must select this check box AND create a CSID routing table that lists RightFax routing codes and the CSIDs to be routed to them. For more information on CSID routing and creating a CSID routing table see “Configuring CSID Routing” on page 216.

Enable Quick Headers  Allows a second line to be added below the TTI line (the line listing the date, time, page number, total pages, and fax ID at the very top of each fax page). After the quick header is enabled, you can customize the text in the DocTransport module (see “Quick Header Format” on page 50). If this check box is selected, quick headers will be applied to all outgoing faxes.

Create New User when Printing to the Fax Queue  Assigns a new RightFax user ID to network users who print to the fax queue but don’t have a RightFax user ID. RightFax uses the “Default” user ID as a template when creating new users.

Disable Routing of Faxes with Errors  When enabled, this option will prevent routing of incomplete faxes through an email gateway or network directory. Faxes are still available through FaxUtil and will have a status of ‘Incompletely Received’.

Event LogLevel  Specify the level of information logged in the Application Event Log under the service name “RightFax Server Module.” You can select the following options:

- None. No information is saved.
- Terse. Records critical errors only.
- Normal. Records errors and major events only.
- Verbose. Records all significant events and is most useful for tracking and resolving problems.

Caution  If you leave this value set to "Verbose" for long periods of time, the Event Log can become full which may prevent new events from being logged.

Delay All Faxes Until  Specify the time of day after which all faxes sent by users without RightFax administrative access will be sent. To send faxes without delay, select “None set.” Forced delays can also be set for groups of RightFax users. For more information on groups, see Chapter 10, “Creating Groups of Users”.

Auto Delete Failed Gateway Faxes  When enabled, this option removes faxes that fail gateway routing.

Enable Shared Services Failover  Select this option to automatically connect a client to a different server in a Shared Services system when the primary connection is lost. If this option is not selected, and the primary connection is lost, the client will be unable to continue processing faxes.

Notification settings

Notification settings can be changed without stopping and re-starting the RightFax services.

Allow Notification  Enables fax notifications to be sent to RightFax users. When this check box is selected, users receive notification messages based on the notification options specified in FaxUtil.
Admin Once Only  Notifies the group administrator and alternate administrator of their users’ unviewed faxes one time only.

User Notify Time  Specify the total length of time in minutes that the server will attempt to notify a user of an unviewed fax before it notifies the user’s group administrator.

Admin Notify Time  Specify the length of time in minutes that the server will notify a user’s group administrator of unviewed faxes.

Note  By default, the RightFax server sends periodic notifications to users every five minutes. To re-define this interval, modify the Notify_Freq keyword in the Windows Registry. See “Notify_Freq” on page 344.

Retry settings

Count  Specify the number of times (including the first attempt) an outgoing fax transmission will be attempted if it encounters a non-fatal error (for example, a busy signal).

Interval  Specify the minimum delay in minutes before a failed fax transmission is rescheduled to send.

SMS Count  Specify the number of times (including the first attempt) an outgoing notification will be attempted if the system encounters a non-fatal error (for example, a busy signal).

SMS Interval  Specify the minimum delay in minutes before a failed notification is rescheduled to send.

While a fax is being retried, it will appear with a yellow status icon in the sender’s FaxUtil mailbox. If the fax has not been successfully sent after the specified number of attempts, it will be abandoned and saved in the sender’s FaxUtil mailbox with a red status icon. The sender can force RightFax to manually retry sending the fax by selecting the fax and pressing CTRL+K.

Record DNIS Information  Specify where to store DNIS (dialed number identification service) information for each incoming fax. DNIS is specially encoded data that may be included with your incoming calls as a service provided by your phone company. RightFax fax records do not include a field dedicated to storing DNIS information, so you must use one of three existing fields:

- Select “Fax DID number” to save DNIS information where the originating phone number is saved.
- Select “Billing code 1” to save DNIS information in the fax Billing Code 1 field.
- Select “Billing code 2” to save DNIS information in the fax Billing Code 2 field.
- Select “Don’t record” to discard DNIS information.

Note  Because it overwrites any data in the location you specify, DNIS information should be saved to a field that is not used by your RightFax system.
Configuring the Advanced Settings

Figure 3.2  The Server Configuration Dialog Box Advanced Tab

Database settings

**Event Log Level**  Specify the level of information logged in the Application Event Log under the name “RightFax Database Module.” You can select the following options:

- **None.** No information is saved.
- **Terse.** Records critical errors only.
- **Normal.** Records errors and major events only.
- **Verbose.** Records all significant events and is most useful for tracking and resolving problems.

**Caution**  If you leave this value set to “Verbose” for long periods of time, the Event Log can become full which may prevent new events from being logged.

**Maximum Threads**  Sets the number of database I/O threads reserved to service client requests.

The RightFax Database module can respond to database requests from multiple clients and multiple protocols at the same time. The efficiency of this process depends on the number of database I/O threads available. Because each thread uses resources (file handles, CPU time, and memory), you should never increase the number of threads to more than 10. If a database request occurs when all the threads are busy, the request will wait in line to be serviced.

**Maximum File I/O Threads**  Sets the number of file I/O threads reserved to service client requests.

The RightFax Database module can respond to file I/O requests from multiple clients and multiple protocols at the same time. The efficiency of this process depends on the number of file I/O threads available. Because each thread uses resources (file handles, CPU time, and memory), setting this value too high will deplete the server’s resources for other tasks. If a file I/O request occurs when all the threads are busy, the request will wait in line to be serviced.

**Maintenance Cycle**

This field sets the time of day when the server will perform its daily maintenance (such as automatic file backup, fax aging, and purging). This should be set to a time when your fax server will be least busy.

**Billing code settings**

Billing code settings can be changed without stopping and restarting the RightFax services.

**Validate from Email Gateways**  Validates all billing codes added to fax-bound email messages. If a billing code cannot be validated, the fax will not send and the user will receive notification that the fax did not send due to an invalid billing code. If this check
box is not selected, billing codes may be added to fax-bound email messages but will not be validated prior to sending (in other words, any billing code will be accepted).

**Use External Validation** Tells RightFax to use an external program to verify billing codes on outbound faxes. This gives the user the ability to validate faxes based on several different criteria, not just billing codes. To work, a program must be written with the RightFax API to perform the verification of billing codes. For information on downloading and using the RightFax API, visit the OpenText Knowledge Center at knowledge.opentext.com.

**Separate Validation** Customizes the way in which required billing codes are validated against the RightFax database. Selecting “Both Fields” requires both Billing Code 1 and Billing Code 2 fields contain valid codes. “Field 1 or Field 2” requires either of the billing code fields to contain a valid code, but not necessarily both. “Field 1 Only” requires only the Billing Code 1 field contain a valid code. “Field 2 Only” requires only the Billing Code 2 field contain a valid code.

**External document connector**

The external document connector settings are used for integrations between RightFax and third-party systems such as FileNet and XML Generator. If you are not using these integrations, do not select this check box.

**SQL Connection**

These fields display the connection strings that define the RightFax server's connection to the SQL database. You can make changes to either SQL connection by clicking the [...] button on the right. For more information on changing and editing the connections to the RightFax database on the SQL server, see “Changing the Connection to the SQL Server” on page 297.

**Character Set Mode**

Select this check box to use the ANSI code page for the character sets used in faxed documents. Deselect it to use the default OEM code page and character sets.

RightFax installed on non-English language operating systems such as German or Turkish may not display special characters (such as umlauts) correctly. Selecting the ANSI code page can resolve this.

**MSMQ Server**

Enter the name of the server on which the Microsoft Message Queue service is installed.

**Configuring Feature Activation**

The Feature Activation tab allows you to launch the Product Licensing Utility (or PLU). The PLU is required when changing or adding to your feature set.

To display the current licenses on a server:

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.
2. Click the name of the RightFax server to configure in the tree in the left pane of the Enterprise Fax Manager window. A list of services appears at the lower-right pane of the window.
3. In the Service Name list, double-click RightFax Licensing Service (or right-click and choose Status from the menu). The Licensing Service Status dialog box opens.
4. The status displays the enabled services with information about each license. Use the scroll bars to view additional services, if necessary.
5. Click OK to close the status box.
For more information on upgrading your server license, add additional fax channels, and add new RightFax components, refer to the RightFax Installation Guide.

Configuring Custom Messages

These options let you customize the text of messages that are sent for fax status notifications for users (described on page 107).

Notification messages can contain a combination of text and variable data. Each message has variable options, described in the following table.

<table>
<thead>
<tr>
<th>Notification message</th>
<th>Variable options</th>
<th>When used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad fax phone number</td>
<td>~1 = User ID</td>
<td>The fax number contains invalid characters.</td>
</tr>
<tr>
<td>~2 = Fax phone number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad form type</td>
<td>~1 = User ID</td>
<td>A bad form was specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fax blocked by Do Not Dial</td>
<td>~1 = Recipient’s name</td>
<td>A fax was not sent because the destination fax number was blocked by the Do Not Dial feature. (described on page 187.)</td>
</tr>
<tr>
<td>~2 = Recipient’s fax number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~3 = Fax error code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~4 = Sender’s user ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~5 = Billing code 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~6 = Billing code 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~7 = Recipient’s company</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~8 = An HTML link to the fax on the WebUtil client (if applicable)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fax needs approval</td>
<td>~1 = User ID</td>
<td>One of the sender’s outgoing faxes needs approval.</td>
</tr>
<tr>
<td>~2 = Recipient’s name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~3 = Recipient’s fax number</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3a Notification Message Options

Figure 3.3 The Server Configuration Dialog Box Custom Messages Tab
Table 3a  Notification Message Options (Continued)

<table>
<thead>
<tr>
<th>Notification message</th>
<th>Variable options</th>
<th>When used</th>
</tr>
</thead>
</table>
| Fax number blocked    | ~1 = Recipient's name ~2 = Recipient's fax number ~3 = Fax error code ~4 = Number of retries ~5 = Billing code 1 ~6 = Billing code 2 ~7 = URL link to the fax on the RightFax server (this option can only be used with RightFax email gateway) | The recipient’s fax number is blocked by the RightFax DocTransport. Fax numbers can be blocked using the following options:  
  • Dialing rules.  
  • The call blocking Windows Registry entry on the DocTransport. |
| Human Answered Fax    | ~1 = Recipient's name ~2 = Recipient's fax number ~3 = Fax error code ~4 = Number of retries ~5 = User ID | The fax was canceled (not accepted) by the recipient when the recipient responded to the RightFax voice prompt. |
| Imaging error         | ~1 = User ID ~2 = Recipient's name ~3 = Recipient's fax number ~4 = Error encountered | The server cannot generate a fax image. |
| Incomplete fax        | ~1 = User ID ~2 = Unique ID of the fax | The sender did not complete all of the required fax information fields. |
| Invalid billing code  | ~1 = User ID ~2 = Billing code 1 ~3 = Billing code 2 | The sender did not provide a valid billing code. |

Table 3a  Notification Message Options (Continued)

<table>
<thead>
<tr>
<th>Notification message</th>
<th>Variable options</th>
<th>When used</th>
</tr>
</thead>
<tbody>
<tr>
<td>New fax</td>
<td>~1 = Number of pages received ~2 = User ID ~3 = Received remote ID ~4 = TeleConnect ID ~5 = Unique ID of fax ~6 = URL link to the fax on the RightFax server (this option can only be used with a RightFax email gateway)</td>
<td>A new fax was received.</td>
</tr>
<tr>
<td>Ready for preview</td>
<td>~1 = User ID ~2 = Recipient’s name ~3 = Recipient’s fax number ~4 = Billing code 1 ~5 = Billing code 2</td>
<td>The fax was held for preview and is now ready.</td>
</tr>
<tr>
<td>Sending error</td>
<td>~1 = Recipient’s name ~2 = Recipient’s fax number ~3 = Fax error code ~4 = Number of retries ~5 = User ID ~6 = Billing code 1 ~7 = Billing code 2 ~8 = Recipient’s company</td>
<td>The fax could not be sent.</td>
</tr>
<tr>
<td>Sending fax</td>
<td>~1 = Recipient’s name ~2 = Recipient’s fax number ~3 = User ID ~4 = Recipient’s company</td>
<td>The fax starts to send or is still sending after a few minutes.</td>
</tr>
</tbody>
</table>
### Configuring User Messages

You can replace the default pager/SMS fax notification messages for users with customized messages. Users will receive pager/SMS notifications only if they have been configured to do so in the Pager Notification tab of their user configuration in Enterprise Fax Manager (described on page 103). For more information on configuring SMS and pager notifications, see Chapter 17, “Adding SMS and Pager Services”.

#### Table 3a Notification Message Options (Continued)

<table>
<thead>
<tr>
<th>Notification message</th>
<th>Variable options</th>
<th>When used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful send</td>
<td>~1 = Recipient’s name &lt;br&gt; ~2 = Recipient’s fax number &lt;br&gt; ~3 = Recipient’s company &lt;br&gt; ~4 = URL link to the fax on the RightFax server (this option can only be used with a RightFax email gateway)</td>
<td>The fax transmission was successful.</td>
</tr>
<tr>
<td>Too many retries</td>
<td>~1 = Recipient’s name &lt;br&gt; ~2 = Recipient’s fax number &lt;br&gt; ~3 = Fax error code  &lt;br&gt; ~4 = Number of retries &lt;br&gt; ~5 = User ID &lt;br&gt; ~6 = Billing code 1 &lt;br&gt; ~7 = Billing code 2 &lt;br&gt; ~8 = Recipient’s company &lt;br&gt; ~9 = URL link to the fax on the RightFax server (this option can only be used with RightFax email gateway)</td>
<td>The fax was abandoned after the maximum number of send attempts.</td>
</tr>
<tr>
<td>Viewed or printed fax</td>
<td>~1 = User ID</td>
<td>A received fax has not been viewed or printed.</td>
</tr>
</tbody>
</table>

To return a notification message to the default setting, select the text, delete it, and then click **OK**. The next time you open the dialog box, the default message will be listed.
For each message type, enter the custom message text you want. Each message type has its own set of variables, described in the following table.

Table 3b User Message variables

<table>
<thead>
<tr>
<th>Alert</th>
<th>Variables</th>
<th>When used</th>
</tr>
</thead>
<tbody>
<tr>
<td>New fax received</td>
<td>~1 = Page count</td>
<td>Sent to a RightFax user when a new fax is received.</td>
</tr>
<tr>
<td></td>
<td>~2 = CSID or ANI of sender</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~3 = TeleConnect ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~4 = CSID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~5 = ANI</td>
<td></td>
</tr>
<tr>
<td>Outgoing fax abandoned</td>
<td>~1 = Recipient’s name</td>
<td>Sent to a RightFax user whose outbound fax has failed to send for any reason.</td>
</tr>
<tr>
<td></td>
<td>~2 = Recipient’s fax number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~3 = Short error description (last attempt)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~4 = Send attempts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~5 = Owner ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~6 = Billing code 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~7 = Billing code 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~8 = Recipient’s company</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~6 = URL link to the fax on the RightFax server (requires the Gateway for Microsoft Exchange)</td>
<td></td>
</tr>
<tr>
<td>Recipient has been sent a fax</td>
<td>~1 = From name</td>
<td>Sent to the fax recipient to notify that a fax has been sent from the RightFax server. The fax recipient notification address is entered by the RightFax client user when creating a new outbound fax.</td>
</tr>
<tr>
<td></td>
<td>~2 = To name</td>
<td></td>
</tr>
</tbody>
</table>

To return a notification message to the default setting, select the text, delete it, and then click OK. The next time you open the dialog box, the default message will be listed.

Configuring Admin Messages

These options let you customize the text of SMS or pager administrative alerts (described on page 103). For more information on configuring SMS and pager notifications in RightFax, see Chapter 17, “Adding SMS and Pager Services”.

RightFax Enterprise versions 8.7 and higher include a more comprehensive Alerting and Monitoring service that lets you select from hundreds of server statistics to monitor and define the event thresholds, alert types, and alert messages to send. For more information on the RightFax Alerting and Monitoring service, see Chapter 18, “Using the Alerting and Monitoring Service”.

Figure 3.5 The Server Configuration Dialog Box Admin Messages Tab
For each message type, enter the custom message text you want. Each message type has its own set of available variables, described in the following table.

Table 3c Admin Message Settings

<table>
<thead>
<tr>
<th>Alert</th>
<th>Default message</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoardServer failed, none running</td>
<td>All DocTransports are down. Fax sending and receiving is not currently operating.</td>
<td>None</td>
</tr>
<tr>
<td>BoardServer failed, one running</td>
<td>The DocTransport on ~1 is no longer running. Fax sending and receiving operations are functioning on other DocTransports.</td>
<td>~1 = DocTransport machine</td>
</tr>
<tr>
<td>Disk space critically low</td>
<td>One or more drives on the fax server are critically low on disk space (&lt;50MB). Many fax server functions have been suspended.</td>
<td>None</td>
</tr>
<tr>
<td>Disk space getting low</td>
<td>One or more drives on the fax server are approaching critically low disk space (&lt;150MB).</td>
<td>None</td>
</tr>
<tr>
<td>Heartbeat (periodic status</td>
<td>Fax server ~1 up for ~2 (d:h:m:s); load:~3; faxes sent:~4, rcvd:~5.</td>
<td>~1 = Fax server name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Alert</th>
<th>Default message</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The fax server internal queue is more than 90% utilized.</td>
<td>None</td>
</tr>
<tr>
<td>Probable bad line</td>
<td>Probable bad phone line detected.</td>
<td>None</td>
</tr>
<tr>
<td>Send queue too deep</td>
<td>The send queue depth on server ~3 is currently: ~1/~2 (faxes/ pgs).</td>
<td>~1 = Queue depth (faxes) ~2 = Queue depth (pages) ~3 = DocTransport machine</td>
</tr>
<tr>
<td>Server shutdown incorrectly</td>
<td>The fax server process was not properly shut down.</td>
<td>~1 = Fax server name</td>
</tr>
</tbody>
</table>

To return a notification message to the default setting, select the text, delete it, and then click OK. The next time you open the dialog box, the default message will be listed.
Configuring Data Sharing

The capacity of RightFax servers can be multiplied by combining two or more servers that share a common SQL database. This is accomplished by installing and configuring multiple RightFax servers to share a RightFax database and corresponding resource folders. See the RightFax Installation Guide for installation instructions.

Table 3d  Shared Folder Names

<table>
<thead>
<tr>
<th>Field</th>
<th>Folder Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images</td>
<td>IMAGE</td>
<td>Contains sent and received faxes stored as compressed graphic image files.</td>
</tr>
<tr>
<td>Signatures</td>
<td>SIG</td>
<td>Contains graphic images of user signatures for placement on faxes.</td>
</tr>
<tr>
<td>Forms</td>
<td>PAPERS</td>
<td>Contains the names of overlay form files.</td>
</tr>
<tr>
<td>Outgoing Files</td>
<td>OUTGOING</td>
<td>Contains outbound files from all submission methods that are held while being processed into fax images, such as temporary fax queue spool files.</td>
</tr>
<tr>
<td>Attachments</td>
<td>BFT</td>
<td>Contains text files created by the OCR process.</td>
</tr>
<tr>
<td>Native Documents</td>
<td>CMDDATA</td>
<td>Contains transaction files for each fax sent via email or via SecureDocs.</td>
</tr>
</tbody>
</table>
Each of these folders can be located in common disk storage, such as a storage area network (SAN), network share on file server, or network access to a local drive on one of the RightFax servers. The folders must be accessible to all the servers in the shared configuration.

Share permissions must be given to the account used to run both the Server module and DocTransport module. This account must have full control of these folders. To specify this account, click the Select Service Account button.

### Configuring eTransport

The eTransport options configure the server to send outbound fax documents to email addresses in addition to fax numbers.

**Figure 3.7 The Server Configuration Dialog Box eTransport Tab**

**SMTP Hostname**  Enter the name of the SMTP mail server to which outbound documents sent to email addresses via the RightFax client applications will be sent. If no SMTP mail server is specified here, RightFax users using the FaxUtil client will not have the option to address fax documents to an email address.

**Account and Password**  If the specified server uses anonymous access, leave the Account and Password fields blank. If the specified server uses basic or Windows Integrated Security, enter the user name (in the format Domain\Username) in the Account field and the password for that account in the Password field. Do not use TLS security on the SMTP server.

**Note**  Anonymous authentication requires relay to be enabled on the SMTP server.

**SMTP service extensions (ESMTP)**  If the SMTP mail server uses SMTP service extensions, select this check box. SMTP service extensions start an SMTP session by issuing the EHLO command instead of the HELO command.

**Web Server**  Enter the Internet host name of the machine running the IIS server that the RightFax SecureDocs module is installed on. This field is required if you have installed the RightFax SecureDocs Module. For more information on this option and configuring RightFax for certified document delivery, refer to the RightFax SecureDocs Module Guide.

To verify that eTransport is configured correctly, follow these steps:

1. From EFM, stop the RightFax eTransport service.
2. Right-click the eTransport service, then select debug to display a command prompt window. Leave this window open.
3. From FaxUtil, submit an email.
4. Check the open debug window for potential error messages.
Starting and Stopping the RightFax Server

The RightFax server is comprised of several services, called "modules." These services are configured and started during installation. You should only need to stop and start RightFax services during server or network maintenance.

Starting or stopping the RightFax server requires starting or stopping the separate processes. There are two ways to start or stop the processes.

Starting the Server Using the Services Program

In Windows Control Panel, start the Services program. In the list of services, you will see several RightFax modules. To start the RightFax server, click the RightFax DocTransport module and click Start. Next, click the RightFax Server module and click Start. This will start the RightFax Database module, RightFax Server module, and the RightFax WorkServer modules.

Note To view the RightFax control panel icons on x64 systems, be sure to select View 32-bit Control Panel Items in Control Panel.

Starting the Server at a Command Prompt

In a command prompt window at any prompt, enter the following command:

net start serviceshortname
(for example, net start rfserver)

Note You should never start the RightFax Database module, WorkServer modules, or Email Gateway modules directly. They must be started by the RightFax Server module.

Stopping the RightFax Server

To stop the RightFax server from Windows Control Panel, click Stop on the RightFax Server module and the RightFax DocTransport module services.

To stop the RightFax server from a command prompt, type the following:

net stop serviceshortname
(for example, net stop rfemail)

Understanding the Services

The following table describes each RightFax service and tells whether the service is started automatically or manually by Windows on startup. Note that if the startup is automatic, it can be stopped and started as needed.

<table>
<thead>
<tr>
<th>Service name</th>
<th>Short name</th>
<th>Startup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RightFax Conversion Engine</td>
<td>RFIsoConv</td>
<td>Auto</td>
<td>Configurable server that controls conversion of Office, HTML, and OCR documents.</td>
</tr>
<tr>
<td>RightFax Sync Module</td>
<td>CapaSync</td>
<td>Auto</td>
<td>Configurable server that controls one-way synchronization from Active Directory or LDAP data sources</td>
</tr>
<tr>
<td>RightFax Database module</td>
<td>RFDB</td>
<td>Manual</td>
<td>A multi-threaded module that handles communication between the database files (located in the RightFax\Database folder) and the fax clients.</td>
</tr>
<tr>
<td>RightFax DocTransport module</td>
<td>RFDOC TRANS</td>
<td>Auto</td>
<td>Allows configuration of the methods by which RightFax will transmit documents.</td>
</tr>
<tr>
<td>RightFax Licensing</td>
<td>RFLicensing</td>
<td>Auto</td>
<td>Manages license distribution for RightFax services.</td>
</tr>
<tr>
<td>RightFax eTransport</td>
<td>RFMIME</td>
<td>Manual</td>
<td>Automates delivery of email documents from the fax server.</td>
</tr>
<tr>
<td>Service name</td>
<td>Short name</td>
<td>Startup</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RightFax Email Gateway module</td>
<td>RFEMAIL</td>
<td>Manual</td>
<td>The communication bridge to an optional email gateway.</td>
</tr>
<tr>
<td>RightFax Paging module</td>
<td>RFPAGE</td>
<td>Auto</td>
<td>Monitors RightFax for pager notification events and handles communication between RightFax and the SMS or pager services.</td>
</tr>
<tr>
<td>RightFax Integration module</td>
<td>RFPROD</td>
<td>Auto</td>
<td>Allows applications on a mainframe to send custom faxes through the fax server.</td>
</tr>
<tr>
<td>RightFax Queue Handler</td>
<td>RFQUEUE</td>
<td>Auto</td>
<td>Monitors the RightFax print queue for jobs to be forwarded to the server for fax conversion.</td>
</tr>
<tr>
<td>RightFax RPC Server module</td>
<td>RFRPC</td>
<td>Auto</td>
<td>The communication bridge to fax clients that use IPX, SPX or TCP/IP via remote procedure calls.</td>
</tr>
<tr>
<td>RightFax Remoting</td>
<td>RFRemote</td>
<td>Auto</td>
<td>Handles communication with remote RightFax services and applications.</td>
</tr>
<tr>
<td>RightFax Server module</td>
<td>RFSERVER</td>
<td>Auto</td>
<td>The bridge between all other RightFax services. Also responsible for stopping and starting the WorkServer, Database, and email gateway modules.</td>
</tr>
<tr>
<td>RightFax WorkServer modules</td>
<td>RFWORK#</td>
<td>Manual</td>
<td>One or more modules responsible for RightFax’s most processor-intensive functions such as cover sheet generation, PCL5-to-fax conversion, and optical character recognition.</td>
</tr>
</tbody>
</table>
Configuring the WorkServer Modules

Each RightFax WorkServer module performs one or more processor-intensive functions on behalf of the RightFax Server module. They regularly query the Database module for jobs to be performed, execute those jobs, and notify the database when finished.

The default configuration of the RightFax WorkServer modules allows you to send and receive fax documents. You can customize the WorkServer modules to meet the needs of your enterprise.

You can also enable product integrations with Kofax and Peoplesoft through the RightFax WorkServer modules.

To configure the RightFax WorkServer modules

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager. This runs Enterprise Fax Manager, the RightFax server administration tool. For more information on Enterprise Fax Manager, see Chapter 8, “Managing Fax Servers with Enterprise Fax Manager”.

2. Click the name of the RightFax server to configure in the tree in the left pane of the Enterprise Fax Manager window. A list of services appears at the lower-right pane of the window.

3. In the Service Name list, double-click RightFax WorkServer1 Module. The WorkServer Configuration dialog box opens.

The rest of this chapter explains each of the options in this dialog box.

Figure 4.1 The WorkServer Configuration Dialog Box

Each WorkServer is configured separately. To configure a WorkServer, click the WorkServer number or one of its configuration options in the left pane.
Remote WorkServer Service  Tells RightFax that this WorkServer will execute on a separate Windows machine on the network. If this check box is selected, the WorkServer service will not be started automatically by the RightFax Server service. For more information on running WorkServers remotely, see “Installing WorkServers on Remote Computers” on page 41.

Use PCL Converters for Text Files  Uses the RightFax Printer Control Language (PCL) when converting PCL and ASCII text files to fax format. This conversion usually produces more accurate fax images of PCL and ASCII text files than the RightFax native document conversion engine. If you notice that PCL or ASCII text files are not converting to fax format as accurately as you expect, click to clear this check box to return to using the RightFax native document conversion engine.

Services  Click the services you want to assign to the current WorkServer, or shift-click to select multiple services. You can assign a single service to multiple WorkServers or dedicate a WorkServer to one service only. How you configure your WorkServers depends on your organization’s needs and RightFax workload. The following table lists the available WorkServer services and their functions.

<table>
<thead>
<tr>
<th>Service</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive</td>
<td>Archive sent faxes.</td>
</tr>
<tr>
<td>Coversheets</td>
<td>Create coversheets.</td>
</tr>
<tr>
<td>CVL</td>
<td>Handle faxes with multiple LIBDOC or LIBDOC2 and ADDDOC embedded codes.</td>
</tr>
<tr>
<td>Delete Image Files</td>
<td>Delete fax image files.</td>
</tr>
<tr>
<td>FileRoute</td>
<td>Route received faxes to network folders.</td>
</tr>
<tr>
<td>InterConnect</td>
<td>Route received faxes to another RightFax server.</td>
</tr>
</tbody>
</table>

Table 4a  WorkServer Services (Continued)

<table>
<thead>
<tr>
<th>Service</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR</td>
<td>Optical Character Recognition (requires the RightFax OCR Converter or OCR Router module).</td>
</tr>
<tr>
<td>Overlay</td>
<td>Overlay faxes with forms.</td>
</tr>
<tr>
<td>PCL</td>
<td>PCL-to-fax conversion.</td>
</tr>
<tr>
<td>PostScript</td>
<td>PostScript-to-fax conversion (requires the RightFax PDF or SecureDocs module).</td>
</tr>
<tr>
<td>Print</td>
<td>Handle requests for both on-demand and automatic fax printing.</td>
</tr>
</tbody>
</table>

Event LogLevel  Specify the level of information logged in the Application Event Log under the service name “RightFax WorkServer Module.” You can select the following options:

- None. No information is saved.
- Terse. Records critical errors only.
- Normal. Records errors and major events only.
- Verbose. Records all significant events and is most useful for tracking and resolving problems.

Caution  If you leave this value set to “Verbose” for long periods of time, the Event Log can become full which may prevent new events from being logged.

Frequency  Specify how often, in seconds, the WorkServer will query the Database module for new requests. If you only have one WorkServer module, 5 to 10 seconds is an appropriate setting. However, if you run multiple WorkServers, a lower frequency (for example, 15) will prevent requests from overloading the Database module.
Billing Code Import Interval  Specify how often, in minutes, the WorkServer will check for a new billing code delta file Codechg.csv. This file is used to query billing codes from external billing code source. If the file exists, the WorkServer imports the additions, changes, and deletions specified in the file. For more information on using billing codes from an external source, “Importing Billing Codes” on page 134.

Telephony server routing

Enable  Select Enable to integrate the RightFax system with your enterprise telephony server system. For information on custom integrations with your RightFax server, refer to your telephony server documentation.

Caution  Any WorkServer that has telephony server routing enabled must be dedicated to telephony routing only. Any other assigned services will be ignored by this WorkServer.

Server  Specify the name of the telephony server on your network to integrate with the RightFax server.

Protocol  Select the network protocol to use for communicating between the RightFax and telephony servers.

InterConnect retry settings

RightFax InterConnect allows faxes received on one RightFax Enterprise server to be automatically routed to a fax mailbox of the same name on a different RightFax Enterprise server on the same network. With InterConnect, interoffice faxes can be sent via the network that links the RightFax Enterprise servers, rather than via the phone lines, saving time and potential long distance phone charges. For information on enabling and configuring InterConnect, see "RightFax InterConnect” on page 218).

These settings will only be available if you have selected “InterConnect” under Services.

Count  Specify the number of times the originating RightFax server will attempt to forward the fax to the destination RightFax server when it encounters a non-fatal error (e.g., server temporarily down).

Interval  Specify the time delay, in minutes, between retries.

Optimize faxing

Short Covers  Makes fax cover sheets only as long as the cover sheet text requires (ignoring any blank space at the end of the cover sheet), potentially reducing transmission times. This may produce a partial page on some destination fax machines.

If this check box is not selected, cover sheets will be padded to fill an entire page.

Short Bodies  Makes each page in the body of the fax only as long as the text requires (ignoring any blank space at the end of pages), potentially reducing transmission times. This may produce partial pages on some destination fax machines.

If this check box is not selected, each fax page will be padded to fill an entire page.

Archive settings

RightFax can save a copy of each user’s outbound faxes. This fax “archive” feature is useful for tracking and storing all of your organization’s outbound faxes or for integrating RightFax with image tracking software systems.

Archived faxes are saved in a network folder that you specify and can include an optional fax history file and archive log entry. Archived faxes are saved using unique file names generated by RightFax with a file extension corresponding to the file format used for the archive.
Each fax is archived individually upon completion, whether or not the fax was successfully sent. A fax will be archived one time for each recipient, so one fax sent to a group of ten recipients will be archived as ten separate faxes.

Each RightFax user is individually configured for fax archiving. To enable fax archiving for a user, select the **Archive Sent Faxes** check box in the **User Permissions** tab of the User Edit dialog box in Enterprise Fax Manager (see “Archive Sent Faxes” on page 99.) Also, in order to archive sent faxes, at least one of the WorkServers must have “Archive” selected under **Services**. For each WorkServer that will manage archiving, you must also complete the archive settings here.

**Format** Specify the file format used when archiving faxes. The file format you should choose depends on how you plan to use the archived faxes. By default, files are archived in a multi-page TIFF-G3 format with Group III data compression.

**History** Includes each fax’s transmission history with the archived fax image. The fax history is a separate ASCII file saved in the archive folder using the same file name as the fax but with the extension.trx.

**Path** Specify the folder, in UNC (universal naming convention) format, where archived faxes will be stored. The WorkServer will create the specified path if it doesn’t already exist.

The path can be customized using special variables that are replaced in the path name each time a fax is archived. Using variables in the path name lets you archive faxes to separate folders based on the sender, the date, the fax destination, or any combination of these. The following table lists each of the archive path variables and their definitions.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>Date (YYYYMMDD)</td>
</tr>
<tr>
<td>~2</td>
<td>Day of the week (SUN-SAT)</td>
</tr>
<tr>
<td>~3</td>
<td>Month (JAN-DEC)</td>
</tr>
<tr>
<td>~4</td>
<td>Year (YYYY)</td>
</tr>
<tr>
<td>~5</td>
<td>Day of the month (DD)</td>
</tr>
<tr>
<td>~6</td>
<td>Month as decimal (01–12)</td>
</tr>
<tr>
<td>~7</td>
<td>User ID (up to 12 characters in 8.3 FAT format)</td>
</tr>
<tr>
<td>~8</td>
<td>Week as decimal (00–51)</td>
</tr>
<tr>
<td>~9</td>
<td>Billing Code #1 (up to 12 characters in 8.3 FAT format)</td>
</tr>
<tr>
<td>~0</td>
<td>Billing Code #2 (up to 12 characters in 8.3 FAT format)</td>
</tr>
<tr>
<td>~A</td>
<td>Remote ID (left to right, up to 12 characters in 8.3 FAT format)</td>
</tr>
<tr>
<td>~B</td>
<td>Remote ID (right to left, up to 12 characters in 8.3 FAT format)</td>
</tr>
<tr>
<td>~C</td>
<td>Group ID (up to 12 characters in 8.3 FAT format)</td>
</tr>
</tbody>
</table>

**Example** For example, this path:

```
\Faxserver\Archive\~C\~7\~3~4
```

might look like this after variable replacement:

```
\Faxserver\Archive\DEVELOPM.ENT\JDOE\JAN1999
```

In this example, all of the faxes sent by user ID “JDoE” in the “Development” group will be stored in a unique archive folder, organized into separate subfolders each month.
The total path length, after variable replacement, cannot exceed 128 characters. If you do not enter a path, no faxes will be archived.

**Caution** Because “~1” is interpreted as a macro in the path name, you cannot use short path names (i.e. \Progra~1\RightFax\Archive) in this field. You must use the full path names.

**Index file** Specify the UNC path and file name of the file where all archive events will be logged. The index is a comma-delimited ASCII file. Each index entry appears on a separate line and includes 24 data fields. The following table lists all of the fields for each index entry in the order the fields appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Length</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner_ID</td>
<td>String</td>
<td>21</td>
<td>User ID of the fax “owner”</td>
</tr>
<tr>
<td>To_FaxNum</td>
<td>String</td>
<td>31</td>
<td>Recipient’s fax number</td>
</tr>
<tr>
<td>To_ContactNum</td>
<td>String</td>
<td>31</td>
<td>Recipient’s phone number</td>
</tr>
<tr>
<td>To_Name</td>
<td>String</td>
<td>59</td>
<td>Recipient’s name</td>
</tr>
<tr>
<td>To_Company</td>
<td>String</td>
<td>59</td>
<td>Recipient’s company name</td>
</tr>
<tr>
<td>To.CityState</td>
<td>String</td>
<td>59</td>
<td>Recipient’s city and state</td>
</tr>
<tr>
<td>From_Name</td>
<td>String</td>
<td>59</td>
<td>Sender’s name</td>
</tr>
<tr>
<td>From_PHONENum</td>
<td>String</td>
<td>31</td>
<td>Sender’s phone number</td>
</tr>
<tr>
<td>Billing1</td>
<td>String</td>
<td>15</td>
<td>Billing code 1</td>
</tr>
<tr>
<td>Billing2</td>
<td>String</td>
<td>15</td>
<td>Billing code 2</td>
</tr>
<tr>
<td>FaxDIDNum</td>
<td>String</td>
<td>31</td>
<td>DID routing number</td>
</tr>
<tr>
<td>OperatorNum</td>
<td>String</td>
<td>31</td>
<td>Organization’s general phone number</td>
</tr>
<tr>
<td>GeneralFaxNum</td>
<td>String</td>
<td>31</td>
<td>Organization’s general fax number</td>
</tr>
<tr>
<td>RemoteID</td>
<td>String</td>
<td>21</td>
<td>Received remote ID</td>
</tr>
<tr>
<td>Send_Time</td>
<td>Integer</td>
<td>N/A</td>
<td>Total time on fax board, in seconds</td>
</tr>
</tbody>
</table>

Because this log file is dynamic, if you plan to use a third-party application to access the log information you must make sure the file is opened in shared mode. Also, no third-party application should be granted write access, and should not be configured so as to keep the log file open for more than 10 to 20 seconds. The optimal method for third-party access is to make a copy of the log file, and then access data from the copy.

If no log file name is specified, RightFax will not log archive events.

**Separate file per page output** Archives each page of each fax as a separate TIFF file (i.e., a five-page fax will be archived as five separate files). This check box will only be available if you have selected “TIFF.G3” or “TIFF.G4” in the **Format** box (see “Format” on page 34.)
EquiTrac Archive  Logs all successfully sent faxes to a file called RightFax.txt in the WorkServer folder. The EquiTrac Archive log is a comma-delimited ASCII file. Each log entry appears on a separate line and includes nine data fields. The following table lists all of the fields for each log entry in the order the fields appear.

Table 4d  EquiTrac Archive Log Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Maximum length or format</th>
</tr>
</thead>
<tbody>
<tr>
<td>RightFax user ID</td>
<td>21 characters</td>
</tr>
<tr>
<td>Phone number dialed</td>
<td>31 characters</td>
</tr>
<tr>
<td>BillInfo1</td>
<td>15 characters</td>
</tr>
<tr>
<td>BillInfo2</td>
<td>15 characters</td>
</tr>
<tr>
<td>Fax transmission duration</td>
<td>hh:mm:ss</td>
</tr>
<tr>
<td>Number of pages in fax</td>
<td>###</td>
</tr>
<tr>
<td>Fax error code</td>
<td>Always 32, indicating success</td>
</tr>
<tr>
<td>Fax date</td>
<td>mm/dd/yy</td>
</tr>
<tr>
<td>Fax time</td>
<td>hh:mm</td>
</tr>
</tbody>
</table>

Always Delete After Archive  Removes all archived faxes from the user’s FaxUtil mailbox.

Selecting a Service Account

All RightFax WorkServers log on to the network as services using a Windows user account that you specify. This user account must have access to all the network resources required by the tasks (services) managed by your WorkServer modules. This account is initially selected during the RightFax installation. To change the WorkServer module service account, click Select Service Account. The Service Account Editor dialog box opens.

Figure 4.2  The Service Account Editor Dialog Box

The account currently defined for each service appears in the Service Account Editor dialog box. The default is for all services to use one of the pre-defined accounts. To change a service account,
1. From the open **Service Account Editor** dialog box, click **Modify** next to the account you want to change.

![Figure 4.3 The Modify Service Account Dialog Box](image)

2. Specify an account in either of the following ways:
   - Select the **Built-in Account** check box, then choose one of the accounts from the drop-down box.
   - Select the **This Account** check box, then type a new service account name.

   **Warning** If you manually type a name that is longer than 15 characters, you may encounter errors in services performed by the WorkServer. To avoid this, you should select the user by clicking the **Browse** button when the desired user account resides on a domain whose name is longer than 15 characters.

3. Click **OK** to close the **Select User** dialog box and display the selected account in the **Modify Service Account** box.

4. In the **Modify Service Account** dialog box, enter the case-sensitive password for the selected user account in both the **Password** and **Confirm Password** boxes. Click **OK** to display the new service account in the **Service Account Editor**.

5. Click **OK** to apply the selected service account and close the **Service Account Editor**.

   **Note** If you will be storing or accessing files on a NetWare volume, you must make sure the WorkServers’ service accounts also exist as accounts within Novell.
Adding and Deleting WorkServers

By default, three WorkServer modules are installed on the RightFax server. Two WorkServer modules are devoted to the most frequent tasks, and one is dedicated to deleting image files only. This default setup is optimal for most RightFax configurations.

However, depending on your RightFax server usage, you may want to reconfigure the WorkServers or add additional WorkServers. For example, if the server is used primarily for broadcast faxing, WorkServer #3 can be configured to perform the greater than average load of PCL5 conversions, instead of other lower-priority functions.

Other processor-intensive tasks that may require a dedicated WorkServer include:

- Running OCR (Optical Character Recognition), either for routing or conversion
- PostScript conversions
- Fax printing

To add a new WorkServer, click Add WorkServer. To delete an existing WorkServer, click the WorkServer to remove and click Delete WorkServer. When you delete a WorkServer, the other WorkServers will arrange themselves so they remain sequential. For example, if you delete WorkServer #1, WorkServer #2 will move to the WorkServer #1 position and WorkServer #3 will move to the WorkServer #2 position.

Printing a Time Strip on Faxes

The WorkServer module can print a time strip at the top of every fax that is printed to a network printer. The time strip can include the time of arrival of received faxes, elapsed transmission time, time printed, and the fax image file name.

Click Printer Configuration under the selected WorkServer.

Figure 4.5  The WorkServer Printer Configuration Dialog Box

<table>
<thead>
<tr>
<th>Enable Time Strip</th>
<th>Enables printing a time strip at the top of every fax that is printed to a network printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td>The time strip is printed as black text by default. To change the time strip to print in white text on a black background, edit the Windows registry to change the PrintTimeReverse value to 1. See “PrintTimeReverse” on page 351.</td>
</tr>
<tr>
<td><strong>SeeName</strong></td>
<td>Specify what information to print in the Time Strip. The Time Strip can contain any combination of text and variables. The following table lists each of the variable options that can be used in this box.</td>
</tr>
</tbody>
</table>

Table 4e  Time Strip Macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>The word “Sent” or “Received”</td>
</tr>
<tr>
<td>~2</td>
<td>Last transmission/receive date (MM/DD/YYYY)</td>
</tr>
</tbody>
</table>
Configuring Kofax NetScan

RightFax can be configured to work in conjunction with the Kofax NetScan network integration tool for scanners. Using the Kofax NetScan, you can scan documents directly into the FaxUtil mailbox of any RightFax user on your network. This makes it convenient to fax printed pages when no electronic version is available.

Scanned images appear in the selected FaxUtil mailbox with the message “Info not complete.” Images can then be faxed by double-clicking the image in FaxUtil and completing the required boxes in the Fax Information dialog box (see “Specifying Addressing Information” on page 230).

In order to integrate RightFax with the Kofax NetScan, at least one WorkServer must have the Kofax integration enabled. Each WorkServer is separately configured for Kofax NetScan integration. Click Kofax NetScan Configuration under the selected WorkServer.

Enable NetScan Interface Enables RightFax integration with a Kofax NetScan. Communication and integration with the Kofax NetScan will only be handled by the WorkServers with this check box selected.

Automatically Update NetScan Users Updates NetScan users with the latest list of RightFax users every six hours or every time the RightFax Server module is restarted. If this check box is not selected, the NetScan can only be updated by selecting
**Synchronize External Systems** from the **Utility** menu in Enterprise Fax Manager (see "Synchronizing the RightFax Server with External Systems" on page 93).

**Location of NetScan Directories** Specify the UNC path to the folders that RightFax will monitor for new NetScan images. To add a directory, type the UNC path in the **Location of NetScan Directories** box and click **Add Directory**. To remove a directory, click the directory and click **Remove Directory**.

**Location for Scan-to-Disk Images** Specify the UNC path to the folder where images that are scanned to disk from the Kofax NetScan will be saved.

For more information about configuring the Kofax NetScan for RightFax integration, refer to your NetScan documentation.

### Configuring PeopleSoft

PeopleSoft is an application for enterprise resource planning that lets companies manage multiple resources from one integrated platform. To use PeopleSoft with the RightFax server, you must purchase a separate license. PeopleSoft must be used with the RightFax Enterprise or Business Integration Module.

RightFax queries PeopleSoft for outgoing faxes, overriding the PeopleSoft built-in ObjectFax server. This lets you combine the benefits of RightFax least-cost routing and load balancing features with your PeopleSoft platform.

To configure RightFax to work with PeopleSoft, at least one WorkServer must have the PeopleSoft integration enabled. Each WorkServer is separately configured for PeopleSoft integration. Click **PeopleSoft Configuration** under the selected WorkServer.

**Enable PeopleSoft Interface** Enables RightFax integration with PeopleSoft. Communication and integration with the PeopleSoft system will be handled by the WorkServers with this check box selected.

**Location of PeopleSoft directory** Specify the UNC path to the folder where PeopleSoft stores its outgoing fax jobs. The service account for this WorkServer (see "Selecting a Service Account" on page 36) must have read and write access to this folder.
Installing WorkServers on Remote Computers

The RightFax server lets you install and operate remote WorkServers (WorkServers running on computers other than the RightFax server). This lets you transfer selected processor-intensive functions to other machines, freeing up resources on your RightFax server. Running remote WorkServers is helpful in systems with 24 or more fax channels in high volume fax broadcast situations. Three or four properly configured WorkServers installed locally on the RightFax server are sufficient to handle the fax load in most other installations.

Remote WorkServers can also be used to provide Server-Side Application conversion support for Windows Server 2008 and Windows Server 2008 R2 systems. See “About the RightFax Conversion Engine” on page 68 for more information.

Warning After you install a remote WorkServer, you cannot delete any WorkServers from your RightFax configuration. This will disrupt the order of the services and the remaining WorkServers may fail to function as expected.

Requirements

Supported Microsoft Windows Operating Systems

RightFax server software is supported on the following server operating systems.

- Windows Server 2008 R2 Standard x64
- Windows Server 2008 R2 Enterprise x64
- Windows Server 2008 Standard x86 and x64
- Windows Server 2008 Enterprise x86 and x64

Local server requirements

- Microsoft .NET Framework *
- Microsoft Data Access Components *
- Microsoft Messaging Queuing *
- Microsoft Visual C++ runtime components *
- A Windows account to run RightFax services. The account you choose must be a domain user that member of the local administrators group and must have the right to logon as service on the local computer.
  * installed during setup

RightFax Server Requirements

Before installing remote WorkServers, you must share the \RightFax folder on the RightFax server. If your RightFax installation is not in the default \RightFax folder, share the installation folder using “RightFax” as the share name.

Grant the WorkServer service account full control of the shared folder. This account must also have write access to the Windows registry on the RightFax server.

To install the WorkServer on a Remote Computer

2. RightFax WorkServers require Microsoft .NET Framework 3.5. If this software is not installed on your system, Setup will prompt you to install it. To install, click OK. To cancel Setup and install .NET Framework 3.5 yourself, click Cancel.
3. Review the welcome screen and click Next.
4. Carefully read and accept the license agreement and click Next.
5. Setup can check for RightFax updates and other late-breaking information. To check for updates, verify you have an active HTTP connection and click **Check for Updates**. If updates are found, follow the instructions in the **Result** section. To skip the update check and continue with Setup, check the box next to **Do not check for updates** and click **Next**.

6. Click **Custom** followed by **Next**.

7. In the list of setup components, under **RightFax Server Modules**, select the **Workserver Module** check box. Ensure that it is the only selected check box in the list. Click **Next**.

8. The **Preview Requirements** page lists third-party software required by your chosen features and also lists the status of setup operations. Software that must be installed will have a status of **Must Install**. To continue, click **Next**.

9. If your server does not already have Microsoft Message Queuing installed, Setup will prompt you to install it. Select your option and click **Next**.

10. To apply your settings and install required third-party software, click **Apply**. This will take several minutes. When finished, click **Next**.

11. Choose your installation folder and click **Next**.

**Caution** On x64 systems, the default folder is **Program Files (x86)**. The **Program Files** folder is reserved for x64 programs. Do not install the RightFax software in the **Program Files** folder on x64 systems.

12. To begin installing RightFax software, click **Apply**. This may take several minutes. When finished, click **Next**.

13. Enter a Windows account to run RightFax services. This account must be a domain user that is a member of the local administrators group and must have the right to logon as service on the local computer. In addition, this account must also have full-control over the \RightFax folder on the RightFax server and have write access to the Windows registry on the RightFax server. Click **Browse** to load and select a user account. Use the **Test Account** button verify account credentials. When finished, click **Next**.

14. Enter the main **RightFax server name** and click **Check Access**. A report will appear in the **Results** box that indicates whether or not the connection to the RightFax server was successful.

15. If the connection was successful, click **Next**.

16. To apply your settings and complete Setup, click **Apply** and then click **Close**.

**Changing the remote WorkServer's service account**

When it is installed, the remote WorkServer uses the same service account information as the WorkServers on the RightFax server. If this is a local administrative account on the RightFax server, the remote WorkServer service may not be able to log on to the network. If so, you must change the service account used by the remote WorkServer so that it has administrative permissions to the computer on which it is installed. To change the WorkServer’s service account on the remote computer, open Windows Control Panel and select **Administrative Tools > Services**. The WorkServer is listed in the services as **RightFax WorkServer Module**. Double-click the service name to open its configuration dialog. You can specify a new service account name on the **Log On** tab. You must repeat this procedure locally at the WorkServer before the changes will take effect.
The RightFax DocTransport module lets you configure the methods by which RightFax will be able to transmit documents. This module lets you configure fax boards for conventional fax transmission, as well as set up RightFax for SMS messaging and Fax-over-IP fax boards.

The DocTransport module acts as an interpreter between some fax board drivers and the RightFax Server module for conventional fax transmission. It handles requests to schedule outgoing faxes for transmission and informs the Server module when a new fax has been received and needs to be processed.

The DocTransport module must be properly configured to allow the RightFax server to send and receive documents. RightFax supports a maximum of 120 fax channels per DocTransport service.

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.

2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.

3. In the Service Name list, double-click RightFax DocTransport Module. The DocTransport Configuration dialog box opens.
Adding transport methods

By default, the DocTransport module includes Brooktrout transport method. For most other types of installations, you’ll need to add the specific transport method for your fax board type.

Table 5a  Transport methods

<table>
<thead>
<tr>
<th>Transport method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brooktrout TR1034 Series, SR140</td>
<td>Required if you will be installing any Brooktrout TR1034-series fax boards or the Brooktrout SR140 software platform of Fax over IP.</td>
</tr>
<tr>
<td>T.37 Fax over IP</td>
<td>Required if you will be creating administrative dialing rules that route faxes to T.37-compatible fax machines. <strong>Note</strong> You must configure the gateway if you plan to send faxes directly to IP addresses and wish to collect route codes.</td>
</tr>
<tr>
<td>Simulation Device</td>
<td>Allows simulated fax sending for testing or demonstration purposes. Outgoing faxes will appear to send but will not. Simulation mode can be used with no fax boards installed.</td>
</tr>
<tr>
<td>SMS Via Push Proxy Gateway</td>
<td>Required if you install the Push Proxy Gateway. See “Text Messaging Using the Push Proxy Gateway” on page 143.</td>
</tr>
<tr>
<td>RightFax Internet Connector Peer-to-Peer Device</td>
<td>Required if you are using the RightFax Internet Connector module.</td>
</tr>
</tbody>
</table>

1. Click the **Add Transport** button. This opens the **Transport Selection** dialog box.

   ![Transport Selection dialog box](image)

2. Expand the tree in the left pane and select the transport method to add.

3. If you select **Brooktrout**, you must select also a specific fax board in the right pane.

4. Click **Select** to add the new transport method.

5. Repeat these steps for each optional transport method you want to add.

6. After you have added all of the transport methods you will be using, each must be properly configured for your system. The rest of this chapter describes how to configure each of the transport options in the DocTransport module.
Configuring Global DocTransport Settings

Global board settings in the DocTransport module are global settings that apply only to the transport methods enabled in DocTransport. RightFax will use these settings regardless of the transport method, fax board, or channel in use. To configure Global DocTransport Settings, select Global DocTransport Settings in the left pane. The rest of this section describes the options on this screen.

![Figure 5.3 The DocTransport Global DocTransport Settings configuration](image)

**Event LogLevel**  Specify the level of information logged in the Application Event Log under the service name “RightFax DocTransport Module.” You can select the following options:

- **None.** No information is saved.
- **Terse.** Records critical errors only.
- **Normal.** Records errors and major events only.
- **Verbose.** Records all significant events and is most useful for tracking and resolving problems.

**Caution**  If you leave this value set to "Verbose" for long periods of time, the Event Log can become full which may prevent new events from being logged.

**Secure RPC Enabled**  Encrypts the data exchanged between multiple RightFax DocTransports (e.g., Remote DocTransports) or between a RightFax DocTransport module and the FaxStat
program. Any DocTransport service on any other RightFax server communicating with this server must be started using a valid account and password rather than a local system account.

If you select this option, you must specify a user account that the DocTransport service can use for authentication to and from other DocTransport modules on the network. To specify a user account, click the [...] button to the right of this option and enter a login name and password. The quick header line can be customized using special macros that are replaced in the quick header of each fax.

**MSMQ Server**  Enter the name of the server on which the Microsoft Message Queue service is installed.

### Brooktrout Fax Board Configuration

After you've added a Brooktrout transport method to the DocTransport service, you must configure it for use with RightFax. The configuration steps apply to all Brooktrout boards, including including TR1034-series, Trufax-series, and the SR140 boardless Fax-Over-IP, though some fields may apply only to some boards. Each board must be configured separately, and each channel must be configured separately for each board. There are three major steps:

1. **Configure the Brooktrout Global Transport Settings**
2. **Configure the Advanced settings (optional) for all Brooktrout boards**
3. **Configure the following elements for each board:**
   - Configure the default settings for the board
   - Use the Brooktrout Configuration Tool to license channels and set additional parameters (see the Brooktrout documentation).
   - Configure each of the RightFax channels

### Configuring Brooktrout Global Transport Settings

Brooktrout Global Transport Settings in the DocTransport module are global settings that apply to all of the Brooktrout fax boards and channels configured in the DocTransport module. RightFax will use these settings regardless of the fax board or fax channel in use. To configure global transport settings, select **Global Transport Settings** in the left pane. The rest of this section describes the options on this screen.

**Figure 5.4 The Brooktrout Global Transport Settings configuration**

#### CD Timeout
Specify the length of time, in seconds, that the RightFax server will wait for a fax answer tone (CED tone) from a remote fax machine when sending a fax.

#### ANI Pattern Match
Specify the pattern of the dialing party information string that will be received during incoming calls. RightFax collects information about the dialing party's phone number for display in FaxUtil and for CSID routing (if used). However, some organizations receive additional information (such
as ANI or DNIS) along with the caller's phone number. This box specifies the pattern of the extra data so that it can be removed prior to display or routing.

Enter the pattern of ANI data you receive using the symbols in the following table.

Table 5b  ANI Pattern Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>An asterisk character.</td>
</tr>
<tr>
<td>#</td>
<td>A pound character.</td>
</tr>
<tr>
<td>X</td>
<td>A digit in an ANI number. (This is the only number sequence that will be used for ANI routing, all other information is ignored.)</td>
</tr>
<tr>
<td>Y</td>
<td>A digit in the DNIS number.</td>
</tr>
<tr>
<td>Z</td>
<td>An extraneous digit. This will be ignored.</td>
</tr>
<tr>
<td>Max. Modifier (1–9)</td>
<td>The maximum number of each of the prior characters. For example, “x2*y” represents up to 2 ANI digits followed by an asterisk and a single DNIS digit.</td>
</tr>
<tr>
<td>Literal Digits (0–9 and A–D)</td>
<td>Valid phone digits. Separate literal digits from Max. Modifiers with a space.</td>
</tr>
</tbody>
</table>

Example  A sample string of 10 ANI digits, such as:

5205554762

Matches both of the following pattern strings:

XXXXXXXXXX

X10

Audit Settings

Allow Auditing  Tells the DocTransport module to record a log of all incoming and outgoing faxes.

File  Specify the path and file name of the log file to use. If the file does not exist, RightFax will create it when it logs the first entry. To output the log file directly to a network printer, enter the printer port instead of a file name. If you output to a network printer, you must also select the Close File Between Each Page check box.

Level  Specify the level of information to include in the log. There are five levels of detail. Level 1 prints a single line summary of each fax event, Level 2 prints a detailed description of each fax event, Level 3 outputs a comma-delimited file, and Level 4 outputs a tab-delimited file. Level 5 is primarily for troubleshooting purposes, and outputs Brooktrout debugging information.

Example  A sample string that begins with the digits “01” and contains a combination of ANI digits, asterisks, and pound characters, such as:

015205554672#1234**

Matches both of the following strings:

01XXXXXXXXXX#ZZZZ**

01X10#Z4*2
If you set **Level** to “3,” each fax event will be saved to a comma-delimited file. Each log entry appears on a separate line and includes 15 data fields. The following table lists all of the fields for each log entry in the order the fields appear.

Table 5c  Audit Log Level 3 Field Descriptions

<table>
<thead>
<tr>
<th>Field name</th>
<th>Type/format</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>String</td>
<td>1</td>
<td>Sent/received flag (“S” or “R”)</td>
</tr>
<tr>
<td>Date sent</td>
<td>MM/DD/YYYY</td>
<td>10</td>
<td>Date that the call was initiated</td>
</tr>
<tr>
<td>Time sent</td>
<td>HH:MM</td>
<td>5</td>
<td>Time that the call was initiated</td>
</tr>
<tr>
<td>Channel</td>
<td>Numeric</td>
<td>2</td>
<td>Channel used by RightFax (0–32)</td>
</tr>
<tr>
<td>Duration</td>
<td>Numeric</td>
<td>5</td>
<td>Total transmission time in seconds</td>
</tr>
</tbody>
</table>
| Phone number   | Alphanumeric| 31     | Sent faxes: Fax number dialed
Received faxes: Routing code (or DTMF) used |
| Remote ID      | String      | 49     | Remote fax machine ID                                                        |
| Result         | String      | 59     | Result of the fax transmission                                               |
| Page count     | String      | 79     | Number of pages transmitted                                                  |
| Contact number | String      | 31     | Sent faxes only: The recipient’s voice number                                 |
| Contact name   | String      | 59     | Sent faxes only: The recipient’s name.                                       |

Table 5d  Audit Log Level 4 Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field name</th>
<th>Type/format</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company name</td>
<td>String</td>
<td>59</td>
<td>Sent faxes only: The recipient’s company name</td>
</tr>
<tr>
<td>User ID</td>
<td>String</td>
<td>21</td>
<td>Sent faxes only: RightFax user ID of the sender</td>
</tr>
<tr>
<td>Billing code 1</td>
<td>String</td>
<td>15</td>
<td>Sent faxes only: Billing code 1</td>
</tr>
<tr>
<td>Billing code 2</td>
<td>String</td>
<td>15</td>
<td>Sent faxes only: Billing code 2</td>
</tr>
</tbody>
</table>

If you set **Level** to “4,” a new file is created each hour containing that hour’s fax events. Because a separate file is created for each hour’s fax events, do not specify a file name in the **File** box. You can optionally specify a path to a folder where the log files, which are given default names, will be saved.

Each log entry appears on a separate line and includes 28 data fields. The following table lists all of the fields for each log entry in the order the fields appear.

Table 5d  Audit Log Level 4 Field Descriptions

<table>
<thead>
<tr>
<th>Field name</th>
<th>Type</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>String</td>
<td>1</td>
<td>Sent/received flag (“S” or “R”).</td>
</tr>
<tr>
<td>Date sent</td>
<td>YYYYMMDD</td>
<td>8</td>
<td>Date that the call was initiated.</td>
</tr>
<tr>
<td>Time sent</td>
<td>HHMM</td>
<td>4</td>
<td>Time that the call was initiated.</td>
</tr>
<tr>
<td>Channel</td>
<td>Numeric</td>
<td>5</td>
<td>Channel used by RightFax.</td>
</tr>
<tr>
<td>Duration</td>
<td>Numeric</td>
<td>5</td>
<td>Total transmission time (in seconds).</td>
</tr>
</tbody>
</table>
### Table 5d  Audit Log Level 4 Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field name</th>
<th>Type</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone number</td>
<td>String</td>
<td>127</td>
<td>Fax number dialed.</td>
</tr>
<tr>
<td>Remote ID</td>
<td>String</td>
<td>47</td>
<td>CSID of recipient fax machine.</td>
</tr>
<tr>
<td>Good pages</td>
<td>Numeric</td>
<td>5</td>
<td>Number of pages transmitted successfully.</td>
</tr>
<tr>
<td>Page count</td>
<td>Numeric</td>
<td>5</td>
<td>Total number of pages in the fax.</td>
</tr>
<tr>
<td>Board type</td>
<td>Numeric</td>
<td>1</td>
<td>Type of fax board used to send the fax</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 = Brooktrout</td>
</tr>
<tr>
<td>BT call status</td>
<td>Numeric</td>
<td>5</td>
<td>Brooktrout call result status value.</td>
</tr>
<tr>
<td>BT call line status</td>
<td>Numeric</td>
<td>5</td>
<td>Brooktrout call result line status value.</td>
</tr>
<tr>
<td>BT fax status</td>
<td>Numeric</td>
<td>5</td>
<td>Brooktrout fax result status value.</td>
</tr>
<tr>
<td>BT fax line status</td>
<td>Numeric</td>
<td>5</td>
<td>Brooktrout fax result line status value.</td>
</tr>
<tr>
<td>CDR flags</td>
<td>Numeric</td>
<td>4</td>
<td>Hex value of CDR flags</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0001 = PartialRetry</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0002 = SchedRemote</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0004 = SendForRemote</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0008 = Has_ANI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0010 = Had_AOC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x0020 = Had_ISDNCauseVal</td>
</tr>
<tr>
<td>AOC value 1</td>
<td>Numeric</td>
<td>9</td>
<td>AOC data value #1 (only valid if indicated by flags).</td>
</tr>
<tr>
<td>AOC value 2</td>
<td>Numeric</td>
<td>9</td>
<td>AOC data value #2 (only valid if indicated by flags).</td>
</tr>
<tr>
<td>AOC value 3</td>
<td>Numeric</td>
<td>9</td>
<td>AOC data value #3 (only valid if indicated by flags).</td>
</tr>
<tr>
<td>ISDN cause value</td>
<td>String</td>
<td>5</td>
<td>ISDN call setup cause value (only valid if indicated by flags).</td>
</tr>
<tr>
<td>Sender ID</td>
<td>String</td>
<td>21</td>
<td>RightFax user ID of the sender.</td>
</tr>
<tr>
<td>To name</td>
<td>String</td>
<td>59</td>
<td>The recipient’s name.</td>
</tr>
<tr>
<td>From name</td>
<td>String</td>
<td>59</td>
<td>Name of sender (descriptive name, not the ID).</td>
</tr>
<tr>
<td>Contact number</td>
<td>String</td>
<td>31</td>
<td>The recipient’s voice number.</td>
</tr>
<tr>
<td>Company name</td>
<td>String</td>
<td>59</td>
<td>The recipient’s company name.</td>
</tr>
<tr>
<td>Billing code 1</td>
<td>String</td>
<td>15</td>
<td>Billing code 1.</td>
</tr>
<tr>
<td>Secure CSID</td>
<td>String</td>
<td>21</td>
<td>CSID match code for secure send operation.</td>
</tr>
<tr>
<td>Unique ID</td>
<td>String</td>
<td>15</td>
<td>Assigned unique ID for fax job.</td>
</tr>
<tr>
<td>Source server</td>
<td>String</td>
<td>47</td>
<td>Source server IP address or name.</td>
</tr>
</tbody>
</table>

**InitialString**  This is a text message that will be included in the audit file at the beginning of every page.
This line can contain control codes that can be used to convey page formatting or other information to the application reading the file. To add control codes to this string, use the following notation.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Example</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>\x##</td>
<td>\x1b</td>
<td>Hexadecimal character values</td>
</tr>
<tr>
<td>###</td>
<td>\027</td>
<td>Decimal character values</td>
</tr>
<tr>
<td>^x</td>
<td>^[</td>
<td>ASCII representation of a control character</td>
</tr>
</tbody>
</table>

**Close File Between Each Page** Closes the log file after each entry. This allows you to output the log to a network printer.

**TTI Line Settings**

*Note* Brooktrout Trufax fax boards do not support the TTI line feature.

**Allow TTI Line** Select this check box to place a TTI line at the top of every page of a fax. The transmit terminal information (TTI) line is a line of text that prints at the top of each received fax page. The TTI line includes the transmitting fax machine, the date and time of the transmission, the fax page number, and the total page count. The date format in your TTI line is a function of the Windows international or regional settings as installed on the RightFax server.

If this check box is selected, you must also specify how the TTI line should be placed on the fax page.

- Select **Overlay TTI Line** to add the TTI line text to add any existing text or image on the first line of the fax. Note that this can obscure the TTI information. With Brooktrout fax boards, this option functions the same as inserting the TTI line.
- Select **Replace TTI Line** to replace any existing text or image on the first line of the fax with the TTI line. This erases existing fax data from the first line but ensures that the overall length of the fax stays the same.
- Select **Insert TTI Line** to add a new line to the top of the fax page for the TTI information. This retains any fax data on the first line but increases the length of the fax by one line.

Follow these steps to optionally add your organization’s name to the TTI line:

1. Open Windows Control Panel and run the RightFax DocTransport application.
2. Click on each fax channel for each fax board listed in the left pane.
3. Type the desired company name in the Fax ID box.
4. Repeat these steps on all RightFax servers and Remote DocTransport computers.

**Display GMT on the TTI Line** Displays the local time relative to Greenwich Mean Time (GMT). If this option is not selected, the TTI line will display the local time at the fax’s place of origin.

**Quick Header Format** Specify heading text to include under the TTI line on outbound faxes. Though defined here, quick headers must be enabled in the General tab of the RightFax Server module **Configuration** dialog box (see “Enable Quick Headers” on page 18).
The quick header line can be customized using special macros that are replaced in the quick header of each fax.

Table 5f  Quick header macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>To-name field (59 characters maximum)</td>
</tr>
<tr>
<td>~2</td>
<td>Shortened to-name (23 characters maximum)</td>
</tr>
<tr>
<td>~3</td>
<td>To-contact number field (31 characters maximum)</td>
</tr>
<tr>
<td>~4</td>
<td>To-company field (59 characters maximum)</td>
</tr>
<tr>
<td>~5</td>
<td>Shortened to-company field (23 characters maximum)</td>
</tr>
<tr>
<td>~6</td>
<td>BillInfo1 field (15 characters maximum)</td>
</tr>
<tr>
<td>~7</td>
<td>BillInfo2 field (15 characters maximum)</td>
</tr>
<tr>
<td>~8</td>
<td>Unique ID (15 characters maximum)</td>
</tr>
</tbody>
</table>

Example  For example, the setting Please deliver to: ~2 at ~5 might appear in a fax Quick Header as Please deliver to: Jane Doe at Acme, Inc.

Beeping  Tells the computer in which the fax boards are installed to beep each time a call is placed or received.

Dialing Settings Prefix  This field specifies one or more dialing characters to add at the beginning of every outbound fax number dialed by the server. The default setting (WW) instructs the fax boards to automatically detect a dial tone before dialing. For a list of valid dialing characters, see “Dialing Characters Supported by Dialing Rules” on page 183.

Dialing Settings Postfix  This field specifies one or more dialing characters to add at the end of every outbound fax number dialed by the RightFax server. For a list of valid dialing characters, see “Dialing Characters Supported by Dialing Rules” on page 183.

Call Grouping  Whenever a fax is placed in the fax queue, Call Grouping checks the queue for another fax going to the same number. If another fax to the same number is scheduled, it keeps the line open and transmits the second fax, saving the time and money of redialing and reconnecting a second time.

Maximum Grouping  This field specifies the maximum number of pages (1-256) that the RightFax server will send to one phone number before hanging up and sending another set of fax pages.

Configuring a Brooktrout Board  
After you have added a new Brooktrout fax board, it must be configured to work with RightFax. To configure the board, click the board name in the Board/Channel list in the left pane. Note that all Brooktrout board types use the same configuration screen, though some fields may be unavailable (greyed out) depending on functionality of each board.

Figure 5.5  Brooktrout Board Configuration

Board module number  Select the number in the list that matches the number on the rotary switch on the fax board.
**DID Settings** In the list, select the number of digits used for routing fax calls. This should match the number of digits in RightFax user routing codes.

**Set Fax ID for All Channels** You can specify a fax ID for all the channels on this fax board. The fax ID is transmitted by each channel on this fax board to remote fax machines. Usually, this is set to your company name or general fax number. To specify a unique fax ID for each channel, see “Configuring Brooktrout Channels” on page 53.

**Set Capability for All Channels** Sets the same capability (dial-only, answer-only, or both) for all the channels on the fax board. To specify the capability of each channel separately, see “Configuring Brooktrout Channels” on page 53.

**Configure Brooktrout** Opens the Brooktrout Configuration Tool for configuring Brooktrout-related board settings. For more information about the settings within the Brooktrout Configuration Tool, see Brooktrout documentation.

**Number of SR140 Channels** (SR140 configuration only) After activating your SR140 channel licenses using the Brooktrout Configuration Tool, select the number of licensed channels from the list.

**Exchange 2010 UM Fax Routing** (SR140 configuration only) Specify the routing method by selecting one of the following:

- **Route to SMTP Email Only** Return the fax as an email to Exchange 2010 for delivery to the FAX search folder in the recipient’s email inbox. The fax will not be stored on the RightFax server for tracking, billing, or accounting purposes.
- **Route to RightFax User Only** Place the fax into the recipient’s fax mailbox on the RightFax server. The fax will not appear in the user’s FAX search folder in Outlook.
- **Route to Both** (this is the default) Return the fax to Exchange for delivery as an email and place a copy in the recipient’s fax mailbox on the RightFax server. If you are also using the RightFax Connector for Microsoft Exchange, duplicate faxes may appear in the user’s mailbox.

**Important** The RightFax Connector for Microsoft Exchange is an optional module that adds inbound and outbound faxing through Microsoft Exchange. If the Connector for Microsoft Exchange is installed and properly configured, and the user is configured for routing inbound faxes to Exchange, the connector will route a copy of a received fax to the user’s Outlook inbox in addition to any faxes delivered by UM based on the routing specified under Exchange SIP Referrals.

For more information about the Connector for Microsoft Exchange, see the RightFax Connector for Microsoft Exchange Administrator Guide.
Exchange 2010/SIP Authentication  (SR140 configuration only)
Enter the account information for the SMTP communication with the Exchange server by entering the following:

- **Exchange Server Name or IP** address of the Exchange 2010 Server that has been configured for Unified Messaging and inbound faxing.
- **Domain** of the Exchange Server.
- **User Account** that will be used by the RightFax server to communicate with the Exchange Server. This account will be used to authenticate all traffic from the RightFax server to the Exchange server. You can also click the button next to **User Account** to select a user from Active Directory.
- **Password** for the User Account entered above.

Configuring Brooktrout Channels

Each fax channel on a Brooktrout fax board can be individually configured. To configure a channel, click the channel number in the Board/Channel list.

Figure 5.6  Brooktrout Channel Configuration Dialog Box

- **Activate Channel** Activates this channel for use by RightFax. To deactivate the channel, click to clear this check box.
- **Fax ID** Specify the fax ID for this channel only. The fax ID is transmitted to remote fax machines to identify the sender. Usually, this is set to your company name or general fax number. This box will not be available if you selected the **Set Fax ID for all Channels** check box when configuring the Brooktrout board.
- **Capability** Sets the capability (dial-only, answer-only, or both) for this channel.
Max. Pages This Channel May Send  Sets the maximum number of pages per fax that can be sent by this channel, from 0 to 999 (up to 1000 pages per fax). This lets you reserve channels for smaller faxes.

Channel Extension  Assigns a routing code to all incoming faxes on this channel if no routing information is specified. Because DID, T1 with DNIS, and ISDN telephone lines require routing codes, this setting only applies to loop-start lines and T1 lines without DNIS. The Channel Extension is also used when DTMF routing is enabled on the line but the caller does not enter a routing code.

Configure Brooktrout  Opens the Brooktrout Configuration Tool for configuring Brooktrout-related board settings. For more information about the settings within the Brooktrout Configuration Tool, see Brooktrout documentation.

Timed ability  This feature changes the capability (send-only, answer-only, or both) of the fax channel at defined times. For example, you can set a channel to answer-only during business hours, and then switch it to both dial and answer after hours so it can be used for broadcast faxing in the evening.

You can define up to three time periods. Times are indicated in 24 hour military time (“0000” represents midnight, “1200” represents noon, and “1730” represents 5:30 p.m.).

Start  Specify the beginning of the time period. The first time period always has its Start time set to “0000” (midnight).

End  Specify the end of the time period. You must always specify the end time of the last time period as “2359”.

Capability  Sets the capability (dial-only, answer-only, or both) for this time period.

Inbound routing

These settings all apply if you will be using DTMF routing. DTMF routing is a method for routing faxes directly to an individual based on the routing code entered manually by the caller.

Enable DTMF Routing  Enables DTMF inbound routing for this channel.

Initial Tone  Prompts callers to enter a routing code for the fax by playing a tone. When this option is selected, you must also select the tone to play and the duration of the tone in seconds. For information on the available tones, refer to your Brooktrout documentation.

Initial Speech  Prompts callers to enter a routing code for the fax by playing a voice prompt. This requires a special voice module license for your Brooktrout board.

When this option is selected, you must also specify the file of the voice prompt. The default file, Prompt.ipk is located in the RightFax\DocTransport\Brooktrout folder. This prompt file can be played or re-recorded via telephone.

To play the voice prompt for review, go to a command prompt on the server and enter this command:

```
RightFax\DocTransport\Brooktrout\voice -p -cPhoneNum prompt.ipk
```

where PhoneNum is the phone number the Brooktrout board will dial to play back the prompt.

The board will dial the phone number you specified. When you answer the phone, it will play the message. Hang up when the playback is complete.

To record a new voice prompt

1. Save a backup copy of the old Prompt.ipk file.
2. From a command prompt on the server, enter this command:

```
RightFax\DocTransport\Brooktrout\voice -r -cphonenum -u0 prompt.ipk
```

where phonenum is the phone number the Brooktrout board will dial to initiate the recording.
3. The board will dial the phone number you specified. When you answer the phone, it will begin recording your message. Press the [#] key (pound key) when you are done.

**Failure** Specify the file to play when a caller does not enter enough DTMF digits to route the fax. The default file, Baddigit.ipk is located in the RightFax\DocTransport\Brooktrout folder. This prompt file can be played or re-recorded via telephone.

**Confirmation** Specify the file to play when a caller has correctly entered DTMF digits for routing. The default file, Gotdigit.ipk is located in the RightFax\DocTransport\Brooktrout folder. This prompt file can be played or re-recorded via telephone.

**No Terminator** Tells RightFax to accept the DTMF code entered by the caller as soon as the correct number of digits have been entered. No additional terminator key needs to be pressed.

**Terminator** Specify the key (on the phone) that the caller must press when finished entering DTMF digits. This is necessary when the Max. Digits and Min. Digits are not set to the same value. Because in this case the routing code can be a variable number of digits, the caller must provide some indication of when he has finished entering DTMF digits.

**Max. Digits** Specify the maximum number of DTMF digits that can be entered by the caller.

**Min. Digits** Specify the minimum number of DTMF digits that can be entered by the caller.

**Tone Wait** Specify the length of time in seconds to wait after the prompt is played for the caller to enter a routing code. If you have specified a terminator key (described previously), the caller must enter the code and the terminator in this length of time.

**Advanced Settings**

Use the Advanced Settings options for Brooktrout boards to enable the Human Answered Fax feature, the TeleConnect module, and the optional Docs-on-Demand module.

Refer to Chapter 30, “Using TeleConnect to Access Faxes by Phone” for more information about configuring and using the TeleConnect module.

Refer to the RightFax Docs-on-Demand Guide for installation and configuration instructions for that product.

**Configuring the Human Answered Fax feature**

The Human Answered Fax feature detects when an outbound fax call is answered by a person, rather than a fax machine, and then provides an automated voice message informing the recipient that a fax is being sent. The recipient is then offered one or more options for receiving the fax.

Because it uses digital voice prompts, the Human Answered Fax feature requires that you have installed at least one Brooktrout fax board with licensed voice capability. For information on voice-compatible Brooktrout fax boards, refer to your fax board documentation or contact your Brooktrout fax board distributor.

The Human Answered Fax feature uses Dialogic .vox voice files located on the RightFax server. These files can be played or modified using any sound editor that supports the .vox file format.
To enable and configure the Human Answered Fax feature, expand **Advanced Settings**, and then click **Human Answered Fax** in the list in the left pane.

**Figure 5.7** The **Human Answered Fax Configuration** dialog box

**Enable Human Answered Fax**  Enables the Human Answered Fax feature.

---

**Calling Mode**  Select one of the following options:

- **Switch to Voice Mode if a Human is detected on a Fax Call.** This option causes the RightFax server to switch from fax transmission mode to voice mode as soon as a human voice is detected. If a fax machine is detected, the fax will be sent.

- **Call back in Voice Mode if a Human is detected on a Fax Call.** This option causes the RightFax server to hang up when a human voice is detected and immediately call back in voice mode. If a fax machine is detected on either call, the fax will be sent.

- **Always start each Fax Call in Voice Mode.** This option causes the RightFax server to initiate all outbound fax calls in voice mode. If you select this option, you should also select **Voice Prompt Only** under **Voice Mode**. This is because if a fax machine picks up the call, RightFax will always send the fax after a short delay, whereas if you select the **Voice Menu** option, RightFax will wait indefinitely for a response from the call recipient, and the fax will never be sent.

**Voice Mode**  Select one of the following options:

- **Voice Prompt Only.** This option plays a voice prompt to the call recipient and then waits for a fax tone before transmitting. The voice prompt is a message informing the call recipient that this is an incoming fax. The voice prompt used by the RightFax server can be either simple or detailed.

- **Voice Menu.** This option plays a voice prompt followed by a menu of options for the call recipient. The voice prompt used by the RightFax server can be either simple or detailed.
If the voice menu is enabled, the call recipient will first hear either the simple or detailed voice prompt (depending on which you have enabled). The prompt will be followed by the file HAF_MainMenu.vox, which says “To receive this fax press 1 or stay on the line. To cancel this fax press 9.”

- If the call recipient presses 1, the file HAF_PressStart.vox plays saying “Please press start on your fax machine to receive your documents” and the RightFax server will attempt to send the fax.
- If the call recipient presses 9, the file HAF_Cancelled.vox plays saying “This fax has been cancelled. We apologize for any inconvenience” and the fax will not be sent.
- If the caller does not press 1 or 9 within 10 seconds, the menu will automatically play the file HAF_PressStart.vox prompting the call recipient to start the fax machine, then the RightFax server will attempt to send the fax.

**Detailed Voice Prompts** The Human Answered Fax feature provides two types of voice prompt: a simple voice prompt and a detailed voice prompt.

The simple voice prompt plays the file HAF_ThisisaFax.vox which says “This is a fax,” followed by HAF_PressStart.vox which says “Please press start on your fax machine to receive your documents.”

The detailed voice prompt combines several separate voice files to create a unique message that says “This is a \[number\] page fax.”

The detailed voice prompt always includes the number of pages in the fax and uses the appropriate a/an article to match the number of pages. The detailed voice prompt can include “...from [company name]” at the end of the prompt if a file called HAF_Source.vox is located in the Voices folder. This file is not provided with the RightFax server software, so you must create this file if you want your organization name identified as the source of the fax. The detailed voice prompt then plays HAF_PressStart.vox which says “Please press start on your fax machine to receive your documents.”

**Translating the voice files** If you will be using the Human Answered Fax feature with a language other than English, follow these guidelines when configuring Human Answered Fax (described on page 56):

- Record a new translated version of the file HAF_ThisisaFax.vox that will inform the call recipient that a fax transmission is being attempted.
- Select **Voice Prompt Only** under **Voice Mode**.
- Do not select the option **Detailed Voice Prompts**.

**Note** when translating the Human Answered Fax voice files to languages other than English, use the simple voice prompt without the menu. Because both the menu and the detailed voice prompt are generated by playing several separate voice files in sequence, simply translating the individual files may result in improper syntax. For descriptions of all of the voice files on the RightFax server, refer to the TeleConnect User’s Guide.

**Cancelling a Human Answered Fax** To cancel a fax call that has been answered by a human:

- Set the Human Answered Fax > Voice Mode option to **Voice Menu**.
- Edit the Windows Registry to set the HAF_CancelIfNoResponse value to 1. See “HAF_CancelIfNoResponse” on page 343.

**Configuring Docs-on-Demand**

The Docs-on-Demand component allows anyone to call into your RightFax server to request faxes. These can be marketing or sales material, informational material, or any kind of fax document your organization wants to make available via touch-tone phone. For more details on how to use Docs-on-Demand, see the OpenText Docs-on-Demand Guide.
To use the Docs-on-Demand module with all defined Brooktrout fax boards, you must enable the feature in the DocTransport service. Under the Brooktrout heading, click **Advanced Settings** in the component tree in the left pane and then click **Docs on Demand**.

**Figure 5.8  The Docs-on-Demand Configuration Dialog Box**

![Diagram of the Docs-on-Demand Configuration Dialog Box]

**Enable Docs on Demand** Enables the two Docs-on-Demand applications, Fax-on-Demand and Web Fax Tools. If this check box is not selected, neither feature will function.

**System Password** This is the password the Fax-on-Demand administrator will use to access the Fax-on-Demand Sysop (System Operator) menu. Because you must be able to enter the password from a touch-tone phone, this password must consist of numeric digits only.

**Routing Code/Channel Ext** Specifies the routing code (such as DTMF extension or DID number) that will be assigned to Fax-on-Demand. When calls arrive on this extension they will automatically enter the Fax-on-Demand system, rather than being received as an incoming fax.

If you have a bank of numbers dedicated to your RightFax server, you must assign one of the numbers to Fax-on-Demand by entering the extension here. If you have channel routing configured on POTS (plain-old-telephone system) lines, then you must dedicate one of your fax channels to Fax-on-Demand. To do this, enter a unique four-digit number in this box, and then click the channel you want to dedicate under **Global Board Settings** in the left pane, and enter the same four-digit value in the **Channel Extension** box.

Users must be able to dial into this channel directly. The channel should not be part of a hunt group unless all the channels in that hunt group are dedicated to Fax-on-Demand. Otherwise, dialing the number may cause users to hear a fax tone instead of accessing Fax-on-Demand.

You can also turn on DTMF routing for a particular analog channel. When users dial this number they will hear a tone or voice prompt to enter an extension. Enter a unique four-digit extension in this box. If you tell your users to enter this number when they hear the prompt, they will connect to the Fax-on-Demand system. If this number is not entered after a few seconds (depending on the DTMF timeout value), the channel will provide a fax tone and attempt to receive a fax.

**User Account** This is the RightFax user ID that Fax-on-Demand will use when sending faxes. All cover sheet information and attributes of the selected user ID will apply to faxes sent by Fax-on-Demand. This setting is also used by Web Fax Tools for assigning a RightFax user ID to outgoing faxes.

**Name on Cover Sheet** Specifies the name or text that will appear in the “To:” field on fax cover sheets sent by Fax-on-Demand.
**Call Type**  Specifies how Fax-on-Demand will connect to the user when faxes are requested. “One Call” requires the user to be calling from a fax machine. Fax-on-Demand uses the same connection to send faxes back to the caller without initiating a second call. In this way, the Fax-on-Demand system incurs no phone charges. “Two Call” causes Fax-on-Demand to request the recipient’s fax number and then initiates a separate call to send faxes. “Prompt” asks each user to specify a one- or two-call session.

**Maximum Documents**  Specifies the maximum number of fax documents that a Fax-on-Demand user can request per call.

**BrookTrout Registry Settings**

In addition to setting the configuration options through the RightFax user interface, you can set some options through the registry editor.

**Adding data to the ISDN string**  You can add a field of data to the calling party number field of the ISDN string for each fax sent from the RightFax server. This data can be captured by some PBX systems for billing purposes. Before implementing this feature, verify that the PBX system can accept the data. If it does not, the PBX will reject the call. For more detail on editing the registry to indicate which data to include, see “UseISDNCallingParty” on page 343.

**Defining an RTI line**  The RTI (Receipt Terminal Information) line is a line of text that can be printed at the bottom of each received fax page. The RTI line includes information about the fax that supplements the TTI line such as the total number of pages received, the name of the RightFax server that received the fax, and the sender’s caller ID. You can enable or disable the RTI line, specify the information you want it to include, specify the font size, and specify where on the fax page to print the line. For more details on editing the registry to enable or modify the RTI line, see

- “StampReceivedPages” to turn the RTI on or off
- “ReceiveStamp Format” to specify which data displays
- “ReceiveStamp Location” to specify where the RTI displays
- “ReceiveStamp FontSize” to specify how large to print the RTI

**Configuring T.37 Fax over IP**

T.37 fax over IP is a fax transmission protocol that allows faxes to be transmitted to T.37-compatible devices over IP, rather than dedicated fax channels. The fax is packaged as an email message with a TIFF attachment and then sent over IP via an SMTP server. This message is automatically interpreted as a fax by the receiving device, which then prints it.

To send documents using fax over IP, you must create dialing rules that route the documents based on the fax numbers or email addresses entered by your RightFax client for outbound faxes. For information on how to configure a dialing rule to route to a fax over IP destination, see page 186.

After you have added the T.37 Fax over IP transport method in DocTransport (described in “Adding transport methods” on page 44), expand the FoIP option in the list in the left pane and select T.37 Fax over IP. This displays the fax over IP configuration options.
Figure 5.9 The T.37 Fax over IP Configuration options

SMTP Server Address  By default, fax over IP messages will be sent via the SMTP server that you specified during the RightFax server installation. If you did not specify an SMTP server name during installation, enter the name of the SMTP server on your network that will transmit fax-over-IP messages.

Email Address in the “From” Section of the T.37 fax message Enter the email address that will be transmitted to the receiving T.37-compatible device.

Configuring Fax over IP Failover

Fax over IP environments with a multi-router topology may configure RightFax (via dialing rules) for real-time FoIP fail-over. When the primary FoIP router or gateway is unavailable or times out, faxes are automatically routed to a secondary router or gateway. FoIP fail-over is compatible with both SR140 and T.37 board-based architecture.

To enable FoIP failover, create two dialing rules that routes faxes based on the outgoing router number. Set the rule that points to the primary router with a higher weight than the rule that points to the secondary router. You must also enable FoIP by editing the registry keyword value DisableDialingRuleOnTimeout (see “DisableDialingRuleOnTimeout” on page 342) to have a value of 1.

To enable FoIP fail-over
1. Log on to Enterprise Fax Manager and click the Dialing Rules view.
3. In the Pattern field, enter a number that, when dialed, will be sent via FoIP.
4. Click the Number Adjustments tab. Type the @ symbol and the IP address of your network’s primary FoIP router. For example, @192.168.0.1
5. When finished, click OK.
6. Repeat steps 2 through 5, but use the secondary router in the Number Adjustments tab.
7. Click the Other tab.
8. Find the Extra Rule Weight box and click the up arrow for the first rule (the router you want to use the most) until the value is greater than 0. When finished, click OK.
9. Open the Enterprise Fax Manager File menu and click Save Dialing Plan.

Important When using FoIP you must remove the wait for wink (or WW) setting in the dialing settings, prefix box located in the DocTransport, Global Transport Settings.
Configuring SMS via the Push-Proxy Gateway

Short message service (SMS) is a communication protocol that lets you send and receive short text messages to and from SMS-compatible devices such as a cell phone. The RightFax server can be configured to send fax notifications and alerts to SMS numbers. RightFax clients can also send and receive SMS messages. Because SMS is a text-only protocol, sent SMS messages include only the notes added to the fax cover sheet. You can also create dialing rules that automatically route outbound faxes to SMS numbers. SMS functionality requires that you have installed the RightFax Push-Proxy Gateway on the server running the DocTransport service.

After you have added the SMS transport method in DocTransport (described in “Adding transport methods” on page 44), expand the SMS option in the list in the left pane and select Mobility Push-Proxy Gateway. This displays the SMS configuration options.

Figure 5.10 The SMS Configuration options

Configure PPG  Runs the Push-Proxy Gateway configuration program. For information on completing these configuration options, refer to the “Text Messaging Using the Push Proxy Gateway” on page 143.

Number of Digits for Routing  When the RightFax server receives an incoming SMS message, it can route the message to one or more mailboxes. Each RightFax mailbox (user ID) has a unique routing code. SMS mailboxes should be configured to use routing codes based on the phone number that the message was sent to, typically the last three or four digits of the number. Enter the number of digits that will be read from the end of the receiving phone number that will be used for routing SMS messages.

Configuring RightFax Internet Connector Channels

Using RightFax Internet Connector transmission between Rightfax servers (either within a company or between companies), faxes go over the Internet instead of through phone lines.

After you have added the RightFax Internet Connector transport method in DocTransport (described in “Adding transport methods” on page 44), expand the RightFax Internet Connector option in the list in the left pane, and then click Peer to Peer Channels. The Peer to Peer Device configuration options appear.

Fax ID  Specify the fax ID for this channel only. The fax ID is transmitted to remote fax machines to identify the sender. Usually, this is set to your company name or general fax number.

Number of Digits for Routing  The RightFax Internet Connector includes the destination fax number with each transmission. Enter the number of digits from the end of the destination phone number that will be used for routing faxes.
Configuring Automated Billing Codes

This feature automatically applies billing codes to outbound faxes based on the user ID of the sender. To configure automatic billing codes, click **Auto Billing Code Settings** in the left pane.

![Auto Billing Code Settings](image)

**Figure 5.11** DocTransport Configuration **Auto Billing Code Settings**.

**Enable User Specific Phone Codes** Enables the Automatic Billing Codes feature.

To assign domestic and international phone codes to specific RightFax users, you must create a list of RightFax users and their phone codes.

Click **Add Entry** to add a new entry to the list. This opens a dialog box asking you to enter a RightFax user ID and that user’s domestic and international long distance phone codes. When you click **OK** to close the dialog box, the new entry is immediately displayed in the **DocTransport Configuration** dialog box.

To edit an entry, click the entry in the list and click **Edit Entry**. To delete an entry, click the entry and click **Delete Entry**.

To load a list of RightFax user IDs and phone codes from a file, type the path and file name in the **Phone Codes File Name** box and click **Load File**. The file name you specify must be a tab-delimited ASCII file. Each entry in this file must include the RightFax user ID, domestic phone code, and international phone code. Individual entries are separated by a carriage return.

**Example**

<table>
<thead>
<tr>
<th>User ID</th>
<th>Domestic Code</th>
<th>International Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>J Doe</td>
<td>1345</td>
<td>0345</td>
</tr>
<tr>
<td>J Smith</td>
<td>1678</td>
<td>0678</td>
</tr>
<tr>
<td>B Jones</td>
<td>1111</td>
<td>0111</td>
</tr>
</tbody>
</table>

After you load the file, any additions, deletions, and editing changes you make in the **DocTransport Configuration** dialog box will be saved.

**To distinguish international and domestic long distance calls**

After you have created a list of RightFax users and their phone codes, you must specify dialing rules that tell RightFax when to dial those codes.

When creating dialing rules, the character “F” added to the dial string will be replaced with the user’s domestic phone code. The character “G” added to the dial string will be replaced with the user’s international phone code.

**Example**

For example, for international calls, you might create a dialing rule like this:

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Append</th>
</tr>
</thead>
<tbody>
<tr>
<td>011+</td>
<td>wGii</td>
</tr>
</tbody>
</table>

This tells RightFax that if the first three digits of an outgoing fax number are “011” (the international dialing prefix) then wait for a dial tone (w), look up the user’s international billing code and dial it (G), and then wait 10 seconds before dialing the number (ii).
For more information on creating dialing rules in RightFax, see “Adding dialing rules” on page 179.

Running DocTransport on Remote Computers

**Note** One RightFax Enterprise server can support a total maximum of 16 separate DocTransport modules.

With the RightFax Enterprise server, you can install and run multiple DocTransport modules simultaneously on the local and one or more remote computers. This distributes the workload of the RightFax server across several computers and provides expanded channel capacity and system redundancy.

**Caution** While running DocTransport modules over a WAN is a supported configuration, it is important that sufficient bandwidth is available across the network to allow the DocTransport and RightFax server to communicate efficiently. Insufficient bandwidth when running remote DocTransport modules across a WAN may result in timeout errors causing both inbound and outbound documents to fail.

When the RightFax server is configured to run one or more DocTransport modules remotely, the workload of faxing is divided between multiple computers. The RightFax server computer can remain dedicated to database management and WorkServer operations, while the remote DocTransport computers handle all the work relating to sending and receiving faxes.

Because the fax boards can be distributed between several computers, your ability to expand your system’s fax channel capacity is virtually unlimited using remote DocTransport modules.

Running remote DocTransport modules allows for system redundancy. If a hardware or phone line failure occurs, fax traffic can be automatically routed to other available DocTransport modules quickly and with no interruption of service. In addition, remote DocTransport modules let you make the most out of redundant hardware in clustered server configurations, as in the following diagram.

Figure 5.12 Remote DocTransport Modules in a Clustered Environment

The ability to install multiple DocTransport modules is available in RightFax Enterprise servers only.
Requirements

Supported Microsoft Windows Operating Systems
RightFax server software is supported on the following server operating systems.

- Windows 2008 Standard x86 (32-bit) and x64 (64-bit)
- Windows 2008 Enterprise x86 (32-bit) and x64 (64-bit)
- Windows Server 2008 R2 Standard x64 (64-bit)
- Windows Server 2008 R2 Enterprise x64 (64-bit)

Note: Terminal Services are not supported on Windows Server 2008 R2 operating systems.

Local server requirements

- Microsoft .NET Framework *
- Microsoft Data Access Components *
- Microsoft Messaging Queuing*
- Microsoft Visual C++ runtime components*
- A Windows account to run RightFax services. The account you choose must be a domain user that member of the local administrators group and must have the right to logon as service on the local computer.
  *
  * installed during setup

RightFax server requirements
Before installing remote DocTransports, you must share the RightFax image folder on the RightFax server and grant the DocTransport service account full control. This account must also have write access to the Windows registry on the RightFax server.

To install the DocTransport on a Remote Computer

Important Because they are not located on your RightFax server computer, remote DocTransport modules cannot prevent you from exceeding your RightFax channel licenses. You must manage the number of activated channels across all the DocTransport modules, and do not attempt to activate more channels than your organization has licensed. The RightFax Server module service will shut down if the total number of channels on all DocTransport modules exceeds your total number of channel licenses.

Caution If you have changed the default DSN for the SQL connection on the main RightFax server, you must manually change the DSN on the remote DocTransport computer to match the DSN on the server.

To ensure that your installation goes smoothly and to avoid unnecessary delays, it is important to perform each step in the installation completely and correctly before proceeding to the next step.

1. If you haven't already done so, download the RightFax installation program from the OpenText Knowledge Center to a network location. Browse to that location and then run Setup.exe. The RightFax Product Suite Setup wizard opens.
2. RightFax DocTransports require Microsoft .NET Framework 4.0 or later. If this software is not installed on your system, Setup will prompt you to install it. To install, click OK. To cancel Setup and install .NET Framework 4.0 yourself, click Cancel.
3. Review the welcome screen and click Next.
4. Carefully read and accept the license agreement and click Next.
5. Click Custom followed by Next.
6. Select the DocTransport Module Setup component and click Next. No other Setup components should be chosen.
7. The **Preview Requirements** step lists third-party software required by your chosen features and also lists the status of setup operations. Software that must be installed will have a status of **Must Install**. To continue, click **Next**.

8. To apply your settings and install required third-party software, click **Apply**. This may take several minutes. When finished, click **Next**.

9. If your server does not already have Microsoft Message Queuing installed, Setup will prompt you to install it. Select your option and click **Next**.

10. RightFax requires TCP ports 10520, 10521, 10062, 34987, and 34988. Setup can reserve these ports for exclusive use by RightFax. To allow setup to reserve these ports, enable the **Reserve Ports** option and click **Next**. If you do not reserve these ports, some RightFax services may not start.

11. To apply your settings and install required third-party software, click **Apply**. This will take several minutes. When finished, click **Next**.

12. Choose your installation folder and click **Next**.

13. To begin installing RightFax software, click **Apply**. This may take several minutes. When finished, click **Next**.

14. Enter a Windows account to run RightFax services. This account must be a domain user that is a member of the local administrators group and must have the right to logon as a service on the local computer. In addition, this account must have full-control over the `\RightFax` folder on the RightFax server and have write access to the Windows registry on the RightFax server. Click **Browse** to load and select a user account. Use the **Test Account** button verify account credentials. When finished, click **Next**.

15. In the **RightFax Server Name** box, enter your RightFax server name.

16. In the **DocTransport Queue Server Name** box, enter the name of the server on which the Microsoft Message Queue service is installed.

17. In the **Image Folder Path** box, enter the path to the shared image directory to be used by both the RightFax server and the remote DocTransport.

18. To verify remote access to the RightFax server, click **Check Access**.

19. When finished, click **Next**.

20. To apply your settings and complete Setup, click **Apply** and then click **Close**.
Chapter 6
Configuring Server-Side Application Conversion

By default, the RightFax server uses its built-in conversion engine to generate fax images from document file attachments. These are files passed to the RightFax server in their original format (such as Word, Excel, or PowerPoint) instead of first being converted to printer output. Document attachments are typically delivered to the RightFax server from one of the email gateway modules (as mail message attachments) or from RightFax Web Access.

While the standard RightFax conversion engine has some advantages (such as being very fast and efficient), there are occasionally variances between the fax image it generates and the original document. In most cases these variances are minor and acceptable. However, if the conversion quality of faxed file attachments is unacceptably low, your RightFax servers can be configured so that the applications associated with certain file formats are launched to allow for direct (and therefore more accurate) conversion by attachments’ native applications. This is known as server-side application conversion or SSA.

Note Server-side application conversion is not used for documents that are printed directly from the native applications to the RightFax print-to-fax driver. The print-to-fax conversion is handled by the native application on the client computer before it is sent to the RightFax server.

Understanding Server-Side Application Conversion

Where possible, server-side application conversion supports multiple concurrent document conversions to save processing time and server resources. Also, blank pages are removed from the fax image to save on fax costs and channel resources.

Server-side application conversion is available when faxing from:

- Files attached using FaxUtil.
- Files attached using WebUtil.
- Files attached using print-to-fax.
- The Send To shortcut menu.
- File attachments sent through the Microsoft Exchange, SMTP, or Lotus Notes email gateways.
- Files attached by using the &lt;ADDDOC&gt; embedded code.
- The RightFax API and COM API.

Launching an application at the RightFax server each time a file attachment fax image is generated has some potential drawbacks. You should weigh these drawbacks against the benefits before configuring your RightFax server to perform server-side application conversion.
Full applications are much larger and more processor-intensive than the standard RightFax conversion engine. You may need to upgrade the RightFax server memory or processing capacity to support server-side application conversion, especially if your organization generates a lot of faxes with attached files.

Most applications are not designed to be run completely without user intervention. Situations may arise in which an application stops while it waits for user input (such as waiting for a password). RightFax makes every attempt to prevent or bypass such occurrences but cannot guarantee it will prevent all such occurrences. If one or more faxes being processed through server-side application conversion fail to send, you should check that the application on the server is not stalled and waiting for attention.

Documents containing objects that the server does not have access to (such as special fonts, links to files on other computers, macros, or templates) may generate unpredictable results, such as incorrect fax image output or conversion failure. To minimize this, install all of the TrueType fonts, document templates, macros, and other components used by your organization to the computer or computers that provides server-side application conversion.

If server-side application conversion does not succeed in creating a fax image, RightFax will use its built-in conversion engine to create the fax.

The Conversion Engine also supports and can be configured to use Optical Character Recognition (OCR) technology. OCR related settings are located under the RecoStar tab. For information about OCR setup and configuration, see “Using Optical Character Recognition” on page 207.

The RightFax Conversion Engine converts documents from these programs:

- Microsoft Internet Explorer 6, 7 or 8.

**Note:** Microsoft does not support Office 2010 on XP 64x systems.

To enable the RightFax server to perform Server-Side Application conversion, install the applications on the RightFax server and any computers running remote WorkServers you want to use for SSA.

The version of Microsoft Office installed on the RightFax server or WorkServers must be able to open the document versions that are submitted by client computers.


**Installing Office Applications**

On each of your RightFax servers and any other computers where RightFax WorkServers will be executed, follow these guidelines to install the Microsoft Office Word, Excel, PowerPoint, and Visio applications (versions 2000 through 2003), for server-side application conversion.
1. On the RightFax server, run Setup.exe. During the installation, select the following options.

<table>
<thead>
<tr>
<th>Table 6a Installing Office</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation option</strong></td>
</tr>
<tr>
<td>Destination folder</td>
</tr>
<tr>
<td>Installation type</td>
</tr>
<tr>
<td>Components to install</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Office Tools</td>
</tr>
<tr>
<td>Converters and Filters</td>
</tr>
<tr>
<td>Text Converters</td>
</tr>
<tr>
<td>Graphics Filters</td>
</tr>
<tr>
<td>Microsoft Excel</td>
</tr>
<tr>
<td>Spreadsheet Converters</td>
</tr>
<tr>
<td>Microsoft Word</td>
</tr>
<tr>
<td>Text Converters</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
</tr>
</tbody>
</table>

2. When the installation is complete, restart Windows.

3. After you have installed Microsoft Office 2003, you must activate the software either through the Internet or by calling Microsoft.

4. Install Microsoft Office 2003 Service Pack 3 and any additional updates.

5. Set the security for macros in Office to the lowest setting.


   **Important:** You must also install any available updates to the Compatibility Pack.

7. Create a folder called Desktop in the system directory on each server where SSA conversions will occur (C:\Windows\System32\config\systemprofile\Desktop). For 64-bit versions of Windows 2008, you must also create a new folder called Desktop in the 64-bit system folder (C:\Windows\SysWOW64\config\systemprofile\Desktop).

8. Each Office 2003 application that you have installed must be launched on the server and then closed so that any additional setup requirements at the user profile level can be completed.

9. Reboot the RightFax server.

Microsoft Office applications may require some configuration to ensure that server-side application conversion works properly. Refer to the following section for additional information about configuration and limitations for Microsoft Word, Excel, and PowerPoint.

**Configuring Office Applications**

Server-side application conversion through Microsoft Office 2000–2003 converts these file types:

- Microsoft Office versions 2000–2003
- Office 2007 and 2010 documents (converted using Office 2003 with the Office Compatibility Pack)
- RTF (rich text format)
Password-protected files will not be converted with the exception of Outlook or Lotus Notes file attachments where the Outlook or Notes client has had the correct password provided in the Document Conversion options (described in the RightFax Connector for Microsoft Exchange Administrator Guide and RightFax Lotus Notes Module Guide.)

**Note:** Running the Exchange Events service on the RightFax server will cause server-side application conversion through Word to fail. If you must run Exchange Server on the same computer as your RightFax server, you must disable the Exchange Events service.

**Note:** RightFax cover sheets must be Word 97-2003 format (with extension .doc), not the Word 2010 format (extension .docx). See “Creating Fax Cover Sheets” on page 197 for more information about cover sheets.

**Note:** Excel 2010 can create two types of XML output, both with the extension .xml. RightFax can convert spreadsheets that have been saved in XML Spreadsheet 2003 format, but not Excel 2010 XML Data format. Office 2007 Excel documents using the column feature (a new feature in Office 2007) have problems converting.

**Note:** Some of the features new to Excel 2007 (such as conditional formatting icon sets and data bars) may prevent conversion. To remedy this, copy the data from the worksheet, then use Paste Special to store only the values to a new file. These features will convert correctly from Excel 2010.

To configure these applications,

1. On the RightFax server, select **Start > Programs > Open Text > RightFax Enterprise Fax Manager**.
2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.
3. In the **Service Name** list, double-click **RightFax Conversion Engine**. The Conversion Engine Configuration dialog box opens.
4. For each application, you can specify memory, time out, and retry settings by completing the following fields.
   - **Application Monitoring** Use the Application Monitoring setting to allocate memory (in megabytes) as needed. The default value of 25 MB is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.
   - **Document Monitoring** Adjust this setting based on the size of the largest document (page and word count) sent for conversion by Excel. The default value of 1 minute is usually adequate for all but the largest documents.
   - **Maximum number of retries** The maximum number of conversion attempts per document is controlled by the Maximum number of retries setting. Documents that fail conversion are marked as Problem Converting Fax Body or Coversheet.

**Configuring Internet Explorer**

The conversion engine can invoke Internet Explorer 7 or later to assist in the conversion of HTML documents. The Internet Explorer tab allows RightFax administrators to control settings associated with Internet Explorer (HTM and HTML) conversions.

1. On the RightFax server, select **Start > Programs > Open Text > RightFax Enterprise Fax Manager**.
2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.
3. In the **Service Name** list, double-click **RightFax Conversion Engine**. The Conversion Engine Configuration dialog box opens.
4. Click the **Internet Explorer** tab.
5. Complete the following fields.
Application Monitoring  Use the Application Monitoring setting to allocate memory (in megabytes) as needed. The default value of 25 MB is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.

Document Monitoring  Adjust this setting based on the size of the largest document (page and word count) sent for conversion by Internet Explorer. The default value of 1 minute is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.

Maximum number of retries  The maximum number of conversion attempts per document is controlled by the Maximum number of retries setting. Documents that fail conversion are marked as Problem Converting Fax Body or Coversheet.

Page Headers and Footers  If your conversions require Internet Explorer header and footer print codes, you must add them to the Header and Footer fields. For information about Internet Explorer print code macros, see Microsoft documentation.

Page Margins  Use the up and down arrows to configure page margins. Number format will vary with regional settings. If the format includes a period as a decimal separator, the values are in inches (.75 inches). If the format includes a comma as a decimal separator, the values are in millimeters (19.0 millimeters).

Note: After installing Internet Explorer, you must complete the configuration wizard by launching IE and responding to the prompts. You will not be able to use RightFax features that require htm conversion (such as cover sheets) if IE is waiting for user input.

Configuring XPS Conversion
RightFax uses a dedicated XPS conversion engine to fax Microsoft XPS files. To configure for XPS:

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.

2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.

3. In the Service Name list, double-click RightFax Conversion Engine. The Conversion Engine Configuration dialog box opens.

4. Click the XPS tab.

5. Complete the following fields.

Application Monitoring  Use the Application Monitoring setting to allocate memory (in megabytes) as needed. The default value of 25 MB is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.

Maximum Conversion Time  Adjust this setting based on the size of the largest document (page and word count) sent for this conversion. The default value of 1 minute is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.

Maximum number of retries  The maximum number of conversion attempts per document is controlled by the Maximum number of retries setting. Documents that fail conversion are marked as Problem Converting Fax Body or Coversheet.

6. Click OK.
Configuring Conversion Logging

The **Logging** tab provides RightFax administrators with control over the types of messages logged by the Conversion Engine. Each of these messages can be customized using categories and logging levels. By default, all output is written to the Windows Event Logs, except when the service is running in debug mode, in which case all messages are shown in real-time via the diagnostics window.

**Note** The RightFax Conversion Engine configuration program cannot be opened from a remote computer.

1. On the RightFax server, select **Start > Programs > Open Text > RightFax Enterprise Fax Manager**.

2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.

3. In the **Service Name** list, double-click **RightFax Conversion Engine**. The **Conversion Engine Configuration** dialog box opens.

![Figure 6.1 The Conversion Engine Configuration Logging tab](image)

4. Click the name or description of a message category, then choose the level of logging for that category from the drop-down menu.
   - **Off**. No information is saved.
   - **Error**. Records critical errors only.
   - **Warning**. Records errors and major events only.
   - **Info**. Records errors, major events, and informational messages.
   - **Verbose**. Records all significant events and is most useful for tracking and resolving problems.

**Caution** If you leave this value set to "Verbose" for long periods of time, the Event Log can become full which may prevent new events from being logged.
For more information about debug mode, see “Troubleshooting the Conversion Engine” on page 74.

Configuring the Service Account

The Conversion Engine must be run under an account that has permission to open the conversion applications and permission to create a printer. The Local System account does not have these permissions, and cannot be used as the service account. To set the service account:

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.
2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.
3. In the Service Name list, double-click RightFax Conversion Engine.
4. On the Conversion Engine Configuration dialog box, click the Service Account button.
5. Enter the information for an account that has permission to:
   - open the Microsoft Office programs and Internet Explorer
   - create a printer
   - print
   This account must also have a profile on the RightFax Server.
6. Click OK to close the Service Account window.
7. Click OK to close the Conversion Engine Configuration dialog box.

To Configure Timeout on a Failed Conversion

In case server-side application conversion fails, you can configure RightFax to automatically time out, stop the conversion, and set the fax status to “conversion failed.”

1. On the RightFax server, stop all WorkServer services.
2. Edit the Windows Registry length of time indicated by the KillServiceTimeout value on the RightFax server for each workserver. See “KillServiceTimeout” on page 350.
3. Restart the services.

To have the WorkServers recover after being stopped by this new feature, open the Windows Control Panel and select Administrative Tools > Services > RightFax WorkServer and go to the Recovery tab to select the service’s response to the shutdown.

Note To view the RightFax control panel icons on x64 systems, be sure to select View 32-bit Control Panel Items in Control Panel.

Controlling Server-Side Application Conversion

To control how and when server-side application conversion is used for specific document types, edit the Windows registry value “NativeDocControl” (as described on page 350. The setting for this value is one or more lines each controlling a specific document type in the format:

DocType,Action

Where DocType is the type of document to control, and Action specifies how the document type should be handled. DocType can be Word, Excel, PowerPoint, VSD, RTF, HTML, or PDF. The following table lists the actions you can specify.
Example  NativeDocControl value setting:

\[ \text{VSD}, 2 \]

<table>
<thead>
<tr>
<th>Value</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Attempt to convert the document using the native application on the server. If this fails because the application is not installed, because the application cannot be started, or because the application returns an error, then attempt to convert the document using the built-in RightFax conversion engine.</td>
</tr>
<tr>
<td>2</td>
<td>Only attempt to convert the document using the native application on the server. If this fails for any reason, abort the fax.</td>
</tr>
<tr>
<td>3</td>
<td>Attempt to convert the document using the built-in RightFax conversion engine. If this fails for any reason, abort the fax.</td>
</tr>
<tr>
<td>4</td>
<td>Do not attempt to convert this type document. Conversion will fail.</td>
</tr>
<tr>
<td>5</td>
<td>Attempt to convert the document using the built-in RightFax conversion engine. If this fails, attempt conversion with the native application.</td>
</tr>
</tbody>
</table>

Word-wrap for Text Attachments

Text attachments that contain long lines of text can potentially be truncated. To configure RightFax to word-wrap text attachments, edit the WordWrapTextLength value in the Windows Registry.

1. Edit the Windows Registry value for WordWrapTextLength for each Workserver. See “WordWrapTextLength” on page 351 for more detail.

2. Open the RightFax WorkServer Module.

3. Configure all RightFax WorkServers to use the option ‘Use PCL Converter for Text Files’.

4. Click OK to restart the WorkServer Modules.

Troubleshooting the Conversion Engine

Like all RightFax services, the Conversion Engine can be run in ‘debug’ mode. Debug mode provides RightFax administrators with robust real-time monitoring, logging, and troubleshooting via a separate diagnostics window. From this window it is possible to customize the trace (logging) level, group by processes, and save the output to an RTF or TXT file. Errors and warnings are also displayed in different colors, making it easier to isolate problems. The diagnostics window also allows the service to be started, stopped, paused and resumed.

To run the Conversion Engine in debug mode

1. Open Enterprise Fax Manager, click your fax server name, and browse to the services view in the lower-right corner.

2. Right-click the RightFax Conversion Engine and choose Stop.

3. When the service has stopped, right-click the service and select Debug. The Diagnostics window opens.

Changes made to the Conversion Engine while running in debug mode are not reflected in the diagnostics window until re-launched. Also note that when running the Conversion Engine in debug mode, it is possible to restart the service by clicking OK in the Conversion Engine configuration. Setting the service that runs the Conversion Engine (RfIsoConv.exe) to manual startup will prevent this problem, however, this is only recommended when performing complex debug associated troubleshooting.
Chapter 7
Enabling and Using the RightFax Sync Module

RightFax maintains a database of users. This database defines each user’s RightFax-specific contact information, logon information, preferences, and permissions. With the RightFax Sync Module, you can import this information in real-time or at definable intervals from other data sources, such as Microsoft Active Directory or any LDAP (Lightweight Directory Access Protocol) compliant data source.

When you use the RightFax Sync Module, only the RightFax database will be updated. The original data source will not be changed.

Description of the Sync Module

The Sync Module is an XML/XSLT based tool that allows RightFax administrators to create and update users from Active Directory (domains, groups, and organizational units) and LDAP compliant data sources.

Features

- Synchronization data is not stored in Active Directory.
- Support for multiple domain environments.
- LDAP support.
- Robust real-time logging and diagnostics.
- Nested groups are not automatically included when synchronizing from parent groups.
- Synchronization is managed as a standalone service.

Configuration Overview

To configure the Sync Module, you must:

1. Define one or more data sources. Data sources may be either Active Directory or LDAP compliant. See “Defining a Data Source” on page 76.

2. Define one or more RightFax databases you want to update. See “Defining a Destination Database” on page 80.

3. Define which sources update each RightFax database by using the Mapping function. With mapping, you can also define how often the RightFax database will be updated from each source. See “Creating Mappings” on page 81.

The rest of this chapter describes these steps in more detail.
Defining a Data Source

Open the Windows Control Panel and double-click RightFax Sync Module. The **RightFax Sync Module Configuration** opens.

**Note** The Sync Module cannot be configured from a remote computer.

---

Adding or Editing a Data Source

Each source and destination you define is represented by a tab on the Configuration dialog box. There is no limit to the number of sources and destinations you can define. For each source you want to define, follow these steps:

1. **Click Sources & Destinations.** The *Sync Sources and Destinations* window opens.

---

2. **Click New** to configure a new data source, or highlight a displayed data source and click **Edit** to make changes.

---

3. Using the drop-down arrow, select your source type, either **Active Directory (Source)** or **LDAP (Source)**.

---

4. Enter a unique name for the source. The source name will be displayed on the tab in the Sync Module Configuration dialog box, preceded by a code for the type. Active Directory sources will get the prefix AD- and LDAP sources will get the prefix LDAP-.

---

5. When finished, click **OK**. The source name displays as a new tab.

You must configure each source to specify information about how the data will be brought into the RightFax database.
Configuring a Data Source

Once you’ve defined a source, you must configure it. To configure a source, follow these steps:

1. From the Sync Module Configuration window, click the tab for the source you want to configure. Active Directory sources will always have the prefix AD- and LDAP sources will always have the prefix LDAP-.

2. For LDAP sources only, you can choose an existing configuration. Click the General tab, and then choose a configuration from the drop-down list. You can also use the General tab to create a new LDAP configuration file (see “Creating a New LDAP Schema” on page 79).

3. For Active Directory sources only, you can choose an existing Active Directory Sync (AD Sync) profile. Click the Special tab and click Import. When you import a profile, a new property collection and a new transform will be created.

4. Click the Filter tab to define which data the Sync module will import to the RightFax database. Filters are a set of parameters used by the Sync Module to determine which users are synchronized into RightFax. For each set of users you must choose a domain and at least one Organizational Unit (OU) or group. You may also choose to exclude users that are in certain groups. If you do not assign a filter, synchronization will not occur.

   **Note:** If you need to change the filter type for the data source from OU to group or group to OU, you must first delete the source tab (see “Deleting a Data Source or Destination” on page 82) and then recreate it for the new filter type.

5. Select New. The Define Filter window opens.

6. In the Define Filter window, browse to your Domain and click OK.

7. If necessary, browse and select OU’s by checking the box next to each OU. If necessary, add an include group and an exclude group.

8. When finished, click OK to close the Filter window and return to the Data Source display. The Filter you’ve defined appears in the list.

   **Important** When synchronizing with Active Directory, nested groups and OU’s are NOT automatically included. This allows for finer control of which groups and OU’s are and are not included. Also note that when browsing for a group that resides in a child domain, you must change the Windows browser to point to the child domain you are attempting to browse to. By default, the Windows browser will select the parent domain for directory searches. Use the Locations button to browse to and select the correct domain.
9. From the Data Source window, click the Output tab to specify the output data for each new, modified, or deleted user found during a synchronization event. This data is transformed into a format suitable for the RightFax database.

Figure 7.4 The Output Tab

10. For New/Modified Users, you can select any number of Active Directory text-based properties that will be used to update the RightFax database. Two predefined property collections are available - Default Windows Properties and Default Exchange Properties. These contain typical properties for use with Windows and Exchange users, respectively, and cannot be edited. To make new Property Collections or to edit existing ones, click Edit Collections to display the list of Property Collections.
   - To make an editable copy of an existing collection, click Copy and then enter a unique name in the Name field of the Property Collection dialog box.
   - To edit a property collection, highlight a collection in the list and click Edit to display the Property Collection dialog box.
   - To create a new property collection, click New, enter a unique name in the Name field of the Property Collection dialog box.
Enabling and Using the RightFax Sync Module

From a displayed Property Collection dialog box, you can remove properties from the displayed collection by clicking Delete.

From a displayed Property Collection dialog box, you can add a property to the displayed collection by clicking Add to display the Property Picker. Highlight the properties you want to update each time the Sync program runs. You can use the Ctrl key to select multiple properties. Click OK to close the Property Picker.

Click OK to close the Property Collection dialog box. Click OK to close the list of Property Collections and return to the Output Tab.

11. The Deleted Users section on the Output Tab allows you to control how RightFax will treat users deleted from Active Directory. By default, the user is only deleted if it is empty (i.e., without documents or phonebook entries). The other options are Always delete users or Never delete users.

If a user that was created on the RightFax server through an Active Directory synchronization does not appear in Active Directory subsequently, you can treat it as a deleted user by selecting the OPTIONAL: Treat users that were previously synced but are no longer included in the sync as if they had been deleted check box. This option applies only to the current source.

Caution In syncs with multiple sources, users created by a preceding source will be detected as “no longer included” in the current source within the same sync. If the check box is selected, the specified deletion action will be performed. This is also true when using filters to sync subsets of previously-synced users.

Warning Avoid combining OPTIONAL: Treat users that were previously synced but are no longer included in the sync as if they had been deleted with “Always delete user” because this can result in a large-scale deletion of users and their faxes.

12. When you’ve completed all the configuration for the specified source, click Apply to save the changes and close the configuration window.

Creating a New LDAP Schema

1. Under the General tab, click the ellipsis button next to the pick-list. The LDAP Configuration window opens.

2. In the LDAP Configuration window, choose New. The Select Default Configuration window opens.

3. Select one of the bundled configuration options (Default LDAP or Default Notes LDAP) and click OK.

4. Under the General tab, enter a unique name for your LDAP configuration.
5. Click the **Connection** tab. In the Server section, enter a host and base DN (i.e., *name/organization*) followed by a port number used by your LDAP server. In the security section, enter the authentication method employed by your LDAP server. Click **Validate** to confirm your information. If correct, you will receive the message Validation Successful. When finished, click **OK**.

6. Click the **Schema** tab. Here you may change the default and standard LDAP values.

7. Use **Deleted Objects** tab to configure deleted object tracking (users, groups, and OU’s). Specify a deleted objects storage container, and if necessary, create search a filter to provide results associated only with deleted objects. This feature can only be used in LDAP environments that support object tracking.

### Defining a Destination Database

Open the Windows Control Panel and double-click RightFax Sync Module. The **Sync Module Configuration** window opens.

*Note* The Sync Module cannot be configured from a remote computer.

1. Click **Sources & Destinations**. The **Sync Sources and Destinations** window opens.

   ![Sync Sources and Destinations Dialog Box](image)

   **Figure 7.6** The Sync Sources and Destinations Dialog Box

2. Click **New** to configure a new destination database, or highlight a displayed destination database and click **Edit** if you need to make changes.

3. Using the drop-down arrow, select **RightFax (Destination)**.

4. Enter a unique name for the destination database. The name will be displayed on the tab in the Sync Module Configuration dialog box, preceded by the destination prefix RF-.

5. When finished, click **OK**. The destination database name displays as a new tab.

You must configure each destination to specify information about how the data will be brought into the RightFax database.
Configuring a Destination Database

Once you’ve defined a destination database, you must configure it. Follow these steps:

1. From the Sync Module Configuration window, click the tab for the destination you want to configure.
2. Click the Server tab, and then enter the RightFax server name in the Server Name field.
3. Click the RightFax Account button to select a RightFax account with Administrative Access. This account is used by Sync Module to create and delete users on the RightFax server. This account should be dedicated solely to the Sync module.

Important The RightFax account password is saved as an encrypted registry item on the RightFax server. To avoid this, use NT authentication.

4. Click the Users Tab to enter a RightFax user account to use as a template or model for creation of new (i.e., synchronized) users. New users will inherit all settings associated with the specified user. You can set up multiple RightFax/Destination profiles, each with a different model user. This allows for all manner of customization, such as having different users synchronized into different RightFax groups, or with different RightFax permissions.

Creating Mappings

After you complete the source and destination configuration, you must specify which sources will be used to update each destination database. Mappings define how and when sources and destinations are synchronized. You can define as many mappings
as you need and previously defined sources and destinations can be used in more than one mapping. This allows, for example, a single Active Directory source to be synchronized into two different RightFax servers, or two different sources to be synchronized to a single RightFax server.

To Create a New Mapping


2. Using the drop-down arrows, choose your Source and Destination.

3. In the Sync Mapping window, browse to the \RightFax\Capasync\Config folder and select the Transform File relevant to your environment. The Transform File is responsible for transforming data generated by the source into an XML file translated by the destination. This file together with the RightFax User Template can be edited to create a custom synchronization template.

4. Select a synchronization schedule.
5. When finished, click OK.

Deleting a Data Source or Destination

Each source and destination you define is represented by a tab on the Configuration dialog box. If you need to remove a source or destination tab, follow these steps:

1. Click Sources & Destinations. The Sync Sources and Destinations window opens.

2. Highlight a displayed data source and click Delete.
3. When finished, click OK. The source or destination is removed from the dialog box.
Verifying User Synchronization

Users created via the Sync Module are denoted in Enterprise Fax Manager by a green dot next to their user icon. Users who do not display this marker have not been updated or created via the Sync Module.

Troubleshooting

The Sync Module provides administrators with convenient and customizable real-time logging and troubleshooting tools.

Logging  The Logging tab provides RightFax administrators with control over the types of messages logged by the Sync Module. Each of these messages can be customized using categories and logging levels. By default, all output is written to the Windows Event Logs, except when the service is running in diagnostics (debug) mode, in which case all messages are shown in real-time via the diagnostics window.

Diagnostics

Like all RightFax services, the Sync Module can be run in 'debug' mode. Debug mode provides RightFax administrators with robust real-time monitoring, logging, and troubleshooting via a separate diagnostics window. From this window it is possible to customize the trace (logging) level, group by processes, and save the output to an RTF or TXT file. Errors and warnings are also displayed in different colors, making it easier to isolate problems. The diagnostics window also allows the service to be started, stopped, paused and resumed.
To run the Sync Module in debug mode

1. Open Enterprise Fax Manager, click your fax server name, and browse to the services view in the lower-right corner.
2. Right-click the RightFax Sync Module and choose Stop.
3. When the service has stopped, right-click the service and select Debug. The Diagnostics window opens.

Changes made to the Sync Module while running in debug mode are not reflected in the diagnostics window until re-launched. Also note that when running the Sync Module in debug mode, it is possible to restart the service by clicking OK in the Sync Module configuration. Setting the service that runs the Sync Module (CapaSync.exe) to manual startup will prevent this problem, however, this is only recommended when performing complex debug associated troubleshooting.
You can use the Enterprise Fax Manager application to administer multiple RightFax servers. With Enterprise Fax Manager, you can manage users, groups, signatures, forms, printers, billing codes, library documents, and more, for all RightFax servers from one application.

Enterprise Fax Manager (EFM) is a client application that can be run on any Windows XP Professional, Windows Vista, or Windows 7 computer. It is installed as an optional component during the client installation (described in the RightFax Installation Guide.)

**Starting Enterprise Fax Manager**

After it has been installed, you can start EFM from the Start > Programs > Open Text menu, or click Enterprise Fax Manager in the RightFax tray icon shortcut menu.

When you start EFM for the first time, it will attempt to log on under your network user ID. If you did not log on to the network as “Administrator,” the Login dialog box opens. Enter a user ID and password with RightFax administrative access.

**Quitting Enterprise Fax Manager**

To quit EFM, on the File menu, click Exit. When you quit the program, all of your changes and additions are saved.

---

**The Enterprise Fax Manager window**

When you start EFM, the Enterprise Fax Manager window opens. The left pane of the window contains the open RightFax servers and their administrative components (users, forms, printers, etc.). The right pane displays details of the selected component. Items listed on the right, such as individual users or library documents, are referred to as “objects.” Objects can be added, deleted, and modified according your needs. If you don't have a mouse, press F6 to switch the cursor between the left and right panes.

---

Figure 8.1 The Enterprise Fax Manager window
Opening RightFax servers

To display a server name in the list, press CTRL+O, or in the File menu, click Open Server. The Open Server dialog box appears.

Figure 8.2 The Open Server Dialog Box

In the Server Name box, type the name of the RightFax server to open. In the Protocol box, enter the network protocol used by that server.

After one or more RightFax servers have been opened in EFM, the servers will, by default, open each time you run the program. This default setting can be changed in Preferences, described later in this chapter.

To close a RightFax server, click the server name and on the File menu, click Close Server.

Refreshing data in the window

Users can create new library documents, forms, and signatures in their FaxUtil mailboxes while EFM is open. These new files will not appear in EFM until the view is refreshed. To refresh all objects, including objects added or modified since the last check, press F5 or on the Edit menu, click Refresh.

Setting Preferences

EFM has several customizable preferences. To view your preferences, on the Edit menu, click Preferences. The Preferences dialog box opens. The rest of this section describes the options in this dialog box.

The User Copy Defaults tab

Figure 8.3 User Copy Defaults

You can copy one or more users from one RightFax server to another by dragging and dropping selected users to another server in the list. The options on the User Copy Defaults tab set the behavior of EFM when copying RightFax users from one server to another.

**Always Prompt** Display this list of options each time users are copied from one server to another. You must select a copy option before the users will be copied.

**Copy for InterConnect (no faxes or phonebooks)** Copies all user information, excluding faxes and phonebook entries, and then sets the user's Routing Type to InterConnect, pointing back to the server that the user was copied from.

**Copy without Faxes or Phonebooks** Copies all user information excluding faxes and phonebook entries.
**Copy with Faxes and Phonebooks**  Copies all user information *including* faxes and phonebook entries. Duplicate users will receive all faxes in the source account, even if the same faxes already exist on the destination server, creating multiple copies of the same fax.

**Copy with Faxes Only**  Copies all user information including faxes but not phonebook entries. Duplicate users will receive all faxes in the source account, even if the same faxes already exist on the destination server, creating multiple copies of the same fax.

**Copy with Phonebooks Only**  Copies all user information including phonebook entries but not faxes.

**Append Faxes and Phonebooks**  Copies only information for duplicate user accounts. All faxes and phonebook entries from the source user account will be added to the destination user account. No other user information will be changed. Users on the destination server will receive all faxes in the source account, even if the same faxes already exist on the destination server, creating multiple copies of the same fax.

**Append Faxes Only**  Copies only information for duplicate user accounts. All faxes from the source user account will be added to the destination user account. No other user information will be changed. Users on the destination server will receive all faxes in the source account, even if the same faxes already exist on the destination server, creating multiple copies of the same fax.

**Append Phonebooks Only**  Copies only information for duplicate user accounts. All phonebook entries from the source user account will be added to the destination user account. No other user information will be changed.

---

### The Dialing Rule Copy Options tab

You can copy one or more dialing rules from one RightFax server to another by dragging and dropping rules to another server in the list. The options on the Dialing Rule Copy Options tab set the behavior of EFM when copying RightFax dialing rules from one server to another.

**Replace all rules on destination**  Copies all dialing rules from the source server to the destination server, deleting any existing dialing rules.

**Copy ‘Receive into Local’ rules**  Includes all dialing rules with the “Receive into local server” action when copying. If this check box is not selected, “Receive into local” rules will be ignored during the copy.

**Copy ‘Send Locally’ rules**  Includes all dialing rules with the “Send locally” action when copying. If this check box is not selected, “Send locally” rules will be ignored during the copy.
The General Preferences tab

The options on the General Preferences tab set some general preferences for views and actions in Enterprise Fax Manager.

Automatically re-open servers upon startup Recalls which servers were open when the program was last quit and opens those servers again on startup. If this check box is not selected, you must reopen each RightFax server upon starting EFM.

Confirm object deletions Displays a confirmation dialog box each time you delete an object, such as a user or library document. If this check box is not selected, there will not be any confirmation prior to deleting objects. This is convenient if you are deleting many objects but makes it more likely that you will accidentally delete an object that you want to keep.

Confirm object overwrites Displays a confirmation dialog box each time you overwrite an object, such as by copying an object with the same name into the system. If this check box is not selected, there will not be any confirmation prior to overwriting objects.

Automatically adjust status display column width Adjusts the widths of the columns in the Server Status and Services pane (see “Monitoring the Status of RightFax Servers and Services” on page 90) to fit the column’s contents. This option will not affect the column widths in any other EFM view. When this check box is selected, you can still manually adjust the column widths in the Server Status and Services pane, but they will resize each time the screen image is refreshed.

Use black and white icons Select this option if your monitor is set to high contrast black and white. This changes the EFM server status icons to colors that are can be read in this color mode.

Enable duplicate routing code warning Displays a warning message when a user is created that has a routing code that is the same as another existing user.

Enable service control warning Displays a warning message when you make any changes to the state of any of the RightFax services.

Enable database locked warning Displays a warning message when you attempt to access the database when it has been locked by certain database management tools.

Viewing RightFax Server Information

To view the status of all open RightFax servers, click Fax Servers at the top of the list. A list of all open servers and the status of each server appears in the right pane of the window. This section describes each column in the right pane.

Server name

The Server Name column displays the name of each open RightFax server and network protocol. An icon to the left of the name indicates the status of the RightFax service. A green ‘+’ indicates that all services are running normally. A yellow ‘!’ indicates that one
or more services are not running but that normal fax operations are available. A red ‘–’ indicates that one or more services are not running and normal fax operations are not available.

### Version

The Version column displays the RightFax server software version.

### Serial number

The Serial Number column displays the serial number that was entered when the RightFax server was installed. You must provide this number when you contact OpenText Customer Support.

### Time running

The Time Running column displays the length of time that has elapsed since the RightFax Server service was last started. Display is in the format DDDD:HH:MM:SS.

### Queue usage

The Queue Usage column displays the percentage of the fax server’s internal Event Queue that is currently in use. For more information on the RightFax Event Queue, see “RightFax Internal Event Queue” on page 15.

### Fax board availability index

The Fax Board Availability Index column displays a number that indicates the relative availability of the server’s fax boards. The higher the number, the more available the server for sending faxes. RightFax uses this value when an outgoing fax number has two equally weighted dialing rules that send it to two different servers. In such a case, RightFax sends the fax via the server with the highest availability index.

### Character set mode

This column displays the OEM or ANSI code page being used by the server. The code page determines the language character sets that are supported for fax conversion.

### Working with Objects

#### Sorting objects

To sort the objects listed in Enterprise Fax Manager by column, double-click the column heading. The objects will sort in ascending order and an indicator will appear in the column heading. You can also click a column heading to alternately sort in ascending and descending order. Enterprise Fax Manager recalls how objects are sorted when you quit and restart the program.

#### Sorting columns

To move a column left or right, click the column heading and drag it left or right to its new position.

#### Selecting objects

To edit, delete, or otherwise work with an existing object, you must first select it in the list of objects displayed. Selected objects are highlighted.

To select an object, click it or use the UP ARROW and DOWN ARROW keys to move to the object and press the SPACEBAR to highlight it. To un-select an object, click it or press the SPACEBAR again. To select multiple objects, drag the mouse pointer down the objects while holding the left mouse button. If the desired objects are not all in a continuous group, click each object while holding down CTRL.
Before adding objects

Before you begin adding objects to the RightFax system, it is important that you plan the structure and anticipate the needs of your network users. Consider whether you will divide your organization into groups, whether you would like each group or department to have its own cover sheet, and who will act as administrator or alternate administrator for the group. Determine a block of routing codes sufficient for the entire system and decide upon any custom notification types desired. You should create new objects in RightFax only after you have carefully considered these issues.

Monitoring the Status of RightFax Servers and Services

EFM displays statistics and fax channel information and manages services on each RightFax server. To view and manage the status and services of each RightFax server, click the name of the server in the list in the left pane.

Figure 8.6  Server Status and Statistics

Note  If you are running remote DocTransports, they can be displayed in Enterprise Fax Manager but will not include data.

If you’re viewing the EFM from the server, the top line of this window displays the most recent update time for the data display. If you’ve logged on to EFM as administrator from a client machine, you’ll need to click Update Now to recompile and update the server statistics. The Update Now button only active from the client software.
Understanding the server statistics

Statistics about the server are displayed in the lower-left corner in the right pane of the window.

Note: The former alert for SQL server free space has been removed from RightFax. Use the Microsoft SQL tools to monitor the health and performance of the SQL Server for your RightFax Server. See your SQL documentation or the Microsoft site at http://technet.microsoft.com/en-us/sqlserver/default.

RightFax Event Queue Usage The percentage of the fax server’s internal Event Queue currently in use. For more information on the RightFax Event Queue see “RightFax Internal Event Queue” on page 15.

RightFax Events Processed The total number of events processed by the fax server since the Server module was started.

Fax Availability Index The relative availability of the fax boards on the server. The higher the number, the more available the server for sending faxes. RightFax uses this value when an outgoing fax number has two equally weighted dialing rules that send it to two different servers. In such a case, RightFax sends the fax via the server with the highest Availability Index.

Current Faxes Queued for Sending The current number of outgoing faxes waiting to be sent.

Current Pages Queued for Sending The current number of outgoing fax pages waiting to be sent.

Available Disk Space for Fax Images The percentage of disk space on your RightFax server available for storing fax images.

All-Time Send Attempts The total number of faxes sent from this server since the All-Time Counter Starting Date (described later).

All-Time Pages Sent The total number of fax pages sent from this server since the All-Time Counter Starting Date (described later).

All-Time Faxes Received The total number of faxes received on this server since the All-Time Counter Starting Date (described later).

All-Time Pages Received The total number of fax pages received on this server since the All-Time Counter Starting Date (described later).

All-Time Counter Starting Date The starting date from which the “All-Time” statistics (described earlier) are calculated.

Tip All of the All-Time statistics will report an error message if you are running fax boards in simulation mode.

Monitoring fax channel information

Information about the fax channels on the server is displayed in the upper-right corner in the right pane of the window

Channel Each fax channel that is available on this RightFax server.

Operation The current operational status of each channel.

Routing Code The inbound routing code of this fax channel for incoming faxes.

User ID The destination user ID of this fax channel for incoming faxes.

Monitoring services

The lower-right pane of the window lists each RightFax service, its status (running or stopped), the length of time it has been running, and its startup method (manual or automatic). To monitor services on remote servers, you must have network administrative access to the server as well as RightFax administrative access.
Starting and stopping services
To start or stop a service, right-click the service to open a shortcut menu.

- Click Start Service to start the selected service.
- Click Start all Services to start all services in the appropriate sequence.
- Click Stop Service to stop the selected service.
- Click Stop all Services to stop all services.

Configuring services
To configure a service, double-click the service. Or, right-click the service to open a shortcut menu, and then click Configure Service.

- For information on configuring a RightFax Server, DocTransport, or WorkServer, refer to the appropriate chapter in this guide.
- For information on configuring the AutoReply service, see Chapter 24, “Responding to Inbound Faxes with AutoReply”.
- For information on configuring the RightFax email gateway, see Chapter 28, “Using RightFax Email Gateways” or refer to the RightFax Gateway for Microsoft Exchange Guide or RightFax Gateway for Lotus Notes Guide.
- For information on configuring the RightFax Integration Module, refer to the RightFax Integration Module Guide.

Monitoring Queues
In addition to monitoring the information in the statistics window, you can display a list of RightFax Queues that show actions that are in process at that moment. To display the queues, click on Queues in the menu tree on the left side of the EFM window.

For each queue, the number of items in the queue is shown in both numeric (in the Value column) and graphic (in the Scale column) formats. Displayed queues include:

- **Pending conversion results** Number of results from WorkServer conversions not yet processed by a Server module.
- **Total server events** Total number of events currently scheduled on a Server module.
- **Documents in queue on FaxServ(s)** Total number of document-related events currently scheduled on a Server module.
- **Documents in queue on DocTransport(s)** (on DocTransport, not yet sent) Number of documents on DocTransport scheduled to be sent.
- **Documents sent by DocTransport(s)** (send completed but not yet discovered by a FaxServ) Number of documents sent by DocTransport, but not yet processed by a Server module.
- **Total documents** All documents in the system.
- **Deleted documents** All documents flagged in the database as deleted. Associated value fluctuates based on the days to keep deleted fax records setting of each user group.
Synchronizing the RightFax Server with External Systems

The RightFax WorkServer modules synchronize with external systems such as the Kofax NetScan user tables, library document catalogs, and import files for billing codes on a periodic, scheduled basis. You can force the server to synchronize immediately without changing the defined schedule.

On the Utility menu, click Synchronize External Systems.

Running Enterprise Fax Manager Web Edition

EFM Web Edition is a Web-based version of Enterprise Fax Manager that allows remote management of your RightFax servers from any Web browser. EFM Web Edition is included with all RightFax servers but must be installed separately on an IIS server on your network. For information on installing EFM Web Edition, refer to the RightFax Installation Guide.

To run Enterprise Fax Manager Web Edition

Note EFM Web Edition was developed and tested for use with Microsoft Internet Explorer version 6.0. Although it will run in other browsers, RightFax recommends using Internet Explorer version 6.0 or later for best results.

1. Open a Web browser and point the URL to the /webefm folder on the IIS server. For example:

   http://server.domain.com/webefm

2. Unless your IIS server is configured to allow anonymous access, a dialog box will appear that prompts you to log on to the IIS server. Enter your logon information and click OK. The browser will prompt you for information to open a RightFax server.
3. Enter the name of the RightFax server to open and a RightFax user ID and password that has administrative access to the RightFax server. Click Logon RightFax Server.

4. The RightFax server you specified opens in the frame in the left side of the page.

Managing RightFax servers in EFM Web Edition is similar to managing RightFax servers in EFM for Windows. Throughout this guide, references to EFM will describe the Windows version of EFM and not the Web edition. However, in almost all cases, the instructions will apply to both versions.

Selecting a language

EFM Web Edition is available in several different languages. To change the language, select the language you want in the Language menu in the upper-right corner of the page.
Chapter 9
Creating RightFax Users

Each fax user must be assigned a user ID on their local RightFax server. The RightFax server uses the user ID to assign ownership to sent faxes and route received faxes to their intended recipients. You can customize each user’s access to and usage of the system in the user profile.

Managing RightFax Users

Every RightFax user in your organization has a unique user ID and profile on a RightFax server. To add, edit, or delete RightFax user profiles, run EFM (see “Starting Enterprise Fax Manager” on page 85) and click **Users** under the RightFax server in the Fax Server Tree. The list of users appears in the right pane of the window.

![Figure 9.1 The RightFax Users List](image)

Each user ID is preceded by an icon.

- If the icon is red, the user has administrative access.
- If the icon is blue, the user does not have administrative access.
- A dot indicates that the user is synchronized with another application, and editing changes should be made in that application only.
Understanding the default RightFax user

The “Default” user ID is included in the list of users on each RightFax server. The Default user ID is used as a template for creating new users. When you are configuring your RightFax users, edit the Default user to have the same attributes as the majority of your fax users. Never delete the Default user.

Note If you are using Active Directory synchronization to create new users (described in Chapter 7, “Enabling and Using the RightFax Sync Module”), the Active Directory synchronization profile settings will override settings in the Default user ID.

Adding a user

To add a new RightFax user, press INSERT or in the Edit menu, click New. The User Edit dialog box opens. To configure the user profile, see “Creating a User Profile” on page 97.

The new user will have the same attributes as the Default user ID, except for the User ID, User Name, Password, and Distinguished Name boxes. Because each RightFax user must have a unique user ID, you must enter a value in the User ID box to create the new user. All other boxes are optional. For information on completing each of the options in each tab see “Editing user properties” on page 97.
Deleting a user
To delete a user, select the user to delete and press DELETE or in the Edit menu, click Delete. By default, you will be prompted for confirmation that you want to delete the user.

Copying a user from one server to another
Using Enterprise Fax Manager you can copy one or more users from one RightFax server to another. Select the users you want to copy, and then drag the selection to another server. The amount of information copied is configured in the Enterprise Fax Manager Preferences dialog box (see “Setting Preferences” on page 86).

If you copy users from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).

Editing user properties
To edit the properties of an existing user, run Enterprise Fax Manager, select the user to edit, and press ENTER or in the Edit menu, click Edit. You can also double-click the user. The User Edit dialog box opens.

Tip: To make global changes to selected groups of users, you can use Moduser.exe. See the Administrative Utilities Guide for more information.

Creating a User Profile
The user’s profile is defined in the User Edit dialog box. This section describes all the options in this dialog box.

The Identification tab

![User Edit Identification Tab](image)

- **User ID** The unique identifier used throughout the RightFax system to identify a user. In most cases, this ID should be the same as the user’s network login name. The ID can be 21 characters long.

- **Use Integrated Windows NT Security** Each RightFax user ID can be linked to a Windows user account to take advantage of your network’s established Windows NT based security system (see “Using Windows NT Security Authentication” on page 108).
Click **Select NT Account** to enter a domain and account name to link to the user. You can also select from a list of all user accounts in each domain.

If you want this fax user to link to a Windows NT based user account, select the **Use Integrated Windows NT Security** check box to allow the user account to be accessed *only* via Windows NT authentication. If a user’s current Windows NT account is not linked to any RightFax user IDs, that user cannot manually enter the user ID and password for anyone with this check box selected when accessing client applications.

With this option, RightFax will authenticate the user based solely on his Windows network account name and password, so the **RightFax Password** field will be disabled.

**User Name**  This is a descriptive name to help the administrator identify users. If you will be adding user names with diacritical or other characters refer to the *RightFax Installation Guide* for information about character sets and code pages on your RightFax server.

**Password**  The password required by each user to access his personal FaxUtil mailbox and to gain access to the RightFax settings in Enterprise Fax Manager. If you are creating a new user, you can enter a password.

To change a user’s password, click **Change Password** and enter a new password. If you click **Change Password** and do not enter a new password, the password will be erased and the user will not be required to enter a password when accessing RightFax client applications.

**Distinguished Name**  The Microsoft Exchange distinguished name, used to confirm accurate RightFax and Exchange user synchronization.

**Group ID**  The name of the RightFax group to which the user belongs. All users must belong to a group. For information on creating new groups, see “Adding new groups” on page 111.

**Voice Mail Subscriber ID**  Specify the mailbox number to use when routing faxes to a telephony server. This box is also used to assign TeleConnect mailbox numbers to RightFax accounts (requires the TeleConnect module, purchased separately).

**Email address**  Enter the user’s email address. This is required if the user will be sending documents to email addresses in addition to fax addresses via the RightFax client applications.

**SMS/Mobile Address**  Enter the user’s SMS-capable cell phone number. This is the number to which SMS notifications about the user's sent and received faxes will be sent.

**Compute Disk Usage**  Click to calculate the space on the server that is taken by this user’s faxes.

### The Permissions tab

---

**Figure 9.4 The User Edit Permissions Tab**
Administrative Access  Gives users access to the administrative functions of RightFax. Without this permission, a user cannot open Enterprise Fax Manager or switch to another user’s mailbox without the correct password. All administrators can run Enterprise Fax Manager and can switch to the mailboxes of users belonging to their administered groups. Administrators with this permission can not view any faxes other than their own without also having the Administrator Can Bypass Privacy Restrictions option also selected.

Administrator Can Bypass Privacy Restrictions  Gives users that have the Administrative Access option selected the additional ability to view faxes in other users’ mailboxes. Only an administrator that has this permission enabled can grant this permission to other users.

Archive Sent Faxes  Archives outbound faxes according to the Archive options defined in the WorkServer configuration program (see “Archive settings” on page 33).

Assign Default Billing Codes to Received Faxes  Assigns the user’s default billing code settings (see “Default Billing Codes” on page 103) to all received faxes. This is most useful if you have set RightFax to require billing codes on received faxes (see “Requiring billing codes on received faxes” on page 135).

Bypass Billing Code Verification  Allows the user to send faxes without supplying correct billing codes. This attribute will not exclude the user from having to supply other required fields in order to send faxes. This attribute is only effective if billing code verification is required system-wide.

Can Change Cover Sheets  Lets the user change cover sheets. If this check box is not selected, the user will be restricted to using the cover sheet specified in the Default Outbound Settings tab (page 102).

Can Edit/Add Forms  Lets the user use the Store as Form feature of FaxUtil to add new overlay forms to the RightFax system.

Can Edit/Add Library Docs  Lets the user use the Store in Library feature of FaxUtil to add new library documents to the RightFax system.

Can OCR Faxes  Allows the user to OCR faxes, either manually or automatically, as defined in FaxUtil. This attribute does not affect OCR routing and does not have to be enabled if OCR routing is being used. You must have licensed the RightFax OCR Conversion module for any OCR functions to be available.

Can Run Reports  Lets the user create reports using the RightFax Fax Reporter utility. For more information about Fax Reporter, see the Administrative Utilities Guide.

Can Send SMS Messages  Lets the user send documents to SMS addresses from within the RightFax client applications.

Can Use High Priority  Lets the user send faxes using “high” priority. If disabled, the user is restricted to “normal” and “low” priorities.

Disallow Billing Code Lookup  Prevents the user from viewing the list of valid billing codes. This requires the user to know at least one valid billing code.

Note  You must check both Disallow Billing Code Lookup and Disallow Editing of Billing Codes to ensure that users will not be able to modify their default billing code settings.

Disallow Changing of Notification Options  Prevents the user from changing their notification options.

Disallow Editing of Billing Codes  Prevents the user from changing the default billing code settings for outgoing faxes. In addition, any billing codes specified in phonebook entries are ignored as are any <BILLINFO> embedded codes.

Disallow Fax Annotations  Prevents the user from adding notes to faxes.
Disallow Fax Deleting Prevents the user from deleting faxes. This setting can be useful for persons doing manual fax routing. The restriction applies to the user and not the mailbox, so if the user switches mailboxes, he still cannot delete faxes.

EDC Process Received Faxes This setting is used with RightFax connectors that are purchased separately.

EDC Process Sent Faxes This setting is used with RightFax connectors that are purchased separately.

Excluded from Group Fax Aging Excludes the user from the automatic fax aging (image deletion) attributes of the group to which he belongs.

Must Have Faxes Approved Requires every fax sent by the user to be approved by a full, group, or alternate group administrator.

Must Have Password Requires the user to have a password. This does not restrict the user from changing his password.

Stamp Pages of Received Faxes with Audit Stamp Enabled printing of the RTI line and adds one line of text to the bottom of each received fax page listing total pages, date and time received, fax server used, inbound routing code used, CSID of sender, and transmission duration.

Unprotected Mailbox Allows all other RightFax users to view, manipulate and delete documents in this user’s mailbox. This does not affect the security of phonebook entries belonging to the user.

View First Page Only Restricts the user from viewing or printing anything but the first page of a received fax. This is useful when manual routing is employed. The restriction applies to the mailbox regardless of the permissions of the user viewing the mailbox. Faxes must be routed out of the restricted mailbox before subsequent pages can be viewed or printed.

The Inbound Routing tab

Figure 9.5 The User Edit Inbound Routing Tab

Routing Code (DID/DNIS Number) The routing code is a unique number that RightFax uses to route received faxes to the correct user. Enter the DTMF extension, DID phone number, or channel number you have assigned to this user. When a fax is received by the server, any routing information included is compared to each user’s Routing Code. If a match is made, the fax is routed to the user’s mailbox. For more information on routing faxes, see Chapter 23, “Routing Inbound Faxes”.

Note You must ensure that no routing code is used more than once. If you do use the same routing code more than once, only one of the persons to whom it is assigned will receive incoming faxes.
Routing Type Specify where incoming faxes will be routed after they arrive in the user’s fax mailbox. For more information on each of the routing types, see Chapter 23, “Routing Inbound Faxes”.

File Format Choose the file format in which faxes will be delivered when routed. The available formats will vary depending on the routing type you choose.

Table 9a File Formats for Routed Faxes

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCX</td>
<td>DCX combines multiple PCX pages into a single file. It solves the multiple attachment problem of PCX files but maintains the large file size (average of 135 Kb per page).</td>
</tr>
<tr>
<td>GIF</td>
<td>GIF is graphics interchange format. This format is available for routing in Microsoft Exchange.</td>
</tr>
<tr>
<td>PCX</td>
<td>PCX produces a single page per file with an average fax page size of 135 Kb. It is useful for routing received faxes to DOS and Macintosh users because DOS and Macintosh have built-in capabilities to view PCX-formatted fax pages. This format is not recommended for Windows client applications, because PCX is a large format and users have to sift through multiple attachments when viewing multiple page faxes.</td>
</tr>
<tr>
<td>PDF</td>
<td>PDF is portable document format.</td>
</tr>
<tr>
<td>PDF (searchable)</td>
<td>PDF (searchable) format includes a searchable text component. This format requires additional licensing. When licensed, all received PDFs will be searchable regardless of which PDF format is selected.</td>
</tr>
</tbody>
</table>

Table 9a File Formats for Routed Faxes (Continued)

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF-G3/</td>
<td>TIFF-G3 is a structured file type that is best for monochromatic images like fax pages (average of 35 Kb per page). Most email systems can read TIFF-G3 files, and you can associate the RightFax Fax Viewer with TIFF-G3 files to view these faxes in any application.</td>
</tr>
<tr>
<td>TIFF-G4</td>
<td>TIFF-G4 is a more compressed file format.</td>
</tr>
<tr>
<td>TIFF (Enhanced)</td>
<td>TIFF (Enhanced) can help improve the readability of text by straightening skewed pages and removing background noise. It does not improve the appearance of graphics.</td>
</tr>
</tbody>
</table>

Routing Info Specify how to route the fax to the correct destination for the Routing Type specified. If you route faxes to an email mailbox, you must enter the email address here. For information on the required Routing Info for each Routing Type see Chapter 23, “Routing Inbound Faxes”.

Received Fax Routing Form Specify the Outlook form you want to route incoming faxes to. Click System Default to use the form set in the Email Gateway configuration program (described in the RightFax Gateway for Microsoft Exchange Guide). This list is only available if you have selected “Exchange Mailbox” as your Routing Type.

Delete After Routing Deletes received faxes from the user’s FaxUtil mailbox after the fax has been successfully routed to the application specified in the Routing Type list.

If this check box is selected, notification of received faxes (page 108) will not work.
The Default Outbound Settings tab

Figure 9.6  The User Edit Default Outbound Settings Tab

Default Fax Resolution

Specify the resolution of the users outbound faxes. Normal resolution (200×100 DPI) creates draft quality images and allows shorter transmission times. Fine resolution (200×200 DPI) is recommended for high quality printed documents and Optical Character Recognition (OCR). This setting affects the body of a fax, but not the cover sheet.

Default Priority

Sets the priority at which all the user’s faxes are responded to by the fax server unless specified otherwise in the Fax Information dialog box when the fax is created.

Auto-Delete Setting

For most users, select Never. If this account is used to send large broadcast faxes, you can select Only If Successfully Sent or All Faxes to prevent large numbers of faxes from accumulating in the user’s fax box and to save disk space. Fax image files, not original documents created in other applications, will be deleted.

Caution  Auto-deleting sent faxes prevents users from reviewing or forwarding their sent faxes, and notifications of sent faxes (page 108) will not work.

If the user has the Archive Sent Faxes permission selected (page 99), or if they have enabled autoprinting of sent faxes in the FaxUtil client application, sent faxes will not be automatically deleted, even if this option is enabled.

Use Smart-Resume  Allows the fax server to intelligently resend only the portion of a fax which failed to send. For example, if the connection is broken after 40 pages of a 50 page fax, normally all 50 pages have to be resent. By enabling Smart-Resume, the server will only resend the last 10 pages.

This option can also be set by fax users on a per-fax basis from the Fax Information dialog box (see “Specifying Addressing Information” on page 230).

Send Cover Sheets

Allows the user to send cover sheets with faxes.

Cover Sheet Model

Specify the default fax cover sheet file to use for this user. The list displays the fax cover sheet files created in EFM\Cover Sheets. Select System Default to use the fax cover sheet specified for the user’s group or Set System Default if no group cover sheet assigned.

Cover Sheet Resolution

Specify the resolution of the user’s cover sheets. Normal resolution (200×100 DPI) creates draft quality cover sheets and allows shorter transmission times. Fine resolution (200×200 DPI) is recommended for high quality cover sheets and Optical Character Recognition (OCR). This setting affects the cover sheet only.

Sender Information Fields

Specify the user’s name, fax number, and phone number information as it will appear on fax cover sheets.
Creating RightFax Users

The Other tab

Figure 9.7  The User Edit Other Tab

Automatic Fax List Updates  Configures the user’s FaxUtil mailbox to automatically refresh (scan for new faxes).

Update Interval in Seconds  Specify the interval at which automatic fax list updates will occur.

Default Billing Codes  Specify the Billing Code #1 and Billing Code #2 settings that will appear in the Fax Information dialog box each time the user sends a fax.

The Pager Notification tab

These settings let the fax server send SMS messages or pages to RightFax users to notify them about the status of sent and received faxes. This dialog box specifies the fax status messages to send to the user. The text of the status messages that will be sent can be customized in the User Messages tab of the RightFax Server configuration program in Windows Control Panel (described on page 24).

Before completing this dialog box, you must configure a list of SMS and pager service types and providers. For information on configuring pager or SMS services, see Chapter 17, “Adding SMS and Pager Services”.

Figure 9.8  The User Edit Pager Notification Tab

Pager ID  Specify the user’s pager ID. This is usually a numeric ID and is often the phone number for the pager.

Pager/SMS Service  Select the pager or SMS service to use for delivering the notification. If you have not added and properly configured paging/SMS services for this user, you must do so before completing this dialog box (described in Chapter 17, “Adding SMS and Pager Services”).
Test SMS  This button lets you send a test message to an SMS-capable device. To send a test SMS message, select an SMS service in the Pager/SMS Service box, type a phone number in the Pager ID box, and then click this button.

New Fax is Received  Pages the user each time a new fax is received. If the TeleConnect module is installed, the RightFax server will include the TeleConnect ID with all notifications of incoming faxes. This lets users retrieve faxes without first requesting a fax list.

New Fax is Received from Specific CSID/ANI  Pages the user each time a new fax is received from one or more specific senders that are specified in the Patterns box.

Patterns  Lists the CSID or ANI numbers that, when received, will send a page alert to the user. Separate multiple numbers with semicolons.

Outbound Fax has been Abandoned  Pages the user each time one of his outbound faxes fails to send for any reason.

The Administrative Pager Alerts tab

These settings let the fax server send SMS messages or pages to RightFax administrators to alert them of specific RightFax events. This dialog box specifies the RightFax server status messages to send to the user. The text of the alert messages that will be sent can be customized in the Admin Messages tab of the RightFax Server configuration program in Windows Control Panel (described on page 25).

RightFax Enterprise versions 8.7 and higher include a more comprehensive Alerting and Monitoring service that lets you select from hundreds of server statistics to monitor and define the event thresholds, alert types, and alert messages to send. For more information on the RightFax Alerting and Monitoring service, see Chapter 18, “Using the Alerting and Monitoring Service”.

Before completing this dialog box, you must configure a list of SMS and pager service types and providers. For information on configuring pager or SMS services, see Chapter 17, “Adding SMS and Pager Services”.

Pager ID  Specify the user’s pager ID. This is usually a numeric ID and is often the phone number for the pager.

Pager/SMS Service  Select the pager or SMS service to use for delivering the alert message. If you have not added and properly configured paging/SMS services for this user, you must do so before completing this dialog box (described in Chapter 17, “Adding SMS and Pager Services”).
**Test SMS**  This button lets you send a test message to an SMS-capable device. To send a test SMS message, select an SMS service in the **Pager/SMS Service** box, type a phone number in the **Pager ID** box, and then click this button.

**Low Disk Space**  Free hard drive space on the RightFax server has fallen below 150 MB.

**Critically Low Disk Space**  Free hard drive space on the RightFax server has fallen below 50 MB.

**Send Queue too Deep**  The number of faxes or fax pages queued to send exceeds a fixed number. Enter the number of faxes to exceed in the **Faxes** box. Enter the number of fax pages to exceed in the **Pages** box.

**RightFax Event Queue Full**  The percentage of the fax server’s internal Event Queue has reached 90%. For more information on the RightFax Event Queue see “RightFax Internal Event Queue” on page 15.

**DocTransport Service Down**  One of the DocTransports has become unable to send or receive faxes.

**All DocTransports Down**  All of the DocTransports have become unable to send or receive faxes.

**Probable Line Failures**  An error or series of errors has indicated to the DocTransport that a phone line is not operating correctly.

**Probable T1 Failure**  Multiple phone lines have failed in such a way that the DocTransport suspects a T1 line is not operating correctly.

**Server improperly shut down**  The RightFax Server module was shut down unexpectedly. This may indicate that the operating system has failed or the server has lost power.

**Periodic Server Heartbeat**  Sends a brief notification of the RightFax server’s status, including statistics on fax activity. When you select this check box, you must also specify the **Heartbeat Interval**, in minutes.

---

**Understanding the Alert Frequencies**

After an alert is triggered, the problem causing the alert must be remedied within a set length of time before a fault of the same type will cause another alert. For example, this prevents free disk space fluctuating around 50 Mb from causing repeated alerts. If an alert condition persists, the alert will be repeated periodically. Different types of alerts have different delays and repeat intervals as listed in the following table.

<table>
<thead>
<tr>
<th>Alert</th>
<th>Delay</th>
<th>Repeat interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>All DocTransports down.</td>
<td>10 minutes</td>
<td>60 minutes</td>
</tr>
<tr>
<td>Send queue too deep.</td>
<td>30 minutes</td>
<td>90 minutes</td>
</tr>
<tr>
<td>Disk space is critically low (&lt;50MB).</td>
<td>10 minutes</td>
<td>30 minutes</td>
</tr>
<tr>
<td>Disk space is getting low (&lt;150MB).</td>
<td>20 minutes</td>
<td>60 minutes</td>
</tr>
<tr>
<td>RightFax internal queue has reached 90% utilization.</td>
<td>30 minutes</td>
<td>90 minutes</td>
</tr>
<tr>
<td>DocTransport service down.</td>
<td>10 minutes</td>
<td>60 minutes</td>
</tr>
</tbody>
</table>

Alerts that are not listed here are sent only once, when the alert condition occurs.

---

**Table 9b  Pager Alert Frequencies**
The Outbound Auto-Printing tab

Enable Automatic Printing of Sent Faxes  Prints a copy of all sent faxes. If this check box is selected, you must also select a printer from the list of available printers. These are the printers that you have set up under Printers in Enterprise Fax Manager (see “Adding a printer” on page 127).

When to Print  Specify whether to print successfully sent faxes, faxes that were not successfully sent, or both.

What to Print  Specify whether to print the fax history, the fax cover sheet, and/or the fax body.

The Default Receive Settings tab

Automatic Forwarding Options  Forward the user’s faxes to either a fax machine or another network user as soon as they are received. Specify the fax number or RightFax user ID to receive the forwarded fax.

Automatic Printing Options  Automatically print received faxes. Select a printer from the list of available printers. These are the printers that you have set up under Printers in Enterprise Fax Manager (see “Adding a printer” on page 127). Click a print resolution in the Resolution list.

Automatic OCR Options  Convert all received faxes to text using OCR (optical character recognition). This option requires the RightFax OCR Converter module. Enter a three-letter file extension for the output file in the Extension box.
In the Format list, click the text format used to interpret your fax pages. “ASCII” produces a plain text file. “RTF” (rich text format) preserves fonts and formatting but is only available for Windows clients.

The Layout item specifies that “Left Justified” text will be displayed starting from the left margin of the fax.

The Notification tab

These settings let you configure the fax server to notify RightFax users about the status of sent and received faxes via email or SMS text messaging. The text of the status messages that will be sent can be customized in the Custom Messages tab of the RightFax Server configuration program in Windows Control Panel (described on page 22).

If you want to send notifications via SMS text messaging, you must configure a list of SMS service types and providers before completing this dialog box. For information on configuring SMS services, see Chapter 17, “Adding SMS and Pager Services”.

Figure 9.12  The User Edit Notification Tab
Method  Select the notification method for the user.

- Use Group's Method. Uses the notification method defined for the group to which the user belongs (described on page 113).
- SMS. Sends the notification to an SMS capable device. If you select this option, you must select an SMS service in the **SMS Service** box.
- Email Systems. Sends the notification to the user’s email box. (Notes and Exchange notifications require you to purchase and license a separate module.) You must specify the email address of the user in the **Notification Address/Info** box.
- Custom notification methods. These can be created using the RightFax API. Information on the RightFax API can be found at the OpenText Knowledge Center at knowledge.opentext.com.

**Note** If you are routing inbound faxes to an email gateway or other destination on your network and you have select the Delete After Routing check box (page 101), no notifications for received faxes will be sent.

SMS Service  Select the SMS service to use for delivering the notification. If you have not added and properly configured an SMS service, you must do so before completing this dialog box (described in Chapter 17, “Adding SMS and Pager Services”).

Test SMS  This button lets you send a test message to an SMS-capable device. To send a test SMS message, select an SMS service in the **SMS Service** box, type a phone number in the **Notification Address/Info** box, and then click this button.

Notification Address/Info  Specify the user’s email address for email notification, or other information necessary for sending fax notifications of the type selected in the **Notification Method** list.

Notification About Outbound Faxes  Specify the events for outbound faxes for which the user will receive notification.

Notification About Received Faxes  Specify the events for received faxes for which the user will receive notification. If you select the check box **Reroute Received Fax Notification**, you must also select a RightFax user ID to route to from the list.

### Using Windows NT Security Authentication

RightFax Enterprise servers can take advantage of your network’s established Windows security system by linking each RightFax user ID to a Windows user account. When logging on to client applications that require authentication (such as Enterprise Fax Manager and FaxUtil), RightFax attempts the Windows account name and password with which you are currently logged on. If the current Windows account name and password have been linked to a RightFax user ID, that RightFax ID is used to log on. If no RightFax user account is linked, a dialog box opens prompting you to manually enter your RightFax user name and password.

Each user’s link status is displayed under the **NT Account Link Status** column in the user list in Enterprise Fax Manager. The status “N/A” means that the user is not required to log on via Windows NT authentication. “No NT Account Assigned” means that the user is required to log on via Windows NT authentication but is not linked to a Windows account. (This user will be allowed to log on manually.) “NT Account Assigned” means that the user is required to log on via Windows NT authentication and is linked to a Windows NT based account. This RightFax ID can only be accessed when the user is logged on to Windows NT based network with the linked account.

### Linking RightFax user IDs to Windows NT based accounts

RightFax Enterprise server provides several methods for linking one or more RightFax user IDs to existing Windows NT based accounts.

**To link a RightFax user ID**

1. Edit the user properties in Enterprise Fax Manager.
2. Click the **Identification** tab.
3. Select the **Use Integrated Windows NT Security** option.
4. Click **Select NT Account**.
5. Type or select the Windows domain and account names to link and click OK. The linked domain and account name will be listed under the RightFax user ID in the Identification tab.

*Note* You can only use the Windows NT account lookup feature when you are running Enterprise Fax Manager on the RightFax server or a Windows workstation.

**To automatically link one or multiple existing RightFax User IDs**

1. In the Enterprise Fax Manager user list, select one or more RightFax users.

2. Right-click any selected user to open a shortcut menu, and select **Enable NT Authentication and Link** from the pop-up menu.

   RightFax links each selected user ID to the matching Windows account in the domain to which you are currently logged on. If there is no matching Windows account name in the current domain, no link is created.

**To automatically link all new user IDs**

Because all new RightFax user IDs created in Enterprise Fax Manager use the default user ID as a template, you can configure the default user ID so that all new user IDs automatically link to Windows accounts.

1. In Enterprise Fax Manager, edit the default user ID.

2. Click the Identification tab and select the **Use Integrated Windows NT Security** option. Click OK.

   For each new user ID you create in Enterprise Fax Manager, RightFax will link the user ID to the matching Windows account in the domain you are currently logged on to. If there is no matching Windows account name in the current domain, no link is created.

---

**Importing Users**

To simplify the process of setting up all your network users in the RightFax server, you can import users into the fax server from your network or from an ASCII file.

**To import users from a Windows NT based network**

1. In Enterprise Fax Manager, on the **Utility** menu, click **Import Users from NT Domain**. The **Import Users from NT Server/Domain** dialog box opens.

   ![Figure 9.13 The Import Users from NT Server/Domain Dialog Box](image)

   2. Enter the computer name of the Primary Domain Controller (PDC) or Backup Domain Controller (BDC) from which the users will be imported.

   3. Select the group to import.

   4. Specify the RightFax user ID to use as a template (usually Default).
5. If you want to automatically assign a routing code to each user, select the **Automatically Assign Routing Codes** check box, and then enter the starting code. The first imported user will receive the starting routing code and each additional user's routing code will increment by one. If the system increments to a routing code that already exists, it will be skipped.

6. When you have completed the dialog box, click **Import** to begin.
You can create groups of users to which you can assign a common administrator, alternate administrator, fax options, and fax cover sheet. You can use groups to subdivide your organization and manage the RightFax system more efficiently. For example, instead of having one administrator responsible for all fax users in your organization, you can create separate Development and Sales groups, then assign separate fax administrators to each.

Groups can also play an important role in notifying users of new faxes. If a user does not respond to his notification by viewing or printing a new fax within a specified time, the group administrator will be alerted to the fax and can then print the fax or forward it to someone else.

### Managing Groups

To add, edit, or delete groups of RightFax users, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85) and click **Groups** under the appropriate RightFax server in the left pane of the window. If groups have been defined, the list of groups appears in the right pane.

#### Figure 10.1 The Server Groups List

![Server Groups List](image)

#### Adding new groups

To create a new group, press **INSERT** or select **New** from the **Edit** menu. The **Group Edit** dialog box opens. Because each RightFax group must have a unique group ID, you must enter a value in the
Deleting groups
To delete a group, select the group to delete and press DELETE or select Delete from the Edit menu. By default, you will be prompted for confirmation that you want to delete the group.

Note: If the group you are deleting is the only group allowed access to a library document, the library document will be marked as expired. It will still be available to the system administrator who can then delete, edit, or reassign the library document to another user group.

Copying groups from one server to another
In Enterprise Fax Manager, you can copy one or more groups from one RightFax server to another. Select the groups you want to copy, and then drag the selection to another server.
If you copy groups from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported on the older server (for example, features on version 10.5 servers will not be available on version 10.0 servers).

Editing Group Properties
To edit the properties of an existing group, run Enterprise Fax Manager, select the group to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the group. The Group Edit dialog box opens.

The Basic Information tab

Figure 10.2 The Group Edit Basic Information Tab

- **Group ID** The unique ID for this group.
- **Administrator** Specify the user ID of the person who will be the administrator of this group. The group administrator has access to all the mailboxes in the group and receives alerts when a user has not printed or viewed a fax before the time specified in User Notify.
1. In the Cover Sheets area, click the **Select** button to display the list of available cover sheets.

![Select Cover Sheet dialog box](image)

2. To prevent the group from using a specific cover sheet, select a **Cover Sheet Name** from the **Available to this Group** list, and then click the upper arrow button to move the document to the **Unavailable to this Group** list. There must be at least one cover sheet available to the group.

3. To allow the group to use a specific cover sheet, select the **Cover Sheet Name** from the **Unavailable to this Group** list, and then click the lower arrow button to move the document to the **Available to this Group** list.

4. To select a default cover sheet for the group, choose a cover sheet from the drop-down list.

5. Click **OK** to close the cover sheet selection window. Click **OK** to close the **Group Edit** window.

---

**Time** in the RightFax Server configuration program expires (see “User Notify Time” on page 19). A group administrator can edit their group’s settings in EFM.

**Alternate Administrator** Specify the user ID of the person who will be the alternate administrator of this group. The alternate administrator will have access to all the mailboxes in this group and will receive messages about faxes belonging to group members if the user and the group administrator have not printed or viewed a fax in the designated interval.

**Default Cover Sheet** Specify the default fax cover sheet for the group. The list displays cover sheets available to this group. Selecting **System Default** uses the default cover sheet assigned by the administrator (see “Setting default cover sheets” on page 204).

**Notification Type** Specify the default notification method for the group.

**Days to keep deleted fax records** The days keep deleted fax records setting is based on the date the fax was received, not the deleted date. Specify the number of days to keep records of deleted faxes in the RightFax database. If set to 0 (zero), deleted fax records will never be automatically purged by RightFax.

**All faxes must have cover sheets** Requires all users in the group to use a cover sheet on outbound faxes.

**All faxes must be held for preview** All the faxes for users in the group will be held for preview before they are sent. Users must view the faxes and verify that they should be sent.

**Group members cannot edit delegates** Members of the group can view delegate information, but can not change it.

**Limiting group access to cover sheets**

By default, all newly-created cover sheets are available to all user groups. To change group access to cover sheets:

1. In the Cover Sheets area, click the **Select** button to display the list of available cover sheets.

2. To prevent the group from using a specific cover sheet, select a **Cover Sheet Name** from the **Available to this Group** list, and then click the upper arrow button to move the document to the **Unavailable to this Group** list. There must be at least one cover sheet available to the group.

3. To allow the group to use a specific cover sheet, select the **Cover Sheet Name** from the **Unavailable to this Group** list, and then click the lower arrow button to move the document to the **Available to this Group** list.

4. To select a default cover sheet for the group, choose a cover sheet from the drop-down list.

5. Click **OK** to close the cover sheet selection window. Click **OK** to close the **Group Edit** window.
Limiting group access to library documents

By default, all newly-created library documents are available to all user groups. To change group access to library documents:

1. In the Library Documents area, click the Select button to display the list of available documents.

   **Note:** All library documents are displayed, even those that are not currently available for use (such as expired or inactive documents). The group members will be able to use these library documents when after the defined activation date.

2. To prevent the group from attaching a library document, select the Document ID from the Available to this Group list, and then click the left (upper) arrow button to move the document to the Unavailable to this Group list.

3. To allow the group to attach a library document, select the Document ID from the Unavailable to this Group list, and then click the right (lower) arrow button to move the document to the Available to this Group list.

4. Click OK to close the library document selection window. Click OK to close the Group Edit window.

The Automatic Fax Aging tab

With automatic fax aging, you can specify the number of days after the date a fax is sent or received that it will be deleted from a user’s FaxUtil mailbox. Automatic fax aging is only available if you have a RightFax Enterprise or Satellite server.

Automatic fax aging does not remove the fax records from the RightFax database, so you can still run reports about the faxes.

You can also perform manual fax aging with the Faxage.exe utility program (see the RightFax Administrative Utilities Guide).

For each type of fax, enter the number of days the fax will remain before it is deleted. To specify that faxes should not be deleted, enter 0 (zero).

To apply these settings to all the users’ folders, select the check box **Settings apply to all user folders**. To disable fax aging, click to clear the check box.
The Forced Scheduling tab

Forced scheduling controls fax traffic volume on the basis of user groups. You can restrict the total number of pages or total number of faxes that are sent simultaneously by all users in the group and limit these restrictions to a specific time period.

For example, if you have 50 sales representatives, each sending 100 faxes every hour, all of your fax channels may be continuously busy processing their faxes. This could delay more important faxes from other departments, as well as block incoming faxes. With Forced Scheduling, you can restrict the members of the Sales group to sending no more than 20 pages at a time between the hours of 8 A.M. and 5 P.M. and delay any faxes over that limit until 6 P.M.

This feature restricts only simultaneously scheduled faxes. It does not restrict the total number of faxes or fax pages that can be sent during the specified time period. If a fax exceeds the maximum limit and is delayed until a later time, it can be rescheduled at any time by selecting Fax > Forward to New Number in FaxUtil.

Figure 10.6 The Group Edit Forced Scheduling Tab

<table>
<thead>
<tr>
<th>Enabled</th>
<th>Enables the Forced Scheduling feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Concurrent Pages</td>
<td>Specify the maximum number of fax pages that can be scheduled at one time by all the users in the group.</td>
</tr>
<tr>
<td>Maximum Concurrent Faxes</td>
<td>Specify the maximum number of faxes that can be scheduled at one time by all the users in the group.</td>
</tr>
</tbody>
</table>
Starting/Ending Time  The starting and ending times for the period that the restriction applies. This is written in 24-hour HHMM format. For example, to set the restriction from 8:00 A.M. to 5:30 P.M., set the Starting Time to 0800, and set the Ending Time to 1730.

If during this time period any faxes exceed the limits you specify, those faxes will be delayed until the time you specify in the Delay Until Time box.

Delay Until Time  The time at which delayed faxes will be sent. This is written in 24-hour HHMM format. For example, to send delayed faxes at 6:00 P.M., enter 1800.

If the Delay Until Time falls between the Starting and Ending times, automatically delayed faxes will never be sent. This is because delayed faxes, by definition, cannot be sent between your Starting and Ending times. In such a case, delayed faxes will be continuously bumped to the next day at that same time.

The Smart Fax Distribution tab

With smart fax distribution, a group routing code is created and all faxes received by the group are distributed systematically between all the users in that group.

Figure 10.7  The Group Edit Smart Fax Distribution Tab

Enabled  Enables smart fax distribution for this group.

Routing Code  Assigns a routing code to the group.

Distribution Type  Specify either linear or balanced distribution. With linear distribution, faxes are distributed to each group member in succession. With balanced distribution, faxes distribution is determined by each user’s processing rate. If one user is faster at processing faxes than another, the faster user is distributed faxes at a faster pace.
**Member Refusal Allowed**  Lets users take themselves temporarily out of the distribution loop. When this check box is selected, users can refuse faxes by running FaxUtil and selecting **Tools > Refuse Distributions**. This option is enabled by default and must be disabled to allow per user customization.

**The Fax Dialog Customization Tab**

This group of check boxes lets you customize the appearance of the **Fax Information** dialog box (the dialog box used to create and address outgoing faxes) for the users in this group. This is useful for removing options that do not apply to or should not be changed by these users.

**Note** The Fax Dialog Customization tab is available with Enterprise editions of RightFax only.

The following table lists each of the checkboxes on this dialog box, and the tab and option on the **Fax Information** dialog box that each checkbox represents. For more information on the options in the **Fax Information** dialog box, see Chapter 25, “Creating, Sending, and Managing Faxes.”

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Fax Information dialog box tab</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquire Attachments from Scanner</td>
<td>Attachments</td>
<td>Scanner button (scanner icon)</td>
</tr>
<tr>
<td>Add Phonebook Entry Button</td>
<td>Main</td>
<td>Add Entry button</td>
</tr>
<tr>
<td>Alternate Body Attachment Checkbox</td>
<td>Attachments</td>
<td>Ability to display Alt. Body column in <strong>Selected Attachments</strong> list</td>
</tr>
<tr>
<td>Alternate Fax Number</td>
<td>Main</td>
<td>Alt. Fax Number text box</td>
</tr>
<tr>
<td>Auto-Delete Control</td>
<td>More Options</td>
<td><strong>Automatic Deletion</strong> selection box</td>
</tr>
<tr>
<td>Billing Information #1 Entry Field</td>
<td>Main</td>
<td>Billing Code 1 text box (title may vary)</td>
</tr>
<tr>
<td>Billing Information #2 Entry Field</td>
<td>Main</td>
<td>Billing Code 2 text box (title may vary)</td>
</tr>
<tr>
<td>Billing Information Lookup Button</td>
<td>Main</td>
<td>Lookup button</td>
</tr>
<tr>
<td>Browse for File Attachment</td>
<td>Attachments</td>
<td>Browse button (folder icon)</td>
</tr>
<tr>
<td>Certified Checkbox</td>
<td>Main</td>
<td><strong>Use certified delivery</strong> checkbox</td>
</tr>
<tr>
<td>City/State Entry Field</td>
<td>Main</td>
<td>City/State text box</td>
</tr>
<tr>
<td>Comments Text</td>
<td>Cover Sheet Notes</td>
<td><strong>Comments for your Records</strong> text box</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Fax Information dialog box tab</td>
<td>Option</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Company Entry Field</td>
<td>Main</td>
<td>Company text box</td>
</tr>
<tr>
<td>Cover Sheet Selection Button</td>
<td>More Options</td>
<td>Cover Sheet File selection box</td>
</tr>
<tr>
<td>Cover Sheet Toggle</td>
<td>Main</td>
<td>Use cover sheet text box</td>
</tr>
<tr>
<td>Delay Send Controls</td>
<td>Main</td>
<td>Delay send checkbox and time/date fields</td>
</tr>
<tr>
<td>Form Type Selection</td>
<td>More Options</td>
<td>Use form checkbox and selection list</td>
</tr>
<tr>
<td>From Name Entry Field</td>
<td>More Options</td>
<td>Name text box</td>
</tr>
<tr>
<td>From Phone Number Entry Field</td>
<td>More Options</td>
<td>Voice Number text box</td>
</tr>
<tr>
<td>General Fax Number Entry Field</td>
<td>More Options</td>
<td>Company Fax Number text box</td>
</tr>
<tr>
<td>General Voice Number Entry Field</td>
<td>More Options</td>
<td>Company Voice Number text box</td>
</tr>
<tr>
<td>Library Document/Attachments Selection</td>
<td>Attachments</td>
<td>Available Attachments library document list and File Attach button (paper clip icon)</td>
</tr>
<tr>
<td>‘More Options’ Tab</td>
<td>More Options</td>
<td>All tab contents</td>
</tr>
<tr>
<td>Native Attach Document Checkbox</td>
<td>Attachments</td>
<td>Native column in Selected Attachments list</td>
</tr>
<tr>
<td>‘Notes’ Button/Tab</td>
<td>Cover Sheet Notes</td>
<td>All tab contents</td>
</tr>
<tr>
<td>Notes Text</td>
<td>Cover Sheet Notes</td>
<td>Notes to be Placed on the Cover Sheet text box</td>
</tr>
<tr>
<td>PDF Options</td>
<td>Main</td>
<td>PDF Options button (next to Create PDF image checkbox)</td>
</tr>
</tbody>
</table>

Table 10a  Fax Dialog Customization Checkboxes (Continued)

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Fax Information dialog box tab</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phonebook Import</td>
<td>Main</td>
<td>Phonebook button</td>
</tr>
<tr>
<td>Phonebook Selection Button</td>
<td>Main</td>
<td>Phonebook button</td>
</tr>
<tr>
<td>Preview Checkbox</td>
<td>Main</td>
<td>Hold for preview checkbox</td>
</tr>
<tr>
<td>Priority Checkbox</td>
<td>More Options</td>
<td>Priority selection box</td>
</tr>
<tr>
<td>Private Fax Number Entry Field</td>
<td>N/A</td>
<td>Phonebook Import option on the Tools menu in FaxUtil.</td>
</tr>
<tr>
<td>Recipient Type Field</td>
<td>Main</td>
<td>Down arrow button next to the Fax number text box that lets users select the Email address option</td>
</tr>
<tr>
<td>Secure Send/Recipient Fax ID Control</td>
<td>More Options</td>
<td>Recipient Fax ID text box</td>
</tr>
<tr>
<td>Smart-Resume Checkbox</td>
<td>Main</td>
<td>Use smart-resume checkbox</td>
</tr>
<tr>
<td>Transmission Quality Control</td>
<td>Main</td>
<td>Fine mode checkbox</td>
</tr>
<tr>
<td>Use PDF Checkbox</td>
<td>Main</td>
<td>Create PDF image checkbox</td>
</tr>
<tr>
<td>Voice Number Entry Field</td>
<td>Main</td>
<td>Voice Number text box</td>
</tr>
</tbody>
</table>
Chapter 11
Creating Signatures

RightFax can personalize users’ outbound faxes with graphic images of their signatures. Signature images are created in FaxUtil and stored in the RightFax\SIG folder on the server. Enterprise Fax Manager catalogs all the signatures and maintains the file names, descriptions, and authorized user information.

Note Signature files are currently not supported in outbound PDF documents.

Managing Signature Files

To edit or delete signature files, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85) and click Signatures under the desired RightFax server in the Fax Server Tree.

You must create a new signature file in order for it to appear as an object in Enterprise Fax Manager. New signature files are created from the FaxUtil mailbox (see “Creating a New Signature File” on page 120).

Deleting signatures

To delete a signature, select the signature to delete and press DELETE or select Delete from the Edit menu. By default, you will be prompted for confirmation that you want to delete the signature.

Deleting the signature’s reference in Enterprise Fax Manager does not delete the signature file itself. A second confirmation dialog box will ask you if you want to delete the file as well.

Copying signatures from one server to another

Enterprise Fax Manager can easily copy one or more signatures from one RightFax server to another. Select the signatures you want to copy, and then drag the selection onto another server.

If you copy signature files from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (in other words, features on version 10.5 servers will not be available on version 9.4 servers).
Editing Signature File Properties

To edit the properties of an existing signature, run Enterprise Fax Manager, select the signature to edit and press ENTER or select Edit from the Edit menu. You can also double-click the signature. The Edit Signature dialog box opens.

Figure 11.1  The Edit Signatures Dialog Box

**Signature Code**  The name the signature that will be displayed in Enterprise Fax Manager.

**Owner's User ID**  The user ID of the owner of the signature file.

**Description**  A description of the signature file for easy reference in Enterprise Fax Manager.

**Image File Name**  The name of the signature image file. This file name is automatically generated and stored in the RightFax\SIG folder on the RightFax server when the signature file is created. If this box contains an invalid file name, RightFax will not be able to use the signature image.

**Authorized Users**  Up to three RightFax user IDs or group IDs who are authorized to use this signature in addition to the owner of the signature.

Creating a New Signature File

Only users with RightFax administrative access can create signature files. Signature files are created from a fax in a your FaxUtil mailbox. You can scan a signature into your mailbox or fax a signed document to yourself. After the document arrives in your FaxUtil mailbox, follow these steps to create a signature file:

1. In FaxUtil, double-click the fax to view it using the RightFax Fax Viewer.

2. Using the Select tool in the Fax Viewer toolbar, click the signature.

3. Select Store from the Fax menu, and then select Make Signature. The Edit Signature dialog box opens.

Enter an ID for the signature in the **Signature Code** box. This must be unique, as it will be the identifying code Enterprise Fax Manager displays in the ID column when viewing the list of signatures. Enter the owner’s user ID and a description of the signature. In the **Authorized Users** boxes, list up to three RightFax user IDs or group IDs who are authorized to use this signature in addition to the owner of the signature.

Adding a Signature to a Fax

Signature files are inserted into fax-bound documents using the `<SIGNATURE>` embedded code. For information on using this and other embedded codes see Appendix A, “RightFax Embedded Codes”.

**Caution**  Signature files will not display properly in documents that have been converted to PostScript.
Controlling signature placement

Signature images are positioned so that the left-middle point of the signature aligns with the left-middle point of the `<SIGNATURE>` embedded code in the document. RightFax supports a Windows registry entry that modifies the vertical alignment of new signatures created on the client workstation where the registry value is present.

Table 11a  Windows Registry Entry for Vertical Placement of Signature

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>32-bit or 64-bit client operating systems:</td>
</tr>
<tr>
<td></td>
<td>HKEY_CURRENT_USER\Software\</td>
</tr>
<tr>
<td></td>
<td>RightFax Client\VWR32</td>
</tr>
<tr>
<td>Value</td>
<td>SignaturePositionPercent</td>
</tr>
<tr>
<td>Type</td>
<td>DWORD</td>
</tr>
<tr>
<td>Data</td>
<td>0–100 (default 35)</td>
</tr>
</tbody>
</table>

Increasing the data for this value causes all newly created signatures to be shifted upwards by a percentage of the height of the signature image (the actual distance depends on the height of the signature). Decreasing the data causes signatures to shift down an equal distance.

This registry value only affects signatures when they are initially created. If you change the data for this value, you will need to recreate each signature that you want the new setting applied to.
Overlay forms are fax image files that RightFax can superimpose over outgoing faxes. These “forms” are typically replicas of documents that your organization uses (for example, company letterhead) and give your faxes the appearance of being printed on the form prior to faxing.

Managing Overlay Form Files

To edit or delete forms, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85) and click Forms under the RightFax server in the Fax Server Tree.

You must create a new form file in order for it to appear as an object in Enterprise Fax Manager. New form files are created from the FaxUtil mailbox (see “Creating a New Overlay Form” on page 124).

Deleting a form

To delete a form, select the form to delete and press DELETE, or select Delete from the Edit menu. You will be prompted for confirmation that you want to delete the form. Deleting the form’s reference in Enterprise Fax Manager does not delete the form file itself. A second confirmation dialog box will ask you if you want to delete the file as well.

Copying forms from one server to another

In Enterprise Fax Manager, you can copy one or more forms from one RightFax server to another. Select the forms you want to copy, and then drag the selection to another server.

If you copy overlay forms from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).
Editing Form File Properties

To edit the properties of an existing form, run Enterprise Fax Manager, select the form to edit and press ENTER, or select Edit in the Edit menu. You can also double-click the form. The Edit Form dialog box opens.

**Figure 12.1** The Edit Form Dialog Box

![Edit Form Dialog Box](image)

**Form Number**  The number that identifies the form. This is assigned by RightFax when the form is created.

**Form ID**  This is a unique name that identifies the form.

**Description**  This is a description of the form file for easy reference in Enterprise Fax Manager.

**Start Page**  Specifies the first page of the body of the fax document onto which the form will be placed. The page numbers you specify are absolute, so if the start page for a form is set to 3 and you apply it to a document that only has two pages, none of the document pages will include the form.

**Note**  Overlay forms are never placed on fax cover sheets. If you enter 1 in the Start Page box, the form will appear on the first page of the body of the fax following the cover sheet.

**Number of Pages**  The number of fax pages that will be overlaid with the form. To overlay each page of the fax with the form, enter 0 (zero).

**Next Form Number**  Specifies the second form to use, if you want to use two overlay forms in one fax (i.e., different forms for the first page and all subsequent pages of your company letterhead). Specify the form number of the next form file. For more information on using two overlay forms in a single fax, see “Using Two Overlay Forms in One Fax” on page 125.

**Image File Name**  The name of the form image file. This is automatically generated and stored in the RightFax\Papers folder on the RightFax server when the form file is created. If this box contains an invalid file name, RightFax will not be able to use the form image.

**Secure Form**  Restricts the form to specific groups or users. To secure a form, select the Secure Form check box. In the Authorized Group or User list, click the users or groups authorized to use the form.

Creating a New Overlay Form

To create new overlay forms in FaxUtil, you must be assigned permission in your user profile (see “The Permissions tab” on page 98).

Form files are created from faxes in your FaxUtil mailbox. You should always create forms using fine resolution. To set fine resolution as the default in FaxUtil, select Tools > Options, and the Options dialog box opens. On the Sending tab, select the Use Fine Mode check box.

![Create New Overlay Form](image)
To create a new overlay form

1. Create the form image in a word processor or any other application that lets you print to the RightFax fax printer. Send the fax image to your FaxUtil mailbox.
2. Run FaxUtil and click the form in the list of received faxes.
3. Select Fax > Store as Form, and the Store Fax as Form dialog box opens.

4. In the Form ID box, enter a unique ID for the form. The remaining boxes are the same as those in the Edit Form dialog box (see “Editing Form File Properties” on page 124).
5. When you have completed the dialog box, click OK. The new form will now appear in the Forms list in Enterprise Fax Manager.

Using Two Overlay Forms in One Fax

You can configure two overlay forms to appear in a fax. For example, page 1 of the fax may include company letterhead, and pages 2, 3, 4, and 5 may include an invoice form.

After the two forms have been configured following these instructions, then each time you add the first form to an outgoing fax, it will automatically be followed by the second form because they are linked.

To configure two forms for use in a single fax document

1. Create two forms according the instructions in “Creating a New Overlay Form” on page 124.
2. Run Enterprise Fax Manager and edit the properties of the first of the two forms (described on page 124).
3. In the Edit Form dialog box, in the Start Page box, enter the page number that you want the first form to initially appear on. In most cases, this value will be set to 1.

   Note  Overlay forms are never placed on fax cover sheets. If you enter 1 in the Start Page box, the form will appear on the first page of the body of the fax, following the cover sheet.

4. In the Number of Pages box, enter the number of pages on which you want the first form to appear. If the first form will only be used on the first page, enter 1.
5. In the Next Form Number box, enter the form number of the second form to use. Click OK to close the Edit Form dialog box.
6. Edit the properties of the second of the two forms.
7. In the Edit Form dialog box, in the Start Page box, enter the page number that you want the second form to appear on. In most cases, this value will be set to 2.
8. In the **Number of Pages** box, enter the number of pages on which you want the second form to appear. If you want the second form to appear on all subsequent pages, enter 0 (zero).

9. Click **OK** to close the **Edit Form** dialog box.

### Adding an Overlay Form to a Fax

Overlay forms are inserted into fax-bound documents using the `<FORMTYPE>` embedded code or by specifying the form to use in the **Fax Information** dialog box. For information on the **Fax Information** dialog box, see “Specifying Addressing Information” on page 230.
You can define an unlimited number of network printers in RightFax and make them available for automatic printing of faxes and other automated network print functions. Printers can be added individually or imported in groups from your network. The printers you configure here are not the printers and print-to-fax devices that allow RightFax users to fax documents from native applications. Rather, these are the printers available to RightFax for automatically printing sent and received faxes.

Managing Printers

To add, edit, or delete printers on the RightFax server, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85) and click Printers under the desired RightFax server in the Fax Server Tree.

Adding a printer

To add a new printer to RightFax, press INSERT or select New from the Edit menu. The Edit Network Printer dialog box opens. For information on completing each of the options in this dialog box see “Editing Printer Properties” on page 128.

Deleting a printer

To delete a printer, select the printer to delete and press DELETE or select Delete from the Edit menu. By default, you will be prompted for confirmation that you want to delete the printer.

Copying printers from one server to another

Using Enterprise Fax Manager you can easily copy one or more printers from one RightFax server to another. Select the printers you want to copy, and then drag the selection to another server. If you copy printers from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).
Editing Printer Properties

To edit the properties of an existing printer, run Enterprise Fax Manager, select the printer to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the printer. The Edit Network Printer dialog box opens.

Figure 13.1 The Edit Network Printer Dialog Box

**Printer ID** The identifier RightFax will use for this printer. This ID should match the printer’s network ID to avoid confusion.

**Description** This is a description of the form file for easy reference in Enterprise Fax Manager. If this box is completed, users will see both the Printer ID and Description in the Print dialog box. If this box is not completed, only the Printer ID will be displayed.

**Printer Type** Sets the printer driver used by RightFax to format faxes printed to this printer. Choose the one that most closely corresponds to your printer. If your laser printer supports both PostScript and PCL5, choose one of the HP LaserJet types rather than PostScript for faster printing.

**Direct TCP/IP Printing** Allows faxes to be printed directly to an IP port on a printer using the LPR, a TCP/IP utility.

**Server Name** Indicates on which file server the queue exists. If the queue is in NDS, this should be the value at the top of the tree.

**Queue Name** Differs depending on your network operating system. On NetWare 3.x, the Queue Name should contain the Bindery name of the queue, i.e. “LASER1.” On LAN Server and Windows NT based networks, Queue Name should contain the share name of the queue. On NetWare 4.x servers that are using NDS, Queue Name should contain the Distinguished Name of the queue object, i.e. “LASER1.SALES.ACME.”

**Default Paper Size** Sets how RightFax will scale a fax page to fit onto the printable area of a laser printer. This also sets what size paper to select. “None” will not scale the image at all which can result in some portion of the page being truncated. “Fit Letter” causes the fax page to be scaled to fit onto the printable area of U.S. letter size paper (8.5 × 11 in.). “Fit Legal” scales the page to fit onto the printable area of U.S. legal size paper (8.5 × 14 in.). “Fit Letter/Legal” scales the fax to fit on letter size paper if it is 12.5 inches or less, otherwise it will be scaled to fit legal size paper. This last option is useful for firms receiving faxes in a mix of letter and legal sizes and where dual-bin laser printers are used. In such cases, the laser printer will select the appropriate size paper, letter or legal, to correspond to the size of the fax page. “Fit A4” scales the fax to fit onto the printable area of A4 size paper (210 × 297 mm). “Fit A4/Legal” is identical to Fit Letter/Legal, except that the printer will choose between A4 and Legal paper trays.

**Default Paper Source** Determines which paper tray selection command RightFax will send to the printer. If the Default Paper Size is set to “Fit Letter/Legal” or “Fit A4/Legal,” it is recommended that this value be set to “None.” Otherwise the automatic selection of paper trays will not work.

---

**Note** All laser printers have an unprintable margin area. RightFax takes this into account when scaling and fits the full fax page within the printable region. The result is a small (5%) reduction in the page image when printed on a laser printer. Because fax pages have no unprintable regions, this scaling is necessary to prevent portions of the fax from being lost during printing.
Importing Printers into RightFax

You can import printers from your network into RightFax in groups or you can import all printers.

To import printers

1. In Enterprise Fax Manager, in the Utility menu, select Import Printers from Network. The Import Network Printers dialog box opens.

   Figure 13.2 The Import Network Printers Dialog Box

2. Select the network context to import from.

3. Before importing printers, you can specify the characteristics of printers for which to search. You can set the printer driver, paper size, paper type, and whether the printer is set to print to an IP port. Click Set Default Printer Information.

4. To search for printers, click Find Printers in Selected Context. Depending on the size of the network, this scan can take several minutes. To cancel the search, click Stop Loading.

5. The list of available printers appears in the Current printer list. Click to select the printers to import, and then click Import Selected Printers.

Configuring RightFax to Automatically Print Faxes

Each RightFax user profile can be configured to automatically print sent or received faxes. Before you can configure automatic printing for users, you must set up at least one network printer in Enterprise Fax Manager. For information on adding and configuring network printers see “Adding a printer” on page 127.

Note The ability to automatically print sent and received faxes can also be configured by individual users in the FaxUtil client application.

To configure a user to automatically print sent and received faxes, select Users in Enterprise Fax Manager and double-click the user ID to edit. Automatically printing sent faxes is configured in the Outbound Auto-Printing tab (page 106) and automatically printing received faxes is configured in the Default Receive Settings tab (page 106).

Using Scanners with RightFax

If you need to fax a document that has already been printed, you can use either a local or network scanner to scan the document directly into RightFax for fax transmission.

Using a desktop scanner

RightFax can scan documents for fax transmission from any TWAIN32-compliant scanner connected to your computer. To make your local scanner available in RightFax, install the scanner,
its drivers, and the TWAIN32 drivers according to the installation instructions provided with the scanner. RightFax automatically detects the TWAIN32 drivers and makes the scanner available when creating a fax document.

To scan a document for fax transmission

1. Open the Fax Information dialog box using any of the methods provided by your RightFax client installation. For information on opening the Fax Information dialog box for creating, addressing, and sending fax documents, see Chapter 25, “Creating, Sending, and Managing Faxes”.

2. In the Fax Information dialog box, click the Attachments tab.

3. Click the scanner button on the toolbar. The Document Scan dialog box opens.

![Document Scan Dialog Box]

4. Select the scanner to use in the Current Scanner box and click Start Scan. RightFax opens the scanner’s control dialogs. Place the document(s) to scan on the scanner bed and complete the dialog(s) that appear according to the instructions for scanning documents provided with your scanner.

When the document has been scanned, it will appear in the Selected Attachments list in the Fax Information dialog box.

Using the Kofax NetScan

RightFax integrates with the Kofax NetScan network scanner (“Configuring Kofax NetScan” on page 39). For more information about configuring these two products to work together, refer to your NetScan documentation.

The Standalone Fax Connector

The Standalone Fax Connector uses a stand-alone fax machine to send faxes through the RightFax server. This makes least-cost routing, automatic retries, and other RightFax features available to conventional fax machines throughout your organization.

Note The Standalone Fax Connector can be used with Brooktrout TR1034 fax boards. TruFax 100 and 200 fax boards do not support this feature.
Each fax machine connects to the RightFax server on a specific channel or DID extension via a phone line or PBX. When a fax is sent, it is redirected to the RightFax server for processing and transmission. The user is prompted with voice or tones to enter the destination fax number and other required fax recipient information.

Connecting a stand-alone fax machine to the RightFax server

There are several ways to connect a stand-alone fax machine to your RightFax server. In each case, a RightFax user ID is created to host the Standalone Fax Connector and is assigned a unique Routing Code value (called the “extension”). The user then dials into this extension from the fax machine (exactly how this is accomplished depends on your phone system) in order to access the RightFax server.

To enable stand-alone fax machine support

1. On the RightFax server, run Enterprise Fax Manager and create a new user. In the Routing Code box, enter an extension that will be dedicated to the Standalone Fax Connector. For information on creating a new user, see “Adding a user” on page 96.
2. Edit the Windows Registry Extensions value (in the SFC key) to include the Routing Code for each stand-alone fax user. See “Extensions (in SFC Key)” on page 342.
3. Change the Windows Registry Change value (in the SFC key) to “1” hex. Once RightFax reads the new values, it will reset the Change value to “0” hex. See “Change (in SFC Key)” on page 341.

After the Standalone Fax Connector has been enabled, users can access it from any fax machine that can dial into the extension you have dedicated. Users have the option of dialing their intended recipients directly or entering the ID of a phonebook entry that then dials the recipient(s) listed in that entry. Add individual or group phonebook entries under the user ID that you have designated for the Standalone Fax Connector and assign each entry a numeric ID.

To send a fax using the Standalone Fax Connector

1. Dial the Standalone Fax Connector extension. This number must be listed in the Extensions value in the SFC key in the Windows registry on the fax server. Depending on your Brooktrout fax board configuration, either a tone or voice message will prompt you for the destination fax number.
2. To manually enter a destination fax number, enter the fax number and billing codes using this format:
   FaxNumber*billInfo1*billInfo2#
   Separate the fax number and billing codes using the asterisk [*] key and press the pound [#] key when you are done. If billing codes are not required, they can be left out of the dial string, but you must include a fax number and end by pressing the pound [#] key.
   To use a phonebook entry, enter the numeric ID of the phonebook entry and press the pound [#] key.
3. Another tone or voice prompt will instruct you to begin transmitting the fax. Press the Start button on the fax machine. The fax machine will proceed to scan the pages and send the fax to the specified phone number or to the destination(s) in the phonebook entry.
Chapter 14
Creating Billing Codes

RightFax tracks and reports fax activity using billing codes. Users can be required to enter one or two codes for every fax before it can be sent or deleted. These codes can be validated internally against a master table or externally using a separate application (for example, an accounting program). To validate billing codes internally, you must create a list of valid billing codes in RightFax.

RightFax supports the use of two billing codes for each faxed document. These are referred to as “Billing Code 1” and “Billing Code 2.” Your organization can require both billing codes on faxes (such as one code for account number and one for a matter number), one billing code (to track the individual or department sending the fax, for example), or no billing codes.

Customizing the Names of Billing Code Fields
For users, the RightFax billing code fields appear in the Fax Information dialog box. By default, the names of the billing code fields are “Account” and “Matter.” To change these names to meet the needs of your organization, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85), select Customize Cover Sheet Fields from the Utility menu, and click the Billing Codes tab. Enter new descriptions for the Billing Code 1 and 2 fields in the description boxes. The new names will appear throughout your RightFax client applications.

Managing Billing Codes
You can create a list of billing codes that is used to validate the codes entered by fax users when sending faxes. To add, edit, or delete billing codes, run Enterprise Fax Manager and click Billing Codes under the desired RightFax server.

Adding a billing code
To add a new billing code to RightFax, press INSERT, or select New from the Edit menu. The Edit Billing Code dialog box opens. For information on completing each of the options in this dialog box, see “Editing Billing Code Properties” on page 134.

Deleting a billing code
To delete a billing code, select the billing code to delete and press DELETE, or select Delete from the Edit menu.

Copying billing codes from one server to another
In Enterprise Fax Manager, you can copy one or more billing codes from one RightFax server to another. Select the billing codes you want to copy, and then drag the selection to another server.

If you copy billing codes from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).
Editing Billing Code Properties

To edit the properties of an existing billing code, run Enterprise Fax Manager, select the billing code to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the billing code. The Edit Billing Code dialog box opens.

![Edit Billing Code Dialog Box]

**Billing Code 1 and 2**  Enter one or two billing codes.

**Description**  Enter a descriptive name for the billing code.

Importing Billing Codes

You can import billing code records from an ASCII text file. This is most useful when systems such as EquiTrac or central databases are used to store a master set of billing codes. Such systems can be programmed to periodically generate a formatted ASCII file that the RightFax server will recognize and process. After such a system is configured, billing code maintenance can be fully automated.

Creating the billing code file

The ASCII billing codes file must be named Codechg.csv and must be located in the RightFax\Worksrv folder.

The file Codechg.csv must be formatted with one complete billing code record per line. The codes themselves cannot contain spaces, but descriptions can. For each record, the codes and description must be separated by commas. You can import new billing codes as well as specify deletions and changes to billing codes. Each billing code record must include a leading field that indicates the desired operation. The leading field (a single character followed by a comma in all cases) can be 'A' indicating an addition, 'C' indicating a change to an existing code, or 'D' indicating that a code should be deleted.

**Format**  Operation,BillInfo1,BillInfo2,Description

**Example**  A,Smith,9054,Harry Smith Inc.
C,Jones,5687,Bob Jones Corp.
D,Smith,2390

(A “delete” line need not contain a description, and any included description will be ignored.)

Configuring RightFax to import billing codes

To configure RightFax to import the ASCII billing code file, run the WorkServer configuration program, select the WorkServer in whose folder you saved the Codechg.csv file, and set a value in the Billing Code Import Interval field. This parameter determines the interval in minutes that the WorkServer should check for a new billing code file. At every interval, the WorkServer checks for the file Codechg.csv, in its own folder. If the file exists, the WorkServer imports the additions, changes, and deletions specified in the file. After the entire file is processed, the WorkServer erases Codechg.csv so that it will not be picked up again at the next check.

The WorkServer also produces a log file, Codechg.log, that can be examined to see what codes were imported from the most recent Codechg.csv. The log file is overwritten each time an import is executed, so it will not grow indefinitely.

When writing the input file it is recommended that it not be initially named Codechg.csv. If it is, the WorkServer may attempt to open and process the file before you have finished building it. It is best to
use a temporary name (such as Codechg.$$$) to build the file. After all lines have been written to the file, close it and re-name it to Codechg.csv.

Example A batch file can be created that automates this process, for example:

```
j:  
cd \fax\worksrv
getcodes codechg.$$$
ren codechg.$$$ codechg.csv
```

In this example, GETCODES is a program supplied by the user that creates an ASCII file of billing code changes in the required format.

**Requiring and Validating Billing Codes**

**Requiring billing codes on sent faxes**

After you have created a list of billing codes, you can require all users to enter one or both billing codes with each fax sent. To require the billing code fields be completed before a fax can be sent, run Enterprise Fax Manager, select **Customize Cover Sheet Fields** from the **Utility** menu, and click the **Sending Required Fields** tab. Select either or both of the **First Billing Info** or **Second Billing Info** check boxes.

Fields that you have marked as required will appear bold in the **Fax Information** dialog box.

**Requiring billing codes on received faxes**

You can also use billing codes to track information about your received faxes. When you require billing codes on received faxes, the recipient will not be able to delete the fax until the required billing codes have been assigned. To require billing codes on received faxes, run Enterprise Fax Manager, select **Customize**

**Cover Sheet Fields** from the **Utility** menu, and click the **Receive Required Fields** tab. Check either or both the **First Billing Info** or **Second Billing Info** fields.

Users can manually assign billing codes to their received faxes by double-clicking the fax in FaxUtil to open the RightFax viewer and selecting **Assign From Information** in the **Fax** menu. A dialog box appears with fields for entering the necessary billing code information.

**Configuring billing code validation**

You can configure the RightFax server to validate billing codes against the billing code list in the RightFax server. If a supplied billing code does not match one in your list, it will be rejected and the fax will not send. To configure RightFax to validate billing codes, run Enterprise Fax Manager, select **Customize Cover Sheet Fields** from the **Utility** menu, and click the **Billing Codes** tab. Check the **Verify Billing Codes for Sent and Received Faxes** option.

**Note** Validating billing codes against an external application requires you to create a custom utility using the RightFax API. For information on customizing your RightFax system with the RightFax API, visit the OpenText Knowledge Center at knowledge.opentext.com or contact OpenText for implementation services.

**Accessing ODBC Billing Codes**

You can integrate billing codes from an external ODBC source for use in all of your users’ outbound faxes. The ODBC source can be created and configured using the ODBC configuration program. Each client workstation must be configured individually to access these billing codes.
Click the RightFax tray icon in the Windows taskbar. In the shortcut menu, select **ODBC Configuration**. The **Configure ODBC Tables** dialog box opens.

Figure 14.2  The Configure ODBC Tables Dialog Box

Under **ODBC Billing Tables**, click **Add**. The **Configure ODBC Billing Table** dialog box opens.

Figure 14.3  The Configure ODBC Billing Table Dialog Box

Complete each of the boxes according to your ODBC database specifications.

**Billing Table Name**  This is a descriptive name for this billing codes table.

**ODBC Source**  The name of your ODBC billing codes data source.

**ODBC Field Names**  Relates the fields of the ODBC database to the standard RightFax billing code fields. This is done with simple SQL query statements.

**ODBC User ID and Password**  These are the ID and password to access the ODBC database. If the ID and password match those used to log into RightFax, you can check those boxes instead.
**Records to Load at Once**  Limits the number of records displayed at one time during billing code lookup by entering the limit in this box.

**SQL Cursor Type**  Selects an SQL cursor type. In most cases, this option should be set to “Dynamic.”

**Querying an ODBC billing code list**

After you have configured the necessary ODBC information on a user’s workstation, that user can access ODBC billing codes when sending faxes.

**To look up ODBC billing codes**

1. In the Fax Information dialog box, click **Lookup** to select RightFax billing codes or a specific ODBC billing code table.

2. Select the ODBC billing code table you created. This opens a list of the ODBC billing codes.

3. If you limited the number of records displayed at one time in the **Records to Load at Once** box in the Configure ODBC Billing Table dialog box, you will see only the specified number of records (or fewer). To view the previous or next batch of codes, click the arrows on the right side of the list.

4. Click the billing code information you want, and click **OK** to enter it in the Fax Information dialog box.
Chapter 15
Creating Library Documents

You can store frequently faxed documents (such as company literature, credit applications, or employment forms) in a fax document library for easy retrieval. Library documents are stored in the RightFax\Image folder on the RightFax server, and can be sent as attachments to faxes. There are several ways to attach a library document:

- When creating a new fax in FaxUtil, in the Fax Information dialog box, click the Attachments tab and select the library documents to include.
- When creating a new fax by using the Quick Fax/Broadcast command from the tray icon, click the Attachments tab and select the library documents to include.
- When creating a new fax by using embedded codes, include <LIBDOC> and <LIBDOC2> in the document. For information on using these and other embedded codes see Appendix A, “RightFax Embedded Codes”.

Creating a New Library Document

Library documents are created from a fax in your FaxUtil mailbox. You should always create library documents using Fine resolution. To set fine resolution as the default in FaxUtil, select Tools > Options, and the Options dialog box opens. On the Sending tab, select the Use Fine Mode check box.

To create a new library document

1. Create the document in a word processor or other application that lets you print to the RightFax fax printer. Send the fax image to your own FaxUtil mailbox.
2. Run FaxUtil and click the document in the list of received faxes.
3. In the Fax menu, click Store in Library. The Store Fax in Document Library dialog box opens.
4. Specify a Document ID and Description for the new library document. These fields and the remaining options are the same as the Edit Library Document dialog box (page 140).
5. When you have completed the dialog box, click OK. The new document will now be available in the Library Documents list for all users except those in groups which have been denied access to all library documents (see “Limiting group access to library documents” on page 114).
Automating the creation of new library documents

You can also automate the creation of new library documents using the `<NEWLIB>` and `<NEWLIB2>` embedded codes. For information on using these and other embedded codes see Appendix A, “RightFax Embedded Codes”.

Editing Library Document Properties

To edit the properties of an existing library document, run Enterprise Fax Manager you can:

- double-click the document name
- select the document to edit and press ENTER
- select the document to edit and select Edit in the Edit menu

The Edit Library Document dialog box opens.

Document ID  This is a unique code that identifies the library document. If you want the library document to be available via the Web or Fax-on-Demand (described in the RightFax Docs-on-Demand Guide), you must assign a numeric document ID.

Description  This is a descriptive name for the library document.

Image File Name  The name of the library document file. This is generated automatically when the library document is created and should typically never need to be changed. All library document files are saved in the RightFax\Image folder on the RightFax server.

Pages  The number of pages in the document.

Accessible via LAN  Makes the library document available on the local area network for faxing from client workstations.

Accessible via Web  Makes the library document available to users via your Web site using Web Fax Tools.

Accessible via FOD  Makes the library document available to users via touch tone phone using Fax on Demand.

Include in Catalog  Includes this document in the Fax on Demand catalog of available faxes.

Request Password  The numeric password that is required by Fax on Demand when users request this document.

Activation Date  The date that the library document becomes available for use. Click to select the check box and select the activation date. To make the library document available immediately, do not select this option.

Expiration Date  The date that you want the library document to become unavailable for use. Click to select the check box and select the expiration date. If you do not select this option, the library document will available indefinitely.
Managing Library Documents

To edit or delete library documents, run Enterprise Fax Manager and click Library Documents under the desired RightFax server in the Fax Server Tree.

Deleting a library document

To delete a library document, select the document to delete and press DELETE, or select Delete from the Edit menu. By default, you will be prompted for confirmation that you want to delete the library document.

Copying library documents from one server to another

In Enterprise Fax Manager you can copy one or more library documents from one RightFax server to another. Select the library documents you want to copy, and then drag the selection to another server.

If you copy library documents from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server.

Library document usage statistics

Enterprise Fax Manager keeps a record of each time a library document is sent via Fax-on-Demand, the Web, or local area network, and displays the totals in the right pane of the Enterprise Fax Manager window. To reset these counters back to zero, click the library documents to reset and select Reset Usage Counts in the Edit menu.
Chapter 16
Text Messaging Using the Push Proxy Gateway

The Push Proxy Gateway (PPG) quickly and easily enables applications to deliver information to mobile users via Short Message Service (SMS) text messaging. It uses a Global System for Mobile Communications (GSM) modem or direct connection to a Short Message Service Center (SMSC) to deliver them via the mobile network to the target device. It can also be a natural extension of the RightFax enterprise fax and e-document delivery solution channels. PPG functionality can be accessed locally and/or remotely.

To install Push Proxy Gateway

1. Run the RightFax installation program on the RightFax Server.
2. On the Select a typical feature set or create your own page, select Custom and click Next.
4. Click Next, and continue following the prompts.

Caution The PPG's public port (default TCP 8980) should be accessible to any computers that will send messages to the PPG. The other ports, especially the internal port (default 5001) and the administration port (8901) should not be accessible from the Internet. As with all servers, take care to keep the server up to date with any necessary patches. If the PPG accepts connections from the Internet, it is especially important to keep Microsoft IIS up to date with security patches.

Understanding Message Types

The PPG supports the delivery of plain text SMS messages. Plain text messages are sent by the PPG as text-only Short Message Service (SMS) messages. All GSM handsets on the market today can receive these SMS messages. PPG is capable of two-way SMS messaging and can receive SMS messages in reply to the outgoing SMS messages that it sends.

Note Plain text messages should only be used with a Modem or SMPP connector.
Understanding Connectors

PPG uses **connectors** (sometimes called **channels**) to support different methods of delivering SMS messages. Modem and SMPP connectors are supported.

Understanding the Modem Connector

Modem connectors allow messages to be submitted to the carrier’s Short Message Service Center (SMSC) through a GSM modem that is attached to the PPG server. You can use any GSM modem that provides a serial-port (COM) interface and supports the GSM 07.07 and 07.05 AT commands. The GSM modem can be a card connected to your server, or a mobile phone (with a GSM modem) connected to your server via a data cable. PPG supports two serial port modems on a single server.

Modem Connector Throughput

The PPG throughput via a modem connector, using API, is as follows:

- **Single Modem:**
  - Sending Outbound only: 14 per minute
  - Receiving Inbound only: 14 per minute
  - Two-way (In and out simultaneously): 10 per minute

- **Two Modems:**
  - Outbound only: 14 per minute
  - Inbound only: 30 per minute
  - Two-way (In and out simultaneously): 10 per minute

Understanding SMPP Connectors

SMPP connectors allow a high volume of messages to be sent via an SMSC. The supported protocol is SMPP version 3.4.

SMPP Connector Throughput

The PPG throughput via an SMPP connector, using API, is as follows:

- Two-way (simultaneously): 120 per minute

Understanding Two-Way SMS Support

PPG supports two-way SMS messaging via SMPP or Modem connectors.

Two-Way SMS and SMPP Connectors

PPG can use SMPP connectors to assist RightFax in associating incoming SMS messages with RightFax user mailboxes for routing purposes.

The wireless carrier allocates a phone number or short code to the PPG Administrator. This number is referred to as a **reply number**. The reply number is used by mobile devices to reply to the SMS messages sent to them via the PPG. It is also used by the SMSC to receive the incoming SMS messages, that are then sent to PPG.

When PPG sends an SMS message, it specifies one of these available numbers in the **From** field. The recipient device sends an SMS message back to one of the reply numbers, all of which are intercepted by the SMSC and routed to PPG. Then, PPG can send the reply number, message contents, and the replying device’s address to RightFax.

Understanding Log Files

PPG maintains log files in its program directory. The three log file types are transaction, error, and debug logs. The log files are rotated, or rolled, every 24 hours by default, where each roll occurs at zero-hundred hours. When this occurs, new log files are created with filenames based on the current time.
The interval setting for transaction logs can be changed so that the roll occurs anytime between 10 minutes and 24 hours. A directory to which the transaction log files are saved can be specified.

Transaction log files are generated in a standard format that can be parsed or saved by external applications, as shown in Table 3a. Error log files display error and warning messages that are also viewable in the debug log file. Debug log files do not need to be enabled in order to generate and view the error log files.

The rolled logs and the current logging file have file names with the following format:

prefix-GYYYYMMDDHHMM.LOG

In the above format, prefix is cppg for transaction log files, dbgp for debug log files, and errp for error log files.

Understanding Transaction Logs

The following table lists the formats used in a PPG transaction log.

<table>
<thead>
<tr>
<th>Col</th>
<th>Value</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Type</td>
<td>The type of message: Outbound, Inbound, Notification, and Service. Service is used for PPG Service Startup/Shutdown messages.</td>
<td>Type: Outbound</td>
</tr>
<tr>
<td>2</td>
<td>Date and time</td>
<td>Date and time of request</td>
<td>12/03/2003 13:50:36:923</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>Static - separator</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Push Initiator address</td>
<td>IP address of the Push Initiator</td>
<td>PI: 1.2.3.4;</td>
</tr>
</tbody>
</table>

Table 16a  Transaction log formats

The transaction logs use this format:

Type: [value]; PI: [value]; MessageID: [value]; FromAddress: [value]; ToAddress: [value]; NotifyTo: [value]; Status: [value]

Transaction log example:

12/03/2003 13:50:36:923 - Type: Outbound; PI: 1.2.3.4; MessageID: PI/64; FromAddress: 14255551234; ToAddress: +14255551212; NotifyTo: ; Status: Delivered

Configuring the Push Proxy Gateway

You can configure PPG using the RightFax interface. This section describes the PPG configuration options, and provides information
Stopping and Starting the PPG Services
The PPG and the PPG Administration run as Windows services and can be started and stopped via RightFax Enterprise Fax Manager.

1. Choose Start > Programs > RightFax Enterprise Fax Manager.
2. In the left pane, select the server on which PPG is installed.
3. Right-click the PPG service that you wish to start or stop, located in the Service Name column.
   - Click Start Service to start the selected service.
   - Click Stop Service to stop the selected service.

Note You should not use the remote feature of the Windows Service Control Manager. To control the service from a remote computer, use \textsf{Terminal Services} to log on to the server and use the Windows Service Control Manager.

Accessing and Configuring the PPG
After you make changes in the PPG interface via RightFax, (described in the following sections), you must stop and restart the PPG service before the changes will take effect. For more information, see the previous section.

Important You must add PPG as a Transport in the Doc Transport Module before you can configure and use the PPG. Refer to the \textsf{DocTransport Module} chapter in this guide for more information.

Accessing PPG via RightFax
You can access PPG configuration options via the Enterprise Fax Manager.

To access PPG via RightFax
1. Choose Start > Programs > RightFax Enterprise Fax Manager.
2. In the left pane, select the server on which PPG is installed.
3. Double-click Mobility Push Proxy Administration, located in the Service Name column.

The PPG Administration dialog box displays.

Using the Interfaces tab
The Interfaces tab establishes connection details for the PPG. The Connector section of the tab displays different fields when you change the Active Connector.

Figure 16.1 The Interfaces tab – Modem
Send Message Port  Enter the port number of the Internal Interface. This is a port used for communication between the IIS extension and the PPG service. It should not be accessible by outside/Internet computers. The port value is 5001 by default.

Receive Message Port  The PPG service sends inbound messages to RightFax via this port. This port uses 5002 by default.

Administration Port  The PPG Administration service listens on this port for configuration requests and uses 8901 by default. This port must be on the machine where PPG is installed.

Important  Some of the ports used by the PPG by default are registered as service contact ports with the Internet Assigned Numbers Authority (IANA). If you encounter a port conflict, you can assign a different port number by modifying the entries on the Interface page or editing the CPPG.INI file.

Refer to http://www.iana.org/assignments/port-numbers for a list of registered ports.

Active Connector  Choose the connector to be used by the PPG. GSM Modem and SMPP are supported.

Message Encoding Format  Select US ASCII for the standard US ASCII character set, or select UCS-2 if you need diacritical characters or most double-byte languages.

Note  SMS message size limits  When sending messages via the Modem connector, all messages are carried in a single SMS message. In the GSM environment, a single SMS message holds 140 bytes of information.

US ASCII messages can be up to 160 characters in length.
UCS-2 messages can be up to 70 characters in length.

These fields are specific to the GSM Modem connector:

Modem  Select an available modem from the drop down box.
Enable Modem  Select this checkbox to instruct PPG that the selected port is active and should use these configuration settings.

Baud Rate, Data Bits, Parity, and Stop Bits  Change the fields for Baud Rate, Data Bits, Parity, and Stop Bits as appropriate for the modem in use.

Number  The phone number of the cell phone or cellular modem that will connect to the communications port.

SMSC  Enter the telephone number of the SMSC used by the carrier to which your modem is subscribed. Contact your carrier to get this number.

Modem Init String  Enter the initialization string. The default is “AT+CMGF=0”. The initialization string can be found in the phone’s manual.
These fields are specific to the UDP connector:

**Figure 16.2  The Interfaces tab – UDP**

- **Default Destination Port** – The PPG uses port number 2948. RightFax 9.4 does not use the UDP connector.

These fields are specific to the SMPP connector:

**Figure 16.3  The Interfaces tab – SMPP**

- **SMSC IP Address**  The IP address of the carrier.
- **Single Port**  Choose to instruct PPG to communicate with the SMSC via a single port.
- **Double Port**  Choose to instruct PPG to communicate with the SMSC via a dual port. This is the default.
- **System ID**  This is identification on the carrier’s system, such as a user name. It is provided by the carrier.
- **System Type**  This is additional information used to identify the user and is provided by the carrier.
Password  This password is used to connect to the SMSC and is provided by the carrier.

Port  The port used to connect to the SMSC, in the format IP Address:Port.

SMPP Version  The version number is generally 3, depending on the SMSC implementation.

Retry Interval  The number of seconds the PPG waits to retry a connection, after a connection fails.

Timeout Interval  The connection is no longer valid if a response is not received within this number of milliseconds.

Max Msg/Min  The maximum number of messages sent per minute.

Msg Lifetime  The number of hours a message is considered valid. The message is discarded if it is not delivered within this time frame.

Short Code  Select if using a shortened phone number, if one was assigned to you.

Address Range  Input the range of phone numbers assigned to your SMPP connection.

- Add an individual number by entering it in the upper field, then clicking Add Range.
- Add a range of numbers by entering the beginning of the range in the upper field and the end of the range in the lower field. Click Add Range. The assigned numbers in the range are automatically generated.

Add Range  Click to specify the addresses as entered in the Address Range fields.

Clear Range  Click to delete all of the numbers currently assigned to this connection.

Using the License Management tab

The License Management tab allows you to add or remove PPG licenses.

A transaction is defined as one message sent to one address. For example:

- One SMS message, sent to one phone, equals one transaction.
- One SMS message, including a list of 10 phone numbers, equals 10 transactions.

Serial Number  The full license key.

Add  Click to add the license entered in the Serial Number field to the list of available PPG licenses.
Delete — Click to remove a selected license from the list.

Licensed transaction per minute — A license is automatically installed that allows 6000 transactions per minute. This high number allows more licensed transactions than the server could ever possibly process, so there is essentially no need for additional licenses.

Using the Logging tab

The Logging tab determines how transaction and debug log files are collected. The transaction log contains the Call Detail Records (CDR) and will be of the form:

```
cppg-GYYYYMMDDHHMM.LOG
```

where G is the gateway ID, and the rest of the string is the date and time the log file started.

See “Understanding Log Files” on page 144 for more information about log files.

Figure 16.5 The Logging tab
**Number of days to retain transaction logs** - Enter a value for how many days old log files will remain on the system. By default, 90 days of previous log activity is saved.

**Automatically rotate logs** - Select to rotate log files automatically. By default, the server’s log file is closed and a new log file is created at midnight each day. This option closes the current log file and opens a new one more frequently.

**Rotate logs every n minutes** – Specifies how often log files should be rotated. Type the value in hours and minutes (00:10 to 24:00).

**Rotate logs to separate directory** - By default, the rotated log files are saved in the PPG installation directory. To save the log files in a different directory, type the complete path of the target directory in this box.

**Note**  
Log files must be saved on a local drive. They cannot be saved to a mapped network drive.

**Debug Log** - Select to enable a detailed log file of gateway activity. Debug logs can be quite large, so this setting should be off for normal operation. If the debug log is enabled, then the PPG service must be stopped and restarted before it will take effect.

**Important** Enable the “Enable Debug Log” setting only if directed to do so by customer support.

**Retain Debug Logs for (Days)** – Enter a value for how many days the debug log files will remain on the system. The default is 90.
You can configure the RightFax server to send email, pager messages, or SMS messages to fax users and administrators to alert or notify them of specific RightFax events. To send these alerts and notifications from RightFax, you must create a list of available services and providers.

If you will be configuring SMS notifications, you must first install and configure the RightFax Push-Proxy Gateway (see Chapter 17, “Text Messaging Using the Push Proxy Gateway”).

To install the RightFax Push-Proxy Gateway

1. Run Add/Remove Programs from Windows Control Panel, highlight RightFax Product Suite, and then click Change.

2. Click Next at the opening screen. This opens a list of installation options. Select Modify and click Next.

3. On the Setup Features screen, expand the RightFax Server category and select Push Proxy Gateway for install. Click Next.

4. Complete the Installation Wizard according to the instructions in the RightFax Installation Guide.

5. When you are prompted to reboot the computer, click Yes.

6. After the computer restarts, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.

7. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.

8. In the Service Name list, double-click RightFax DocTransport Module. The Transport Configuration dialog box opens. (The DocTransport configuration program is described more thoroughly in “Configuring the DocTransport Modules” on page 43.

9. Click the Add Transport button. In the Select Transport dialog box, select the option SMS Via Push-Proxy Gateway in the left pane and the click Select. This will add SMS functionality to the RightFax server.

10. Close the DocTransport configuration program and select Start > Programs > Open Text > RightFax Enterprise Fax Manager.

11. In the Enterprise Fax Manager application, select Dialing Rules under the local fax server in the left pane.

12. Press INSERT to add a new dialing rule. Click the Destination tab and select SMS in the Send Via Transport box.

13. Close Enterprise Fax Manager.
After it is installed, the Push-Proxy Gateway must be configured for your organization’s specific needs. For information on configuring the RightFax Push Proxy Gateway, refer to the RightFax Push-Proxy Gateway Guide.

Managing SMS and Pager Services

You must create a pager service configuration for each type of service, run Enterprise Fax Manager and click SMS/Pager Services under the desired RightFax server in the Fax Server Tree.

Adding SMS and pager services

To add a new pager service to RightFax, press INSERT or select New from the Edit menu. The Edit SMS/Pager Service Definition dialog box opens. For information on completing the options in this dialog box, see “Editing SMS and Pager Service Properties” on page 154.

After you have created a list of SMS and pager services, you can configure fax user notifications and administrative alerts. Fax status notifications and how they will be delivered are configured individually for each RightFax user (described on page 107). A default notification method can also be configured for groups, (described on page 113). Fax server status alerts for administrators can be configured for individual administrative users (described on page 104), or you can use the RightFax Alerting and Monitoring service to create and customize a list of server statistics to monitor and alert on (described in Chapter 18, “Using the Alerting and Monitoring Service”).

Users can be paged via SMTP email (requiring Internet connectivity), via TAP or UCP protocols (requiring any TAPI-compatible or AT-compatible modem), or send SMS messages (requiring the RightFax Push-Proxy Gateway).

Deleting SMS or pager services

To delete a pager service, select the service to delete and press DELETE, or select Delete from the Edit menu.

Copying SMS and pager services from one server to another

In Enterprise Fax Manager, you can copy one or more pager services from one RightFax server to another. Select the pager services to copy, and then drag the selection to another server.

If you copy pager services from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (in other words, features on version 10.5 servers will not be available on version 9.4 servers).

Editing SMS and Pager Service Properties

To edit the properties of an existing service, select the pager service to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the service. Each type of service you add has different configuration settings. The sections that follow describe each type of service and the required configuration options.
Configuring SMTP services

Service ID   This is a descriptive ID for the service provider or type of service. When you edit and change the service ID of a listed pager service, Enterprise Fax Manager creates a copy of the service with the new name, rather than re-naming the service.

Service Type   Select SMTP as the service type.

SMTP Server   The name of your service provider’s SMTP server.

SMTP Sender Address   This is an SMTP mail address from which the page will be sent. Some SMTP message servers require the sender’s SMTP address in order to process transactions.

Configuring TAP and UCP Dial-up services

TAP dial-up and UCP dial-up both have the same configuration options.

Service ID   This is a descriptive ID for the service provider or type of service. When you edit and change the service ID of a listed pager service, Enterprise Fax Manager creates a copy of the service with the new name, rather than re-naming the service.

Service Type   Select TAP Dial-up or UCP Dial-up as the service type.

Terminal Phone Number   This is your service provider’s modem phone number (for TAP and UCP messaging only).

Service Password   The password your service provider requires to access their TAP or UCP messaging systems (if any).

Provider   Specify the specific provider for your UCP or TAP service. If your provider is not listed here, select “None.”
**Connection Timeout**  The length of time, in seconds, for RightFax to successfully connect to the TAP or UCP messaging system. If a timeout occurs, RightFax will abandon the call and no message will be sent.

**Message Transaction Timeout**  The length of time, in seconds, for RightFax to successfully send the message to the TAP or UCP messaging system. If a timeout occurs, RightFax will abandon the call and no message will be sent.

**Maximum Message Size**  The maximum number of characters allowed by your service provider for pager or SMS messages.

**Modem Communication Driver**  Specify the COM port for the modem on the RightFax server. If you have installed one or more TAPI modems on your RightFax server, you can select from those modems as well. If you select a TAPI modem, the **Direct Modem Parameters** settings (described later) will be unavailable because those settings will be taken from your TAPI modem configuration on the RightFax server.

**Ignore TAPI Dialing Location Rules**  Ignores any specified dialing location rules (such as add 9 to dial out) if you have specified a TAPI modem in the **Modem Communication Driver** box (described earlier).

**Direct Modem Parameters**  These parameters are configured according to your modem type and phone system dialing requirements. If your pager or SMS service provider recommends a baud rate for connecting to their TAP or UCP systems, enter the baud rate in the **Port Speed** box.

---

**Configuring SMS services**

Figure 17.3  SMS service configuration

**Service ID**  This is a descriptive ID for the service provider or type of service. When you edit and change the service ID of a listed pager service, Enterprise Fax Manager creates a copy of the service with the new name, rather than re-naming the service.

**Service Type**  Select **SMS** as the service type.

**PPG Host (IP or Name)**  Use the default value for the PPG Host.

**PPG Port Number**  Use the default value for the PPG Port Number.
Logging SMS and Pager Alerts

SMS and pager alerts are logged in the Windows Event Log with a special event identifier. The purpose of this identifier is to allow Windows monitoring systems to identify when an alert has occurred without monitoring the contents of the event entry. To filter on these events, filter for Source = “RightFax Server Module” and Category = “Administrative Alert.”

At least one person must be set up to receive an alert of each type to cause this logging to occur. If no users are set up to receive alerts, then none will be logged in the NT Event Log using the special event identifier.
Chapter 18
Using the Alerting and Monitoring Service

The RightFax Alerting and Monitoring service lets you monitor a set of server statistics that you define in Enterprise Fax Manager and receive alerts relating to those statistics. To use the RightFax Alerting and Monitoring service, you must first install and configure the service, and then define the statistics to monitor and their alert thresholds.

Installing the Alerting and Monitoring Service

There are two ways to install the RightFax Alerting service:

- During initial RightFax setup, select a custom installation and check the box for Alerting Module under RightFax Server Modules. If you do not manually check the Alerting Module box, the service will not be installed.
- After RightFax installation, use the Windows Control Panel to modify the RightFax product suite and select the Alerting Module under the Server Modules Section.

For more details about RightFax Installation procedures, see the RightFax Installation Guide.

Because the RightFax Alerting service is designed to provide information about and send alerts relating to the RightFax server, you may choose to run the Alerting service on a computer other than the RightFax server. When the Alerting service is installed on a remote computer, it will continue to operate and send alerts even if the RightFax server shuts down or experiences other problems.

When the Alerting service is installed on a remote computer, all of the configuration for the service and the individual alerts is managed on the RightFax server that the service will be monitoring. No additional configuration on the remote computer is required.

Configuring the RightFax Alerting Service

To configure the Alerting and Monitoring service, open Windows Control Panel and double-click RightFax Alerting Monitoring. The Alerting & Monitoring Configuration dialog box opens.

The rest of this section describes the options on each of the tabs on this dialog box.
The Alerting and Monitoring Configuration General Tab

Figure 18.1 The Alerting & Monitoring Configuration General tab

Event log level Specify the level of information logged in the Application Event Log under the service name “RightFax Alerting Module.” You can select the following options:

- **None.** No information is saved.
- **Terse.** Records critical errors only.
- **Normal.** Records errors and major events only.
- **Verbose.** Records all significant events and is most useful for tracking and resolving problems.

**Caution** If you leave this value set to “Verbose” for long periods of time, the Event Log can become full which may prevent new events from being logged.

Refresh delay Specify the frequency, in minutes, that the Alerting service will poll the RightFax server for statistics.

Repeat delay Specify the frequency, in minutes, that alerts will be sent when statistic thresholds are met.

Remote alerting service This option indicates that the Alerting service will operate on a computer separate from the RightFax server. If you select this option, the Alerting service will not be started automatically by the Server module.

Select service account The RightFax Alerting service logs on to the network by default using the local system account. Click this button to optionally specify a different Windows user account for the service to use. If you want the Alerting service to authenticate to the RightFax server using NT authentication, you must select a Windows user account that has a corresponding RightFax user with NT authentication enabled.

When you select this option, the Select service account dialog box opens. For information on how to complete the options on this dialog box, see “Selecting a Service Account” on page 36.
Using the Alerting and Monitoring Service

The Alerting and Monitoring Configuration Launch Program Tab

Figure 18.2 The Alerting & Monitoring Configuration Launch Program tab

The RightFax Alerting service lets you optionally run a program (such as a batch file or other process) when thresholds for monitored statistics are reached. The options on this tab let you configure how these programs will be launched by the Alerting service.

**Log on as** Programs launched by the Alerting service require a Windows user account in order to access the network. Select one of the following options:

- **Same credentials as alerting service account.** Programs launched by the Alerting service will use the same user account information as the Alerting service.
- **This account.** Specify a Windows user account other than that used by the Alerting service. If you select this option, you must also enter the password for the specified user account in the NT password box.

Allow program to interact with desktop  Specifies whether the program launched will be accessible from the Windows desktop and usable by whomever is logged on when the service is started.

The Alerting and Monitoring Configuration SMTP Tab

Figure 18.3 The Alerting & Monitoring Configuration SMTP tab

The RightFax Alerting service lets you optionally deliver alerts as email messages via SMTP when thresholds for monitored statistics are reached. In the SMTP Server box, enter the name of the SMTP server that will transport these alerts. The email addresses to which alerts will be sent are configured for each individual alert in Enterprise Fax Manager (described in the next section).
Defining the Statistics to Monitor and their Alert Thresholds

To create, edit, or delete individual alerts, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85 and click Alerts & Monitors under the desired RightFax server in the Fax Server Tree.

The alerts and monitors that you create are displayed when you click Alerts & Monitors in Enterprise Fax Manager. Each monitor is preceded by a colored icon to indicate its current status. These icons are:

- **Yellow.** Indicates an error retrieving the value of the statistic.
- **Blue.** Indicates that the statistic is being monitored but no alert has been set.
- **Green.** Indicates that the statistic that has an associated alert condition, but the condition has not been met.
- **Red.** Indicates that the statistic that has an associated alert condition, and the condition has been met.

The current value for the statistic you are monitoring is displayed in the Value column. Not all monitored statistics can be configured to deliver an alert. Monitored statistics that are configured to deliver alerts are indicated by a green icon in the ID column. Statistics that cannot be configured to deliver an alert are indicated by a blue icon. Statistics that cannot be determined due to failure of the monitored service or other problems are indicated by a yellow icon.

Adding new alerts

To create a new alert, press INSERT or select New from the Edit menu. The Alert Properties dialog box opens. For information on completing each of the options on each tab see “Editing Alert Properties” on page 163.

Deleting alerts

To delete an alert, select the alert to delete and press DELETE or select Delete from the Edit menu. You will be prompted for confirmation that you want to delete the alert.

Copying alerts from one server to another

In Enterprise Fax Manager, you can copy one or more alerts from one RightFax server to another. Select the alerts you want to copy, and then drag the selection to another server in the Fax Server Tree.

**Note:** If you copy alerts from one RightFax server version to a different server version, you will lose any configuration data that is not supported by the second server. For example, RightFax 10.5 generates fax board information with DocTransport, but RightFax 9.3 uses BoardServer for similar information. If you copy a DocTransport alert to a 9.3 server, it will not trigger because the older server can’t monitor the newer service. If you copy a 9.3 BoardServer alert to a RightFax 10 server, it will not trigger because the newer server no longer monitors the BoardServer service.
Editing Alert Properties

To edit the properties of an existing alert, run Enterprise Fax Manager, select the alert to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the alert. The Alert Properties dialog box opens.

Figure 18.4 The Alert Properties Monitor Tab

Some of the statistics that you configure in this dialog box do not support alerts. These statistics can be configured entirely on the Monitor tab. If you select a statistic for which an alert can be configured, two additional tabs, Actions and Message, will appear on this dialog box. These tabs are described later in this section.

Name  This is the name of the alert that will appear under the ID column in Enterprise Fax Manager.

Description  This is the alert description that will appear under the Description column in Enterprise Fax Manager.

Category  Alerts are divided into several categories. The statistics that you can monitor (selected in the Statistics to monitor box) will differ depending on the category you select. Select from the following options:

- Fax Server. Statistics related to activity and events on the RightFax server.
- Database. Statistics related to the RightFax database.
- Gateway. Statistics related to email gateways.
- Local BoardServer (Legacy). Statistics related to the BoardServer service on the RightFax server.
- All BoardServers (Legacy). Statistics related to the local BoardServer and any remote BoardServer services.
- RPC Server. Statistics related to the RPC server which coordinates communication between the RightFax server and other resources on the network.
- Paging Server. Statistics related to the paging server used to send notifications via SMS and pages.

Statistic to monitor  Select the statistic you want to monitor. The statistics that you can monitor will differ depending on the category you select. For a description of each statistic in this list, see Appendix D, "Alerting and Monitoring Statistics". Depending on the statistic you select, additional options may appear below the Statistic to monitor box. These additional options must be
completed in order to correctly define the statistic. For a definition of these options, click the [?] icon in the title bar and then click on the option to define.

**Caution** Alerting statistics that allow you to specify a fax channel number require that you start numbering from 1. This differs from the DocTransport configuration which starts numbering channels with 0 (zero). If you want to monitor the first fax channel, you must specify channel 1, even though it is numbered as channel 0 in the DocTransport. If you specify channel 0 in the alerting statistics to monitor, it will be changed automatically to channel 1.

### The Actions tab

When you select a statistic on the Monitor tab for which an alert can be generated, two additional tabs will appear on the Alert Properties dialog box: Actions and Message. See Appendix D, “Alerting and Monitoring Statistics” for a list of statistics that support alerts. You must complete the options on both of these tabs in order to generate an alert.

The options on the Actions tab let you define the conditions and thresholds under which an alert will be generated, as well as the alert action to take when a statistic’s threshold is met.

![Alerting Properties Actions tab](image)

**Condition** Select the operator by which the threshold value will be evaluated.

**Threshold** Specify a threshold value. An alert will be generated only if the condition you select meets this threshold value.

**Alert on error** If this option is selected, an alert will be generated if the value for the statistic cannot be generated due to errors or other problems with the RightFax service being polled.

**Actions** The options in this group box let you create, edit, and delete alert actions that will be taken when the statistic threshold is met. You can configure multiple actions for each alert. Follow these steps to create a new alert action:
To create a new alert action

1. Click the New Action button in the Actions group box. This opens the Action tab of the Edit Action dialog box.

![Figure 18.6 The Edit Action dialog box Action tab](image)

2. In the Name box, type a name for the alert to create.

3. In the Action box, select the type of alert to send. Alerts can be sent using these methods:
   - **Program.** The RightFax Alerting service lets you optionally run a program (such as a batch file or other process) when thresholds for monitored statistics are reached. A specified program will be launched.
   - **SMS.** A message will be sent to an SMS-capable device such as a cell phone or PDA.
   - **SMTP.** An email message will be sent to a specified user via an SMTP server.

   **Note:** The Network Broadcast Action is no longer functional in any of the currently supported Windows operating systems.

   Depending on the type of alert action you select, additional options will appear below the Action box. These additional options must be completed for the alert to successfully send. For a definition of each of these options, click the [?] icon in the title bar and then click on the option to define.

4. When all of the options on the Action tab have been completed, click the Time of Use tab.

![Figure 18.7 The Edit Action Time of Use tab](image)

5. To limit the alert to occur only on specific days, select the active days under Days of the week to use this alert.
6. If you want to limit the alert to occur only at specific times, select the **Limit use to the specified time** option, and then select a start and end time.

**Note** The Start time must be earlier than the End time within a single day; the Start and End times cannot span days. To create an overnight alert, create one alert that ends at 11:59 PM and another one that begins at 12:00 AM.

7. Click **OK** to save the alert. The new alert will appear in the list of alerts on the **Actions** tab of the **Alert Properties** dialog box.

8. To enable the alert, click the check box next to the alert name in the list of alerts.

**The Message tab**

The **Message** tab on the **Alert Properties** dialog box only appears if a statistic you select in the **Statistic to monitor** box supports alerts. See Appendix D, “Alerting and Monitoring Statistics” for a list of statistics that support alerts. The options on this tab let you define the message text of the alert that will be sent.

**Message** Enter the message text of the alert. You can use any combination of text and macros from the **Macros** list. An example of the alert message will be displayed in the box below this option.

**Macros** This is a list of macros that can be included in your message text. To add a macro to the message, place the cursor in the **Message** box where you want the macro text to appear and then double-click the macro in this list.

![Figure 18.8 The Alerting Properties Message tab](image)
Chapter 19
Using SNMP Alerting

The RightFax SNMP Alerting feature collects status data from the RightFax server and returns it to a monitoring application for processing and reporting. SNMP Alerting also actively sends status messages and alerts to your network monitor application for realtime monitoring of RightFax processes. RightFax alerts are divided into four severities: Critical, Error, Warning, and Informational, and alerts can be enabled or disabled according to their severity. The RightFax SNMP Alerting feature also allows RightFax services to be stopped and restarted directly from your network monitor application.

To use SNMP Alerting, the Microsoft SNMP service must be installed on both the RightFax server and on the network server that will monitor messages.

To install the Microsoft SNMP Service

If the SNMP service has not already been installed on the RightFax server, follow these steps:

1. On the RightFax server, from the Start menu, click Administrative Tools and then click Services.
2. Verify that SNMP Service does not yet appear in the Services list.
3. From the Start menu, click Administrative Tools and then click Server Manager.
4. In the Features area, click Add Features.
5. Click the checkbox next to SNMP Service and click OK.
6. Once the SNMP service has been installed, close the Network dialog box.

Configuring the SNMP Service on the RightFax Server

To configure the SNMP service properties

1. On the RightFax server, from the Start menu, click Administrative Tools and then click Services.
2. Double-click SNMP Service in the list of network services, and then click the Traps tab.
3. In the Community Name box, add the community name Public.
4. In the **Trap Destinations** box, enter the IP address of each machine on your network where you want to send RightFax SNMP alerts (each machine used for network monitoring) and then click **Add**. RightFax alerts can be sent to an unlimited number of network monitoring stations on your network. Click **OK**.

### Configuring the Network Monitor Application

Before it can receive SNMP alerts from the RightFax servers, your organization’s network monitor application must be configured to recognize the RightFax SNMP Alerting Management Information Base (MIB) variables and trap definitions.

In the network monitor, execute the appropriate command(s) to load new SNMP MIB variables and trap definitions. The MIB variables for RightFax SNMP Alerting are located in a file called Avtc.mib and the trap definitions are located in Rftrapd.conf. Both of these files are installed by default to the RightFax server in the RightFax\SNMP folder.

RightFax includes a utility that automates this configuration for HP OpenView Network Node Manager. To automatically load the MIB variables and trap definitions in Network Node Manager, run the file Rfhpov.bat from a command line on the Network Node Manager machine. This file is installed by default to the RightFax server in the RightFax\SNMP folder.

### Receiving RightFax Alerts in Your Network Monitor

RightFax SNMP Alerting actively pushes RightFax alerts to your SNMP-capable network monitoring application. This helps you ensure that problems with the RightFax server are reported and addressed promptly. SNMP Alerting also lets you query several variables on the RightFax server so you can view the status of the fax server in real time.

The fax server can send up to nine alerts to your SNMP network monitor. The following table defines each RightFax alert. The default RightFax severity is also listed, however your network monitor software may be configured to use different terminology. In RightFax terms, “Critical” is severity level one, “Error” is severity level two, and “Warning” is severity level three.

<table>
<thead>
<tr>
<th>Alert message</th>
<th>Default severity</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>“All BoardServers are down. Fax sending and receiving is not currently operating.”</td>
<td>Critical</td>
<td>All DocTransports attached to this fax server have gone down.</td>
</tr>
<tr>
<td>“One or more drives on the fax server are approaching critically low disk space (&lt;150 MB).”</td>
<td>Warning</td>
<td>One or more drives on the RightFax server have less than 150 MB free. Note that the actual amount of disk space that triggers this warning is configurable.</td>
</tr>
<tr>
<td>“One or more drives on the fax server are critically low on disk space (&lt;50 MB). Many fax server functions have been suspended.”</td>
<td>Critical</td>
<td>One or more drives on the RightFax server have less than 50 Mb free. Note that the actual amount of disk space that triggers this warning is configurable.</td>
</tr>
<tr>
<td>“Possible phone line failure on channel #, three consecutive no-dial tone errors within 45 minutes.”</td>
<td>Critical</td>
<td>One or more fax channels have gone down due to line failure.</td>
</tr>
</tbody>
</table>
Using SNMP Alerting

Each alert severity indicates how vital the component is to the operation of the RightFax server. “Critical” and “Error” alerts indicate a loss of fax functionality. “Warning” and “Informational” alerts indicate a loss of fax capacity. These severity levels may use different names in your network monitoring application, but the hierarchy of severities remains the same. RightFax does not send specific “clearing” alerts that indicate when the cause of an alert has been resolved.

Alerts generated by RightFax SNMP Alerting are stored in your network monitor under the “RightFax Server Alerts” category. Please refer to your network monitoring application’s documentation for information on displaying and managing alarm messages.

Because SNMP alerts are generated from the Windows Event Log on the RightFax server machine, the event log level of each individual RightFax service must be set to an appropriate level. The “Terse” setting records critical errors only. “Verbose” records all significant events and is most useful for tracking and resolving problems but can cause the event log to fill up quickly, which may prevent new events from being logged. For information on configuring the event log level for each RightFax service, refer to “Using the Alerting and Monitoring Service” on page 159.

### Enabling and disabling RightFax alerts

The RightFax SNMP MIB contains four variables that let you enable or disable the RightFax alerts according to severity. To edit these variables, expand the MIB tree to:

```
.iso.org.dod.internet.private.enterprises.AVTC.Right-FAX.
rfFaxServer.rfServerTraps
```

This object contains four editable (read/write) variables:

- `rfSvrEnableCriticalTraps`
- `rfSvrEnableErrorTraps`
- `rfSvrEnableWarningTraps`
- `rfSvrEnableInformationalTraps`

Each variable can be set to either “objectENABLE” or “objectDISABLE.” Changes to these variables take effect immediately. Please refer to your network monitoring application’s documentation for information on editing variables in the MIB.

### Table 19a  RightFax SNMP Alerts (Continued)

<table>
<thead>
<tr>
<th>Alert message</th>
<th>Default severity</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>“RightFax Email Gateway Module on FaxServerName: The Exchange Connector has not responded in a timely fashion. Inbound message processing temporarily disabled.”</td>
<td>Warning</td>
<td>The RightFax server is unable to communicate with the Exchange server.</td>
</tr>
<tr>
<td>“The fax server internal queue is more than 90% utilized.”</td>
<td>Critical</td>
<td>The RightFax internal event queue is more than 90 percent utilized.</td>
</tr>
<tr>
<td>“The fax server process was not properly shutdown.”</td>
<td>Critical</td>
<td>A fax server was shut down unexpectedly.</td>
</tr>
<tr>
<td>“The send queue depth on server ServerName is currently: #/# (faxes/pps).”</td>
<td>Critical</td>
<td>There are more than 1,000 faxes or 10,000 fax pages in the fax queue.</td>
</tr>
<tr>
<td>“Unable to communicate with BoardServer ServerName (error 2)”</td>
<td>Error</td>
<td>One DocTransport is down, but at least one other DocTransport is still running.</td>
</tr>
</tbody>
</table>
Querying RightFax Status Variables

The RightFax SNMP MIB is comprised of 12 objects, each made up of several variables. These variables provide realtime status information on the RightFax server. To query the RightFax variables in your network monitoring application, expand the MIB tree to:

```
.iso.org.dod.internet.private.enterprises.AVTC.Right-FAX.
rfFaxServer
```

All addresses below this branch point to a RightFax SNMP object or variable. The following tree lists each object in the RightFax SNMP MIB tree. Objects in bold contain variables.

rfFaxServer (.1.3.6.1.4.1.3529.2.1)
--- rfFaxServer_OV_v1Traps_ (.0)
--- rfServer (.1)
--- rfServerModule (.2)
--- rfBoardServerModule (.3)
--- rfBoards (.4)
--- rfBoardInfoTable (.4.1)
--- rfBoardInfoEntry (.4.1.1)
--- rfChannelInfoTable (.4.2)
--- rfChannelInfoEntry (.4.2.1)
--- rfDatabaseModule (.5)
--- rfRPCServerModule (.6)
--- rfQueueHandler (.7)
--- rfPagingServer (.8)
--- rfWorkServers (.9)
--- rfWorkSvrModuleTable (.9.1)
--- rfWorkSvrModuleEntry (.9.1.1)
--- rfWorkSvrFunctionTable (.9.2)
--- rfWorkSvrFunctionEntry (.9.2.1)
--- rfEMailGateway (.10)
--- rfGatewayModuleTable (.10.1)
--- rfGatewayModuleEntry (.10.1.1)
--- rfServerTraps (.11)

The following tables list each of the RightFax SNMP variables and their definitions grouped according to the objects they are contained in. Variables in boldface are editable. For information on using your network monitoring application to access the MIB tree and query variables in the MIB, please refer to the documentation for your particular application.

### rfFaxServer_OV_v1Traps_

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfSvrCriticalTrap</td>
<td>Notif.</td>
<td>Text of critical alert reported by the RightFax server. This is a notification type variable and cannot be queried or edited.</td>
</tr>
<tr>
<td>rfSvrErrorTrap</td>
<td>Notif.</td>
<td>Text of error alert reported by the RightFax server. This is a notification type variable and cannot be queried or edited.</td>
</tr>
<tr>
<td>rfSvrWarningTrap</td>
<td>Notif.</td>
<td>Text of warning alert reported by the RightFax server. This is a notification type variable and cannot be queried or edited.</td>
</tr>
<tr>
<td>rfSvrInformationalTrap</td>
<td>Notif.</td>
<td>Text of informational alert reported by the RightFax server. This is a notification type variable and cannot be queried or edited.</td>
</tr>
</tbody>
</table>
Using SNMP Alerting

### rfServer

Table 19c  Variables in the rfServer MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfSvrQueueUsage</td>
<td>Integer</td>
<td>Percentage of the fax server’s internal Event Queue currently in use.</td>
</tr>
<tr>
<td>rfSvrEventsProcessed</td>
<td>Integer</td>
<td>Total number of events processed by the fax server since the Server module was started.</td>
</tr>
<tr>
<td>rfSvrBoardSvrAvailIndex</td>
<td>Integer</td>
<td>Availability of the server’s fax boards.</td>
</tr>
<tr>
<td>rfSvrCurrentFaxesQueued</td>
<td>Integer</td>
<td>Current number of outgoing faxes waiting to be sent.</td>
</tr>
<tr>
<td>rfSvrCurrentPagesQueued</td>
<td>Integer</td>
<td>Current number of outgoing fax pages waiting to be sent.</td>
</tr>
<tr>
<td>rfSvrDiskAvailForfaxImages</td>
<td>Integer</td>
<td>Percentage of disk space on the fax server available for storing fax images.</td>
</tr>
<tr>
<td>rfSvrDiskAvailForfaxDB</td>
<td>Integer</td>
<td>Percentage of space available for storing fax database information.</td>
</tr>
<tr>
<td>rfSvrAllTimeFaxesSent</td>
<td>Integer</td>
<td>Total number of faxes sent from this server since the All-Time Counter starting date (ifSvrAllTimeCounterStart).</td>
</tr>
<tr>
<td>rfSvrAllTimePagesSent</td>
<td>Integer</td>
<td>Total number of fax pages sent from this server since the All-Time Counter starting date (ifSvrAllTimeCounterStart).</td>
</tr>
</tbody>
</table>

Table 19c  Variables in the rfServer MIB Object (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfSvrAllTimeFaxesReceived</td>
<td>Integer</td>
<td>Total number of faxes received on this server since the All-Time Counter starting date (ifSvrAllTimeCounterStart).</td>
</tr>
<tr>
<td>rfSvrAllTimePagesReceived</td>
<td>Integer</td>
<td>Total number of fax pages received on this server since the All-Time Counter starting date (ifSvrAllTimeCounterStart).</td>
</tr>
<tr>
<td>rfSvrAllTimeCounterStart</td>
<td>Integer</td>
<td>Starting date from which the “All-Time” statistics are calculated.</td>
</tr>
</tbody>
</table>

### rfServerModule

Table 19d  Variables in the rfServerModule MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfSvrModuleServiceName</td>
<td>String</td>
<td>RightFax Server module service name.</td>
</tr>
<tr>
<td>rfSvrModuleVersionNumber</td>
<td>String</td>
<td>RightFax Server module version number.</td>
</tr>
<tr>
<td>rfSvrModuleServiceStatus</td>
<td>Integer</td>
<td>Current Server module service state.</td>
</tr>
<tr>
<td>rfSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time the Fax Server service has been running.</td>
</tr>
</tbody>
</table>
### rfBoardServerModule

Table 19e Variables in the rfBoardServerModule MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfBoardSvrModuleName</td>
<td>String</td>
<td>BoardServer service name.</td>
</tr>
<tr>
<td>rfBoardSvrVersionNumber</td>
<td>String</td>
<td>BoardServer module version number.</td>
</tr>
<tr>
<td>rfBoardSvrModuleStatus</td>
<td>Integer</td>
<td>Current BoardServer service state.</td>
</tr>
<tr>
<td>rfBoardSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time the BoardServer has been running.</td>
</tr>
</tbody>
</table>

### rfBoards.rfBoardInfoTable.rfBoardInfoEntry

Table 19f Variables in the rfBoards.rfBoardInfoTable.rfBoardInfoEntry MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfBoardIndex</td>
<td>Integer</td>
<td>Fax board index.</td>
</tr>
<tr>
<td>rfBoardName</td>
<td>String</td>
<td>Each installed fax board type.</td>
</tr>
</tbody>
</table>

### rfBoards.rfChannelInfoTable.rfChannelInfoEntry

Table 19g Variables in the rfBoards.rfChannelInfoTable.rfChannelInfoEntry MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfChannelIndex</td>
<td>Integer</td>
<td>Channel table index (lists each installed fax channel).</td>
</tr>
<tr>
<td>rfChannelChannel</td>
<td>String</td>
<td>Channel numbers and [S] or [R] flag indicating send or receive functionality.</td>
</tr>
<tr>
<td>rfChannelOperation</td>
<td>String</td>
<td>Current operational status of all channels.</td>
</tr>
<tr>
<td>rfChannelRoutingCode</td>
<td>String</td>
<td>Inbound routing code for all incoming faxes.</td>
</tr>
<tr>
<td>rfChannelPhoneNumber</td>
<td>String</td>
<td>Destination phone number of outgoing faxes.</td>
</tr>
<tr>
<td>rfChannelUserID</td>
<td>String</td>
<td>Destination User ID for incoming faxes.</td>
</tr>
<tr>
<td>rfChannelState</td>
<td>String</td>
<td>Channel state.</td>
</tr>
<tr>
<td>rfChannelRemoteID</td>
<td>String</td>
<td>Remote ID of machines sending incoming faxes.</td>
</tr>
<tr>
<td>rfChannelRate</td>
<td>String</td>
<td>Current rate of transmission.</td>
</tr>
<tr>
<td>rfChannelCompression</td>
<td>String</td>
<td>Data compression method.</td>
</tr>
<tr>
<td>rfChannelPagesInCall</td>
<td>Integer</td>
<td>Number of fax pages being transmitted during this call.</td>
</tr>
<tr>
<td>rfChannelMinutesRemain</td>
<td>Integer</td>
<td>Estimated number of minutes remaining until end of transmission.</td>
</tr>
</tbody>
</table>
### rfDatabaseModule

Table 19h Variables in the rfDatabaseModule MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfDatabaseSvrModuleServiceName</td>
<td>String</td>
<td>Database module service name.</td>
</tr>
<tr>
<td>rfDatabaseSvrVersionNumber</td>
<td>String</td>
<td>Database module version number.</td>
</tr>
<tr>
<td>rfDatabaseSvrModuleStatus</td>
<td>Integer</td>
<td>Current Database module service state.</td>
</tr>
<tr>
<td>rfDatabaseSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time the Database service has been running.</td>
</tr>
</tbody>
</table>

### rfRPCServerModule

Table 19i Variables in the rfRPCServerModule MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfRPCSvrModuleServiceName</td>
<td>String</td>
<td>RPC module service name.</td>
</tr>
<tr>
<td>rfRPCSvrVersionNumber</td>
<td>String</td>
<td>RPC module version number.</td>
</tr>
<tr>
<td>rfRPCSvrModuleStatus</td>
<td>Integer</td>
<td>Current RPC module service state.</td>
</tr>
<tr>
<td>rfRPCSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time the RPC service has been running.</td>
</tr>
</tbody>
</table>

### rfQueueHandler

Table 19j Variables in the rfQueueHandler MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfQueueHandlerModuleServiceName</td>
<td>String</td>
<td>Queue handler service name.</td>
</tr>
<tr>
<td>rfQueueHandlerModuleStatus</td>
<td>Integer</td>
<td>Current Queue handler service state.</td>
</tr>
<tr>
<td>rfQueueHandlerModuleTimeRunning</td>
<td>String</td>
<td>Length of time the queue handler has been running.</td>
</tr>
</tbody>
</table>

### rfPagingServer

Table 19k Variables in the rfPagingServer MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfPagingSvrModuleServiceName</td>
<td>String</td>
<td>Paging module service name.</td>
</tr>
<tr>
<td>rfPagingSvrVersionNumber</td>
<td>String</td>
<td>Paging module version number.</td>
</tr>
<tr>
<td>rfPagingSvrModuleStatus</td>
<td>Integer</td>
<td>Current Paging module service state.</td>
</tr>
<tr>
<td>rfPagingSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time the Paging module has been running.</td>
</tr>
</tbody>
</table>
### Table 19l  Variables in the rfWorkServers.rfWorkSvrModuleTable.rfWorkSvrModuleEntry MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfWorkSvrModuleIndex</td>
<td>Integer</td>
<td>WorkServer module table index (lists all WorkServers).</td>
</tr>
<tr>
<td>rfWorkSvrModuleName</td>
<td>String</td>
<td>Each WorkServer module service name.</td>
</tr>
<tr>
<td>rfWorkSvrModuleVersionNumber</td>
<td>String</td>
<td>Each WorkServer module version number.</td>
</tr>
<tr>
<td>rfWorkSvrModuleStatus</td>
<td>Integer</td>
<td>Each WorkServer module service state.</td>
</tr>
<tr>
<td>rfWorkSvrModuleTimeRunning</td>
<td>String</td>
<td>Length of time each WorkServer has been running.</td>
</tr>
</tbody>
</table>

### Table 19m  Variables in the rfWorkServers.rfWorkSvrFunctionTable.rfWorkSvrFunctionEntry MIB Object (Continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfWorkSvrFunctionIndex</td>
<td>Integer</td>
<td>Workserver function table index (lists all WorkServers).</td>
</tr>
<tr>
<td>rfWorkSvrFunctionArchive</td>
<td>Integer</td>
<td>Is Archive service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionCoverSheet</td>
<td>Integer</td>
<td>Is Cover sheet service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionCVL</td>
<td>Integer</td>
<td>Is CVL service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionFileRoute</td>
<td>Integer</td>
<td>Is FileRoute service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionOverlay</td>
<td>Integer</td>
<td>Is Overlay service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionPCL5</td>
<td>Integer</td>
<td>Is PCL5 service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionPrint</td>
<td>Integer</td>
<td>Is Print service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionNetMessaging</td>
<td>Integer</td>
<td>Is Network Messaging service processed? Should be No. Network messaging is no longer functional in any of the supported Windows operating systems.</td>
</tr>
<tr>
<td>rfWorkSvrFunctionDelImageFile</td>
<td>Integer</td>
<td>Is Delete Image File service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionOCR</td>
<td>Integer</td>
<td>Is OCR service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionInterConnect</td>
<td>Integer</td>
<td>Is InterConnect service processed? (Yes/No)</td>
</tr>
<tr>
<td>rfWorkSvrFunctionPostscript</td>
<td>Integer</td>
<td>Is PostScript service processed? (Yes/No)</td>
</tr>
</tbody>
</table>
rfEMailGateway.rfGatewayModuleTable.rfGateway ModuleEntry

Table 19n  Variables in the rfEMailGateway.rfGatewayModuleTable.rfGatewayModuleEntry MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfGatewayModuleIndex</td>
<td>Integer</td>
<td>Gateway module table entry index (lists each email gateway).</td>
</tr>
<tr>
<td>rfGatewayModuleServiceName</td>
<td>String</td>
<td>Each gateway service name.</td>
</tr>
<tr>
<td>rfGatewayModuleVersionNumber</td>
<td>String</td>
<td>Each gateway module version number.</td>
</tr>
<tr>
<td>rfGatewayModuleStatus</td>
<td>Integer</td>
<td>Current state of each gateway service.</td>
</tr>
<tr>
<td>rfGatewayModuleTimeRunning</td>
<td>String</td>
<td>Length of time each gateway has been running.</td>
</tr>
</tbody>
</table>

rfServerTraps

Table 19o  Variables in the rfServerTraps MIB Object

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rfSvrTrapSeverity</td>
<td>Integer</td>
<td>Severity of the alert. This variable is used only for trap notifications and cannot be queried or edited.</td>
</tr>
<tr>
<td>rfSvrTrapMessage</td>
<td>String</td>
<td>Alert notification message. This variable is used only for trap notifications and cannot be queried or edited.</td>
</tr>
<tr>
<td>rfSvrEnableCriticalTraps</td>
<td>Integer</td>
<td>Critical alerts enabled/disabled.</td>
</tr>
<tr>
<td>rfSvrEnableErrorTraps</td>
<td>Integer</td>
<td>Error alerts enabled/disabled.</td>
</tr>
<tr>
<td>rfSvrEnableWarningTraps</td>
<td>Integer</td>
<td>Warning alerts enabled/disabled.</td>
</tr>
<tr>
<td>rfSvrEnableInformationalTraps</td>
<td>Integer</td>
<td>Informational alerts enabled/disabled.</td>
</tr>
</tbody>
</table>
Controlling RightFax Services From Your Network Monitor

Each RightFax service object in the MIB contains a status variable. For example, the rfDatabaseModule object contains the variable rfDatabaseSvrModuleStatus. There are a total of eight service status variables, each contained in a separate MIB object:

- rfSvrModuleServiceStatus
- rfBoardSvrModuleStatus
- rfDatabaseSvrModuleStatus
- rfRPCSvrModuleStatus
- rfQueueHandlerModuleStatus
- rfPagingSvrModuleStatus
- rfWorkSvrModuleStatus
- rfGatewayModuleStatus

When queried, these variables list the current state of the service on the RightFax server (such as stopped, started, or paused). You can also edit these variables to manually start or stop the services on the RightFax server. Each variable can be set to either “statSERVICE_STOPPED” or “statSERVICE_RUNNING.” Changing any of these variables automatically instructs the RightFax server to start or stop the appropriate service. Please refer to your network monitoring application’s documentation for information on editing variables in the MIB.

Troubleshooting the RightFax Alerts

SNMP alerts are designed to call attention to events or conditions on the RightFax server that may effect your server’s ability to send and receive faxes. The actual causes of these events and conditions are not reported as part of the SNMP alerts. In most cases, reviewing the Event Log on the server which is reporting the alert will provide details as to the cause of the alert.

The troubleshooting information in this chapter is designed to point network administrators who have a familiarity with RightFax to the most common causes and solutions for each of the nine SNMP RightFax alerts. However, as a client-server application, RightFax relies on the network for much of its functionality. Because network related problems can trigger RightFax alerts, the steps included here may not always resolve the cause of the alert. If RightFax alerts persist after following these steps, contact your RightFax administrator and/or network administrator.

All BoardServers down

This alert indicates that all primary and remote DocTransport services have failed.

- Run Enterprise Fax Manager or the Windows Services application and attempt to restart the DocTransports. If the DocTransport(s) fail to start, check the RightFax log in the Windows Event Viewer for details.
- If the RightFax log does not provide adequate information to resolve the problem, attempt to run the DocTransport in a window. On the RightFax server and any machines running remote DocTransports, change to the RFBoard folder and enter:
  ```
  doctransport.exe -d -1
  ```
  This runs the module as a session in a window in debug mode. As the board initializes, debug information is displayed and the reason for the failure should appear as the last line of the debug text. (There may be additional lines of information associated with the DocTransport module shutting down again after the failure.)
- If a RightFax DocTransport module on a remote machine starts and appears to be running normally but the alert persists, the failure may be due to problems with network connectivity between the remote machine and the RightFax server.
Critically low disk space
This alert indicates that one or more drives on the RightFax server have fallen below 50 MB of available space.
- Run Enterprise Fax Manager and check the status of the RightFax services. If the RightFax Server module has not already stopped, stop it. RightFax will automatically stop processing additional fax traffic until both the drive that RightFax is installed on and the drive that Windows is installed on have more than 50 MB available. Additional SNMP alerts may be generated as a result of this action.
- Uninstall any unnecessary applications from the RightFax server using the Add/Remove Software program in Control Panel.
- If this does not alleviate the storage problem, check the RightFax\Image folder. If it is exceptionally large, consider adjusting the fax aging (see “The Automatic Fax Aging tab” on page 114) or running the Faxage utility (see the RightFax Administrative Utilities Guide). This will delete faxes from the server database based on the age of the fax.
- Another option is to move the RightFax\Image folder to a new drive. To do this:
  1. Create a RightFax\Image folder on a new drive with sufficient free storage space.
  2. Stop the RightFax Server module and move all of the images from the old RightFax\Image folder to the new one.
  3. Edit the Windows Registry value Image to point to the new directory. See “Image” on page 347.
  4. Restart the RightFax Server module.

Exchange server is not responding
This alert indicates that the RightFax server is unable to communicate with the Exchange server. This is probably due to a failure of the RightFax connector for Exchange which is the service responsible for all communications between the two systems.
1. Attempt to restart the connector on the Exchange server through Windows Services.
2. If the connector still appears to be running, shut down and restart the connector.

Low disk space
This alert indicates that one or more drives on the RightFax server have less than 150 MB free. This condition by itself should not effect your server’s fax functionality, but is intended to warn you that resources are getting low. Please see the troubleshooting steps for “Critically low disk space” on page 177 for information on resolving this alert.

Probable line failure
This alert indicates that one or more of the fax channels have gone down due to line failure. This alert is only generated when the DocTransport returns certain errors in sequence over a given period of time and is the direct result of phone line problems as opposed to a failure on the RightFax server.
1. To prevent additional alerts while diagnosing the problem, run the DocTransport configuration program and deactivate the channel that is generating the alerts.
2. Verify that all phone lines are correctly and securely attached to the fax board(s).
3. Disconnect the phone lines from the server and attach a standard phone to verify that the line is still active.
4. If using a of PBX, verify that the line is still active through the PBX.
5. For T1 installations, confirm that the green light on the fax board that indicates the T1 line is active is lit.

Send queue too deep

This alert indicates that there are more than a predefined number of faxes or fax pages in the fax queue waiting to send.

- Verify that there are no other problems being reported with the server or phone lines that might prevent all of your outbound fax channels from being used.
- If this alert appears frequently, too few fax channels may be dedicated to outbound faxing. Run the DocTransport configuration program and reevaluate each channel’s send/receive capability.
- If your fax traffic exceeds the capability of all of your fax channels, consider increasing your total number of channels.

Server improperly shut down

This alert indicates that a fax server was shut down unexpectedly. This indicates a sudden and unexpected loss of power.

- Ensure that the server has recovered properly and is stable. The RightFax services should restart automatically. Monitor services and the Event Viewer for any problems.
- The most common result of an unexpected shutdown is database corruption, which, if severe, can prevent the RightFax Server module from starting. For information on diagnosing and resolving RightFax database problems, see “Error and Status Messages” on page 319.
- Faxes that were in progress during the shutdown may need to be released or resent by the creator of the fax. To “release” a fax, highlight the fax in FaxUtil, and then select Fax > Status > Release.

One BoardServer down

A DocTransport attached to this server has gone down, but at least one other DocTransport is still running.

This alert is generally not produced as the result of a DocTransport going down, but rather the loss of network connectivity between the RightFax server and a remote machine. You can verify this by running the Windows Services application on each remote machine to confirm that they are all operating correctly. If this is the case, contact your network administrator.

If one or more DocTransport services are down, refer to the instructions for the “All BoardServers down” alert (page 176).
Chapter 20
Creating Dialing Rules and Least-Cost Routing Plans

Dialing rules allow precise control of outbound faxing by specifying rules and restrictions about how faxes are sent, according to their destination fax numbers. For example, a dialing rule might specify that all faxes to a certain area code are sent via WAN to another RightFax server, saving long-distance charges. Another dialing rule might specify that all international faxes can only be sent at times of day when rates are lowest.

RightFax Intelligent Least-Cost Routing™ (LCR) routes outbound faxes between servers on a wide-area network (WAN) in order to minimize long distance and other telephone charges. Intelligent Least-Cost Routing is composed of several RightFax components: dialing rules, load balancing, destination tables, InterConnect, and testing tools.

Managing Dialing Rules
When creating a dialing rule, you specify the fax number (or, using wildcards, a number pattern) and then attach rules and restrictions to faxes whose destination fax number matches that pattern. In cases where one fax number matches multiple dialing rule patterns, the fax server weighs each rule according to how closely it matches the fax number, and then sends the fax according to the rule with the greatest weight.

Because servers can be in different locations or serve groups with varying needs, dialing rules are server-specific. If you have multiple RightFax servers, you must create an appropriate list of dialing rules for each server.

To add, edit, or delete dialing rules in RightFax, run Enterprise Fax Manager and click Dialing Rules under the desired RightFax server in the Fax Server Tree.

Important The RightFax 9.0 version of Enterprise Fax Manager cannot create, edit, or otherwise manage dialing rules created by RightFax 9.4 or later software.

Adding dialing rules
To add a new dialing rule, press INSERT or select New from the Edit menu. The Rule Edit dialog box opens. For information on completing each of the options in this dialog box, see “Editing Dialing Rules” on page 180.

Deleting dialing rules
To delete a dialing rule, select the rule to delete and press DELETE, or select Delete from the Edit menu.
Copying dialing rules from one server to another

In Enterprise Fax Manager, you can copy one or more dialing rules from one RightFax server to another. Select the rules you want to copy, and then drag the selection to another server. The amount of information copied is configured in the Enterprise Fax Manager Preferences dialog box (see “Setting Preferences” on page 86).

If you copy dialing rules from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported by the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).

Saving dialing rules

Changes you make to dialing rules are not automatically saved when you quit Enterprise Fax Manager. If you have unsaved dialing rules, an asterisk appears next to the Dialing Plan icon in the server tree. To save changes or additions to your dialing rules, press CTRL+S or select Save Dialing Plan from the File menu.

Editing Dialing Rules

To edit the properties of an existing dialing rule, run Enterprise Fax Manager, select the rule to edit and press ENTER, or select Edit from the Edit menu. You can also double-click the dialing rule. The Rule Edit dialog box opens.

The Matching tab

Figure 20.1 The Rule Edit Matching Tab
**Pattern** The destination fax number or number pattern that the dialing rule will apply to. RightFax ignores any hyphens, parentheses, or spaces in the pattern string. The pattern can include the digits 0–9, as well as the pound [#] and asterisk [*] keys.

**Note** To add other symbols to the list of supported characters, such as a comma or period, edit the Windows registry to change the `ValidPatternChars` value. See “ValidPatternChars” on page 344.

You can use wildcards to define variables in the number pattern and thereby specify a range of numbers that the rule will apply to. The following table lists each wildcard that can be used in the **Pattern** box and its definition.

**Table 20a Dialing Rule Pattern Wildcards**

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Matches zero or more digits; must always appear at the end of number string.</td>
<td>“+” matches any fax number entered. “415+” matches any number that begins with 415, including 415-555-7000, 415-4455, and 4151.</td>
</tr>
<tr>
<td>~</td>
<td>Matches zero or one digit; can be placed anywhere in the number string.</td>
<td>“~415+” matches any number beginning with 415 or [digit]415 including 415-555-7000, 415-3222, 1-415-555-7000, and 2415. “~~415+” matches 1-415-555-7000, 9-1-415-555-7000, and 415-555-7000.</td>
</tr>
<tr>
<td>%[tableID, #]</td>
<td>Matches digits defined in a destination table to the number of digits specified (see “Managing Destination Tables” on page 188).</td>
<td>“415-%[EAST,3]+” matches all numbers that begin with 415 and have a three-digit prefix defined in the destination table “EAST.”</td>
</tr>
</tbody>
</table>

Wildcards decrease the weight of a pattern match because they are always less specific than an exact match. For example, the fax number 520-555-7000 matches the pattern “520-555-700??” and “520+”, but will always be matched with the first rule because it is more specific.

**Priorities** Restricts rule matching by the priority assigned by the user to the fax. Only faxes with the priority levels selected here will be considered for this rule. Matching based on priority can be useful when doing fax broadcasts or other large volume faxing. It can also be useful for universal redirection of faxes (e.g., send all high priority faxes from Server2 instead of Server1).

**Fax Traffic Type** Apply the dialing rule based on whether the fax was generated by the RightFax Integration Module. You can restrict the rule to production faxes only, non-production faxes only, or apply the rule to all faxes.

**Minimum Queue Depth** Specify the number of fax pages that must be waiting in the server’s queue before this rule will be considered. This lets you define a dialing rule that can offload outgoing fax traffic to another server when the load on the current server gets too high.
**Minimum Fax Size**  Specify the minimum number of pages a fax must be before this rule will be considered. This lets you define a dialing rule that can offload very large faxes to another server, leaving the local server free to send only smaller faxes.

**The Restrictions tab**

Each dialing rule can be restricted to specific servers, users, or groups in your organization.

Figure 20.2  The Rule Edit Restrictions Tab

You have the following options:

- To apply the rule regardless of the origin of the fax, click **All (Every)**.
- To apply the rule to only the IDs you specify, click **Only These**. Enter one or more names of the servers, users, or groups to which the rule applies. Separate multiple entries with commas.
- To apply the rule in all cases except the IDs you specify, click **All But These**. Enter one or more names of the servers, users, or groups that are exempt from the rule. Separate multiple entries with commas.
The Number Adjustments tab

The Number Adjustments tab specifies how fax numbers that match the dialing rule should be modified in order to properly send from the specified destination.

Figure 20.3 The Rule Edit Number Adjustments Tab

These options let you add or remove digits from the beginning or end of the destination fax number. This can be used to automatically add a “1” to long distance calls or to add a “9” if necessary to get an outside line. It can also be used to add a user’s long distance billing code, or to remove all but the last four digits of a number for internal routing.

Note RightFax can specify a global dialing prefix for all outbound faxes in your Global Board Settings (see “Configuring the DocTransport Modules” on page 43). If your organization requires a dialing prefix for all outgoing calls, you should specify the prefix there and not here in the dialing rules.

You can append or prepend any combination of dialable digits. You can also include special dialing characters that have special meaning to RightFax. The following table lists the dialable characters and their definitions (characters are not case-sensitive).

Table 20b Dialing Characters Supported by Dialing Rules

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–9</td>
<td>Dialable phone digits.</td>
</tr>
<tr>
<td>!</td>
<td>Hook-flash signal.</td>
</tr>
<tr>
<td>#</td>
<td>Pound button on phone.</td>
</tr>
<tr>
<td>*</td>
<td>Asterisk button on phone.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>1-second pause (you can combine several of these characters to increase the length of the pause).</td>
</tr>
<tr>
<td>A</td>
<td>Replaced in the dial string by the fax’s Billing Code 1 value.</td>
</tr>
<tr>
<td>B</td>
<td>Replaced in the dial string by the fax’s Billing Code 2 value.</td>
</tr>
<tr>
<td>C</td>
<td>Replaced in the dial string by the fax’s ToContactNum value (the recipient’s voice number).</td>
</tr>
<tr>
<td>D</td>
<td>Replaced in the dial string by the fax’s ToName value (the recipient’s name). Any undialable characters in this field will be discarded.</td>
</tr>
</tbody>
</table>
The Time and Day tab

The Time and Day tab let you specify the time periods for each day of the week that the rule will be applied. This can be used to take advantage of special off peak phone rates or to balance fax loads between servers at the times when your fax traffic is the highest.

For each day of the week, enter the time period when the rule will apply using 24-hour military notation (i.e., “07” for 7:00 a.m. and “19” for 7:00 p.m.). Do not specify minutes. The rule will apply throughout the last hour in the range. For example, when you specify the time range “06–18,” the rule will apply from 6:00 a.m. until 6:59:59 p.m.

If you leave a box blank, the rule will not be in effect during that day. To apply a rule at all times, enter “00–23” next to each day.

Table 20b  Dialing Characters Supported by Dialing Rules (Continued)

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Replaced in the dial string by the fax’s ToCompany value (the recipient’s company name). Any undialable characters in this field will be discarded.</td>
</tr>
<tr>
<td>F</td>
<td>Replaced in the dial string by the user’s domestic long distance Auto Billing Code (see “Configuring Automated Billing Codes” on page 62).</td>
</tr>
<tr>
<td>G</td>
<td>Replaced in the dial string by the user’s international long distance Auto Billing Code (see “Configuring Automated Billing Codes” on page 62).</td>
</tr>
<tr>
<td>I</td>
<td>5-second pause (you can combine several of these characters to increase the length of the pause).</td>
</tr>
<tr>
<td>P</td>
<td>Pulse dialing mode.</td>
</tr>
<tr>
<td>T</td>
<td>Tone dialing mode (default).</td>
</tr>
<tr>
<td>W</td>
<td>Wait up to 15 seconds for a dial tone.</td>
</tr>
<tr>
<td>{</td>
<td>Do not prepend the dialing prefix.</td>
</tr>
<tr>
<td>}</td>
<td>Do not append the dialing postfix.</td>
</tr>
<tr>
<td>@</td>
<td>Required for SR140 and T.37 FoIP numbers. Appends the IP address of the FoIP router.</td>
</tr>
</tbody>
</table>
Quick Sets  These buttons let you quickly apply the most common time restriction settings.

The Destination tab
The Destination tab specifies where in your organization faxes matching the dialing rule pattern should be routed prior to dialing the destination fax number.

Figure 20.5  The Rule Edit Destination Tab

Send via Fax Server  Causes the fax to be routed to any RightFax server (including the local server) on your network for transmission. When you select this option, you must also specify the destination server name to use for routing.

When a fax is routed to another RightFax server on the network, the destination fax number is reevaluated against the dialing rules on the new server. The new server then transmits or forwards the fax according to its own rules. Be careful not to create dialing rules on two or more servers that would result in the servers looping one fax between them. If this occurs, RightFax will send the fax after ten loops.

Receive into Fax Server  Causes the fax to be routed to a RightFax server (including the local server) on the network and delivered as an inbound fax. This allows you to define “intra-office” routing rules that let RightFax users in your organization send faxes to each other across different fax servers on the network. When you select this option, you must also specify the destination server name to use for routing. If the fax number does not match a routing code on the receiving RightFax server, the fax will be routed to the Default user ID on that server.

Note  The Send via Fax Server and Receive into Fax Server fields are limited to a total of 15 characters if using a netbios name, or 16 characters if using an IP address.

Send via Transport  This option lets you select one of the transport methods that you added and configured in the RightFax DocTransport module (described in Chapter 5, “Configuring the DocTransport Modules”) as the fax destination, rather than a specific RightFax server.
In order to select a transport method in this box, the transport must have been added in the DocTransport module. You can select from the following transport methods:

- **FOIP.** The fax will be transmitted via your SMTP server to a T.37-compatible device. T.37 fax over IP is a fax transmission protocol that allows faxes to be transmitted to T.37-compatible devices over IP, rather than dedicated fax channels. The fax is packaged as an email message with a TIFF attachment and then sent over IP via an SMTP server. This message is automatically interpreted as a fax by the receiving device, which then prints it. To specify the email address of the destination T.37-compatible device, click the **Number Adjustments** tab (described on page 183), strip all of the digits from the destination fax number, and then prepend the destination email address.

- **SMS.** The fax will be routed to an SMS number. When a fax is sent to an SMS device, only the cover page notes are transmitted.

To specify the destination SMS number, click the **Number Adjustments** tab (described on page 183), strip all of the digits from the destination fax number, and then prepend the desired SMS number.

**Applies Only when Local Channels are Disabled** Causes the rule to be in effect only when the fax server has detected that all fax channels are disabled.

### The Other tab

![Figure 20.6 The Rule Edit Other Tab](image)

**No Special Action** Processes the fax without delay on any available channel.

**Send on Specific Range of Channels** Sends the fax only on the channels you specify. The channel range specified here will override any channel restriction placed on a specific fax using the `<CHANNEL>` embedded code. This parameter is not transferred with the fax if it is routed to another fax server for sending.

**Disallow Sending** Prevents faxes from sending based on certain attributes such as the number pattern, time of day, or sender. The user will get the message “Fax blocked from dialing phone number.” This is sometimes referred to as the “Do Not Dial” or DnD feature. You can set notifications for disallowed faxes on the “The DnD Notifications tab”.

---

OpenText RightFax 10.5 Administrator’s Guide 186
**Delay Fax**  Prevents the fax from sending until a specified time of day. If the specified time is earlier than the time the fax is received, the fax will send at that time on the next day. Specify the **Delay Until** time using military notation (0000–2359).

**Note**  Intelligent Least-Cost Routing rules are evaluated one time. If transmission is delayed by the Delay Fax setting, then other settings for the rule will not be evaluated.

**Priority Delta**  Set dialing rules to adjust a fax’s priority setting (low, normal, or high). Priority is rated on a three-point scale: low priority \( \leq 1 \), normal priority = 2, high priority \( \geq 3 \). Using the priority delta, you can add or subtract points from all faxes that match the dialing rule pattern to adjust their priority up or down.

**Extra Rule Weight**  Add additional weight to the dialing rule. When a fax number matches two or more dialing rules, RightFax “weighs” each rule according to how closely it matches the dialed number and uses the rule with the highest weight. This setting adds extra weight to the rule so it can be selected over another rule that has a better pattern match.

Dialing rule pattern characters are weighted as follows: digit match (0–9) = 10 points, + (plus) = 0 points, ? (question mark) = 5 points, ~ (tilde) = 4 points.

**Rule Disabled**  Removes the dialing rule from consideration by the fax server. To enable the dialing rule, click to clear the check box.

**Comment**  Optionally enter a descriptive comment for the dialing rule.

---

**The DnD Notifications tab**

**Notify sender that the document was blocked**  Select this option if you want the sender to be notified after attempting to send a fax to a number that has been blocked by the Disallow Sending (or Do-Not-Dial) feature on “The Other tab”. If this option is not selected, the sender will get the “Fax number blocked” custom message. To configure this message, see “Configuring Custom Messages” on page 22.

**Users to Notify**  Specify the RightFax user IDs to which notifications will be sent. If you want to specify multiple user IDs, separate ID’s with a comma. You can also select user IDs from a list of all user IDs on the local server by clicking the [...] button. To select multiple users from this list, press CTRL and click on each user ID you want.
Example of dialing rules in use
A company with RightFax servers in New York and Seattle adds the following dialing rules on the New York server:

206-???-????
Remove first three digits and send via Seattle server

206-820-50??
Remove first six digits and receive into Seattle server

When someone in New York sends a fax to 206-820-7000 (faxing to a customer in Seattle) the server will route the fax to the Seattle server which then sends it via a local call. However when someone in New York sends a fax to a co-worker in Seattle at 206-820-5065, the server will consider the fax a “received fax” and will route it to the appropriate internal fax mailbox (5065).

Load Balancing
Load balancing is the process of dividing your outgoing fax traffic across multiple RightFax DocTransports, routing faxes to the DocTransport with the most available fax channels.

To do this, create multiple dialing rules with the same number pattern, each routing faxes to a different DocTransport computer. Because the number patterns are the same, each rule will be assigned the same “weight.” When multiple rules match a fax number with equal weight, RightFax directs the fax to the DocTransport with the most available fax channels. Equal distribution is not guaranteed. If none of the servers have outbound fax channels available, faxes will be directed to the DocTransport that will have a channel available the soonest.

Important Outbound faxes are always sent to the DocTransport with the most assigned fax channels before the dialing rules that determine load balancing are processed. For this reason, you should include all load balancing dialing rules on all fax servers and remote DocTransport computers. This will ensure that your load balancing rules operate even if one or more DocTransport computers fail.

Managing Destination Tables
You can store and organize groups of numbers such as dialing prefixes and area codes in destination tables. These tables are used when creating dialing rules to represent a range of numbers, rather than creating a separate rule for each number pattern.

For example, a destination table can be created that contains all of the area codes in a major metropolitan area. Using this destination table, you can create a single dialing rule that addresses all of these area codes, rather than creating a separate rule for each area code.

To add or edit destination tables in RightFax:
1. Run Enterprise Fax Manager and click **Dialing Plan**, and then **Destination Table** under the desired server in the server list.

2. To create a new table, click **New** from the **Edit** menu or right-click **Destination Table** and then choose **New**. To edit an existing table, double-click the table name.

3. Enter or edit the Destination Table Name. Note that the name may not include spaces.

4. Add new numbers you want to block to the table in any of three ways:
   - Enter the numbers in the **Insert Text** box, separating numbers with carriage returns so that there’s one number on each line. All the entries in a destination table must be the same length. Entries can only include the digits 0–9, pound [#], and asterisk [*]. Click the **Insert Text** button to display the numbers in the **Entries** box.
   - If the destination table will contain a range of numbers, enter the starting and ending numbers in the series under **Insert Range** and click the **Insert Range** button. All the numbers in the range you specify will appear in the **Entries** list.
   - Check the **Use External Data Source** option, then browse to a SQL database and specify the column you want to import. For more information about using this feature refer to the next section, “Importing Destination Table Entries from an External Source”.

5. To remove an entry (and allow faxes to be sent to the number), click the number in the **Entries** box, then click **Delete Selection**.

6. Click **OK** to close the editing window and display the destination table in the list of table names.

**Deleting destination tables**

To delete a destination table, select the table to delete and press **DELETE**, or select **Delete** from the **Edit** menu.

**Copying destination tables from one server to another**

In Enterprise Fax Manager, you can copy one or more destination tables from one RightFax server to another. Select the tables you want to copy, and then drag the selection to another server. If you copy users from a new RightFax server version to an earlier server...
version, you will lose configuration data that is not supported by the older server (in other words, features on version 10.5 servers will not be available on earlier server versions).

**Importing Destination Table Entries from an External Source**

If your organization maintains a database containing lists of phone numbers that should not be dialed, you can link the destination table directly to this database and then set up a dialing rule that will prevent these numbers from receiving fax transmissions.

Before you can set up a Do not Dial list, you must configure the database containing the numbers to block as an ODBC data source. Refer to the documentation for your server’s operating system for information on configuring a new ODBC data source.

After you have set up the ODBC data source for the database containing the numbers to block, follow these steps to set up Do not Dial rules.

1. In Enterprise Fax Manager, create a new destination table.
2. Enter a name for the table, select the option **Use External Data Source**, and then click the [...] button. This opens the **Configure External Data Source** dialog box.

Figure 20.9 The **Configure External Data Source** dialog box
3. Click the [...] button next to the SQL Connection box to configure the ODBC data source. This opens the RightFax SQL Connection Editor dialog box.

![Figure 20.10 The RightFax SQL Connection Editor dialog box](image)

4. Click the [...] button next to the ODBC Data Source box and select the ODBC data source you created for the Do not Dial list.

5. Specify the login information required to access the database and then click OK. This will return you to the Configure External Data Source dialog box with the connection information entered in the SQL Connection field.

6. In the Table Name field, enter the name of the table that contains the phone numbers to block.

7. In the Destination Column Name field, enter the name of the table column specific to the phone numbers.

8. In the Primary Key Column Name field, enter the name of the primary key column for the table you specified in the Table Name field.

9. In the Condition field, enter any SQL script that you might want to use to limit the range of phone numbers in the database. For example, you could enter a query for a field called “Block Number” set to true. This would limit the range of blocked phone numbers to only those for whom a separate field in the table called “Block Number” is set to true.

10. Click OK. The Destination Table Edit dialog box reopens with all of the phone numbers from the database listed in the Entries box. The entries in the box are dynamic and will be automatically updated as you make changes to the database that you are linked to. There is no need to update this list after it has been set up.

Testing Dialing Rules and Fax Routes

Because Intelligent Least-Cost Routing involves many variables that could conflict with one another, RightFax includes diagnostic tools for testing and confirming your fax routing scheme.
To run the tests, run Enterprise Fax Manager and click **Dialing Plan** under the server you want to test.

**Figure 20.11 Diagnostic Tools for Testing Least-Cost Routing Rules**

### Pinging a server

By pinging a server, you can test communications with a selected RightFax server using a particular protocol. To run this test, click **Ping**. The amount of time it takes information packets to make a round trip between machines will display in seconds as "time for call." The current server load will display as "server availability index." The higher the index value, the greater the server availability.

### Tracing the route of a fax

You can test the dialing rules you have constructed using real fax numbers without actually sending a fax. This test will show where the fax will be sent from, such as a specific server or a connector in your system. This test will *not* indicate if the fax is delayed or if the transmission is unsuccessful based on dialing rules. For this level of detail, use the rule execution test.

To run this test, enter a fax telephone number in the **Phone Number** box. You can also enter a specific user ID, group ID, fax priority, and fax size to test how each affects the fax routing.

If the dialing rule applies to production faxes, click to select **Integration Fax**. Production faxing is implemented with the optional Integration Module.

Click **Route Trace** to start the test. As the fax number passes one or more servers, the dialog box will display which rules are being used, how the fax number is manipulated along the way, the number of hops, or jumps, from server to server, and the time it takes to route between servers. The time between servers does not include the time to transfer image data. That additional time will depend on the size, resolution, and density of the fax.

### Executing rules

Like tracing the route of a fax, you can test the dialing rules you have constructed using real fax numbers without actually sending a fax. Using the rule execution test, you can obtain more detailed information about dialing rules on a server.

To run this test, enter a fax telephone number in the **Phone Number** box. You can also enter a specific user ID, group ID, fax priority, and fax size to test how each affects the route and execution of the rule.

If the dialing rule applies to production faxes, click to select **Integration Fax**. Production faxing is implemented with the optional Integration Module.

Click **Test** to start the test.
Creating Dialing Rules and Least-Cost Routing Plans

As the fax is routed, the dialog box displays each dialing rule against which the fax number is compared and provides information about the match weights and server availability.

Viewing disabled rules

The Downed Servers list displays any rules that are disabled due to downed RightFax servers and the error that caused the rule to be disabled.

To refresh the list of downed servers, click Reset Downed.

Call Blocking

By default, the DocTransport module blocks all outgoing calls to numbers beginning with 911 (the standard emergency number throughout the United States). All non-numeric characters are ignored by DocTransport. For example, if a user sends a fax to „911, DocTransport will ignore the two preceding commas and match 911, thus blocking the number.

You can set up additional numbers to be blocked using the Dialing Rules in combination with a Destination table.

To add or change blocked numbers:

1. Create a destination table for the numbers you want to block.
2. Create a dialing rule that uses that table for the matching string.
3. On the Other tab of the dialing rule select "Disallow sending"
4. Save the rule.

Note: you can also use the Windows registry keys “BlockedNumbers” and “BlockingFlags”s to prevent faxes from being sent to specific numbers, or to turn off the 911 blocking feature.

Spam Handling

It is possible to automatically route unwanted or ‘spam’ faxes to a dedicated spam user account based on ANI information. You must first create a RightFax account(s) that will receive the unwanted faxes (such as SpamAccount). Then create a Windows registry sub-key ANI that contains the Entries for each blocked number and the newly created account to which it will be routed. See “Entries (in ANI Key)” on page 342 for more information.

Approving Blocked Faxes

Faxes that are blocked by dialing rules can be approved for transmission by RightFax administrators. Group administrators and alternate group administrators cannot approve faxes.

To approve a fax blocked by a dialing rule

1. Logon to FaxUtil as an administrator.
2. On the List menu, click Administrative Mode. to view the contents of all fax mailboxes for which you are an administrator.
3. On the List menu, click Needing Approval to display faxes waiting for approval.
4. To approve or disapprove a fax, right-click the fax and select Status > Approve Fax or Disapprove Fax. You can add a note (up to 450 characters) that will be stored with the date and your user ID in the fax history. You can also delete the fax rather than approve or disapprove it. If the fax is approved, it is immediately scheduled to send. If the fax is not approved, it is assigned a status of “ED: Approval Denied” in the original sender’s FaxUtil mailbox.
Least-Cost Routing Examples

Scenario 1: Using LCR (a simple example)
PDQ Company has a RightFax server in New York City ("NYSERVER") and one in Tucson ("TSNSERVER") and wants to save money using Intelligent Least-Cost Routing. PDQ has determined that it would be cheaper to send New York faxes bound for Tucson and Southern Arizona numbers via TSNSERVER. It adds this rule to NYSERVER:

520+
Send via fax server TSNSERVER.

Scenario 2: Using dialing destination tables
PDQ Company wants to make sure that Southern Arizona calls outside of Tucson are dialed correctly from TSNSERVER. The 458 prefix requires a ‘1’ be prepended onto the number. Also, the 520 area code should not be used. It adds this rule to TSNSERVER:

458+
Send via local fax server. Prepend 1.

520-458+
Send via local fax server. Strip 3 digits from beginning. Prepend 1.

Actually there are more prefixes that could be dialed in Southern Arizona, but it would be cumbersome to add rules for each one. PDQ determines that there are three prefixes (458, 459, 652) in the 520 area code that function this way. PDQ creates a destination table named SOUTHAZ and includes these three prefixes. It can then use these two rules on TSNSERVER to cover all of Southern Arizona outside Tucson:

%[SOUTHAZ,3]+
Send via local fax server. Prepend 1.

520-%[SOUTHAZ,3]+
Send via local fax server. Strip 3 digits from beginning. Prepend 1.

Scenario 3: Distinguishing ‘+’ wildcard rules from other local numbers
The system administrator for NYSERVER now finds that faxes bound for internal four-digit PBX numbers in New York beginning with “520” are inadvertently being routed out to Tucson. In addition, New York just added a prefix for the Tri-State area of “520” (requiring a 1 be dialed first from the PDQ office) and those calls are going to Tucson, too. To correct this situation, the administrator adds these two rules to NYSERVER:

520?
Send via local fax server

520-????
Send via local fax server. Prepend 1

These two rules intercept 520 calls that would otherwise match the “520+” rule in Scenario #2. These rules would match the local destination numbers more specifically and therefore be weighted more heavily.

Scenario 4: Stripping unnecessary digits
The PDQ system administrator for NYSERVER has also noticed that recent transfers from the Tucson site are still using the long distance carrier from there. They are always putting a ‘1’ on the beginning of ten digit long distance numbers. Because the PDQ New York long distance carrier does not require it, she adds this rule to NYSERVER to strip the ‘1’:

1-????-????-????
Send via local fax server. Strip 1 beginning digit.

Scenario 5: Using LCR (an advanced example)
PDQ Company opens a sales office in Los Angeles with a new RightFax server ("LASERVER"). PDQ has worked a deal with the local phone companies in L.A. such that all calls in the local L.A./Orange County area are at a special low rate. A similar deal was worked for the New York metro area. This means PDQ can
save money by routing all LA faxes to the LASERVER and all NY faxes to the NYSERVER. However, because of charges related to the TCP/IP connection between L.A. and N.Y., it is still cheaper to send faxes during off-peak periods to L.A. and N.Y. via direct long distance dialing.

PDQ would first set up four destination tables: an LA area code ("LAACODE") table and an LA area code+destination table ("LAPREFIX") on NYSERVER, and a NY area code ("NYACODE") table and a NY area code+destination table ("NYPREFIX") on LASERVER.

LAACODE and NYACODE each contain a list of area codes that match the cut-rate phone numbers in their respective regional areas. LAPREFIX and NYPREFIX match numbers in area codes where the whole area code was not part of the cut-rate deal and thus only certain prefixes are eligible.

NYSERVER would then have these two rules:

%[LAACODE,3]+ Time of day set to peak times. Send via fax server LASERVER.
1%[LAPREFIX,6]+ Time of day set to peak times. Send via fax server LASERVER.

LASERVER would have a matching set of rules referencing NYACODE and NYPREFIX and routing to NYSERVER. Peak times must be specified because it is still cheaper to send in the evening and at night via long distance.

In addition, a local rule is required on both the NYSERVER and LASERVER to strip off the unnecessary area code. PDQ adds this rule on NYSERVER:

212+ Send via local fax server. Strip 3 digits
A similar rule would be necessary for LASERVER as well.

To enable Intelligent Least-Cost Routing for TSNSERVER to NY and LA, a copy of each of the four destination tables and each of the dialing rules would be entered on TSNSERVER.

**Scenario 6: Boosting priority**

PDQ Company is expanding and the load on the RightFax servers is increasing. PDQ decides to boost the priority of faxes from certain high priority Groups and Users on LASERVER to ensure that their faxes are sent quickly. This rule is added to LASERVER:

+ Restricted only to Users: SALES, CFO and to Group: TOPDOGS. Priority Delta +1.

**Scenario 7: International routing**

PDQ Company expands into the international market. Their first overseas site is London which has a RightFax server installed ("UKSERVER"). All faxes from LA, NY, and Tucson bound for England need to be routed to UKSERVER. This rule is added to each of these servers:

011-44+ Send via fax server UKSERVER.

Rules would need to be placed on UKSERVER to “normalize” the phone numbers for England (such as stripping area codes or adding digits if necessary).

**Scenario 8: Load balancing**

PDQ adds another RightFax server to its expanding NY site ("NYSERVER2"). Also, usage data indicates that during peak times, faxes on NYSERVER are taking, on average, several minutes longer to be sent than those on NYSERVER2. Upon analysis, PDQ finds that the users of NYSERVER are sending many more faxes than the users on NYSERVER2.

By entering these two rules on each server, new outgoing faxes on each server will be routed to the one with the least load:

+ Send via local fax server
+ Send via fax server NYSERVER2 (or NYSERVER).
Because each rule is weighted the same, RightFax load balances
between the two servers.

**Scenario 9: Backup servers**
PDQ Company’s system administrator for LASERVER hears about
the new NYSERVER2 in New York and decides to make use of the
additional server by replicating all the dialing rules on LASERVER
for NYSERVER but this time referring them to NYSERVER2. This
leads to a guaranteed path of Intelligent Least-Cost Routing should
one or the other of the N.Y. servers fail for any reason.
Chapter 21
Creating Fax Cover Sheets

The RightFax server has cover sheet templates in the RightFax\FCS\Imported folder. This folder contains sample fax cover sheets that you can either modify or refer to as examples in creating your own custom cover sheet files.

As a general rule, fax cover sheet templates include information about your organization (such as logo, address, and phone number). Cover sheet templates also include codes that represent specific sender and destination information. When generated for each outgoing fax, the selected cover sheet will include the text and graphics from the template and data based on cover sheet codes. You can create multiple cover sheet files, such as a cover sheet for each department or separate cover sheets for different types of fax documents.

You can create the following types of cover sheets:

- HTML (described on page 197)
- Microsoft Word (described on page 198)
- PCL (described on page 199)

Once you’ve created the cover sheets you need, import the files into RightFax. See “Importing Cover Sheets” on page 202.

**Note:** On a RightFax 10.5 server, cover sheets can have long file names. Earlier versions of RightFax FaxUtil and Enterprise Fax Manager will only display cover sheets that have the standard 8.3 file name length. Cover sheets with longer names will not appear.

Creating an HTML Cover Sheet

HTML cover sheets can be created using an HTML or text editor. RightFax supports both HTML and HTM cover sheet files. Both HTML and HTM files may include any text and graphics that are supported by these file types.

When creating an HTML cover sheet file, follow these guidelines:

- RightFax cover sheet files may not be longer than one page. Any cover sheet information that appears on subsequent pages will be ignored.
- When referring to other files (such as graphics) in an HTML cover sheet, use absolute paths (not relative paths) to ensure that RightFax processing can find the referenced information.
- To specify where the specific sender and destination data will display for each outgoing fax, use HTML cover sheet codes described in “Using HTML cover sheet codes”.
- Save the cover sheet file with a descriptive name with a file name extension of HTM or HTML. The file name will be displayed when the user is selecting a cover sheet.
Using HTML cover sheet codes

In HTML cover sheets, all cover sheet codes are indicated by braces { }. For example, to include the recipient's company name in the cover sheet, use {TOCOMPANY}. For a complete list of codes, see “Cover Sheet Codes” on page 200.

Creating a Microsoft Word Cover Sheet

If you have Microsoft Word installed on your RightFax server for server-side application conversion (described in Chapter 6, “Configuring Server-Side Application Conversion”), you can create and use cover sheets in the native Word document format (.DOC).

Note In order to perform native Word document cover sheet generation, you must have correctly installed and configured Microsoft Word on the RightFax server (page 69).

When creating a Word cover sheet file, follow these guidelines:

- Cover sheets must be stored in .DOC format (not .DOCX). If you’re using Word 2007 or 2010, you must use the Save As option to store .DOC files.
- Cover sheets stored in the native Word format support all language character sets supported by Word and Windows, including Hebrew. To display special characters, such as French accents, ensure that ANSI mode is enabled on the code page of the server. See “Character Set Mode” on page 21 for more information. Word cover sheet codes can use any TrueType font in addition to native printer fonts.
- RightFax cover sheet files may not be longer than one page. Any cover sheet information that appears on subsequent pages will be ignored.
- To specify where the specific sender and destination data will display for each outgoing fax, use Microsoft Word cover sheet codes described in “Using Microsoft Word cover sheet codes”.
- Save the cover sheet file with a descriptive name and the 3-character extension .DOC). The file name will be displayed when the user is selecting a cover sheet.

Note: Native Word cover sheets can take slightly longer to convert to fax format than PCL files, and this will be exaggerated if the server running Word has insufficient RAM.

Using Microsoft Word cover sheet codes

Cover sheet codes in native Word cover sheets are inserted as Word DocVariable fields. Word cover sheet codes can be any TrueType or native printer font.

Note Although double-byte characters added to the text of a Microsoft Word cover sheet will convert correctly, double-byte characters inserted into DocVariable fields on Microsoft Word cover sheets will not.

To insert a DocVariable field

1. In your Word cover sheet, position the cursor where you want to place the cover sheet code and select Field from the Insert menu. The Field dialog box opens.
2. Click Document Automation, and click DocVariable under Field Names. This displays DOCVARIABLE in the Field Codes field.
3. Add the cover sheet code to the variable in the format:

   DOCVARIABLE code

   Where code is one of the supported cover sheet codes ("Cover Sheet Codes" on page 200). For example, the following cover sheet code displays the destination fax number:

   DOCVARIABLE ToFaxNum

   **Note** The DocVariable field will not appear in your document unless you have selected Field Codes in the View tab of the Word Options dialog box.

4. Click OK to insert the code.

   **Note** If you place cover sheet codes in a Word text box, and the text box is not large enough to fit all of the text that replaces the codes, any extra text will be truncated on the cover sheet. You can fix this by increasing the size of the text box.

Creating a PCL Cover Sheet

You can store a cover sheet as a PCL (Printer Control Language) file using any application that has the ability to print to a PCL5 file. You can't directly edit a PCL file, so it is a good idea to store both the source file (such as a .doc or .txt) and the PCL output on the RightFax server.

When creating a PCL cover sheet file, follow these guidelines:

- **To specify where the specific sender and destination data will display for each outgoing fax, use PCL cover sheet codes in your source file as described in “Using PCL cover sheet codes”.**

- **To save your source as a PCL5 file, select an HP LaserJet 5200 Series PCL5 or compatible printer driver and select the “Print to file” option in your application’s Print dialog box.**

- **Save the cover sheet file with a descriptive name with the 3-character extension .PCL. The file name will be displayed when the user is selecting a cover sheet.**

   **RightFax** is shipped with sample cover sheet files and the source documents they were created from. You can edit these source files rather than create a new cover sheet. Using Microsoft Word for Windows 6.0 or later, open the FCS.doc file in the RightFax\FCS\PCL_Source folder, make any desired changes, and print the modified cover sheet to a file in the RightFax\FCS folder with the extension .pcl.

   **Note** If you have trouble modifying the sample cover sheet and are using Microsoft Word 97 or later, select Options in the Tools menu and click the Compatibility tab. Select “Microsoft Word 6.0” in the Recommend Options For field.

**Using PCL cover sheet codes**

Although you can use any font in the text of your cover sheets, PCL cover sheet codes must always use a native printer font. When the cover sheet document is printed to PCL5 format, only the native fonts are stored in text format. All other font types are converted to graphic images. If you enter a non-native font in the cover sheet code, RightFax will not be able to convert the code to data, and the code itself will appear on the cover sheet.

PCL cover sheet codes are surrounded by angle brackets (<>), which must also use the same native printer font. For a complete list of codes, see “Cover Sheet Codes” on page 200. For example, to include the sender’s phone number, use <FROMPHONENUM>.
Cover Sheet Codes

Cover sheet codes specify the types of information that will be inserted into the cover sheet for each outgoing fax. When a cover sheet is generated by the RightFax server, the cover sheet codes are replaced by the data they represent.

Use the following codes in cover sheet templates. For HTML cover sheets, enclose the code in brackets {}. For PCL cover sheets, enclose the code in angle brackets < >.

Table 21a Cover Sheet Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Maximum Characters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BILLINFO1</td>
<td>15</td>
<td>Billing code 1 (if any).</td>
</tr>
<tr>
<td>BILLINFO2</td>
<td>15</td>
<td>Billing code 2 (if any).</td>
</tr>
<tr>
<td>CALL_BACK</td>
<td>31</td>
<td>The callback information (if any). These codes are not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>CALLBACK2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CCTEXT</td>
<td>69</td>
<td>All the listed recipients of a fax (including CC and BCC recipients) in this format: Name,FaxNum;Name,Faxnum;... You can include up to 21 (CCTEXT) codes on a cover sheet, each code representing one line of recipients up to 69 characters long. Include one (CCTEXT) code on each line that should contain recipients. The cover sheet will only list the number of recipients for which space is provided.</td>
</tr>
<tr>
<td>CUSTOM1</td>
<td>Variable</td>
<td>Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>EMAIL_ADDRESS</td>
<td>Variable</td>
<td>The sender’s email address. This is the email address that is entered in the RightFax user properties (described on page 97). Not available for Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>EMAILADDRESS</td>
<td>Variable</td>
<td>The sender’s email address. This is the email address that is entered in the RightFax user properties (described on page 97).</td>
</tr>
<tr>
<td>FAXDATE</td>
<td>Variable</td>
<td>The date that the fax is created, for Microsoft Word .DOC cover sheets only.</td>
</tr>
<tr>
<td>FAXDIDNUM</td>
<td>31</td>
<td>The sender’s fax number.</td>
</tr>
<tr>
<td>FAXSENDDATE</td>
<td>Variable</td>
<td>The date that the fax was sent, for Microsoft Word .DOC cover sheets only.</td>
</tr>
<tr>
<td>FROMCOMPANY</td>
<td>59</td>
<td>The sender’s company name.</td>
</tr>
<tr>
<td>FROMCITYSTATE</td>
<td>59</td>
<td>The sender’s city and state.</td>
</tr>
<tr>
<td>FROM_NAME</td>
<td>59</td>
<td>The sender’s name. Not available for Microsoft Word cover sheets.</td>
</tr>
<tr>
<td>FROMNAME</td>
<td>59</td>
<td>The sender’s name.</td>
</tr>
<tr>
<td>Code</td>
<td>Maximum Characters</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FROM_PHONENUM</td>
<td>31</td>
<td>The sender’s phone number, for use with HTML and PCL cover sheets only.</td>
</tr>
<tr>
<td>FROMPHONENUM</td>
<td>31</td>
<td>The sender’s phone number, available for all three types of cover sheets.</td>
</tr>
<tr>
<td>FROMPHONE</td>
<td>31</td>
<td>The sender’s phone number, for Microsoft Word .DOC cover sheets only.</td>
</tr>
<tr>
<td>GENERALFAXNUM</td>
<td>31</td>
<td>The general fax number for the sender’s organization.</td>
</tr>
<tr>
<td>NOTETEXT</td>
<td>69</td>
<td>The notes added to the fax when it was addressed. You can include up to 21 &lt;NOTETEXT&gt; codes on a cover sheet, each code representing one line of notes up to 69 characters long. Include one &lt;NOTETEXT&gt; code on each line that you want notes to be listed on. The cover sheet will only include as much note text as there is space allotted for. If the notes for a fax are shorter than the space provided by &lt;NOTETEXT&gt; codes, the remaining lines will be filled with blanks.</td>
</tr>
<tr>
<td>NUMPAGES</td>
<td>Variable</td>
<td>The number of pages in the fax body, not including the cover sheet. To include the cover sheet in the page count, use the &lt;NUMPAGES&gt; code.</td>
</tr>
<tr>
<td>NUMPAGESC</td>
<td>Variable</td>
<td>The number of pages in the fax including the cover sheet. To exclude the cover sheet in the page count, use the &lt;NUMPAGES&gt; code.</td>
</tr>
<tr>
<td>OPERATORNUM</td>
<td>31</td>
<td>The general phone number for the sender’s organization.</td>
</tr>
<tr>
<td>ROUTEINFO</td>
<td>Variable</td>
<td>The routing information entered in the user profile of the user creating the fax (described on page 101).</td>
</tr>
<tr>
<td>TIMEONLY</td>
<td>Variable</td>
<td>The time that the fax cover sheet was generated. The time format is determined by the default time format on the RightFax server. Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TO_CITYSTATE</td>
<td>59</td>
<td>The recipient’s city and state. Not available for Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TO_CITYSTATE</td>
<td>59</td>
<td>The recipient’s city and state.</td>
</tr>
<tr>
<td>TO_COMPANY</td>
<td>59</td>
<td>The recipient’s organization name for PCL or HTML cover sheets. Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TOCOMPANY</td>
<td>59</td>
<td>The recipient’s organization name.</td>
</tr>
<tr>
<td>TO_CONTACTNUM</td>
<td>31</td>
<td>The recipient’s phone number for PCL or HTML cover sheets. Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TOCONTACTNUM</td>
<td>31</td>
<td>The recipient’s phone number.</td>
</tr>
</tbody>
</table>
Importing Cover Sheets

After you’ve created a cover sheet, you must import it into RightFax before you can use it. To import a cover sheet:

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85).
2. Click **Cover Sheets** to display a list of the existing cover sheets on that server. The default cover sheet is indicated by a green checkmark.
3. To import a new cover sheet, right-click on an existing cover sheet then select **New**.

---

### Table 21a  Cover Sheet Codes  (Continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Maximum Characters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TO_FAXNUM</td>
<td>31</td>
<td>The recipient's fax number for PCL or HTML cover sheets. Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TO_FAXNUM</td>
<td>31</td>
<td>The recipient's fax number.</td>
</tr>
<tr>
<td>TO_NAME</td>
<td>59</td>
<td>The recipient’s name for PCL or HTML cover sheets. Not available on Microsoft Word .DOC cover sheets.</td>
</tr>
<tr>
<td>TONAME</td>
<td>59</td>
<td>The recipient’s name.</td>
</tr>
<tr>
<td>UNIQUEID</td>
<td>16</td>
<td>The unique ID assigned to the outgoing fax.</td>
</tr>
<tr>
<td>USERID</td>
<td>59</td>
<td>The RightFax User ID, for Microsoft Word .DOC cover sheets only.</td>
</tr>
<tr>
<td>USERNAME</td>
<td>59</td>
<td>The RightFax User Name, for Microsoft Word .DOC cover sheets only.</td>
</tr>
<tr>
<td>WHEN_FAXED</td>
<td>Variable</td>
<td>For PCL cover sheets only. The date and time the document was generated by the fax server. The time the fax was processed by the fax server can be very different from the time it is actually sent as recorded on the TTI line, especially if you are using the RightFax Delay Send feature.</td>
</tr>
<tr>
<td>WHENFAXED</td>
<td>Variable</td>
<td>For all three types of cover sheets. The date and time the document was generated by the fax server. The time the fax was processed by the fax server can be very different from the time it is actually sent as recorded on the TTI line, especially if you are using the RightFax Delay Send feature.</td>
</tr>
</tbody>
</table>
4. Enter all of the following information:
   - **ID** contains the text string that displays when a user is selecting a cover sheet.
   - **Description** contains a text string that displays in the cover sheet list.
   - **File Name** is the actual name of the file that will be copied to the SQL database. To choose a file for the ID, click **Import** and browse to the location of the new file. Select the file and click **Open**.

5. Click **OK** to copy the cover sheet to RightFax.

You can also edit or delete existing RightFax cover sheets.

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85).
2. Click **Cover Sheets** to display a list of the existing cover sheets on that server. The default cover sheet is indicated by a green checkmark.
3. To edit an existing cover sheet, right-click the cover sheet then select **Edit**.
4. You can change any of the following information:
   - **ID** contains the text string that displays when a user is selecting a cover sheet.
   - **Description** contains a text string that displays in the cover sheet list.
   - **File Name** is the actual name of the file that will be copied to the SQL database. To choose a new file for the ID, click **Import** and browse to the location of the new file. Select the file and click **Open**.
5. To preview the displayed file, click **View**. Microsoft Word files will open in read-only mode in Word; HTM files will open in read-only mode in your browser. PCL files can not be previewed by the cover sheet viewer.

6. To remove a cover sheet from RightFax, select one or more cover sheets, then right-click and choose **Delete**. The selected file or files will be removed from the cover sheet list.
7. Click **OK** to save your changes to the cover sheet list.

**Selecting a Cover Sheet File**

If your organization has several fax cover sheets for different types of faxes, users who have been assigned the appropriate permissions can specify which cover sheet to use for each fax they send. In addition, you can specify a default cover sheet for each user or each group of users.

**To assign a user permission to change cover sheets**

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85).
2. Click **Users** under the appropriate server and double-click the user ID to modify.
3. Click the **Permissions** tab and select the **Can Change Cover Sheets** check box.

**To specify a cover sheet on a fax**

When a user is entering the fax addressing information in the Fax Information dialog box (page 230), a check box in the lower left lets the user specify whether or not to include a fax cover sheet. The cover sheet is included only with the current fax.

Users can include the `<FCSFILE>` code in documents (see Appendix A, “RightFax Embedded Codes”) which specifies a cover sheet file to use for that document.
Setting default cover sheets
When a user does not specify a cover sheet template when sending a fax, RightFax creates the cover sheet using a default template. There are several places you can specify a default cover sheet template:

- Specify a default for each user. This is the cover sheet that will be created if the user doesn’t choose a cover sheet for a fax when sending.
- Specify a default for a group. This is the cover sheet that will be created if the user doesn’t choose a cover sheet and does not have a default user cover sheet.
- Specify a system default. This is the cover sheet that will be created if the user doesn’t choose a cover sheet, doesn’t have a default user cover sheet, and doesn’t have a default group cover sheet. The system default cover sheet is indicated in the list of cover sheets by a green checkmark.

Changing a user’s default cover sheet
To assign a new default cover sheet to a specific user, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85), click Users under the appropriate server, double-click the user ID to modify, and click the Default Outbound Settings tab. Under Cover Sheet Defaults, select the Send Cover Sheets check box, and select the cover sheet file to use in the Cover Sheet Model box.

Changing a group’s default cover sheet
To assign a default cover sheet to a RightFax group, follow these steps:

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85).
2. Click Groups under the appropriate server.
3. Double-click the group ID to modify.
4. Click the Basic Information tab.
5. Click Select and choose a cover sheet from the Default Cover Sheet drop-down menu.
6. Click OK.

Changing the system default cover sheet
1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85).
2. Click Cover sheet under the appropriate server.
3. Right-click the name of the cover sheet that you want to use as the new system default.
4. Click Set as System Default.

Requiring cover sheet fields on outgoing faxes
To transmit an outgoing fax, information about the recipient must be completed in the Fax Information dialog box. The RightFax administrator can specify how much information the user must complete before the fax will send. To set the required fields, run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85), click Users under the appropriate server, double-click the user ID to modify, and click the Default Outbound Settings tab. Under Cover Sheet Defaults, select the Send Cover Sheets check box, and select the cover sheet file to use in the Cover Sheet Model box.
Creating Fax Cover Sheets

page 85) and select **Customize Cover Sheet Fields** from the Utility menu. The **Customize Cover Sheet Information** dialog box opens.

Figure 21.1 Required Fields for Outbound Faxes

Select the check box next to each field you want to require. The **To Fax Number** option is required in order to send the fax, so it cannot be cleared. If all of the required fields on an outgoing fax are not completed, the fax will remain in a user’s FaxUtil mailbox with the status “Info Not Complete.”

**Requiring cover sheet fields on received faxes**

You can specify required fields for received faxes. This allows you to require that the fax recipient include billing codes or other fields for billing records.

In the **Customize Cover Sheet Information** dialog box, click the **Receive Required Fields** tab. Select the check box next to each field that you want to require.

If a fax arrives that does not include all required fields, the recipient will not be able to delete the received fax without completing the specified fields.

**Copying cover sheets from one server to another**

In Enterprise Fax Manager, you can copy one or more cover sheets from one RightFax server to another. Select the cover sheets you want to copy, and then drag the selection to another server.

If you copy cover sheets from a new RightFax server version to an earlier server version, you will lose configuration data that is not supported on the older server (for example, features on version 10.5 servers will not be available on version 9.4 servers).
Chapter 22
Using Optical Character Recognition

RightFax can be licensed to use Optical Character Recognition (OCR) to convert images of text in received faxes into standard, editable text files. The OCR software also converts bar codes on received faxes into numbers. The resulting text files can then be viewed, edited, or used to automatically route faxes to their intended recipients.

To configure OCR conversions, you must enable OCR on the workservers, grant OCR permission to each user who will be authorized to use the feature, and enable OCR and the output file defaults for each user. Users can choose whether to convert select faxes or automatically convert all received faxes to text.

Once you have OCR enabled, you can also configure the server to use the OCR results to route each fax to a RightFax user. To use OCR routing, you must enable OCR on the workserver and create a routing table that specifies the text strings that identify each user.

Enabling OCR Processing on the WorkServers

To enable OCR functionality on the RightFax server, it must be added as a process to at least one WorkServer. You can enable OCR processing on as many WorkServers as you want.

1. Run the WorkServer configuration program from Windows Control Panel on the RightFax server to display the WorkServer Configuration dialog box.

2. In the component tree in the left pane, select the WorkServer that you want to perform OCR processing.

3. To enable OCR processing, click OCR in the Services list.
4. Click OK to save your changes and close the WorkServer Configuration dialog box.

**Configuring the Conversion Engine for OCR**

RightFax uses RecoStar to perform OCR conversion. To configure RecoStar:

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.
2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.
3. In the Service Name list, double-click RightFax Conversion Engine. The Conversion Engine Configuration dialog box opens.
4. Click the RecoStar tab.
5. Complete the following fields.
   - **Maximum Conversion Time** Adjust this setting based on the size of the largest document (page and word count) sent for this conversion. The default value of 1 minute is usually adequate for all but the largest documents. Local testing will ultimately determine the optimal setting for your environment.
   - **Maximum number of retries** The maximum number of conversion attempts per document is controlled by the Maximum number of retries setting. Documents that fail conversion are marked as Problem Converting Fax Body or Coversheet.
   - **Country** Select an option from the drop-down list. This list contains all supported languages, as well as some country and region codes that incorporate multiple languages with similar character sets (such as Western_Europe).
6. Click OK.

---

**Configuring RightFax Users for OCR Conversion**

Before a user can receive OCR versions of fax images, you must specifically grant the user permission to access the OCR function, and the user must specify which faxes that are to be converted.

**Granting OCR Permissions**

You must grant each individual RightFax user permission to perform OCR conversion on received faxes. Because OCR conversion is very processor-intensive, you may choose to restrict OCR rights to a limited number of users.

To give a RightFax user OCR permission,

1. Run Enterprise Fax Manager, and double-click the user name to open the User Edit dialog box.
2. Click the Permissions tab and select Can OCR Faxes.
3. Click the Default Receive Settings tab.

4. Under Automatic OCR Options, select the Enabled? check box to automatically convert all received faxes using OCR. Enter a default three-letter file extension for the output file in the Extension box. Valid options are TXT, RTF, or DOC.

5. In the Format box, select the text format used to interpret your fax pages. “ASCII” produces a plain text file. “RTF” (rich text format) preserves fonts and formatting but is only available to Windows users.

6. Click OK to close the User Edit dialog box.
Using OCR to Route Received Faxes

When you route using OCR, the text on the received fax cover sheet is compared to a customized routing table that contains names and other text that identifies RightFax users in your organization. When a match is found, the fax is routed to the specified RightFax user.

Important Because large organizations can have several members with the same or very similar names, OCR routing is not recommended as a primary routing method. For large organizations, OCR routing should be used only as a backup for other fax routing methods (described in Chapter 23, “Routing Inbound Faxes”). With other fax routing methods, a mailbox can be configured that receives all “lost” faxes whose intended recipient cannot be determined. These “lost” fax mailboxes can then be configured for OCR routing.

Barcodes are decoded to the equivalent text strings, and will be treated just like any other OCR text string.

To use OCR routing, you must configure a “central” mailbox from which the faxes will be routed, and then you must create a custom routing table that contains RightFax user IDs and their associated text. When a fax arrives in the central mailbox, the cover sheet text is checked against the routing table for a match. If a match is found, the fax is routed. If no match is found, the fax remains in the central mailbox.

Creating and configuring the OCR central mailbox

To use OCR to route faxes to their intended recipients, the faxes must arrive in one or more “central” mailboxes. These mailboxes are configured so that all incoming faxes are rerouted using OCR routing.

To create a central mailbox for OCR routing, run Enterprise Fax Manager and add a new RightFax user called “OCR,” and then edit the user properties. Click the Inbound Routing tab, and enter “0” (zero) in the Routing Code box. This will cause all incoming faxes whose owners cannot be determined to automatically route to this mailbox. Next, click the Inbound Routing tab, and click OCR in the Routing Type box. This configures the mailbox to perform OCR routing on each received fax.

Note Only the central mailbox should have its Routing Type set to OCR. Do not set the routing type of individual RightFax user mailboxes to OCR or each user’s mailbox will attempt to reroute all received faxes, potentially creating endless routing loops.

In most cases, one central mailbox performing OCR routing is sufficient. If the needs of your organization require you to create multiple central mailboxes, each mailbox must have a routing code that corresponds to a channel extension configured in the DocTransport.

Creating the OCR routing table

The OCR routing table is a text file that is used to link text on the fax cover sheet to specific RightFax user IDs. This file must be called Route.txt and it must be located in the RightFax\WorkSrv folder on the RightFax server. A sample Route.txt file is provided in this folder for you to use as an example.

Each line of Route.txt must contain a separate entry in this format:

```
UserID MatchingText
```

Where UserID is the RightFax user ID to route to, and MatchingText is the fax cover sheet text that is associated with that user. The user ID and matching text must be separated by a single space. The matching text may contain spaces and other special characters. Here is an example of a short OCR routing table:

```
J Doe Jane
J Doe Doe
J Doe Jane Doe
J Doe Director of Marketing
J Doe 555-1212
J Smith John Smith
J Smith 555-1000
```
The matching text must be matched exactly in order to route the fax. In this example, a match on the word “Smith,” if not preceded by “John,” will not be routed. Similarly, a fax that comes in addressed to simply “Marketing” or “VP Marketing” would not be routed. Only the exact title “Director of Marketing” would cause the fax to be routed to user J Doe.

RightFax scans the routing table from top to bottom, routing the fax to the first match it finds. For this reason, the order in which you list user IDs in the table is very important. In the sample routing table, above, any fax that comes in with the word “Jane” will be routed to J Doe (even if it is addressed to Jane Smith, even if there are other Janes later in the routing table). You should place your highest priority user IDs at the top of the list so they will be sure to receive their faxes even if matching text conflicts with other users in your organization.

If you want bar code routing to take precedence over text strings, the bar codes should be at the top of the routing table. If you want to try to match text first, and then bar codes, the bar code strings should be at the bottom of the table. Another example of a routing table might be:

J Doe 5205551212
J Smith 520555100
T Logan 520555198
J Doe Jane Doe
J Smith John Smith
T Logan Ted Logan
J Doe Director of Marketing
J Smith Sales
T Logan Development

This sample would route on the numbers first, then the names, then the titles or departments.

**Note** Because OCR routing requires an exact match between your OCR routing table and the cover sheet text, you should remove any blank spaces at the end of your OCR routing table entries. If the matching text includes trailing spaces, those spaces will be required as part of the text to match.

### Creating alternate routing tables

If you have set up multiple central mailboxes for OCR routing, you can use a separate routing table for each mailbox. To specify a file name for the routing table other than Route.txt, run Enterprise Fax manager and edit the user ID for the mailbox. Click the **Inbound Routing** tab, and enter the file name for the routing table in the **Routing Info** box. The new routing table file must be located in the same RightFax\WorkSrv folder and use the same format as the Route.txt OCR routing file.

You can also specify a RightFax user ID to which unmatched faxes will automatically route for each central mailbox. In the **Routing Info** box, after the file name, type a comma followed by a RightFax user ID. For example, if you have set up an OCR central mailbox for the Sales department, you can specify a routing table called Sales.txt and have all unmatched faxes automatically route to Jane Doe (RightFax user ID J Doe). To do this, would enter the following line in the **Routing Info** box of the Sales central mailbox: SALES.TXT,JDoe

### Creating and Managing OCR Text Files

Once the workserver is configured and permissions granted, users can either convert individual faxes to OCR text or they can configure RightFax to automatically convert all received faxes to text. Once a fax has been converted to text, RightFax stores the text file along with the original fax image.
Converting individual faxes to OCR text files

To convert a fax image to text, the user displays a list of received faxes with either FaxUtil or RightFax Web Access. To convert each fax, click on the fax to select it, then either:

- Click the OCR icon.
- Right-click, then choose OCR from the menu.

Once the OCR processing is complete, an icon appears in the OCR column for the fax and the text file will be stored as a fax attachment.

Configuring automated OCR conversion

To configure RightFax to automatically convert all received faxes to text with OCR, the OCR module must be enabled and the current user must have been granted OCR permission. Once the automated conversion is enabled, each user can set the OCR Options defaults and be able to override any of these settings for each individual fax.

1. From FaxUtil, choose Tools and then Options.
2. Click the Receiving tab.
3. Select Automatically OCR Received Faxes to enable the OCR Options button.
4. Click the Set OCR Options button to display the available options.
5. From the OCR Options window, choose the Output Type (TXT, DOC, or RTF).
6. Choose a Format from the drop-down box (RFT or ASCII).

Opening OCR Text Files

The method you use to view OCR-converted faxes depends on the fax client application you use. If you use an email gateway application as your fax client (such as Microsoft® Exchange or Lotus® Notes®), OCR-converted faxes will arrive as file attachments to email messages along with the associated fax image file. These text file attachments can be viewed and edited exactly like any other email attachment.

If you use FaxUtil or RightFax Web Access as your fax client, OCR-converted faxes are stored in the RightFax database along with their associated fax image files. If a fax has an associated OCR text file, an OCR icon will appear next to the fax entry.
Chapter 23  
Routing Inbound Faxes

The RightFax server provides several methods for routing received faxes to their intended recipients in your organization. The routing method you choose will be based primarily on the type of telephone service you use.

To route faxes to users, assign a unique routing code to each user. RightFax attempts to match information from the received fax (such as digits dialed to the routing code) to one of the defined RightFax users. This user is then determined to be the intended fax recipient.

After RightFax has determined who should receive an incoming fax, you then have several options for how that fax should be delivered (for example, to the FaxUtil mailbox or attached to an email message).

Configuring DID/DNIS Routing

Direct Inward Dial (DID) lines support inbound phone service only, and Dialed Number Identification Service (DNIS) supports bi-directional faxing. These two methods are considered the most accurate for fax routing.

A DID/DNIS interface assigns multiple telephone numbers to a single pair of wires (a telephone trunk). Often these numbers are sequential and all contain the same prefix. For example, a single DID/DNIS line may have 20 numbers associated with it ranging from 555-1001 to 555-1020. Your phone company will forward any or all of these dialed numbers to your system along with the call. RightFax then uses these included numbers to route faxes to the proper recipients.

Each RightFax user is assigned a personal fax mailbox that is assigned a DID/DNIS number (routing code). When a call comes in with a valid DID/DNIS number, the fax is placed in the corresponding user’s fax mailbox.

1. Configure the RightFax server and fax board(s) for DID/DNIS routing by running the RightFax DocTransport configuration program. Each fax board must be configured for DID/DNIS routing separately. See “Brooktrout Fax Board Configuration” on page 46 for more detail.

2. Assign routing codes to users in accordance with the number of DID/DNIS digits for which your services are configured. For example, if you have a set of DID/DNIS numbers of 555-1001 through 555-1020, and your phone service is configured to forward the last four digits of the dialed number, then you would assign the routing codes 1001 through 1020 to your users. If you have three digit service, then you would assign the routing codes 001 through 020 to your users.

3. From the Enterprise Fax Manager, click Users and then double-click a user name to open the User Edit dialog box.
4. Click the **Inbound Routing** tab, and enter the user’s DID/DNIS phone extension code in the **Routing Code** box.

**Note:** The number you enter in the user’s Routing Code box must have the exact number of digits that you specified in the **Number of Digits for Routing** box when configuring the fax boards.

### Configuring DTMF Routing

Unlike DID/DNIS routing, DTMF uses Plain Old Telephone Service (POTS) with a single phone number assigned to each phone line. The person sending the fax dials this number and the call connects normally. However, before the fax transmission starts, the fax board prompts the caller with a tone or voice prompt to enter a routing code for the fax they are sending.

If the caller enters a valid routing code (one that is assigned to a RightFax user) the fax is placed in that user’s mailbox. If the caller does not enter a code before a certain amount of time has elapsed, or if the code does not correspond to a valid RightFax mailbox, the fax is placed in the mailbox that corresponds to the **Channel Extension** setting for the channel it arrived on (or to the administrator of the Everyone group if no channel extension match is found).

To configure DTMF routing:

1. Configure the RightFax server and fax board(s) for DTMF routing by running the RightFax DocTransport configuration program (see “Brooktrout Fax Board Configuration” on page 46). Each fax channel must be configured for DTMF routing separately.

2. From the Enterprise Fax Manager, click **Users** and then double-click a user name to open the **User Edit** dialog box.

3. Click the **Inbound Routing** tab, and enter the user’s DTMF code in the **Routing Code** box. The digits entered here correspond directly to the digits entered by the caller when prompted.

### Configuring Channel Routing

With channel routing, faxes are routed based on the phone line on which they are received. For example, if each of your departments use a unique fax number, all faxes to that number are delivered to a single fax mailbox. Each of the members of the department can check the department mailbox for faxes, the faxes can be directed to a printer located in the department, or each fax can be routed to the intended recipient.

#### Configuring RightFax for channel routing

Each fax channel must be configured for channel routing separately. To configure the RightFax server and fax boards for channel routing, run the RightFax DocTransport configuration program.

Click each channel number under the fax board names. For each channel, set the **Channel Extension** to a number between 1 and 99. This setting will correspond to the Routing Code of the mailbox that is to receive all faxes coming in on this channel. You can also set two or more channels to the same Routing Extension if you want a single mailbox to receive faxes from multiple channels.

#### Channel routing with digital fax boards

To implement channel routing with digital fax boards, set the Windows registry value **DoDigitalChanRoute** to 1. See “**DoDigitalChanRoute**” on page 342.

#### Configuring recipient mailboxes

To assign channel extensions to mailboxes, edit the user profile for each recipient mailbox in Enterprise Fax Manager. Click the **Inbound Routing** tab and enter the **Channel Extension** setting of the channel that you want to receive faxes from in the **Routing Code** box.
Configuring ANI Routing

ANI (Automatic Number Identification) is a service provided by telephone service providers. It precedes each incoming phone call with a series of digits that includes (among other things) the phone number dialing in.

RightFax can use ANI information to route inbound faxes to a user mailbox based on the phone number that the fax originated from. Using ANI routing, all faxes from a certain phone number can be routed to a specific recipient. Similarly, all faxes originating from a specific area code or telephone number prefix can be routed to a specific recipient. This routing method can be useful to sales departments for routing faxes according to sales territories.

ANI routing is not available with analog fax boards.

Configuring RightFax for ANI routing

To route faxes with ANI routing, the faxes must arrive in one “central” mailbox. This mailbox is configured so that all incoming faxes are rerouted using ANI routing.

In most cases, one central mailbox performing ANI routing is sufficient. If the needs of your organization require you to create multiple central mailboxes, each mailbox must have a routing code that corresponds to a channel extension configured in the DocTransport.

To create a central mailbox for ANI routing,

1. Run Enterprise Fax Manager and add a new RightFax user called “ANI”.
2. For the new user ANI, edit the user properties. On the Inbound Routing tab, enter “0” (zero) in the Routing Code box. This will cause all incoming faxes whose owners cannot be determined to automatically route to this mailbox.
3. Click ANI in the Routing Type box. This configures the mailbox to perform ANI routing on each received fax.

   Note Only the central mailbox should have its Routing Type set to ANI. Do not set the routing type of individual RightFax user mailboxes to ANI or each user's mailbox will attempt to reroute all received faxes, potentially creating endless routing loops.

4. If you haven’t already done so, enter the ANI pattern matching string in the DocTransport module. See “ANI Pattern Match” on page 46.

5. On the RightFax server, create an ASCII file called Ani.tbl in the RightFax\Bin folder. This file is the ANI routing table. Each line must contain a separate entry using this format:

   **RoutingCode ANIString**

   Where RoutingCode is the routing code setting of the user to route to and ANIString is the ANI data represented by ‘X’ characters in the ANI pattern match. The ANI string and routing code must be separated by a single space. Here is an example of a short ANI routing table:

   1001 15205551212
   1002 15205552345
   1003 15205550982
   1004 15205551000

Creating alternate routing tables

You can set up multiple central mailboxes for ANI routing. For example, you could set up a mailbox that receives and routes faxes to the Sales department. Create a central mailbox for Sales, and specify a routing table called Sales.tbl.

To specify the routing table for the mailbox, edit the user profile for the mailbox in Enterprise Fax Manager, click the Inbound Routing tab, and type the file name in the Routing Info box. The custom routing table files must be located in the RightFax\Bin folder.
Configuring CSID Routing

CSID (caller subscriber identification) routing routes inbound faxes to a specific mailbox based on the ID of the sending device. Using CSID routing, faxes sent from a specific fax number can be routed to a specific recipient.

This method relies on data from the sending device, which may or may not include a fax phone number. The CSID may be the company name or other data, and it may be impossible to match with data in RightFax. For this reason, CSID routing can be an unreliable method of routing.

CSID routing precludes some other routing types like DTMF and channel routing. However, routing types that occur after arriving in a fax mailbox (like OCR routing) can still be used. If an ID for the sending device is not transmitted or cannot be determined, the fax is placed in the mailbox that corresponds to the Channel Extension setting for the channel it arrived on (or to the administrator of the Everyone group if no channel extension match is found).

Configuring RightFax for CSID routing

To configure RightFax for CSID routing, run the RightFax Server configuration program. Click the General tab and select Enable CSID Routing.

On the RightFax server, create an ASCII file called CSID.tbl in the RightFax\Bin folder. The CSID.tbl file is the CSID routing table. Each line must contain a separate entry using this format:

RoutingCode CSID

where RoutingCode is the routing code setting of the user to route to, and CSID is the CSID information (either text or a phone number) that, when sent, will route to that user. The routing code and CSID must be separated by a single space. The CSID text can contain spaces and other special characters. Here is an example of a short CSID routing table:

1001 520*
1002 Acme, Inc.
1003 RIGHTFAX

The asterisk (*) wildcard character can be used to represent any unspecified characters at the end of the CSID string. This wildcard can only be used at the end of the CSID string in the CSID.tbl file, and all characters preceding the wildcard must match the incoming CSID exactly for routing to be successful. In the preceding example, all incoming faxes with CSIDs that indicate they originated from area code 520 will be routed to the RightFax user with the routing code 1001.

Configuring Delivery Methods for Users

After you have configured a routing method for your organization, you have several options for the delivery method to the user. The delivery method is configured individually for each RightFax user.

To assign a delivery method to a user

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on page 85), and click Users under the RightFax server in the Fax Server Tree. The list of users appears in the right pane of the window.
2. Double-click a user to edit the user’s profile. The User Edit dialog box opens.
3. Click the Inbound Routing tab, and select the delivery method in the Routing Type box. Delivery options include:
   - Fax mailbox When you select this routing type, incoming faxes will be routed to the user’s FaxUtil mailbox.
   - Email When you select this routing type, incoming faxes are forwarded to the user as an email message. If you select this option, you must also provide the necessary routing information in the Routing Info box so that RightFax can find the correct email.
mailbox. For information on routing faxes to an email mailbox see “Configuring Users to Receive Faxes via Email” on page 266, or refer to the documentation included with the RightFax email gateway module.

**Network directory** When you select this routing type, incoming faxes will be sent to a network folder that you specify. If you select this option, you must type the path to the folder in the *Routing Info* box and/or choose from several macros as to how you would like the faxes stored (such as by month, day, or billing code).

**Example** The following entry in the *Routing Info* box would route faxes to the RightFax\Faxin folder on the `SYS` volume of the FILESERV file server:

`\fileserv\sys\rightfax\faxin`

In this example, the RightFax fax server would have to be attached to FILESERV with sufficient privileges to write to the Faxin folder. RightFax will create any specified folders, assuming it has the necessary network access privileges.

The destination path can also specify one or more folder macros that cause unique or descriptive folders to be created dynamically. The following table lists the available folder macros.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>Date (YYYYMMDD)</td>
</tr>
<tr>
<td>~2</td>
<td>Day of the week (SUN–SAT)</td>
</tr>
<tr>
<td>~3</td>
<td>Month (JAN–DEC)</td>
</tr>
<tr>
<td>~4</td>
<td>Year (YYYY)</td>
</tr>
<tr>
<td>~5</td>
<td>Day of the month (DD)</td>
</tr>
<tr>
<td>~6</td>
<td>Month as decimal (01–12)</td>
</tr>
<tr>
<td>~7</td>
<td>User ID (truncated to 11 characters)</td>
</tr>
<tr>
<td>~8</td>
<td>Week of year as decimal (00–51)</td>
</tr>
<tr>
<td>~9</td>
<td>Billing Code 1 (truncated to 11 characters)</td>
</tr>
<tr>
<td>~0</td>
<td>Billing Code 2 (truncated to 11 characters)</td>
</tr>
<tr>
<td>~A</td>
<td>Remote ID (left to right, truncated to 11 characters)</td>
</tr>
<tr>
<td>~B</td>
<td>Remote ID (right to left, truncated to 11 characters)</td>
</tr>
</tbody>
</table>

**Example** Entering `\FILESERV\SYS\RIGHTFAX\~1` will cause the fax server to create a folder `\FILESERV\SYS\RIGHTFAX\20020101` when storing a fax received on January 1, 2002.

The file name stored in this folder is a unique name assigned by the RightFax server and cannot be changed. The total length of the path, after macro replacement, cannot exceed 72 characters.

**Note** Only received faxes will be routed to a network folder using this method. If a sent fax is forwarded or routed from one RightFax user to another RightFax user with a network routing destination specified, the fax will appear in the recipient’s fax mailbox, but will not appear in the specified network folder.
OCR  When you select this routing type, incoming faxes will be OCR'd for recognizable character strings, compared to a table of RightFax user IDs and matching strings, and, when a match is found, routed to the appropriate user. No additional routing information is necessary if you plan to use the default OCR routing table Route.txt.

This routing type requires RightFax OCR Routing module, purchased separately.

RightFax InterConnect  When you select this routing type, incoming faxes will be redirected from one RightFax server to another. In the Routing Info box, enter the destination RightFax server name. The InterConnect service must be enabled on at least one of the receiving RightFax server's WorkServers, and the RightFax user account (user ID) of the fax recipient must exist on both RightFax servers.

Auto-printing, auto-OCR, and auto-forwarding are not available with this routing type, because they are performed by the destination fax server only. This routing type requires the RightFax Enterprise server.

Note  By default, faxes routed from one RightFax server to another RightFax server in a different time zone will have the time and date stamp from the originating server. To change this so that faxes have the time and date of the receiving server, set the Windows registry value InterconnectSetTZ to 1. See "InterconnectSetTZ" on page 349.

Telephony server  RightFax can route incoming faxes to a telephony server mailbox. In the Routing Info box, enter the telephony server routing information using this format:

(NP: or TCP:)server/source/sourcepassword/destination

Where NP: or TCP: represents the network protocol, either named pipes or TCP/IP.

Distributing Faxes to a Group of Users

Smart Fax Distribution is a method of distributing received faxes between all the members of a user group.

With Smart Fax Distribution, the user group that will share the faxes is assigned a Routing Code. Faxes that are routed to the group ID are then distributed between the group members (using each individual's configured routing method) either round-robin or according to each user’s ability to process the faxes.

To configure Smart Fax Distribution for user groups, see “The Smart Fax Distribution tab” on page 116.

Assigning Unique ID Numbers to Fax File Names and Routing to a Network Folder

Faxes stored in a network folder can be assigned unique ID numbers, and the ID numbers can be used as the file names. By default, RightFax generates and assigns unique ID numbers to each fax it receives. You can specify an alternative ID number scheme if you want to store faxes on a network folder. For example, you can specify an ID that consists of the server name, date, and page count.

This unique ID number is printed on the fax page in the receipt terminal information (RTI) line.

To assign unique IDs, complete the following tasks:

1. Set the Windows registry value for UseReceiveStampUnique to 1 on the FaxServer and on each WorkServer. See “UseReceiveStampUnique” on page 346 and page 351.
2. In Enterprise Fax Manager, select the server.
3. In the Service Name list, double-click RightFax WorkServer# Module. The WorkServer Configuration dialog box opens.
4. Under **Services**, select **FileRoute**, and click to clear the selection of **Archive**.

5. Under **Archive Settings**, select the **Separate File Per Page Output** check box.

6. Repeat steps 3 through 5 for each WorkServer that you want to handle file routing.

7. Specify the users whose faxes should be routed to the folder.

8. In Enterprise Fax Manager, edit each user whose received faxes should be routed. In the **User Edit** dialog box, click the **Permissions** tab. Select the check box **Stamp Pages of Received Faxes with Audit Stamp**.

9. Click the **Inbound Routing** tab. In the **Routing Type** box, select **Network Directory**.

10. In the **File Format** box, select TIFF (G3-1D) or TIFF (G4).

11. In the **Routing Info** box, type the name of the folder where the faxes will be saved.
Chapter 24
Responding to Inbound Faxes with AutoReply

The AutoReply service monitors one or more RightFax mailboxes for inbound faxes, and faxes replies to the sender (based on each sender’s CSID number). If no valid CSID number is included with the inbound fax, the fax can be automatically printed or forwarded to another RightFax mailbox so that a reply can be sent manually.

The faxed reply is fully customizable. You can format the reply to include personalized messages, relevant fax addressing information, your organization’s logo or other graphic images, and a copy of the cover page from the received fax being replied to.

Requirements

- Microsoft .NET Framework
- Microsoft C++ runtime components
- For each user that will be monitored for automatic replies, inbound routing should not be set to delete after routing, or AutoReply will fail. To change this setting, see “Editing user properties” on page 97.
- The AutoReply fax is sent from one user account in RightFax. It is recommended that you create a unique user ID from which all AutoReply faxes will be sent. To create a user ID, “Creating a User Profile” on page 97.

Installing and Configuring AutoReply

AutoReply Setup can be run on any computer with network access to the RightFax server. After Setup is finished, you must run the AutoReply Wizard to add the AutoReply service to the RightFax server.

1. Log on to the computer with a Windows account that is a member of the domain users and local administrators group.
2. Run the RightFax Setup.exe. The RightFax Product Suite Setup wizard opens.
3. Setup requires Microsoft .NET Framework. If this software is not installed on your system, Setup will prompt you to install it. To install, click OK. To cancel Setup and install .NET Framework yourself, click Cancel.
4. Review the welcome screen and click Next.
5. Carefully read and accept the license agreement and click Next.
6. Setup can check for RightFax updates and other late-breaking information. To check for updates, verify you have an active HTTP connection and click Check for Updates. If updates are found, follow the instructions in the Result section. To skip the update check and continue with Setup, check the box next to Do not check for updates and click Next.
7. Click Custom followed by Next.
8. Select the **RightFax AutoReply** Setup component and click **Next**. No other Setup components should be chosen.

9. The **Preview Requirements** step lists third-party software required by your chosen features and also lists the status of setup operations. Software that must be installed will have a status of **Must Install**. To continue, click **Next**.

10. To apply your settings and install required third-party software, click **Apply**. This may take several minutes. When finished, click **Next**.

11. Choose your installation folder and click **Next**.

12. To begin installing RightFax software, click **Apply**. This may take several minutes. When finished, click **Next**.

13. To apply your settings and complete Setup, click **Apply** followed by **Close**.

To configure the **AutoReply** service

1. Click **Start > All Programs > Open Text > RightFax AutoReply Wizard**. The **AutoReply Setup Wizard** opens. To continue, click **Next**.

2. In the **RightFax Server** field, type the server that AutoReply will monitor. Enter the log on user ID and password. Click **Connect** to connect to the server, and then click **Next**.

3. In the **Choose RightFax Server** window, specify the server that AutoReply will monitor. Enter the **Log on user ID**, **Password**, and **Network Protocol**. Click **Connect** to connect to the server, and then click **Next**.

4. Click the option to **Set up and configure a new RightFax server** and click **Next**.

5. Using the pick-list, choose a RightFax user ID from which reply faxes will be sent. For each server, you can specify just one user ID from which all reply faxes will be sent. Click **Next**.

6. In the **Select Monitored Users** window, create a list of users to monitor for the AutoReply service. In the **Available users** list, click one or more users, and then click **Add**. The users appear in the **Monitored users** list. When you have created the list, click **Next**.

7. In the **Edit Monitored Users** window, choose the AutoReply response for the monitored users. To create one method of response for all users, in the **Select the monitored user ID** box, click **Default**. Or, choose a user and the responses for that user.

You have the following options for AutoReply responses.

<table>
<thead>
<tr>
<th>Response</th>
<th>Enter this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route the received fax to another user after an AutoReply is sent.</td>
<td>The user ID where the fax should be routed.</td>
</tr>
<tr>
<td>Route the received fax to another user if an AutoReply cannot be sent. (If no valid CSID number is included with the received fax, an AutoReply cannot be sent.)</td>
<td>The user ID where the fax should be routed.</td>
</tr>
<tr>
<td>Print the received fax if an AutoReply cannot be sent. (If no valid CSID number is included with the received fax, an AutoReply cannot be sent.)</td>
<td>The printer ID for the printer where the fax should print. (Enter a printer ID defined in Enterprise Fax Manager.)</td>
</tr>
</tbody>
</table>

When finished, click **Next**.
8. In the **Enter File Names** window, enter the location of the file to use for formatting the AutoReply fax. A sample file called Format.ini is available in the RightFax\AutoReply\Samples folder. It is recommended that you modify this sample file to fit your organization’s needs. (To format the AutoReply fax, see “Customizing the Reply Fax” on page 224.) Click **Next**.

9. Click **Finish**.

**Managing AutoReply from a Remote Computer**

You can manage AutoReply from a computer that is remote from the server. To do so, first install the AutoReply configuration program on the remote computer. Next, run the configuration program on the remote computer.

**Installing AutoReply on a remote computer**

On the remote computer, run AutoReply Setup (see “Installing and Configuring AutoReply”). When Setup completes, proceed to the next section to configure AutoReply on the local computer.

**To run the AutoReply configuration program**

1. On the remote computer click **Start > All Programs > Open Text > RightFax AutoReply Configuration**. The **AutoReply Configuration** window opens.

2. In the **Connection** tab, specify the server to connect to. Enter your log on user ID and password, and then click **Connect** to connect to the server.

3. In the **AutoReply User ID** tab, enter the RightFax user ID from which reply faxes will be sent. For each server, you can specify just one user ID from which all reply faxes will be sent.

4. In the **Monitored Users** tab, create a list of users to monitor for the AutoReply service. In the **Available users** list, click one or more users, and then click **Add**. The users appear in the **Monitored users** list.

In the **Monitored User Configuration** tab, choose the AutoReply response for the monitored users. To create one method of response for all users, in the **Select the monitored user ID** box, click **Default**. Or, choose a user and the responses for that user.

You have the following options for AutoReply responses

<table>
<thead>
<tr>
<th>Response</th>
<th>Enter this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route the received fax to another user after an AutoReply is sent.</td>
<td>The user ID where the fax should be routed.</td>
</tr>
<tr>
<td>Route the received fax to another user if an AutoReply cannot be sent. (If no valid CSID number is included with the received fax, an AutoReply cannot be sent.)</td>
<td>The user ID where the fax should be routed.</td>
</tr>
<tr>
<td>Print the received fax if an AutoReply cannot be sent. (If no valid CSID number is included with the received fax, an AutoReply cannot be sent.)</td>
<td>The printer ID for the printer where the fax should print. (Enter a printer ID defined in Enterprise Fax Manager.)</td>
</tr>
</tbody>
</table>

5. In the **Format File** tab, enter the location of the file to use for formatting the AutoReply fax. (To format the AutoReply fax, see “Customizing the Reply Fax” on page 224.)

6. Click **OK**.
Customizing the Reply Fax

You can specify the appearance of your reply fax. The appearance is defined in a text file.

The text file can have any file name and can be located in any folder accessible by the fax server. Specify the path and file name in the AutoReply configuration.

A sample file called Format.ini is available in the RightFax\AutoReply\Samples folder. It is recommended that you modify the sample file to fit your organization’s needs. This file includes layout settings for a reply fax page.

The Format.ini file is divided into sections. The General section defines values that apply to the entire fax page. The Frame sections each define the location of a frame on the fax page and the contents of the frame. You can place an unlimited number of frames on a page.

Table 24c Options in the General Section

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Name, Size</td>
<td>The default font that will be used for text if a font is not specified for a frame.</td>
</tr>
<tr>
<td>OutputSize</td>
<td>Letter, A4, Legal</td>
<td>The size of the page for the reply fax.</td>
</tr>
</tbody>
</table>

Table 24d Options in the Frame Section

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Left, Top, Right, Bottom</td>
<td>The boundaries of the frame. The left and right values are measured from the left edge of the page. The top and bottom values are measured from the top edge of the page. For example, a frame that fills the lower-right quarter of a letter-size page might have this value: 4.25,5.5,8,10.5.</td>
</tr>
<tr>
<td>Border</td>
<td>Width</td>
<td>The width (in pixels) of the border to draw. Omit or set to zero for no border.</td>
</tr>
<tr>
<td>File</td>
<td>File name</td>
<td>The name of the file to include in the frame. This can be either a text file (if the Type option is set to Text) or graphic file (if the Type option is set to Graphic). For graphic files, monochrome bitmap files are recommended for best image rendering. To add variables to the text in a text file, see “Using variables in text” on page 225.</td>
</tr>
<tr>
<td>Font</td>
<td>Name, Size, Style</td>
<td>The font that will be used for all text in this frame. Specify the name of the font, the point size, and (optionally) the style (Bold, Italic, or both).</td>
</tr>
<tr>
<td>Horizontal-Alignment</td>
<td>Left, Center, or Right</td>
<td>The horizontal alignment of the text or graphic within the frame.</td>
</tr>
</tbody>
</table>
Responding to Inbound Faxes with AutoReply

Using variables in text

Text in the format file and text included from an external file can contain one or more of the following variables.

For example, the text TO: Fax Sender at ~1 would appear in the reply fax as TO: Fax Sender at 520-555-0100.

Troubleshooting the AutoReply Service

To troubleshoot the service, you can run AutoReply in a command window to view debug information.

1. In Enterprise Fax Manager, stop the AutoReply service.

2. Open a command prompt and change to the RightFax\AutoReply folder.

3. Type `AutoReply -d -1` and press ENTER.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table 24d</strong> Options in the Frame Section (Continued)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Value</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>Text</td>
<td>Text</td>
<td>If you have set the Type option to Text, this option supplies the text that will appear. Note that this option supports a single line of text only. To include a longer text message, use the File option. To add variables to the text, “Using variables in text” on page 225.</td>
</tr>
</tbody>
</table>
| Type              | Text, Graphic, or FaxPage | Each frame must be one of these types:
- Text frames display literal text from the Text option or text from a text file specified in the File option.
- Graphic frames display the graphic file specified in the File option, scaled to fill the frame.
- FaxPage frames display the first page of the fax that is being replied to, scaled to fit the frame. |
| Vertical-Alignment | Top, Center, Bottom, or Wrap | The vertical alignment of the text or graphic within the frame. The Wrap value should be used for unformatted text to wrap the text to fit within the boundaries of the frame. |

| **Table 24e** Text Variables                                                                                                                                         |
| **Variable** | **Definition**                                                                                                                                            |
| ~1            | Destination fax phone number.                                                                                                                            |
| ~2            | Number of pages in the received fax.                                                                                                                      |
| ~3            | Date and time the fax was received (the start of receipt). The date and time will appear as Date Time [Timezone], where the Date and Time are formatted according to the Regional settings in Control Panel. |
| ~5            | Unique ID of the fax (assigned by the RightFax server).                                                                                                   |
There are several ways you can begin to create a fax. You can create a fax from within RightFax Faxutil, or from external programs such as Microsoft Word. You can also create faxes from existing files. Whichever method you use, you can include a variety of elements in each outgoing fax:

- A cover sheet
- One or more files such as Word documents, PDF files, or Excel spreadsheets
- One or more library documents that are stored on the RightFax server

You must also specify addressing information that may or may not go on the cover sheet, depending on your cover sheet configuration.

Note: If you have installed one or more RightFax email gateway modules, you can create a fax as an email message and fax it directly from your email mailbox. For information on faxing from your email client application, see Chapter 28, “Creating, Sending, and Managing Faxes”, or refer to the RightFax Gateway for Microsoft Exchange Guide or RightFax Gateway for Lotus Notes Guide.

Creating and Sending a Fax

To send a fax from the RightFax server, follow these general steps:

1. Choose the fax method. This will vary depending on the type of information you want to send. See “Choosing the fax method” on page 228. For all fax methods, RightFax opens the Fax Information dialog box. This dialog box prompts you for fax addressing information and also lets you attach files, library documents, and your own notes. The Fax Information dialog box also provides several options that let you control when and how the document is sent.

2. To send a new fax, you must enter fax addressing information (such as the destination fax number) on the Fax Information dialog box Main tab. See “Specifying Addressing Information” on page 230.

   Note: Boxes that appear in bold are required. If you send a fax before completing all the required boxes, the fax will remain in your FaxUtil mailbox with the status “Info Not Complete” until the required boxes are completed. In most cases, To Name and Fax Number are the only required boxes. The RightFax administrator can determine the required entries for users in Enterprise Fax Manager (see “Requiring cover sheet fields on received faxes” on page 205).

3. Add notes that you want to include on the cover sheet to the Cover Sheet Notes tab. See “Adding Cover Sheet Notes” on page 232.
4. You can add files to the fax, or remove files from the fax, by entering information on the Attachments tab (see “Attaching Files” on page 232). If you chose either the Send To or print-to-fax method, there will already be files attached to the fax.

5. To use RightFax overlay forms, set fax priority, modify cover sheets, or enter more recipient information, see “Entering Additional Processing Options” on page 234.

6. When you have completed all the required and optional entries, click Send to send the fax.

Choosing the fax method

RightFax provides users several convenient ways to create a new fax. Depending on which components you want included in your fax, choose one of the following fax methods.

- Use the RightFax FaxUtil program.
- To fax from an external application such as a word processor, spreadsheet, or other business application, print to fax by selecting the RightFax Fax Printer. See “Faxing from an external application” on page 228.
- To send a document that’s already stored on your system without opening the application that created it, use the Send To feature. See “Faxing Stored Files Using SendTo” on page 228.
- To create a new fax without launching any other programs, use Quick Fax. See “Faxing from the System Tray” on page 229.

All four methods bring up the same fax information dialog box and display the same faxing options.

Fax from the RightFax FaxUtil program

Open RightFax FaxUtil from your program menu or FaxUtil icon. To begin creating a fax, click the New Fax icon in the upper left corner.

Faxing from an external application

From within an application like a word processor or spreadsheet, you can fax a document by printing it to the RightFax Fax Printer.

To enable this feature:

- The RightFax Print Driver component must have been selected during the RightFax client installation (described in the RightFax Installation Guide).
- The application used must be able to print to a network printer.
- The service account running the Print Spooler (spoolsv.exe) needs Full Control on the 'spool' folder in %windir%\system32 and Full Control of the %allusersprofile% folder. The local system account which runs the Print Spooler service by default has the necessary permissions by default.
- The user account running the RightFax system tray icon (FaxCtrl.exe) needs List folder / read data, Delete, and Delete Subfolders and Files permissions for the ‘RightFax’ folder in %allusersprofile% folder. The RightFax folder may be in a subdirectory (either Application Data or Roaming). The user account also needs Full Control permissions on the %tmp% folder.

Faxing Stored Files Using SendTo

You can fax a stored file without opening the application that created it. The stored file must be in a format that RightFax can convert to fax format (see Appendix B, “File Formats that Convert to Fax Format”). From the folder that contains the file you want to fax, right-click the file name to open a shortcut menu, click Send To, and then click File Destination via RightFax.
To enable this feature:

- The RightFax Print Driver component must have been selected during the RightFax client installation (described in the RightFax Installation Guide).

- The user account running the RightFax system tray icon (FaxCtrl.exe) needs List folder / read data, Delete, and Delete Subfolders and Files permissions for the 'RightFax' folder in %allusersprofile% folder. The RightFax folder may be in a subdirectory (either Application Data or Roaming). The user account also needs Full Control permissions on the %tmp% folder.

Faxing from the System Tray The Quick Fax feature creates a fax by combining files, library documents, addressing information, and your own notes from one convenient dialog box. Click the RightFax tray icon to open the tray icon shortcut menu, and then select Quick Fax/Broadcast.

To enable this feature:

- The RightFax Print Driver component must have been selected during the RightFax client installation (described in the RightFax Installation Guide).

- The user account running the RightFax system tray icon (FaxCtrl.exe) needs List folder / read data, Delete, and Delete Subfolders and Files permissions for the 'RightFax' folder in %allusersprofile% folder. The RightFax folder may be in a subdirectory (either Application Data or Roaming). The user account also needs Full Control permissions on the %tmp% folder.

- Right-click the RightFax system tray icon and select Configuration to view or change the defaults that were set at installation. The Configure Client window includes:
  - Fax Server Name
  - Protocol (TCP/IP or Secure TCP/IP)
  - Login Method (NT Authentication, Network Login, or User Specified)
  - User ID (if needed)
  - Language (default is English)
  - Tray Icon Double-click (choose to launch either FaxUtil or the Quick Fax/Broadcast shortcut when you double-click the icon)
Specifying Addressing Information

Figure 25.1  The Fax Information Dialog Box Main Tab

Under **To**, enter the name, phone number, and other addressing information for the intended fax recipient as you want it to appear on the fax cover sheet. Boxes in bold (such as **Fax Number**) must be completed before the fax can be sent.

**Fax Name**  Enter the name of the recipient. To select a fax destination from your RightFax phonebook, click **Phonebook**. The **Phonebook** dialog box opens, listing the individual and group entries in your RightFax phonebooks. Double-click a phonebook entry to add it to the **Current Recipients** list. You can add as many fax recipients to this list as you want. To add the fax addressing information entered under **To** as a new entry in your RightFax phonebook, click **Add Entry**. For more information on creating and using RightFax phonebooks and phonebook entries, see “Using the RightFax Phonebook” on page 227.

**Fax Number**  You can specify the recipient addressing information in any one of three different ways. Click the arrow button directly below the **Name** field and choose one of the following options:

- Select **Fax Number** to enter a fax number. Special characters such as hyphens, parentheses, and spaces can be included, but are not required.
- Select **E-Mail Address** to enter an email address. Sending to an email address allows several additional options including sending via certified delivery, sending images in portable document format (PDF), and sending file attachments that cannot be rendered as images (such as WAV files). The email address can be up to 254 characters long and must include one and only one “@” symbol.
- Select **SMS** to store the fax and send a text message to the recipient.

You must enter at least one destination for the fax. If you don’t enter a destination, or if the entered information is invalid for that address type, the **Send** button will remain unavailable.

**Accounting**  You can also specify up to two codes under **Accounting**. These codes can be used by the RightFax administrator to track who the fax was sent to or who sent the fax, depending on the needs of your organization. The names of the codes are customizable. For example, they may be called BillingCode 1 and BillingCode 2 or they may be called Account and Department. Click **Lookup** to view and select from a list of available codes. For more information on using billing codes, see Chapter 14, “Creating Billing Codes”.

**Note:** To use email or SMS addressing, the fax administrator must configure the RightFax server appropriately (see “Adding and Configuring Email Gateways” on page 259 or “Configuring SMS via the Push-Proxy Gateway” on page 61).
Fine mode  Select this check box to create the fax using 200×200 dots per inch (DPI) resolution. Using this resolution takes longer to generate and send the fax but produces a clearer fax image.

Use cover sheet  Adds a cover sheet to the beginning of the fax. RightFax uses the cover sheet file specified by the RightFax administrator as your user or group default. If you have permission to change cover sheets in your RightFax user profile (“The Permissions tab” on page 98), you can select the cover sheet to use (see “Entering Additional Processing Options” on page 234).

Hold for preview  You can examine the final version of the outgoing fax before you send it. The fax will be held in your FaxUtil mailbox with the status “Held for Preview” and can be viewed there. To send the fax after you have previewed it, click the fax in FaxUtil and select Release in the Fax menu.

Use smart resume  Allows the fax server to intelligently re-send only the portion of a fax that failed to send. For example, if the connection is broken after 40 pages of a 50-page fax, normally all 50 pages have to be re-sent. By enabling Smart-Resume, the server will only re-send the last 10 pages.

Create PDF image  When sending your document to an email address, check this option to send each attachment as a PDF file instead of a TIFF file (the standard image format used for faxes). To create PDF files, you must purchase and enable the PDF Module. To send PDF files as faxes, you must purchase and enable the SecureDocs module.

If you are sending the fax by email, you can click the […] button to open a list of PDF password protection options (if the administrator has enabled them). For more information, see the SecureDocs Guide.

For information on creating PDFs and setting PDF options, refer to Chapter 25, “Working with PDF Files”.

Use cheap rates  Tells RightFax to delay sending the fax until a specified time (typically in the late evening when long distance rates are lower). The Cheap Rates time can be specified by selecting Options in the FaxUtil Tools menu, and then clicking the Other Options tab.

Delay send  Tells RightFax to postpone the transmission of your fax to a later day or time. This lets you take advantage of off-peak phone rates or ensure that the fax recipient is available at the other end. If you select this check box, you must also specify a date and time to queue the fax for transmission. If you specify a time and date that has already passed, the fax will be sent as soon as possible.

Note  The fax is queued at the time you specify, but will not actually be sent until it reaches the top of the queue. This can cause a delay between the time you specify and the time that the fax is actually sent.

Recording Manual Fax Information  When you send or receive a fax from a fax machine that is not connected to the network or to the RightFax server (such as a thermal fax machine), no record of the fax is stored on the RightFax server. In FaxUtil, you can record such a fax transmission on the RightFax server for tracking purposes. The Sent, Received, and Pages options in this dialog box let you specify information about the fax. These options are available when you select Fax > Record Manual Fax in FaxUtil.
Adding Cover Sheet Notes
A cover sheet contains fields that are populated with recipient and sender data when the fax is generated. It may also contain a field for notes. Click the Cover Sheet Notes tab to add cover sheet notes or comments.

Figure 25.2 The Fax Information Dialog Box Cover Sheet Notes Tab

Notes to be Placed on the Cover Sheet Type the notes that you want to appear on your fax cover sheet. You can enter up to 21 lines of text, up to 69 characters each.

Text Limit This displays the current number of lines in your note and the number of lines remaining. Although it is possible to enter more than 21 lines of text, only 21 can be displayed on the cover sheet. If you exceed 21 lines, the computer will beep and an error message will appear in this box.

Comments for your Records This is a comment for your own use only. This text is not sent to the fax recipient. Text you enter in this box will appear in your FaxUtil mailbox in the Comments column.

Attaching Files
You can fax two types of documents as attachments: library documents and documents in their native file format. Library documents are frequently faxed documents that your fax administrator has stored on the fax server. Native documents are electronic document files that you have saved on your local computer or on a server (such as Microsoft Word DOC files). You can attach any of the file types supported by the RightFax document conversion engine (described in Appendix B, “File Formats that Convert to Fax Format”), and you can attach as many files to a fax as you want.
To work with attachments, click the **Attachments** tab on the **Fax Information** dialog box. If you began the fax process with a stored document or by printing a document within an external application, that document is automatically attached to the fax and appears in the list of attachments.

Figure 25.3 The Fax Information Dialog Box Attachments Tab

This box lists the library documents and native document files you have attached to the fax. Each of your attachments will be added to the fax in the order it is listed here. To move an attachment up or down, select the attachment and click the arrow keys. To remove an attachment, select it and click the **Delete** button [X]. To preview an attachment, select the attachment and click the View Fax (magnifying glass) button.

To add more attachments to the fax, choose one of the following:
- Click **File Attachments** (paperclip), then choose a file to attach.
- Click **Library Documents**, then choose from the library.
- Click **Scanned Documents**, then specify a scanner and click **Start Scan**.

The new attachment appears in the list.

If you are sending to an email address and you have attached a native document file, the check box in the **Native** column will be enabled. Check this option to send the file in its native document format as a file attachment to the email message, rather than rendering the document into a fax image. Using this option, you can attach files of any type, including file types that cannot be rendered as images (such as WAV files). In addition, form overlays cannot be applied to attachments when the Native option is selected.

**Note** Because most email client applications support plain ASCII text files, these files can almost always be used as email body text. Many email client applications also support HTML and rich text format (RTF). If the file type you specify is not supported by your recipient’s email client application, it will be ignored.
Entering Additional Processing Options

Recipient Notify Address  Enter an SMS address to receive an SMS/pager notification of a new fax.

Recipient Fax ID  Specify the exact remote fax ID of the intended recipient’s fax machine or server. When this feature is enabled, the fax will not be sent unless the remote ID matches the ID specified. You can use the asterisk (*) and question mark (?) wildcards if you are not sure of the exact ID. Asterisks represent zero or more characters or digits. Question marks represent exactly one digit or character each. This feature is supported for Brooktrout fax boards only.

Use Form  Select this check box to add an overlay form to the fax. To specify the form file to use, click the arrow to open a list all available forms. For more information on forms, see Chapter 12, “Creating Overlay Forms”.

Cover Sheet File  If your user profile includes permission to change fax cover sheets, you can select a cover sheet in this list.

Priority  Specify the priority that is assigned to the fax. Select low, normal, or high priority from the list. If you do not have the Can Use High Priority permission checked in your RightFax user profile (see “The Permissions tab” on page 98), the “High Priority” option will not appear here.

Automatic Deletion  Specify when sent faxes should be automatically deleted from your FaxUtil mailbox.

From  Enter your name, fax number, phone number, and other contact information. This information will appear on the fax cover sheet.

Using Embedded Codes

Note  The embedded codes described in this section are not supported on fax cover sheets. Cover sheets support a separate list of cover sheet codes. For information about fax cover sheets and cover sheet codes, see Chapter 21, “Creating Fax Cover Sheets” on page 197.

Embedded codes are special faxing instructions that you insert into documents created in other applications. You can use embedded codes to include fax cover sheet information, attach library documents, add billing information, and more.

To add an embedded code to a document, type the code you want, along with any required parameters, between angle brackets. For example, an embedded code that provides the destination fax number is written like this:

<TOFAXNUM:555-1212>

The RightFax server removes all embedded codes from a document when it converts the document to fax form, so they don’t appear in your final fax. If you type an embedded code incorrectly, it will be ignored by the RightFax server and will be included in your
fax. Embedded codes can be written in either upper or lower case. Embedded codes always work the same way regardless of the application used to create the document.

**Note:** In very large documents that use embedded codes, the prescanning process can cause the FaxServer to appear unresponsive. You can specify the maximum length of time for embedded code processing by editing the Windows registry "PrescanTimeoutSeconds" value as described on page 344.

Although you can use any fonts you want in the text of your documents, embedded codes must always use a native printer font. This is because when the document is converted to PCL5 format, all other font types are encoded as graphic images. Only native printer fonts are stored in the PCL file that the document is generated from in their original text format. And it is this text in the PCL file that is replaced. If you do not use native printer fonts for your embedded codes, the codes themselves will appear in the instead of being replaced by the information or instruction they represent. All embedded codes are surrounded by angle brackets (< >) which must also use the same native printer font.

Embedded codes can be placed anywhere in the document that you will be faxing and can be used in any document that accepts text characters. Embedded codes cannot line wrap and any embedded code statement that is so long that it wraps to a second line will be ignored.

For a complete list of embedded code keywords, descriptions, and their correct syntax, see Appendix A, “RightFax Embedded Codes”.

### Viewing Received Faxes

FaxUtil displays information about the sent and received faxes for each user. The left side of the FaxUtil window displays a folder tree that sorts the faxes. The right side of the window displays a list of the fax documents. A series of icons across the top of the window displays actions you can take (such as view, delete, print, or forward) for each selected fax.

### FaxUtil Folder Tree

The left side of the FaxUtil window includes the following folders:

- **All** displays all faxes
- **Main** displays all faxes except for those manually moved to other folders
- **Other Users** (optional) this folder appears only when the user is a RightFax administrator, group administrator, or delegate.

In addition, each user can create custom folders for storage of faxes by category. Faxes must be moved to the custom folders manually.

### Viewing Other Users

RightFax administrators, group administrators, and delegates all have the ability to view the mailboxes of other RightFax users. If you have the ability to view other mailboxes, an **Other Users** entry is included in your FaxUtil folder tree.

1. Click + next to **Other Users** in the folder tree to expand the list. The first level of the list will display Group names.
2. Click any group name to display the names of users in that group. Users not assigned to a group will be displayed in the default group **Everyone**.
3. Continue to expand the tree as necessary until you have listed the user mailboxes that you want.
4. Click any user name to display the faxes for that user.

### Working with Folders

To create a new folder and move faxes to it:

1. Right click on any of the folder names and choose **New**.
2. Enter a name for the folder.
3. From the list of faxes, right-click on any fax name and choose **Move to Folder**.
4. Click the folder where the fax should be stored, then click **OK**.
**FaxUtil List of Faxes**

The right side of the FaxUtil window displays information about the sent and received faxes, including date and time of transmission, number of pages, and status of transmission. Newly received faxes that have not yet been viewed are displayed in a bolder font than viewed faxes. There is also a series of status flags that indicate which actions have been performed on each fax.

**Task Flags**

The first few columns before the Date/Time column contain symbols that indicate the tasks that have been performed on each fax:

- **Sent/Received** An arrow pointing up indicates a sent fax; an arrow pointing down indicates a received fax. A curved arrow indicates that the fax has been forwarded.
- **Viewed** A magnifying glass icon appears for each fax that has been viewed.
- **Printed** A printer icon appears for each fax that has been printed from FaxUtil.
- **Converted with OCR** A document icon appears for each fax that has been converted from image to text using Optical Character Recognition (OCR). The resulting text displays in a separate tab on the RightFax Viewer.
- **Converted to PDF** A rectangular icon appears for each fax that has been converted from image to Portable Document Format (PDF). The resulting PDF file displays in a separate tab on the RightFax Viewer.
- **Certified, Secure, or Email** An envelope icon indicates that the fax has been delivered by email, or secure email. A globe icon indicates certified delivery. For more information on secure mail, see the OpenText RightFax SecureDocs Guide.

**Sorting the List of Faxes**

By default, the list of faxes appears in order by date with the most recent fax on top of the list. You can change the order in which faxes are listed as follows:

- Click any column header in the document list to sort the documents in that column in ascending order.
- Click the same column header again to sort the documents in that column in descending order.
- Right-click any column header to open a list of filter options.

**The RightFax Viewer**

To view a fax, open the RightFax Viewer by double-clicking any fax in your list. The RightFax Viewer shows the first page of the fax. You can scroll through additional pages, if any, by clicking the Go to Next Page or Go to Previous Page icons at the top of the Viewer.

Additional icons at the top of the Viewer let you save, print, or delete the displayed image, display the next or previous fax in the list, or forward or route the displayed fax to other RightFax users. Additional views of each fax may be available by clicking the tabs across the top of the image as follows:

- **Enhanced Image** When enabled for a user, both the enhanced image and the original received image will be available in the RightFax Viewer. If you route or forward to a RightFax user, both the original image and the enhanced image will be sent. If you forward to a destination outside of your RightFax system, only the original image will be sent.
- **OCR** The OCR tab will only appear if you have the Optical Character Recognition (OCR) feature enabled and have performed OCR on this fax. If you route or forward to a RightFax user, both the original image and the OCR text will be sent. If you forward to a destination outside of your RightFax system, only the original image will be sent.
PDF  The PDF tab will appear only when viewing sent documents for which you have created Portable Document Format (PDF) output. To view PDF images in FaxUtil, you must have installed Adobe Acrobat Reader version 4.0 or higher.

History  This tab is available for all faxes. It displays information about the fax transmission as well as information about tasks performed on the fax such as viewing, forwarding, or annotations.

Annotations
You can add notes or graphics on top of any original image or enhanced image. These annotations will be stored with that document. To annotate a document:

1. Open a fax in the RightFax Viewer.
2. To display the annotation tools, from the RightFaxViewer Tools menu, choose Options, and then select the Annotation Toolbar checkbox.
3. Click the tab for the image that you want to annotate.

   Note  If the image you want to annotate is displayed when you turn on the Annotation Toolbar, you’ll need to select another tab (such as History) and then reselect the image tab before the annotation tools will appear.

4. Click any of the annotation tools, then click and drag the mouse on your image to create the annotations. Choices include a hollow rectangle, a hollow circle, a solid rectangle, a solid circle, a text box, and a straight line.
5. When your annotation is complete, choose Save from the File menu.

Forwarding and Routing Documents
There are two ways to send a received fax to someone else:

- When you forward a document from your FaxUtil mailbox, a copy of the document is sent to the recipient and the original document remains in your mailbox.
- When you route a document, the original document is sent to the recipient and is removed from your mailbox.

1. Select the document from your received fax list and click the appropriate icon on the tool bar:
   - Forward to New Number
   - Forward to User
   - Route to User

2. If forwarding to a new number, complete the addressing boxes in the Fax Information dialog box. If sending to another RightFax user, double-click each user who should receive the document.

3. Click OK to send.

Note: If you route or forward to a RightFax user, the original image, enhanced image, and OCR file (if any) will be sent. If you forward to a destination outside of your RightFax system, only the original fax pages will be sent.
Splitting Faxes

You can split any fax in your FaxUtil mailbox into multiple faxes. Each of the new faxes will have a status of “Information Incomplete” until you specify addressing information for forwarding or routing.

To split a fax:

1. Select a multi-page document from your FaxUtil list and click the Split Fax icon on the tool bar.

2. Specify the pages of the original fax that you want included in each of the new faxes. You can specify a single page or a range of pages for each fax. Separate the output faxes with commas.

   For example, if you have a 5 page fax, and want to create one fax with the first 3 pages and another fax with just the last page, you might enter:

   1-3, 5

3. (optional) You can click the View Fax button to view the original fax.

4. Select the Keep Original Fax check box to store both the new split faxes and the original fax. Clear the check box to remove the original fax after the split.

5. Click OK to create the new faxes you specified and return to the FaxUtil mailbox.

6. You can route or forward the new faxes with the standard Fax Information dialog box.

Combining Faxes

You can combine any number of faxes in your FaxUtil mailbox into a single fax. To combine several faxes into one fax:

1. Select two or more faxes from your FaxUtil list and click the Combine Fax icon on the tool bar. The selected faxes appear in a list in the Combine Fax window in the order in which they’ll be placed in the new fax.

2. From the Combine Fax window, you can select any fax in the list, then move it up or down in the list, remove it from the list, or specify specific pages that you want included.

3. (optional) You can click the View Fax icon (magnifying glass) to view a selected fax.

4. Click Combine to create the new fax with each of the original faxes as attachments. The Fax Information window appears.

5. Complete the addressing information then click OK to send the new fax.

Managing Faxes

Monitoring Transmission Success and Failure

Use FaxUtil to monitor the transmission of your faxes. A transmission is successful if the RightFax server made a connection, transmitted the information across the line, and received information from the target fax machine indicating that the fax information was received.

If a transmission attempt is not successful, it will be retried. While a fax is being retried, it will appear with a yellow status icon in the sender’s FaxUtil mailbox. If the fax has not been successfully sent after the specified number of attempts, it will be abandoned and saved in the sender’s FaxUtil mailbox with a red status icon.

For information about specifying retry counts and intervals, see “Retry settings” on page 19.
For a complete list and description of RightFax error messages, see Appendix C, “Error and Status Messages”.

**Fax Approval**

RightFax can be configured to hold outbound faxes for approval by an administrator before sending. Only RightFax administrators, group administrators, and group alternate administrators can view and approve these faxes.

To require fax approval for a user

1. Edit the user profile in Enterprise Fax Manager (see “Editing user properties” on page 97).
2. On the Permissions tab, select the Must Have Faxes Approved check box.

To view a list of all faxes waiting for approval

1. Run FaxUtil.
2. On the List menu, click Administrative Mode to view the contents of all fax mailboxes for which you are an administrator.
3. On the List menu, click Needing Approval to display faxes waiting for approval.
4. To approve or disapprove a fax, right-click the fax and select Status > Approve Fax or Disapprove Fax. You can add a note (up to 450 characters) that will be stored with the date and your user ID in the fax history. You can also delete the fax rather than approve or disapprove it. If the fax is approved, it is immediately scheduled to send. If the fax is not approved, it is assigned a status of “ED: Approval Denied” in the original sender’s FaxUtil mailbox.

**Approving Faxes Blocked by Dialing Rules**

Faxes that are blocked by dialing rules can be approved for transmission by RightFax administrators. Group administrators and alternate group administrators cannot approve faxes.

To approve a fax blocked by a dialing rule

1. Logon to FaxUtil as an administrator.
2. On the List menu, click Administrative Mode to view the contents of all fax mailboxes for which you are an administrator.
3. On the List menu, click Needing Approval to display faxes waiting for approval.
4. To approve or disapprove a fax, right-click the fax and select Status > Approve Fax or Disapprove Fax. You can add a note (up to 450 characters) that will be stored with the date and your user ID in the fax history. You can also delete the fax rather than approve or disapprove it. If the fax is approved, it is immediately scheduled to send. If the fax is not approved, it is assigned a status of “ED: Approval Denied” in the original sender’s FaxUtil mailbox.

**Controlling Deleted Faxes**

By default, RightFax will retain the image files of faxes that have been deleted from FaxUtil until all corresponding database records have been removed. To configure RightFax to immediately delete fax images:

1. Open the Windows Registry on the RightFax server.
2. Browse to the subkey of HKLM\Software\RightFax\FaxServer.
4. Edit this entry to contain a value of 0.
5. Restart the RightFax services.
RightFax works with portable document format (PDF) files in three ways:

- Users can specify that they want incoming faxes delivered to their email boxes as PDF files. The default RightFax configuration can convert received faxes to standard PDF before routing; the optional RightFax Searchable PDF Module license is required to convert to received faxes to searchable PDF.
- When sending faxes by email, users can attach existing PDFs to their emails. If the attachments are not yet in PDF, RightFax can create PDF files in either standard or password-protected formats. Password protection, also called “encrypted delivery”, requires the optional RightFax SecureDocs Module (see the SecureDocs Guide).
- RightFax can convert PDF documents into TIFF image files for faxing. The optional RightFax PDF Module is required to convert PostScript or PDF files to TIFF format.

Converting Received Faxes to PDF

You can specify PDF as the inbound routing delivery format for each user.

1. In Enterprise Fax Manager, from the User Edit Inbound Routing tab, select any of the routing types for which PDF is available (such as Microsoft Exchange or Network Directory).
2. Select either of the two PDF options:
   - Select PDF to deliver faxes as PDF files to the user’s email.
   - Select PDF (Searchable) to deliver a searchable PDF to the user’s email (requires the RightFax Searchable PDF Module license). For more information, see “Using the PDF Module to Convert PDF Files for Faxing” on page 242.

Creating and Sending a PDF by Email

Depending on your licensed options, you can use RightFax to create PDF files for email delivery in three ways:

- To convert attachments to PDF, select the Create PDF checkbox on the Fax Information dialog box. When viewing the sent fax in FaxUtil, the attachments will be displayed in their own PDF tab.
If you have licensed the RightFax SecureDocs module, you have two more options available in the Fax Information dialog box:

- Add a password to the PDF. Select the **Create PDF** checkbox, then click the PDF options (...) button to specify the password and the functions to be protected. See the SecureDocs Guide for more information.
- Create and store the PDF on a web site for certified delivery, select the **Use Certified Delivery** check box. The recipient will receive an email containing a link to the PDF and instructions for opening it.

### Using the PDF Module to Convert PDF Files for Faxing

When this module is activated, you have the option to use a PostScript print driver to create the RightFax printer on each RightFax client computer. RightFax users can print native PostScript and PDF documents directly to the RightFax printer, and also send rich PDF files (files that include full color and editable data) to e-mail addresses.

**Important** The RightFax PDF conversion engine does not support conversion of PDF files that contain embedded TrueType (CID) fonts that use “Identity-H” encoding.

### Activating the PDF Module on the RightFax Server

The files required by the RightFax PDF Module are installed on all RightFax servers during the server installation, however, the PDF Module must be licensed and activated before its functionality is enabled.

To activate the PDF Module, you must have licensed a RightFax server type that includes this module, or purchased and licensed this module separately. For information on activating new components on the RightFax server, refer to the RightFax Installation Guide.

After the RightFax PDF Module has been activated on the RightFax server, you must enable PostScript processing on at least one RightFax WorkServer module (described in the next section) and copy the PostScript fonts you want to support onto the RightFax server.

### Enabling PostScript Processing on a WorkServer

After the PDF module is activated, run the WorkServer configuration program from Windows Control Panel on the RightFax server to display the WorkServer Configuration dialog box. In the component tree in the left pane, select the WorkServer that you want to perform PostScript processing. You can enable PostScript processing on as many WorkServers as you want.

![Figure 26.1 The WorkServer Configuration dialog box](image)

To enable PostScript processing, click **PostScript** in the Services list.
Adding PostScript Fonts

To correctly convert Type 1 PostScript fonts in PostScript and PDF files, the fonts must be copied into the RightFax\Shared Files\PDF\PSFonts\Font folder. When it is activated, the RightFax PDF module supports 35 basic PostScript fonts including Times, Helvetica, Courier, and Symbol.

To add additional font conversion support, copy the PostScript fonts you want to support into the RightFax\Shared Files\PDF\PSFonts\Font folder on the RightFax server. Be sure to include both the .pfm and .pfb components of the PostScript fonts.

Adding a Margin Before Conversion

When PDF files have images that go to the edge of the page, part of the image may be cut off and replaced with a margin during conversion. To reduce the size of the page slightly before conversion so that the margin does not cut off any content, set the Windows registry ShrinkToView value on each machine running the conversion WorkServer. See “ShrinkToView” on page 351 for more information.
RightFax phonebooks store fax addressing information (such as name, fax number, and phone number) in a single location so you can easily apply all fax destination information when addressing an outgoing fax. You can also create group phonebook entries that contain fax addressing information for multiple fax recipients. RightFax users can choose to use the phonebook built in to the RightFax FaxUtil client or can link to existing ODBC, LDAP, or MAPI contact lists.

You can use phonebooks or other databases containing contact information to send fax broadcasts. Fax broadcasting sends a single fax to multiple recipients without addressing each fax individually.

Using the RightFax Phonebook

The RightFax phonebook is a fax recipient database customized for each RightFax user. Because each user’s phonebook is unique, all phonebook functions are managed from within the FaxUtil client application.

For information on using phonebook entries to address outgoing faxes, see “Specifying Addressing Information” on page 230.
Creating an individual phonebook entry:
1. Click the Phonebook button in the FaxUtil toolbar.
2. Click the New Entry button.
3. Enter a name for the phonebook entry in the ID field, then complete the addressing fields. You must include at least a name and fax number to be able to send a fax to this recipient.
4. Check any options you want and click OK. The new entry will immediately appear in your phonebook preceded by an "individual" icon.

Creating a group phonebook entry:
You can combine several individual entries into a group entry. When choosing a fax recipient, you can choose the group just as you would an individual. The fax will be sent to all members of the group. Before you create a group, create the individual phonebook entries for each member of the group.
1. Click the Phonebook button in the FaxUtil toolbar.
2. Select the phonebook entries you want to add to the new group. You can add both individual entries and group entries to a group. Press SHIFT and click to select a range of entries. Press CTRL and click to select multiple separate entries.
3. When all the entries you want in the group have been selected, click the New Group button.
4. Enter a name for the phonebook entry in the ID field.
5. Check any options you want and click OK. The new entry will immediately appear in your phonebook preceded by a group icon.

Importing Entries Into the RightFax Phonebook
You can import entries into your personal phonebook from a specially formatted text file.

Creating a file to import
The file used to import phonebook entries is typically generated by an existing database of contact information. This must be an ASCII text file with each phonebook entry separated by a line break. Each entry is made up of one or more phonebook fields. The following table lists each of the valid phonebook entry fields in the order the fields appear in the file.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Maximum length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>17</td>
<td>A unique ID used only to reference the phonebook entry. It never appears on the fax</td>
</tr>
<tr>
<td>Name</td>
<td>59</td>
<td>The recipient’s name as it will appear on the fax cover sheet</td>
</tr>
<tr>
<td>Company</td>
<td>59</td>
<td>The recipient’s company name as it will appear on the fax cover sheet</td>
</tr>
<tr>
<td>Address</td>
<td>59</td>
<td>The recipient’s address as it will appear on the fax cover sheet</td>
</tr>
<tr>
<td>CityState</td>
<td>59</td>
<td>The recipient’s city and state as they will appear on the fax cover sheet</td>
</tr>
<tr>
<td>Fax1</td>
<td>31</td>
<td>The recipient’s primary fax number. This is used when dialing the fax destination and may appear on the fax cover sheet</td>
</tr>
<tr>
<td>Fax2</td>
<td>31</td>
<td>The recipient’s alternate fax number. This is used when dialing the fax destination and may appear on the fax cover sheet</td>
</tr>
<tr>
<td>Voice1</td>
<td>31</td>
<td>The recipient’s primary voice number as it will appear on the fax cover sheet</td>
</tr>
<tr>
<td>Voice2</td>
<td>31</td>
<td>The recipient’s alternate voice number as it will appear on the fax cover sheet</td>
</tr>
</tbody>
</table>
The fields must be separated by either commas, tabs, or spaces. If quotes are used around each field, they must be placed around every field in the file.

The first line in the file is used to specify what data fields are included for each entry. This line uses the same format as the individual phonebook entries, but specifies the data fields being imported using the field names from the table above. The phonebook entries that follow must include all the same data fields in the same order that they are listed in the first line.

If a data field in any of the entries is left empty or contains no data, the import will fail. Any unpopulated fields that you want to include in this file must be indicated using a single space bounded by double-quotes.

Sample phonebook import file

The following is a short example of a file that can be imported into your RightFax phonebook. Some unpopulated data fields are illustrated in the last entry.

"ID","Name","Fax1","Company","CityState"
"Bob","Bob Jones","444-3333","Acme","Tucson AZ"
"Jane","Jane Doe","555-1212","","

For information on outputting a properly formatted text file from your contact database, refer to the documentation for your contact database management application.

Using FaxUtil to import the phonebook entries

After you have created the text file to import from, run FaxUtil, and select Phonebook Import from the Tools menu. The Phonebook Import dialog box opens. Complete each box according to the format of the file you are importing. When all boxes are complete, click Import to import the entries.

Import File  Enter the path and file name of the text file to import. Click Browse to search for and select the file.

Quotes Around Fields  Fields in the text file you import can be surrounded by, but do not require, quotes. If quotes are used, they must be used on every field in the file. You cannot mix fields with quotes and fields without quotes. Select this check box only if your data fields are surrounded by quotes.

Publish Imported Entries  Select this check box to make each new imported entry published. Published entries can be accessed by other RightFax users; unpublished entries can be accessed only by you and the RightFax administrator.

Text Format  Select the text mode of the file to import. If your text application doesn’t specify whether it’s using OEM or ANSI text, select OEM. If accented or other special characters do not import properly, re-import the file and select ANSI.

Field Delimiter  Specify which type of character, a comma, tab, or space, is used to separate the individual fields in each phonebook entry in the file.
**Duplicate ID Handling**  You have the following options for handling imported entries that contain IDs that already exist in your phonebook:

- **Replace Existing Entry** replaces any existing entry in the phonebook with the imported entry containing the duplicate ID.
- **Replace After Confirmation** replaces existing entries only if you agree to a confirmation prompt.
- **Generate Unique IDs** adds a number to the end of duplicated IDs in order to make the new ID unique.
- **Skip** ignores any entry in the import file with a duplicate ID.

**Saving phonebook entries**

Phonebook entries can be saved to a comma separated values file (.CSV) using the Phonebook dialog box.

1. Run FaxUtil, and select **Phonebook** from the **Tools** menu. The **Phonebook** dialog box opens.
2. Select a user or group of users. The **Ctrl** and **Shift** keys can be used for this purpose.
3. After selecting users to save, right-click the filter bar and choose **Save Contents As**. The **Select Export File** window opens.
4. Choose a location to save your file, enter a file name and click **Save**.
5. Click the **Close** button when finished.

**Using MAPI Phonebooks**

RightFax also integrates with MAPI-compliant contact lists such as Microsoft Exchange address lists and Outlook contact lists. In order to access MAPI contact lists, each client workstation must have MAPI installed.

MAPI address books and contact list profiles are created by Exchange, Outlook, and other MAPI-compliant applications. Because these profiles conform to a universal standard, you do not need to configure the MAPI-to-RightFax connection.
To select a recipient from a MAPI source

1. In the Phonebook dialog box, click MAPI. The Choose Profile dialog box opens.

   Figure 27.3 The Choose Profile Dialog Box

2. Select the MAPI profile name in the Profile Name box, and then click OK. The Enter Password dialog box opens.

3. Enter your network user name, domain, and password, and then click OK. This will open the MAPI contact list.

4. Double-click each contact entry to add it to the Fax Destinations list. When you have all the contacts you want, click OK. The MAPI contacts will appear in the Phonebook dialog box in the Current Recipients list.

Configuring ODBC drivers on the client workstation

Because every database is different, this document cannot provide specific instructions for configuring the ODBC drivers on your workstations. Note the following guidelines:

- Verify that you have the 32-bit version of ODBC installed on your system by opening Windows Control Panel and running the ODBC program to display the ODBC Data Source Administrator.
- Note the user ID and password that is used to log on to the database or database server. You will use this ID and password in the RightFax ODBC configuration.
- After you have configured the drivers on your workstation, create a data source under a User DSN or System DSN in the ODBC Data Source Administrator.

Configuring RightFax for ODBC connectivity

After the workstation has had ODBC drivers correctly installed, you must map the ODBC fax contact information to the corresponding fields in RightFax.

To configure ODBC in RightFax

1. Display the list of ODBC phonebooks in either of the following ways:
   - Click the RightFax tray icon in the taskbar and select ODBC Configuration
   - In the FaxUtil Phonebook dialog box, click Configure Phonebooks and choose ODBC Configuration.

Using ODBC Phonebooks

RightFax can connect to an existing ODBC database in order to use your organization's existing contact database information for addressing faxes. This is especially useful for sending fax broadcasts to large numbers of recipients.

There are two parts to configuring ODBC connectivity: general ODBC configuration and RightFax-specific ODBC configuration. Each workstation must be configured individually for both types of ODBC information.
2. Click **Add** next to **ODBC Phonebooks** to create a new ODBC source or select an existing phonebook and click **Edit**. The **Configure ODBC Phonebook** dialog box opens.

Figure 27.4 The Configure ODBC Phonebook Dialog Box

3. In the **Phonebook Name** box, enter a descriptive name for this contact database.

4. In the **ODBC Source** box, enter the name under which this database appears in the **User DSN** tab of the ODBC program in Control Panel.

5. Under **Select**, use simple SQL queries to relate ODBC database fields to each of the listed RightFax phonebook fields. Enter two single-quotes (""") in any field you want to leave blank. If you are familiar with SQL code, you can create this information quickly and enter it in the **Select** boxes. If you are not familiar with SQL code, you should use a tool such as Microsoft Query to generate the SQL code for you, and then cut and paste the codes into the **Select** boxes.

   **Note** SQL queries also let you combine multiple ODBC source fields in a single RightFax field. This is useful, for example, if your database contains separate fields for first, middle and last names. Because RightFax has only one “Name” field, each of these source fields should be combined into the single RightFax field.

6. In the **From** and **Where** boxes, enter the SQL information specified by the query results.

7. To presort the data, enter the necessary SQL data in the **Order** box, however this should not be necessary because RightFax can sort phonebook entries by column after it retrieves the data.

8. Specify the **ODBC User ID** and **ODBC User Password** required to access the database information. If the ID and password match those used to log in to FaxUtil, you can select those check boxes instead.

9. If you have a large database, limit the number of records loaded at one time in the **Records to Load at Once** box.

**Using ODBC phonebooks to send faxes**

After you have configured your ODBC information, you can access these contact records as phonebook entries when addressing faxes via the **Fax Information** dialog box (see “Specifying Addressing Information” on page 230).

Click **Phonebook** and select the **ODBC Phonebook** tab, and a list of contacts opens. If you limited the number of records displayed at one time, you will see only that number of records. To view the previous or next increment of records click the arrows on the far
right side of the table. Click one or more records and click OK to address the fax. The new fax will be sent to each of the specified recipients.

LDAP Phonebooks

RightFax allows users to connect to an existing LDAP database in order to use your organization’s existing contact database information for addressing faxes. This is especially useful for sending fax broadcasts to large numbers of recipients. LDAP phonebooks are only accessible from Windows XP, Windows Vista, and Windows 7 workstations.

Configuring RightFax for LDAP connectivity

In order for RightFax to work with your LDAP database, you must map the LDAP fax contact information to the corresponding fields in RightFax.

To configure LDAP in RightFax

1. Display the list of LDAP phonebooks in either of the following ways:
   - Click the RightFax tray icon in the taskbar and select LDAP Configuration
   - In the FaxUtil Phonebook dialog box, click Configure Phonebooks and choose LDAP Configuration.

2. Click Add to create a new LDAP source or select an existing phonebook and click Edit. The Configure LDAP Phonebook dialog box opens.

3. In the Phonebook Name box, enter a descriptive name for this contact database.

4. In the LDAP Server box, enter the name of the LDAP server. Specify the server’s IP port in the IP Port box.

5. Under Attribute Mappings, map the LDAP fields that correspond to the listed RightFax fields. In addition, you can filter the number and type of entries returned to RightFax.
6. If you have a large database, limit the number of records loaded at one time in the **Records to Load at Once** box.

**Note** The LDAP User ID field is limited to 47 characters.

**Using LDAP phonebooks to send faxes**

After you have configured your LDAP information, you can access these contact records as phonebook entries when addressing faxes via the **Fax Information** dialog box (see “Specifying Addressing Information” on page 230).

Click **Phonebook** and select the LDAP database, and a list of contacts opens. If you limited the number of records displayed at one time, you will see only that number of records. To view the previous or next increment of records click the arrows on the far right side of the table. Click one or more records and click **OK** to address the fax. The new fax will be sent to each of the specified recipients.

**Fax Broadcasting**

You can send one fax to hundreds or thousands of recipients at once. This is called sending a “fax broadcast” or “fax broadcasting.”

The RightFax server provides three methods for sending a fax broadcast.

- Fax broadcasting from phonebooks.
- Fax broadcasting from a mail merge.
- Fax broadcasting from a database.

The method you choose for your fax broadcast should be determined by the nature of the fax broadcast as well as the source of the fax contact information.

**Note** When broadcasting the same document to a large number of people, it is generally better to store the fax as a library document. As a library document, the fax is already stored in TIFF G3 format and will not need to be converted again for faxing. If a fax is not saved as a library document and is broadcast to 500 recipients, the WorkServers will have to perform 500 separate PCL-to-TIFF G3 conversions.

**Fax broadcasting from phonebooks**

The easiest way to send a fax broadcast is to select **Quick Fax/Broadcast** from the RightFax tray icon, and then, in the **Fax Information** dialog box, click **Phonebook** to open your RightFax, ODBC, LDAP, or MAPI phonebook (as described earlier in this chapter). From each of these phonebooks you can specify multiple recipients for your fax. The biggest advantage of using phonebooks for fax broadcasts is convenience. After a phonebook is created, faxing to one or more contacts in the phonebook is as easy as clicking the desired contacts in the list.

Fax broadcasting from your RightFax or MAPI phonebook is most useful for small fax broadcasts to your personal contacts. This is because these phonebooks are typically used only for private contact management and exist separately from your organization's primary contact data source. Fax broadcasting from your ODBC or LDAP phonebook is better geared towards large fax broadcasts because these phonebooks can be dynamically linked to your organization’s primary contact data source.

Using your phonebooks for fax broadcasts has some disadvantages. First, all recipients receive the same fax body pages. Although each cover page has the correct contact information, the body of the fax cannot be not customized to each recipient. Also, the fax broadcast must be specifically initiated by someone and the contacts to fax to specified manually.
Fax broadcasting from a mail merge

You can also send a fax broadcast using a mail merge from applications such as Microsoft Word or Microsoft Access. The benefit of a mail merge is that each individual fax can be personalized or customized to fit the recipient. The main drawback, however, is that each individual fax page must be converted from its native format to the TIFF-G3 format, which can slow down the rate at which faxes are sent and delay other fax server processes, especially during very large fax broadcasts.

To send a fax broadcast using mail merge, you must create a document in a native application that supports mail merges. This document must contain all necessary fax addressing information in the form of embedded codes (described in Appendix A, "RightFax Embedded Codes"). Each fax addressing embedded code then uses the mail merge variables instead of specific fax addressing information.

After the document is created, each mail merged version of the document must be printed as a separate print job to the RightFax print queue. Depending on the application you use to generate the mail merge document, you must create some type of macro that instructs the application to send each mail merge document as a separate print job.

In addition, you must print mail merge fax broadcasts to a RightFax printer that does not automatically prompt you for fax addressing information. To create a RightFax printer that does not automatically open the Fax Information dialog box, click the RightFax tray icon and select Configuration. Click Create Fax Driver and select Create PCL-5 Fax Driver. Enter a name for the printer and specify the fax server to which jobs should be sent. This new printer will be listed under Fax Printers in the Configure Fax Printers dialog box. Finally, move the new printer to the Available Printers list. This printer will still output to the fax server but will not prompt you for fax addressing information.

The following is an example of a mail merge document created in Microsoft Word (merge fields are shown as they would appear if the Field Codes option in the View menu in Word is enabled).

```
<FORMTYPE:letterhead><TONAME:{mergefield Name}>
<TOFOAXNUM:{mergefield FaxNumber}>
<TOCOMPANY:{mergefield Company}>
{mergefield Name}
{mergefield Company}
{mergefield Address}
Dear {mergefield Name}
Thank you for remitting payment.
Sincerely,
```

If this letter is merged with a list of ten names, Word will create a single document with ten copies of the letter, each separated by a section divider. Normally you could just print the new document and all ten sections would be output as a single print job to a network print queue. However, if you were to print the document this way to the RightFax fax printer, you would get one fax with ten
pages and it would be addressed to the person referenced by the last set of embedded fax codes. For Word to output ten separate print jobs, you can use this Word XP macro.

```vba
Attribute VB_Name = "NewMacros"
Sub SendFax()
'Attribute SendFax.VB_Description = "Macro created 1/21/2003 by Peter A. Schott"
'Attribute SendFax.VB_ProcData.VB_Invoke_Func = "Normal.NewMacros.SendFax"

' SendFax Macro
'Macro created 1/21/2003 by Peter A. Schott
'
'Remove comments from appropriate lines for your configuration
'Adjust FaxPrinter variable for your RightFAX Printer (without prompts)

Dim TotalSec, i, CurrentSection
Dim OldPrinter 'Used to store old printer name
Dim FaxPrinter 'Can be customized for RightFax Printer (no messages) name
FaxPrinter = "\RIGHTFAX\HPFAX"

TotalSec =
Selection.Information(wdNumberOfPagesInDocument)
'OldPrinter = ActivePrinter
'Application.ActivePrinter = FaxPrinter
For i = 1 To TotalSec
CurrentSection = "s" + Trim(Str(i))
ActiveDocument.PrintOut Copies:=1,
Range:=wdPrintFromTo, From:=CurrentSection, To:=CurrentSection
Next i
'Application.ActivePrinter = OldPrinter
End Sub
```

**Note** If you use a different word processor or a different version of Word, you will have to modify this macro to meet your application’s specific requirements.

This macro first counts the number of letters to print by jumping to the bottom and obtaining the current section number (subtracting one because there is always an extra section break inserted during the *Merge To New Document* operation). Next, the macro starts a loop, executing a print range from 1 through the total number of sections. Because the print range is prefixed with "S," the print command prints all of the specified section, no matter how many pages are in each section.

In the previous example, the Word document itself is broadcast. In some cases, however, you can want to send a RightFax library document to a group of people using a mail merge. This Word document could be used to fax broadcast only the library document “Promo1.”

```xml
<LIBDOC:Promo1><TONAME:{mergefield Name}>
<TOFAXNUM:{mergefield FaxNumber}>
<TOCOMPANY:{mergefield Company}>
<NOTE: This is the first cover sheet notes line>
<NOTE: This is the second.>
```

Then, using the Word print macro, only the library document “Promo1” will be broadcast.

**Fax broadcasting from a database**

Fax broadcasting from a database uses the scripting power of your contact database with the faxing capabilities of RightFax. There are a virtually unlimited number of possible variations on this method.

The main benefit of fax broadcasting from a database is that the fax broadcast can be partially or completely automated depending on the database you use. You also have the added flexibility of sending the same document to all recipients, such as a library document, or customizing each document for each recipient. The drawback to
this fax broadcasting method is that it can be highly complex and may require substantial programming in your database’s scripting language.

The following figure shows how fax broadcasting can work with databases. This example is intended only to provide database administrators with the fundamental concept of database fax broadcasting. You must apply these concepts when developing a customized database fax broadcast in your own environment.

In the following example, FoxPro is used to send the library document “Promo1” to all contacts in Arizona and California. The database is named “MyList” and includes four fields: “name,” “faxnum,” “state,” and “company.” The RightFax fax printer is already linked or captured to LPT1.

```
set talk off
Select * from MYLIST;
where STATE=="AZ" or STATE=="CA"
to table TEMP1
set printer to LPT1
set printer on
? "DUMMY TEXT TO FLUSH ANY DATA IN LPT BUFFER"
set printer off
set printer to
if (!used("TEMP1"))
select 0
use TEMP1
endif
select TEMP1
SCAN ALL
set printer to LPT1
set printer on
?? "<libdoc:PROMO1>"
?? "<toname:"+temp1.name+">"
?? "<tofaxnum:"+temp1.faxnum+">"
?? "<tocompany:"+temp1.company+">"
?? "<autodelete>"
set printer off
set printer to
ENDSCAN
```
Chapter 28

Using RightFax Email Gateways

The RightFax server includes an email gateway for SMTP/POP3. Advanced gateways for Microsoft Exchange and Lotus Notes are available as separate, optional modules.

**Tip** For information about the Exchange and Notes gateways refer to the Microsoft Exchange Module Guide and the Lotus Notes Module Guide located on the RightFax server in the \RightFax\Docs folder.

Each RightFax email gateway acts as a communication link between the RightFax server and your email server(s). This lets you use your email client software as a fax client system as well.

**Important** UTF-8 encoding (unicode) is required for the Euro symbol and some other special characters to appear properly in RightFax documents created in email clients. To support documents with these characters, your email client must be configured for UTF-8 encoding. Refer to the documentation for your email client for information on enabling UTF-8 encoding.

Email messages addressed to the RightFax email gateway are picked up by the RightFax server, which converts them into faxes and transmits them. Incoming faxes can be routed to an email mailbox by specifying each RightFax user’s mailbox information in Enterprise Fax Manager. The gateway can also provide notification of fax events via email.

**Important** Required information for outbound faxes (described in “Requiring cover sheet fields on received faxes” on page 205) does not apply to faxes sent via the email gateways. For example, if you have configured RightFax to require that the To Name field be completed before a fax can be sent, faxes may still be transmitted via the email gateways without a recipient name specified.

### Installing the Email Gateway Software

The SMTP/POP3 email gateway is installed when you run the RightFax server installation. However, the mail server requires some configuration to work with the gateway software. After the mail server has been properly configured, you must add and configure the email gateway on the RightFax server (described on page 259).

#### Configuring SMTP/POP3 gateway installations

For SMTP/POP3 installations, SMTP/POP3 server(s) must be accessible by the computer running the RightFax email gateway(s).

You must create a new POP3 mailbox specifically for use by the gateway. The gateway will periodically check this mailbox for fax-bound email messages to forward to the fax server. Several
common configurations for routing fax-bound email messages to
this mailbox are outlined in the following sections. Although the
configurations vary, the goal is always the same—to route outgoing
fax-bound email messages to the mailbox on the SMTP server
specified in the POP3 Mailbox Name box in the Email
Configuration dialog box (see “Adding and Configuring Email
Gateways” on page 259).

Note The RightFax email gateway for SMTP/POP3 can be set to
recognize one of three addressing schemes for specifying outgoing fax
information like the fax number and recipient name (see “Using the
RightFax addressing scheme” on page 264). In the examples that follow,
the RightFax addressing scheme is used.

Dedicated domain for fax-bound email messages
This is typically the easiest configuration for email users to
understand and for SMTP/POP3 mail client software to access.
Email users send all fax-bound mail messages to a specific domain
(e.g., faxgate.company.com) and specify the pertinent fax
information as the mailbox portion of the mail address (left of the @
symbol). For example:
/fax=555-1212/name=Jane Doe@faxgate.company.com

Create a domain on your SMTP/POP3 mail server that will be
dedicated to receiving fax-bound mail messages. All mail
messages received at this domain must be placed in the POP3
mailbox specified in the POP3 Mailbox Name box in the Email
Configuration dialog box. The RightFax email gateway will
periodically check this mailbox for outgoing messages. If the
messages contain valid fax addresses, they will be routed to the
RightFax server for transmission.

A new MX (mail exchanger) entry in the DNS server may be
required to tell other computers what mail server handles
messages for the new domain.

Important The SMTP gateway requires an SMTP server with open
relay enabled.

Mailbox pattern-matching routing
This addressing scheme has the advantage of not requiring a new
mail domain; however, email users may not find it as intuitive as the
dedicated domain method (page 258).

Many mail servers allow messages with addresses that match a
specific pattern to route to a particular mailbox. For example, the
pattern “fax=**” (meaning any mailbox that starts with text “fax=”)
can be defined to route matching addresses to the email gateway’s
POP3 mailbox on the SMTP server. An address matching this
pattern might look like this:
/fax=555-1212/name=Jane Doe@company.com

Simple mailbox with description-area fax information

Note This configuration is not compatible with the IETF addressing
scheme. If your SMTP server requires that you use this addressing
method, you must use the RightFax addressing scheme (page 264).

Some SMTP mail servers allow very few configuration and routing
options. In these cases, fax-bound email messages can be
addressed directly to the email gateway’s POP3 mailbox. Fax
destination information is specified in the description-area of the
address string, using the same method used to provide descriptive
names for standard email addresses. For example:
"/name=Jane/fax=5551212/" <faxgate@company.com>

The information in quotes is not interpreted as part of the address.
It is treated as descriptive information only. The email message is
routed directly to the “faxgate” mailbox on the SMTP mail server. In
this example, the name of the mailbox specified in the POP3
Mailbox Name box in the Email Configuration dialog box (where
the gateway checks for outgoing faxes) is “faxgate.” When
destination fax information is not found as part of the address, the
RightFax email gateway scans the descriptive information.
Although this method requires little configuration at the mail server, many email client programs make it difficult to add descriptive information to an email address, often misinterpreting it as part of the mail destination address.

Adding and Configuring Email Gateways

To add or configure an email gateway, run the Email Gateway configuration program.

- If you did not add an email gateway during the RightFax server installation, you can open the Email Gateway configuration program from Windows Control Panel.
- If you already have one or more email gateways configured, you can open the Email Gateway configuration program by double-clicking the RightFax Email Gateway service in Enterprise Fax Manager.

The Email Configuration dialog box opens.

**Note** To view the RightFax control panel icons on x64 systems, be sure to select View 32-bit Control Panel Items in Control Panel.

To add a new gateway, click Add Gateway and select the type of gateway to add. Because RightFax allows you to install multiple email gateways, each installed gateway is listed in the tree on the left. Click each gateway in the list to view its configuration options.

**General Settings**

Click the General tab to begin configuration for all gateways.

**From Message** Specify a text string that will be in the FROM: field of messages placed into your system by the e-mail gateway.

**Delivery Direction** Specify the type of messages the gateway will process. Valid options are:

- Both (for both inbound and outbound messages)
- Inbound Only
- Outbound with Notifications
- Outbound without Notifications
**Frequency** Specify (in seconds) how often the gateway will check the mail system and the fax server for incoming or outgoing faxes to process. To avoid overloading system resources, the Frequency should not be set below 30 seconds.

**Event Log Level** Specify the level of information logged in the Application Event Log under the service name “RightFax E-Mail Gateway Module.” You can select the following options:

- **None.** No information is saved.
- **Tense.** Records critical errors only.
- **Normal.** Records errors and major events only.
- **Verbose.** Records all significant events and is most useful for tracking and resolving problems.

**Caution** If you leave this value set to “Verbose” for long periods of time, the Event Log can become full which may prevent new events from being logged.

**Remote e-mail gateway service** Check this option if you are running the E-mail Gateway service on a computer other than the fax server. See “Running the Email Gateway Remotely” on page 268.

**Use FaxUtil user information** Checking this option will use the information from the user’s RightFax account in place of the SMTP friendly name. Depending on the information found in the user’s profile, an email address, a user name, or a friendly name will appear in the From User Name field on cover sheets using the <from name> embedded code.

**Include fax with notifications** Check this option to include a copy of the fax with notifications. Once enabled, select TIF or PDF format. Choose First Page if you want only the first page of the fax to be included with the notification. Choose All Pages if you want the full fax to be included.

**Server Timeouts** Specify how long the client should wait for a response from the e-mail server by moving the slider to the right to increase the time or to the left to decrease it.

---

**SMTP Settings**

Click the SMTP tab to enter information about the SMTP server.

**Figure 28.2 The Email Configuration Dialog Box SMTP Tab**

- **SMTP Server:** Name or IP address of the SMTP server
- **Port:** Defaults to 25, the standard for nonencrypted SMTP messaging. The standard port for encrypted messaging is 465. Enter the port number for your configuration.
- **Encryption type:** Specifies whether the server is using encryption (TLS/SSL) or not. Defaults to None.

**Note:** In order to enable encryption, you must have first configured your email server for secure communication.
• **Use Default:** Click this button to return to the default settings of the Port 25 and Encryption Type of None. When the confirmation box appears, click OK.

• **The server requires authentication:** Click this to activate the following authentication fields:
  - **Log on using the same settings as the incoming server:** Click this to use the account name and password from the POP3 tab.
  - **Log on using:** Click this to enter SMTP Account name and Password.

**POP3 Settings**

POP3 servers can be specified separately for each email gateway. The content of this tab is unavailable if the email direction is set to Inbound only.

Figure 28.3 The Email Configuration Dialog Box POP3 Tab

- **POP3 Server:** Name or IP address of the POP3 server.
- **Port:** Defaults to 110, the standard for nonencrypted POP3 messaging. The standard port for encrypted messaging is 995. Enter the port number for your configuration.
- **Encryption type:** Specifies whether the server is using encryption (TLS/SSL) or not. Defaults to None.

  **Note:** In order to enable encryption, you must have first configured your email server for secure communication.
• **Use Default**: Click this button to return to the default settings of the **Port 110** and **Encryption Type** of **None**. When the confirmation box appears, click **OK**.

• **Account name**: POP3 login name

• **Password**: password for the account above.

• **Send APOP passwords as**: Choices are **Auto**, **Encrypted only**, **Clear text only**. This option is not available if you have selected encryption (TLS/SSL).

• **Maximum number of messages to retrieve**: Specify the maximum number of messages that can be processed at one time by the e-mail gateway.

• **Use PCL converter for text files**: Check this option to use the fax server’s PCL conversion engine when converting e-mail messages to fax format. This option is required to properly convert embedded codes in mail messages. This conversion also usually produces more accurate fax images of ASCII text than the fax server’s native document conversion engine.

• **Remove e-mail headers**: Click this option to remove e-mail headers before converting to fax format.

• **Use IETF fax addressing**: Check this option to allow the fax server to recognize the Internet Engineering Task Force (IETF) fax addressing standard for encoding fax destination information as part of the SMTP e-mail address. You must use the IETF format when using the RightFax SMTP Gateway with Outlook 2010.

• **Send through this user when e-mail sender is unknown**: If the sender does not have a RightFax account, this option specifies a valid RightFax UserID that will be used to send the fax.

**Custom messages**

When a fax is received as an email attachment or when an email fax status notification is received, a header is included in the mail message that provides details about the fax.

To customize the text of these header messages, click the **Custom Messages** tab.

The options on this tab are the same for all email gateways. Each message combines text with one or more variables and each has its own available variable options, described in the following table.

<table>
<thead>
<tr>
<th>Notification message</th>
<th>Variable options</th>
</tr>
</thead>
</table>
| Elapsed time                      | ~1 = The total time that the fax spent being processed by the fax board displayed (MM:SS)  
~2 = The fax channel used to send or receive the fax |
| Inbound user                      | ~1 = The RightFax user ID of the fax recipient  
~2 = The fax recipient’s routing code |
| Page record                       | ~1 = The range of page numbers successfully sent or received                      |
| Received remote ID                | ~1 = Remote ID                                                                    |
| Result                            | ~1 = The result code and any accompanying text as reported by the fax board (These codes and messages may differ depending on your fax board type.) |
| Sent remote ID                    | ~1 = The destination fax number  
~2 = The destination remote ID |
| Sent/Received time                | ~1 = Date (in Windows locale format) and time (HH:MM)                              |
To customize the subject line of the inbound message you must edit the Windows registry.

1. Log on to the RightFax server using a Windows account that is a member of the local administrators group.

2. Open the Windows registry editor and browse to `HKLM\SOFTWARE\RightFax\Gateway\Gateway`. If you have more than one gateway, each will be represented by its own subkey (e.g., Gateway1, Gateway2, etc.).

3. Create a new REG_SZ entry called **FaxSubject**.

4. Edit FaxSubject to contain the information you wish to appear in the subject line of inbound messages.

5. Close the Windows registry.

**Select service account**

*Note* If you will be storing or accessing files on a NetWare volume, you must make sure the Service Account also exists as an account within Novell.

All RightFax email gateways log on to the network as a services using a Windows NT based user account that you specify. To change the email gateway service account, click **Select Service Account**. The **Select Service Account** dialog box opens.

This dialog box lists all the user accounts in a specified domain and select the user account that the email gateway will use to log in to the server. Click **Load Users**. This lists each user account in all domains on the network. Click a user account in the list to automatically fill in the **Domain or Workgroup** and **User Account** boxes. Enter the password for the selected user account in both the **Password** and **Confirm Password** boxes. Click **OK** to apply the new service account.

**Starting and stopping the gateway service**

After installing the gateway, a new service called the RightFax Email Gateway Module is created. If the email gateway is running on the same computer as the fax server, the service is set to “Manual” and is automatically started and stopped by the RightFax Server service. You should not stop the RightFax Email Gateway Module service manually. However, if the email gateway is running on a remote computer (see “Running the Email Gateway Remotely” on page 268), you must start and stop the gateway service manually.

**SMTP/POP3 gateway registry settings**

Some additional functions can be set by editing the Windows registry settings for the gateway. To see the full list, see “Gateway Registry Entries” on page 346.

**Sending a Fax via SMTP/POP3**

Sending a SMTP/POP3 message to a fax number is similar to sending email, except the message must be specially addressed. Text entered in the **Subject** box will appear in the “Notes” section of the fax cover sheet. Text entered in the body of the email will appear as the body of the fax. Attached files will be converted to fax images and appended to the fax. (For a list of supported file types, see Appendix B, “File Formats that Convert to Fax Format”.) Unsupported file attachments cannot be converted and will be ignored.

*Note:* Attachments sent from Microsoft Outlook use a proprietary format that is not supported by the SMTP gateway. If you need to send attachments from Outlook, use the Microsoft Exchange Module (available separately).

The RightFax email gateway looks for fax-bound email messages in a dedicated POP3 mailbox on the SMTP mail server. Fax destination information must be included somewhere in the
address of each message. The SMTP/POP3 gateway supports three addressing formats: Simple SMTP Fax Addressing, RightFax-specific format, and IETF. Which addressing scheme the gateway will recognize is specified in the SMTP/POP3 Email Configuration dialog box (see “Adding and Configuring Email Gateways” on page 259).

**Important** For the SMTP gateway to correctly display characters such as the Euro symbol in the subject line and body text of the received email message, the client application must send data to the RightFax server using UTF-8 encoding. UTF-8 encoding must be configured as a system setting on each client computer that uses the SMTP gateway.

**Using the Simple SMTP Fax Addressing scheme**

The Simple SMTP Fax Addressing scheme allows fax-bound email messages to be addressed using a format that is similar to standard SMTP addressing - `<fax number>@<domain.com>`

For example, to send a fax-bound SMTP message to the fax number 555-1212 with a domain of RightFax.com, the address format would read:

```
5551212@RightFax.com
```

The following table lists the characters supported by Simple SMTP Fax Addressing. Space and Tabs are removed.

<table>
<thead>
<tr>
<th>Character</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-9</td>
<td>0123456789@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>*</td>
<td>123*456@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>#</td>
<td>#123456@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>+</td>
<td>+15551212@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>-</td>
<td>555-1212@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>A-Z</td>
<td>ABCDEFG@&lt;domain.com&gt;</td>
</tr>
<tr>
<td>.</td>
<td>Name.Org@&lt;domain.com&gt;</td>
</tr>
</tbody>
</table>

**Using the RightFax addressing scheme**

The RightFax addressing scheme allows a great deal of flexibility in how fax-bound email messages are addressed. In all cases, faxes must be addressed in such a way that they are forwarded to a mailbox that has been dedicated to RightFax. How fax-bound messages are routed to this mailbox depends on how you configured the SMTP server (see “Configuring SMTP/POP3 gateway installations” on page 257). In addition, the name and fax number for the recipient must be included as part of the address. Use these rules to address fax messages using the RightFax addressing scheme:

- The first forward-slash encountered in the address indicates the beginning of the fax destination information.
- Each element of fax information (such as name and fax number) is separated by a forward-slash.
- Addressing elements can appear in any order (i.e., the fax number can come either before or after the name).
- Addressing elements cannot be separated by the RightFax mailbox address itself.
- A fax recipient name and destination fax number are required. If either element is not found, the message will be discarded.
- The last element of fax information must be terminated by either a forward-slash (/), an ‘@’ symbol, or the end of the line. This allows any character to be part of a fax information element, including spaces.

If a special character is required as part of a fax information element, it can be specified by using a percent symbol (%) followed by the ASCII value of the character expressed in hexadecimal. For example, the space character has the ASCII value of 32, which is written as 20 in hexadecimal, so a space can be represented as ‘%20’. This encoding is only required if the special characters needed cause problems for your mail system.
The following table lists all fax destination elements supported by the RightFax addressing scheme. Only the fax number and name elements are required. Except for the fax number, all of these addressing elements are used only for display on the fax cover sheet.

Table 28c RightFax Scheme Addressing Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/bi1=</td>
<td>Billing code 1</td>
<td>/bi1=1111</td>
</tr>
<tr>
<td>/bi2=</td>
<td>Billing code 2</td>
<td>/bi2=2222</td>
</tr>
<tr>
<td>/city=</td>
<td>Recipient city, state</td>
<td>/city=Tucson, AZ</td>
</tr>
<tr>
<td>/com=</td>
<td>Recipient company name</td>
<td>/com=Acme, Inc.</td>
</tr>
<tr>
<td>/fax=</td>
<td>Destination fax number</td>
<td>/fax=555-1212</td>
</tr>
<tr>
<td>/name=</td>
<td>Recipient name</td>
<td>/name=Jane Doe</td>
</tr>
<tr>
<td>/voice=</td>
<td>Recipient voice number</td>
<td>/voice=555-4567</td>
</tr>
</tbody>
</table>

Examples /name=Jane/fax=555-1212@faxgate.company.com /fax=5551212/name=Jane/com=Acme@faxgate.acme.com faxgate@company.com/name=Jane/fax=555-1212 /name=Jane%20Doe/fax=5551212/faxgate@company.com

Using the IETF addressing scheme

The IETF addressing scheme requires faxes be addressed in such a way that they are forwarded to a mailbox that has been dedicated to RightFax. How fax-bound messages are routed to this mailbox depends on how you configured the SMTP server see “Configuring SMTP/POP3 gateway installations” on page 257. In addition, the name and fax number for the recipient must be included as part of the address. Use these rules to address fax messages using the IETF addressing scheme:

- Only the portion of the address to the left of the domain name (everything to the left of the ‘@’ sign) is significant to the fax destination.
- The address must begin with the fax destination number.
- The fax number can be followed by one or more optional keywords that provide additional fax information.

The following table lists supported keywords for the IETF addressing scheme.

Table 28d IETF Scheme Addressing Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/dd.bi1=</td>
<td>Billing code 1</td>
<td>/dd.bi1=1111</td>
</tr>
<tr>
<td>/dd.bi2=</td>
<td>Billing code 2</td>
<td>/dd.bi2=2222</td>
</tr>
<tr>
<td>/fax=</td>
<td>Recipient fax number</td>
<td>/fax=555-1212</td>
</tr>
<tr>
<td>/g=</td>
<td>Recipient first (given) name</td>
<td>/g=Jane</td>
</tr>
<tr>
<td>/i=</td>
<td>Recipient middle initial</td>
<td>/i=M</td>
</tr>
<tr>
<td>/o=</td>
<td>Recipient company name</td>
<td>/o=Acme, Inc.</td>
</tr>
<tr>
<td>/pn=</td>
<td>Recipient name (separate first, middle, and last name with a period)</td>
<td>/pn=Jane /pn=Jane.Doe /pn=Jane.M.Doe</td>
</tr>
<tr>
<td>/s=</td>
<td>Recipient last name (surname)</td>
<td>/s=Doe</td>
</tr>
</tbody>
</table>

Any invalid keywords included in the address will be ignored.

Example fax=555-1212@faxgate.company.com /fax=555-1212/pn=Jane.Doe@faxgate.company.com fax=5551212/g=Jane/s=Doe/o=Acme@faxgate.acme.com
Configuring Users to Receive Faxes via Email

With the RightFax email gateways, RightFax users can receive faxes as email message attachments instead of (or in addition to) receiving them in their FaxUtil mailboxes.

To configure a user to receive faxes in email

1. In Enterprise Fax Manager, double-click the user to open the User Edit dialog box, and then click the Inbound Routing tab.

![Figure 28.4 The User Edit Dialog Box Inbound Routing Tab]

2. In the Routing Type box, click your email gateway type.

3. In the File Format box, click the file format RightFax will use for the fax attachment. For information on each fax image format, see “File Format” on page 101.

4. In the Routing Info box enter the user’s SMTP email address (e.g., user@company.com). For example: jdoe@acme.com.

5. Select the Delete After Routing check box only if you want to delete the fax from the user’s FaxUtil mailbox after it is routed to email. If RightFax cannot route a fax to the destination email mailbox, it will leave the fax in the user’s FaxUtil mailbox regardless of how this option is set.
Email Notification of Faxes

The RightFax email gateways can be used to notify users of fax status whether or not the installed gateway is configured to send and receive faxes.

To configure a user to receive fax notification in email

1. In Enterprise Fax Manager, double-click the user to open the User Edit dialog box, and then click the Notification tab.

2. In the Notification Method box, click your email gateway type.

3. In the Notification Address/Info setting enter the user’s SMTP email address (e.g., user@company.com). For example: jdoe@acme.com.

4. From the Notifications about outbound faxes and Notifications about received faxes lists, choose the events that will trigger notifications.

5. Click OK when you are done.

The SMTP gateway requires that you set up a default user. When sending faxes from the SMTP gateway, notifications may be sent to either the default User ID or the actual sending User ID as follows:

- If the fax is held for preview or approval, the notification will go only to the default User ID.
- If the fax is sent successfully, the notification will go only to the sender’s User ID.
- If the fax fails for any reason, the notification will go to both the sender’s User ID and the SMTP gateway default User ID.

The notification method can be configured for a user group by editing the group ID properties in Enterprise Fax Manager and setting the group Notification Type to the option that corresponds to your email gateway type.

Embedded Codes in Mail Messages

Embedded codes are special faxing instructions that you insert directly into fax-bound documents such as email messages. You can use embedded codes to include fax cover sheet information, attach library documents, add billing information, and more.

To add an embedded code to an email message, type the code you want, along with any required parameters, between angle brackets. For example, an embedded code that tells RightFax to send a library document called “PriceSheet” is written as:

<LIBDOC:PRICESHEET>
RightFax removes all embedded codes from the mail message when it converts it to fax form so they don’t appear in your final fax. If you type an embedded code incorrectly, it will be ignored by RightFax and will be included in your fax. Embedded codes can be written in either upper or lower case.

**Tip** Select **Use PCL converter for text files** if you plan to use embedded codes in your faxes.

Embedded codes can be placed anywhere in the body of the mail message (they will not work in the **Address** or **Subject** boxes). Embedded codes cannot line wrap and any embedded code statement that is so long that it wraps to a second line will be ignored.

The RightFax email gateways support the following embedded codes. For descriptions and examples of each embedded code, see Appendix A, “RightFax Embedded Codes”.

- ATDATE
- ATTIME
- CHANNEL
- COVER
- DELETE
- DELETEALL
- FCSFILE
- FINE
- FROMFAXNUM
- FROMGENFAXNUM
- FROMNAME
- FROMPHONE
- IGNORE
- LIBDOC (Same as LIBDOC2 in email gateways)
- LIBDOC2
- NOCOVER
- NORMAL
- PREVIEW
- PRIORITY
- SAVE

**Running the Email Gateway Remotely**

By default, each email gateway installs and runs directly on the RightFax server, however, there are some situations where it is beneficial to run the email gateway on a different computer on your network. You might not, for example, want to increase the workload...
on your fax server. Or, you may anticipate a very high volume of
gateway traffic and don’t want the added workload to interfere with
the routine operation of your fax server.

To run the gateway remotely

1. Select the RightFax Email Gateway configuration in Enterprise
   Fax Manager. The Email Configuration dialog box opens.
2. Select the Remote Email Gateway Service check box to
   enable remote operation.
3. Map a drive to the \RightFax folder on the fax server.
4. Switch to the \RightFax\Gateway folder and enter the following
   command:

   \smtpgateway\ -l path -f database -sgateway n

   Where path is the directory path to the RightFax files, database
   is the name of the server containing the fax database, and n is
   the number of the email gateway. This number is zero-based, so
   the first email gateway is “gateway,” the second email gateway
   is “gateway1,” the third email gateway is “gateway2,” and so on.
   To confirm the gateway number, open the Windows registry and
   check the Gateway keys under
   HKEY_LOCAL_MACHINE\Software\RightFax\Gateway
   (64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Gateway).

   For example, to start the Remote Gateway service process from
   drive R: (which is mapped to the RightFax folder on the fax
   server) using the RightFax Database Module on the server
   “rfaxserv,” enter:

       \smtpgateway\ -lR: -frfaxserv -sgateway

Troubleshooting the Email Gateways

If you experience problems with your RightFax Email Gateway
Module service, you should first check for errors in the RightFax log
of the Windows Event Viewer. Select Start > Programs >
Administrative Tools > Event Viewer. In the Event Viewer, select
RightFax from the Applications and Services Logs menu to open
the RightFax log. Email gateway-related problems will appear on
the log in the Source column as “RightFax Email Gateway Module.”
Double-click the entry for a description of the error.

The amount and type of information saved to the event log is
determined by the LogLevel setting in the RightFax Email Gateway
configuration in Enterprise Fax Manager. With the log level set to
terse, only critical errors will be recorded. Log levels normal and
verbose record more information which may help track down
problems.

Running the gateway in a command prompt window will also give a
very detailed report of gateway events. To run the gateway in a
command window, first make sure that the RightFax Email Gateway
Module service is stopped (for information on stopping the
RightFax services, see “Starting and stopping services” on
page 92.) Open a command prompt window and change to the
RightFax\Gateway folder. To run the gateway, enter the following
command

   \smtpgateway\ -d -1 -sgateway n

   Where n is the number of the email gateway. This number is
   zero-based, so your first email gateway is referred to as “gateway,”
your second email gateway is referred to as “gateway1,” your third
email gateway is referred to as “gateway2,” and so on. To confirm
the gateway number, open the Windows registry and check the
Gateway keys under HKEY_LOCAL_MACHINE\Software\RightFax\Gateway
(64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Gateway).

Example If you are running the SMTP gateway and it is your only
e-mail gateway, enter: \smtpgateway\ -d -1 -sgateway
When running the email gateway in a command window, you must set the window properties to allow you to scroll back many lines. To set the command window to sufficient size, click the MS-DOS icon in the top left of the command window. Click **Properties** to open the **Command Prompt Properties** dialog box. Click the **Layout** tab, and then set **Screen Buffer Size** height to “2000.”

**Error 2140 Starting Service**

Error 2140 is a generic Windows NT based error stating that the service did not start. Check the Event Viewer RightFax log, under the **Source** column “RightFax Email Gateway Module” for more details.

**Error 53**

This is a Windows NT based networking error which indicates that the UNC name that was specified for the **Location of Mail Files** in the gateway configuration is an invalid network path. If the specified path is correct and valid, it may be that the account being used to start the Email Gateway Module service does not have access rights to that folder.

**Error 85 The local device is already in use**

This is a Windows NT based networking error stating that the drive to which RightFax is trying to connect the UNC name that was specified for the **Location of Mail Files**, or **API Files** is already assigned.
Overview

OpenText RightFax 10.5 is a partner fax solution for Microsoft Exchange 2010 Unified Messaging. Inbound fax calls are detected by Exchange 2010 UM and referred to the RightFax server for processing. The RightFax server handles the fax call, receives the fax image, and sends it to the recipient's mailbox as an email message with TIFF image attachment.

Requirements

- Microsoft Exchange Server 2010 with the Unified Messaging role installed and configured.
- An IP Gateway installed and configured to communicate with the Exchange Server.
- OpenText RightFax 10.5.
- Brooktrout SR140 Transport installed and licensed on the RightFax server.

Configuring Exchange 2010 UM for Faxing

This chapter assumes that the Microsoft Exchange 2010 Unified Messaging role is already installed and configured in your organization. These steps include creating the following items in UM:

- UM Dial Plans
- UM Mailbox Policies
- UM IP Gateway
- UM IP Hunt Groups
- UM-enabled Mailboxes

For detailed instructions on how to complete these steps, consult the Microsoft Exchange 2010 documentation which can be found at http://technet.microsoft.com/en-us/library/dd335104(EXCHG.140).aspx.

This section describes the additional requirements to enable inbound faxing with Unified Messaging.
Fax Tone Detection

Fax tone detection is deactivated by default in Exchange 2010 UM. Ensure that fax tone detection has been activated on each UM Server that will receive fax calls. Change the EnableInbandFaxDetection setting in the MSExchangeUM.config file located in the X:\Program Files\Microsoft\ExchangeServer\V14\Bin directory from False to True.

Note: Restart the Exchange 2010 server for the changes to take effect.

Dial Plans

Ensure that each UM dial plan is enabled to receive faxes. By default, the ability to receive faxes is activated. If you prevent the dial plan from receiving faxes, no users in the dial plan will be able to receive faxes. The Dial Plan setting takes precedence over individual UM-enabled user settings.

UM Mailbox Policy

Configure each UM mailbox policy to allow users with that policy to receive faxes. The Mailbox Policy configuration includes the RightFax server URI in the following format (include the quotation marks):

- sip:<FQDN or IP of RightFax server>:<port>:<transport>"
- Port = The port on which the fax server listens (Default is 5060)
- Transport = The transport protocol (Default is UDP)

Example: "sip:172.17.18.19:5060;Transport=UDP"

User Mailboxes

The ability to receive faxes can be enabled on an individual Unified Messaging mailbox basis. Ensure that each Exchange 2010 mailbox is UM-enabled and is enabled to receive faxes.

Dedicated Receive Connector

Fax messages sent to Exchange 2010 UM from the RightFax server must be authenticated. To facilitate authentication, create a new partner receive connector on the Hub Transport server to which the RightFax server will submit SMTP fax messages. Configure the receive connector with the following values:

- Intended use: Partner
- AuthMechanism: ExternalAuthoritative
- PermissionGroups: ExchangeServers, Partners
- RemoteIPRanges: (RightFax server IP address)
- requireTLS: False
- EnableAuthGSSAPI: False

Note: For more information about creating receive connectors, see the Microsoft documentation at http://technet.microsoft.com/en-us/library/bb125159(EXCHG.140).aspx
Configuring OpenText RightFax for Exchange 2010 UM

When fax calls are detected by Exchange 2010 Unified Messaging, they are referred back to the IP Gateway for delivery to the RightFax server for processing. After processing, each fax is handed off to the Exchange 2010 UM server for delivery to the user. The email with attached fax TIFF image is placed into the Inbox as well as a new Search Folder called "Fax" in the recipient's Outlook mailbox.

Figure 29.1 Inbound Faxing with Exchange 2010 Unified Messaging
Chapter 30
Using TeleConnect to Access Faxes by Phone

With the RightFax TeleConnect feature, users can access their fax mailboxes via a touch-tone telephone. Users dial in to the RightFax server to use RightFax’s automatic forwarding, printing, and notification features to manage faxes. The TeleConnect menu of options includes:

- Retrieve new faxes
- Retrieve a catalog of faxes
- Retrieve specific faxes from the catalog
- Hear fax statistics
- Change fax mailbox options

To run TeleConnect, you must have a RightFax server installed and operational. Because it uses digital voice prompts, you must also have a Brooktrout fax board with voice capability installed.

TeleConnect does not require a separate or additional installation to your fax server.

Configuring TeleConnect

Configure TeleConnect through the RightFax DocTransport module.

1. On the RightFax server, select Start > Programs > Open Text > RightFax Enterprise Fax Manager.
2. In the Enterprise Fax Manager application, click the name of the RightFax server to configure in the tree in the left pane. A list of services appears at the lower-right pane of the window.
3. In the Service Name list, double-click RightFax DocTransport Module. The DocTransport Configuration dialog box opens.
4. Under *BrookTrout* in the left pane, select *Advanced Settings* and then *TeleConnect*.

**Figure 30.1  The TeleConnect Configuration Dialog Box**

Enable TeleConnect  Enables the TeleConnect Module.

**Routing Code/Channel Ext**  Specifies the routing code (such as DTMF extension or DID number) that will be assigned to TeleConnect. When calls arrive on this extension they will enter the TeleConnect system automatically, rather than being received as an incoming fax.

If you have a bank of numbers dedicated to your fax server, you must assign one of the numbers to TeleConnect by entering the extension here. If you have only analog channels you must dedicate one of your fax channels to TeleConnect. To do this, enter a unique four-digit number in this box, and then click the channel you want to dedicate under *Global Board Settings* in the left pane and enter the same four-digit value in the *Channel Extension* box. Users must be able to dial into this channel directly. The channel should not be part of a hunt group unless all the channels in that hunt group are dedicated to TeleConnect. Otherwise, dialing the number may cause users to hear a fax tone instead of accessing the TeleConnect system.

You can also turn on DTMF routing for a particular analog channel. When users dial this number they will hear a tone or voice prompt to enter an extension. Enter a unique four-digit extension in this box. If you tell your users to enter this number when they hear the prompt, they will connect to the TeleConnect system. If this number is not entered after a few seconds (depending on the DTMF timeout value), the channel will provide a fax tone and attempt to receive a fax.

**Call Type**  Specifies how TeleConnect will connect to the caller when faxes are requested.

- “One Call” requires the user to call from a fax machine. TeleConnect uses the same connection to send faxes back to the caller without having to initiate a second call. In this way, TeleConnect incurs no phone charges.
- “Two Call” causes TeleConnect to request the recipient’s fax number and then initiates a separate call to send faxes.
- “Prompt” asks each user to specify a one- or two-call session.

**RightFax user setup**

To use TeleConnect to access RightFax via touch-tone phone, each caller must have a RightFax user account with unique numeric *Voice Mail Subscriber ID* setting and a *Password*. (The *Password* setting cannot be blank.) TeleConnect uses these settings to identify the user when calling in to the system.

**Multilingual Support**

The TeleConnect Module supports messaging in up to nine languages in addition to the English language default. When multilingual support is enabled, you can record your own language
message files and save them to their own folders. When callers first
dial into the system, TeleConnect will play a message asking them
to select the language they want.

To enable multilingual support, add the TeleConnect registry
keyword Multilingual(1).

Then create a TeleConnect registry keyword for each additional
language you want to support using the format
VoicePath#(voicepath1;voicepath2), where # is a number 2
through 9 that the user will press to access alternate language files
(English is automatically set to “1”), voicepath1 is the path to the
local folder where the language files are stored, and voicepath2 is
an optional secondary folder path. If TeleConnect cannot find the
file it wants in the first folder, it will look in the second folder.

For information on creating TeleConnect registry entries see
“TeleConnect Registry Configuration” on page 281.

Multilingual selection prompts

After multilingual support is enabled, TeleConnect will automatically
cycle through every defined VoicePath entry, starting with
VoicePath1 and ending with VoicePath0. It will play message
010.VOX from each VoicePath folder, if the file exists.

The default message file 010 says “For an English language menu,
press 1.” In VoicePath2, this file might say (in Spanish) “For a
Spanish language menu, press 2.” In VoicePath3, it might say (in
German) “For a German language menu, press 3.”

Recording multilingual messages

You can record custom multilingual messages for TeleConnect
using a third-party sound editor that supports the Dialogic OKI32
file format, or using the message recorder built into the
Fax-on-Demand component of the Docs-on-Demand Module (if it is
licensed and installed.) For information on using Docs-on-Demand
to record prompts, refer to the RightFax Docs-on-Demand Guide.

Toll-Number Support

Your TeleConnect system can be set up on 1-900 and 1-976
toll-lines. FCC requirements for toll-numbers state that callers may
not be charged until a full minute has gone by. During the first 30
seconds of the call, callers must be told how much they are going
to be charged and they must agree to the charges. If the caller
does not immediately agree to the charges, the line must be
disconnected.

To enable toll-number support, add the TeleConnect registry
keywords 900Enable(1) and 900Agree(#), where # is a number 0
through 9 that the caller must press to respond affirmatively and
continue with the call. If this parameter is left blank, any key will be
accepted. The system will automatically hang up on anyone who
has not pressed the agree button within the first 28 seconds of the
call.

For information on creating TeleConnect registry entries see
“TeleConnect Registry Configuration” on page 281.

Toll-number prompt

Note If you have both toll-number and multilingual support enabled,
Fax-on-Demand will play the VoicePath prompts before the toll-number
prompt. Because selecting a language option is interpreted as an
agreement by the caller to accept the charges, toll-call information should
be included in your foreign language prompts.

After toll-number support is enabled, message 020.VOX will play
one time. This message should explain how much the caller will be
charged, that he must be 18 years or older, and request him to
press a key to agree to the charges. This prompt must be less than
the 28 second limit to press the required agreement key.

If the caller doesn’t press a key or presses a key other than one
specified by the 900Agree registry keyword, the line will be
disconnected. If the caller presses the key specified by the
900Agree keyword (or any key if the 900Agree value is blank), the
system will proceed to the Main menu.
Requesting Fax Routing Information

If a fax is sent to a number that delivers faxes to several people (such as a public or hotel fax machine), there may be a problem determining the fax recipient. TeleConnect can be configured to ask the caller to enter a name or phone number to assist in routing. Requests for fax routing information are skipped if the caller requests the fax(es) be sent back to the fax machine he is calling from using the same connection (the One-call option).

To ask the caller to enter a phone number to assist with routing, add the TeleConnect registry keyword AskVoiceNumber(1).

To ask the caller to enter an alphanumeric sequence (such as a name), add the TeleConnect registry keyword AskAlphaNumeric(1).

If either of these options is enabled, TeleConnect will play message file 306. If you enabled AskVoiceNumber only, message file 306 will be followed by message file 307. If you enabled AskAlphaNumeric only, message file 306 will be followed by message file 312. If you enabled both AskVoiceNumber and AskAlphaNumeric, message file 306 will be followed by message file 311. For a complete list of TeleConnect’s message files refer to the next section.

Voice Prompt Files

The TeleConnect module uses voice prompt files located in the RFB:Mainapp\Voices folder on the RightFax server. Voice prompt files are saved as Dialogic® OKI32 files (.vox files). These files can be customized in Fax-on-Demand (described in the RightFax Docs-on-Demand Guide) or using a third-party sound editor that supports the Dialogic OKI32 file format.

All files in the RFB:Mainapp\Voices folder are listed in the following table along with their voice text.

<table>
<thead>
<tr>
<th>File name</th>
<th>Voice prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.vox</td>
<td>&quot;...a...&quot;</td>
</tr>
<tr>
<td>allque.vox</td>
<td>&quot;All of your queued faxes will be sent.&quot;</td>
</tr>
<tr>
<td>b.vox</td>
<td>&quot;...b...&quot;</td>
</tr>
<tr>
<td>badfaxnum.vox</td>
<td>&quot;Invalid entry. We will not send documents to that fax number.&quot;</td>
</tr>
<tr>
<td>badlogin.vox</td>
<td>“The mailbox and password combination you entered is not valid. Please try again.”</td>
</tr>
<tr>
<td>beginrec.vox</td>
<td>“You may begin recording after the beep. Press pound when finished.”</td>
</tr>
<tr>
<td>c.vox</td>
<td>&quot;...c...&quot;</td>
</tr>
<tr>
<td>catalog.vox</td>
<td>&quot;...catalog...&quot;</td>
</tr>
<tr>
<td>catalogs.vox</td>
<td>&quot;...catalogs...&quot;</td>
</tr>
<tr>
<td>count.vox</td>
<td>&quot;...faxes with a total of...&quot;</td>
</tr>
<tr>
<td>d.vox</td>
<td>&quot;...d...&quot;</td>
</tr>
<tr>
<td>deliverif.vox</td>
<td>&quot;Are you sure you want to delete this message? Press 1. If not, press 2.&quot;</td>
</tr>
<tr>
<td>doc.vox</td>
<td>&quot;...document...&quot;</td>
</tr>
<tr>
<td>docs.vox</td>
<td>&quot;...documents...&quot;</td>
</tr>
<tr>
<td>fax.vox</td>
<td>&quot;...fax...&quot;</td>
</tr>
<tr>
<td>faxes.vox</td>
<td>&quot;...faxes...&quot;</td>
</tr>
<tr>
<td>faxnum.vox</td>
<td>&quot;Enter your fax number and then press the pound key.&quot;</td>
</tr>
<tr>
<td>faxtype.vox</td>
<td>&quot;If you are calling from your fax machine, press 1. If you wish the fax delivered to a fax number, press 2.&quot;</td>
</tr>
<tr>
<td>fwdfax.vox</td>
<td>“Your faxes are currently being forwarded to...”</td>
</tr>
</tbody>
</table>
### Table 01 Voice Prompt Files Used by TeleConnect (Continued)

<table>
<thead>
<tr>
<th>File name</th>
<th>Voice prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>fwdfaxnm.vox</td>
<td>“Please enter the fax number to forward your faxes to.”</td>
</tr>
<tr>
<td>fwdmenu.vox</td>
<td>“To automatically forward your faxes to a fax machine, press 1. To forward your faxes to a network user, press 2. To disable fax forwarding, press 3. To cancel changes, press the Star key.”</td>
</tr>
<tr>
<td>fwdnous.vox</td>
<td>“You may not enable fax forwarding to a network user because a destination user has not been specified.”</td>
</tr>
<tr>
<td>fwduser.vox</td>
<td>“Your faxes are currently being forwarded to a network user.”</td>
</tr>
<tr>
<td>fwdwarn.vox</td>
<td>“Your fax forwarding option is currently set to a network user. If you change this, there will be no way to restore this setting over the telephone interface. If you still want to change this option, press 1. If not, press 2.”</td>
</tr>
<tr>
<td>goodbye.vox</td>
<td>“Goodbye.”</td>
</tr>
<tr>
<td>greeting.vox</td>
<td>“Welcome to RightFax, the leading enterprise fax server.”</td>
</tr>
<tr>
<td>hundred.vox</td>
<td>“...hundred...”</td>
</tr>
<tr>
<td>ifcorrec.vox</td>
<td>“If this is correct, press 1. To reenter, press 2.”</td>
</tr>
<tr>
<td>invalid.vox</td>
<td>“Invalid entry. Please try again.”</td>
</tr>
<tr>
<td>isnotavail.vox</td>
<td>“...is not available.”</td>
</tr>
<tr>
<td>login1.vox</td>
<td>“Please enter your mailbox number.”</td>
</tr>
<tr>
<td>login2.vox</td>
<td>“Please enter your security code.”</td>
</tr>
<tr>
<td>mainmenu.vox</td>
<td>“To retrieve faxes, press 1. To retrieve a list of all faxes, press 2. To hear fax mailbox statistics, press 3. To change mailbox options, press 4. To quit, press the Star key.”</td>
</tr>
<tr>
<td>million.vox</td>
<td>“...million...”</td>
</tr>
<tr>
<td>n00.vox</td>
<td>“...zero...”</td>
</tr>
<tr>
<td>n01.vox - n99.vox</td>
<td>“...one...” - “...ninety-nine...”</td>
</tr>
<tr>
<td>new.vox</td>
<td>“...new...”</td>
</tr>
<tr>
<td>nofwd.vox</td>
<td>“Your faxes are not currently being forwarded.”</td>
</tr>
<tr>
<td>nonewfxs.vox</td>
<td>“You have no new faxes.”</td>
</tr>
<tr>
<td>nonque.vox</td>
<td>“We are unable to queue your faxes for transmission.”</td>
</tr>
<tr>
<td>noprinter.vox</td>
<td>“Your faxes may not be automatically printed because a destination printer has not been selected.”</td>
</tr>
<tr>
<td>notavail.vox</td>
<td>“The fax server is not available. We are unable to process your call.”</td>
</tr>
<tr>
<td>notones.vox</td>
<td>“No entries detected. Please try again.”</td>
</tr>
<tr>
<td>ntfdisab.vox</td>
<td>“Alternate notification to another network user is disabled.”</td>
</tr>
<tr>
<td>ntfenab.vox</td>
<td>“Alternate notification to another network user is enabled.”</td>
</tr>
<tr>
<td>ntfmenu.vox</td>
<td>“To enable alternate notification press 1. To disable alternate notification, press 2. To cancel changes, press the Star key.”</td>
</tr>
<tr>
<td>ntfwarn.vox</td>
<td>“You may not enable alternate notification because a network user to notify has not been selected.”</td>
</tr>
<tr>
<td>onecall.vox</td>
<td>“Shared call beginning.”</td>
</tr>
<tr>
<td>optmenu.vox</td>
<td>“For automatic forwarding options, press 1. For automatic printing options, press 2. For alternate notification options, press 3. To return to the Main menu, press the Star key.”</td>
</tr>
<tr>
<td>new.vox</td>
<td>“...new...”</td>
</tr>
<tr>
<td>File name</td>
<td>Voice prompt</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>outbound.vox</td>
<td>&quot;...outbound...&quot;</td>
</tr>
<tr>
<td>page.vox</td>
<td>&quot;...page...&quot;</td>
</tr>
<tr>
<td>pages.vox</td>
<td>&quot;...pages...&quot;</td>
</tr>
<tr>
<td>pound.vox</td>
<td>&quot;...pound...&quot;</td>
</tr>
<tr>
<td>prndisab.vox</td>
<td>&quot;Your faxes are not being automatically printed.&quot;</td>
</tr>
<tr>
<td>prnenabl.vox</td>
<td>&quot;Your faxes are currently being automatically printed.&quot;</td>
</tr>
</tbody>
</table>
| prnmenu.vox | "To automatically print your faxes, press 1. To disable automatic printing, press 2. To cancel changes, press Star."
| rcvstat1.vox | "...received faxes totaling..."                                            |
| rcvstat2.vox | "...of your received faxes have not been viewed or printed."             |
| received.vox | "...received..."                                                          |
| recmenu.vox | "To play back, press 1. To record, press 2. To save this message, press 3. To cancel changes, press 4. To delete this message, press 5."
| rtverr1.vox | "You entered an invalid fax ID number."                                    |
| rtvid1.vox | "You may retrieve up to..."                                                |
| rtvid2.vox | "Enter the fax ID number and press Pound."                                 |
| rtvmax.vox | "You have entered the maximum allowable fax IDs."                         |
| rtvmen.vox | "To retrieve all new faxes, press 1. To retrieve a list of all faxes, press 2. To retrieve faxes by their ID number, press 3. To return to the Main menu, press the Star key." |
| sil_100.vox | 0.1 second silence                                                          |
| sil_1000.vox | 1 second silence                                                            |
| sil_250.vox | 0.25 second silence                                                          |
TeleConnect Registry Configuration

TeleConnect is configured primarily via multi-string (Reg_Multi_SZ) registry entries. Each channel dedicated to TeleConnect has its own configuration registry entry. The TeleConnect configuration registry entry is located at HKEY_LOCAL_MACHINE\Software\RightFax\DocTransport\Transports\Brooktrout\TUI\Extensions (64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\DocTransport\Transports\Brooktrout\TUI\Extensions). The multi-string registry entries for TeleConnect use this format: 

```
extension'keyword(value)'keyword(value)'...`
```

Where `extension` is the phone number extension or DID channel assigned to TeleConnect, `~` is the “grave” character located on the same key as the tilde (~), `keyword` is one of the configuration setting keywords from the following table, and `value` is an optional value setting for the keyword. The phone number extension or DID channel assigned to TeleConnect is always the first entry. The extension and all keywords must be separated by a grave (`~`) character.

For example, if you want to set up TeleConnect for DID extension 2000 so that it asks the caller to enter a return-fax number, limits the caller to 32 faxes per call, and disconnects after 3 errors, the entry would be:

```
2000'CallType(0)'MaxErrors(3)'MaxFaxes(32)'
```

If you want extension 2001 to have a limit of 25 faxes, always send the faxes back to the originating number, and disconnect after only 2 errors, the entry would be:

```
2001'CallType(1)'MaxErrors(2)'MaxFaxes(25)'
```

The following table lists all available TeleConnect keywords, and includes the default settings (if any) and descriptions.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>900Agree</td>
<td>N/A</td>
<td>900 caller agreement sequence.</td>
</tr>
<tr>
<td>900Enable</td>
<td>False</td>
<td>900 telephone processing.</td>
</tr>
<tr>
<td>AppType</td>
<td>0</td>
<td>Application type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = TeleConnect</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = One-Doc Poll</td>
</tr>
<tr>
<td>AskAlphaNumeric</td>
<td>False</td>
<td>Ask caller for alpha-numeric sequence.</td>
</tr>
<tr>
<td>AskVoiceNumber</td>
<td>True</td>
<td>Ask caller for voice number.</td>
</tr>
<tr>
<td>CallType</td>
<td>0</td>
<td>Default call type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = Prompt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = One-call</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Two-call</td>
</tr>
<tr>
<td>CSID</td>
<td>N/A</td>
<td>CSID to use during a one-call transaction. If blank, it uses the channel default.</td>
</tr>
<tr>
<td>DefaultBI1</td>
<td>N/A</td>
<td>Default billing code #1 for a two-call fax TeleConnect. If a fax is being forwarded from a user’s mailbox, the system will attempt to use the billing codes from the source fax. If no billing codes are present in the source fax, the value specified here, and that of DefaultBI2, will be used.</td>
</tr>
<tr>
<td>DefaultBI2</td>
<td>N/A</td>
<td>Default billing code #2 for two-call.</td>
</tr>
<tr>
<td>MaxErrors</td>
<td>3</td>
<td>Maximum number of errors allowed (timeouts, invalid doc numbers, etc.) If this number is exceeded, the caller will be disconnected.</td>
</tr>
</tbody>
</table>
Retrieving Faxes Via TeleConnect

When retrieving your faxes via TeleConnect you can choose to have all new faxes that have not yet been viewed or printed sent to a specified fax machine, or you can retrieve a specific fax by specifying its TeleConnect ID number. A TeleConnect ID is assigned to every outgoing and incoming fax processed by RightFax. After a fax is assigned a TeleConnect ID, it keeps that ID until it is deleted from the system.

Each fax’s TeleConnect ID is displayed when you receive notification of the fax’s arrival. If you don’t know the TeleConnect ID of the specific fax you want, the TeleConnect Main menu gives you the option of retrieving a list of all faxes in your RightFax mailbox along with their TeleConnect IDs.

To access your RightFax mailbox with TeleConnect

1. Dial the phone number that you specified in the Routing Code/Channel Ext. box of the TeleConnect configuration (see “Routing Code/Channel Ext” on page 276).

2. When the system prompts you, enter your RightFax voice mail subscriber ID and press the pound key (#).

3. When the system prompts you, enter your RightFax password and press the pound key (#).

   If your RightFax password does not consist of numeric digits only, you can enter alphanumeric characters by pressing the keys on the telephone keypad that the characters are on. To enter the word ‘PASSWORD’ the caller should enter ‘72779673’. Any digit will work for the letters Q and Z.

4. After TeleConnect validates your voice mail subscriber ID and password, you will be placed in the main menu (described in the next section).
The TeleConnect main menu

The following table lists the options available from the TeleConnect main menu. There may be additional prompts and messages depending on your system's configuration.

<table>
<thead>
<tr>
<th>Main menu option</th>
<th>Option/description</th>
</tr>
</thead>
</table>
|                  | [2] Retrieve a list of all inbound and outbound faxes  
|                  | [3] Retrieve faxes by their TeleConnect ID |
| [2] Retrieve a List of All Faxes | Retrieve a list of all inbound and outbound faxes |
| [3] Fax Mailbox Statistics | [1] Outbound fax statistics, including total outbound fax count, total fax pages sent, total faxes sent successfully, total failed faxes, and total faxes in process  
|                  | [2] Inbound fax statistics, including total inbound fax count, and total received fax pages |
|                  | [2] Enable automatic printing  
|                  | [3] Enable alternate notification |

Although you can enable automatic forwarding, automatic printing, and alternate notification via TeleConnect, you must first configure the forwarding, printing, and notification destinations in your FaxUtil mailbox.

Entering alphanumeric data via touch-tone phone

To enter an alphanumeric string (such as a recipient name for a cover sheet), enter each character by pressing the button for the character, then the position of the character on the button. For example, the telephone button “6” has the letters M, N, and O. To enter the letter “N”, you would press the “62” to indicate the second character on the number 6 button. To enter a number instead of a letter, use position zero. To enter a space, press “02”. The exceptions to this method are the letters Q (“01”) and Z (“03). The following table lists all characters available via this encoding method.

| Table 30b  Alphanumeric Touch-Tone Key Sequences |
|-----------|------------------------------------------|
| A = 21    | I = 43                                  |
| B = 22    | J = 51                                  |
| C = 23    | K = 52                                  |
| D = 31    | L = 53                                  |
| E = 32    | M = 61                                  |
| F = 33    | N = 62                                  |
| G = 41    | O = 63                                  |
| H = 42    | P = 71                                  |
|           | Q = 01                                  |
|           | R = 72                                  |
|           | S = 73                                  |
|           | T = 81                                  |
|           | U = 82                                  |
|           | V = 83                                  |
|           | W = 91                                  |
|           | X = 92                                  |
|           | Y = 93                                  |
|           | Z = 03                                  |
|           | 0 = 00                                  |
|           | 1 = 10                                  |
|           | 2 = 20                                  |
|           | 3 = 30                                  |
|           | 4 = 40                                  |
|           | 5 = 50                                  |
|           | 6 = 60                                  |
|           | 7 = 70                                  |
|           | 8 = 80                                  |
|           | 9 = 90                                  |

The decoded sequence will be used in the To: field on the fax cover sheet. You have 40 seconds to enter up to 60 digits, which will decode to a maximum of 30 characters.
Chapter 31
RightFax Dashboard

The RightFax Dashboard provides a view of RightFax server status in your Web browser. The view includes information about RightFax server system health and its core services status, including remote services. This view is display-only. It does not provide support to modify RightFax system status.

Configuring the RightFax Dashboard

Before displaying RightFax server status on the Dashboard, the RightFax server needs to be added in the configuration page. The server configuration includes RightFax Server IP/Host and RightFax credentials.

Note: By default, the RightFax Dashboard URL is configured with Windows authentication. Any Windows user can access the dashboard URL and view the configured server status. However, the configuration URL is limited to the Windows Administrators user group of the server where RightFax is installed. RightFax Administrators can modify the security settings.

To configure the dashboard to display information about one or more RightFax servers:

2. Enter the server name, user ID, and password for each server you want to display.
3. Click Add to add more servers to the Dashboard.
4. Click the red X to the left of a server name to remove it from the Dashboard.
5. When done, click Save.
6. By default, all errors generated by Dashboard are logged into the Windows event log under source ‘Application’. Administrators can change the logging configuration by editing the web.config file located at RightFax/WebApps/Dashboard.

Viewing the RightFax Dashboard

The RightFax Dashboard is a web application that can be accessed from any remote system.

   This URL can be accessed using Internet Explorer 9 or later, Firefox 12 or later, Opera 12 or later, Chrome 18 or later.
2. Select the RightFax server name in the list at the top right corner of the window.
3. Specify the Refresh interval in minutes. The default is to refresh the display once per minute.
4. Click the **Go** button. The information about the specified server appears.

Figure 31.1  The RightFax Dashboard

![RightFax Dashboard](image)

The Dashboard contains seven sections:
- **Server**
- **Services**
- **WorkServers**
- **Documents Queued**
- **Work Requests**
- **Doc Transports**
- **Channels**

The **Server** section shows a graph of CPU usage percentage and Hard Disk space available for fax images, where each block represents 10% of the available CPU or hard disk space. The blocks are color-coded as follows:
- Blue represents unused or available blocks of CPU or disk space.
- Green represents used blocks from 10% to 70% of CPU or disk capacity.
- Orange represents used blocks at 80% and 90% of CPU or disk space capacity.
- The red block indicates the usage of CPU or disk space is above 90%.

The **Services, WorkServers, and DocTransport** sections display the status of each component, with color-coding to indicate status as follows:
- Green indicates the elapsed time since the service or server started. The format of the displayed time is days:hours:minutes:seconds. For example, if the displayed value is 0002:01:54:23, the service has been running for 2 days 1 hour 54 min and 23 sec.
- Orange indicates a transition such as starting or stopping.
- Red with yellow text indicates that the service or WorkServer is stopped.

The **Documents Queued** section displays the number of documents queued for faxing by DocTransports. This section displays 0 until all outbound channels are busy.

The **Work Requests** section displays the number of work requests queued for gateways and WorkServers. Information in this section is displayed in a bar graph. The number of work requests queued for gateways displays in light yellow; the number for work servers appears in dark yellow.
The **Channels** section displays the status of all of the channels on the server, color-coded by status as follows:

- Idle: light gray
- Receiving: aqua
- Sending: purple
- Disabled: blue
The RightFax Internet Connector (RIC) is an optional module with which you can send faxes between trusted RightFax servers as secure peer-to-peer transmissions over the Internet, saving time and telephony expense. The receiving server registers its destination fax numbers with a cloud-based registry. The sending server checks the destination fax number against the registry, and if the number matches, the transmission will bypass the telephone system and be sent over the Internet. The fax is broken into secure packets for transmission. The receiving RightFax server reassembles the file and delivers the fax to the recipient associated with the destination fax number.

If for any reason the transmission cannot be completed successfully over the Internet, the fax is sent over the telephone system.

To configure the RightFax Internet Connector, you must:

- Create a RightFax Internet Connector account
- Configure the connector in the RightFax Sync Module
- Register the Fax System
- Configure the RightFax Internet Connector Transport
- Enable the RightFax Internet Connector Dialing Rule
- Configure the RightFax Internet Connector Receiver

Creating a RightFax Internet Connector Account

To create a RightFax Internet Connector Account:

1. Open a web browser and browse to http://www.rightfaxic.com/. The RightFax Internet Connector site uses Microsoft Silverlight v4. If you have not already installed Silverlight, you will be prompted to install Silverlight before continuing.
2. Click **Create an Account**. The Account Registration page appears.

![Account Registration Company Details](image1.png)

**Figure 32.1** Account Registration Company Details

3. Complete the company name and address information fields, including the SUID number you received from OpenText Fulfillment when purchasing the RIC option. The SUID is a **RightFax Internet Connector** specific **SUID**; it is not the same SUID used to activate the RightFax 10.5 system.

4. Click **Next** to display the Administrator Details page.

![Account Registration Administrator Details](image2.png)

**Figure 32.2** Account Registration Administrator Details

5. Enter the email address that will be the primary login for accessing the registered account, the name you want displayed for the Administrator, and at least one phone number.

6. Click **Finish** to send the entered information to OpenText.

7. OpenText will send a verification email to the specified email address. Click on the link in the email and follow the instructions that appear to specify the Administrator password and complete the registration process.
Configuring RightFax Internet Connector in the RightFax Sync Module

The RightFax Internet Connector uses the RightFax Sync Module to maintain a local list of registered destination fax numbers. The synchronized fax numbers are stored as encrypted strings.

Creating the RIC Source and Destination

In Enterprise Fax Manager, double-click RightFax Sync Module in the list of Service Names.

*Note* The Sync Module cannot be configured from a remote computer.

To add the RIC Source and Destination:

1. Click Sources & Destinations.

2. On the Sync Sources and Destinations dialog box, click New.

3. In the Type list, select RIC Fax Delivery (Source).

4. Enter a unique name for the source. The source name will be displayed on the tab in the Sync Module Configuration dialog box, preceded “RICS-”.

5. Click OK.

6. Click New again.

7. In the Type list, select RIC Fax Delivery (Destination).

8. Enter a unique name for the destination. The source name will be displayed on the tab in the Sync Module Configuration dialog box, preceded “RICD-”.

9. Click OK.

10. Click OK on the Sync Sources and Destinations dialog box.

The RICS and RICD source and destination tabs appear in the configuration dialog box.
Configuring the Sync Mapping and Schedule

1. Click the General tab.
2. In the Mappings section, click the New button.
3. In the Sync Mapping dialog box, Select RICS-<YourName> in the Source list.
4. Select RICSD-<YourName> in the Destination list.
5. Click Browse.
6. Navigate to the Default RIC Source to RightFax XSLT file and click Open. (This file is in Rightfax\CapaSync\config.)
7. Select a Schedule option and specify any required parameters. To disable RIC synchronization, select Never. To synchronize immediately after the Sync Module Configuration dialog box is closed, select the check box.
8. Click OK to close the Sync Mapping dialog box.

Configuring the RIC Source

The RIC Source is the cloud-based OpenText RightFax Internet Connector Registrar of verified fax numbers. To configure your system to synchronize with the registrar:

1. Click the RICS-<YourName> tab. The Registrar URL is provided, and Registration Code is initially blank.
2. Enter your local Area Code.
3. Select your Country Code from the list.
4. By default, only recently added or modified fax numbers are synced. To force a synchronization of all fax registered fax numbers, select the Force synchronization of all numbers with the registrar check box.
5. To generate your registration code, click Apply.

6. To register or update your fax server on the RightFax Internet Connector Web site, click Register Fax System. For information about registering your fax system, see “Registering the Fax System”.
7. Click OK to save changes to the RightFax Sync Module Configuration. The Sync Module service will restart automatically.

Registering the Fax System

Before you begin the registration process, you must have a configured the Sync Module and generated a Registration Code. See “Configuring the Sync Mapping and Schedule” on page 292.

1. Open a web browser and browse to http://www.rightfaxic.com/.
2. Log into your RightFax Internet Connector account.
3. Click the Add New Fax System link on the right side of the Fax System Summary group.

Figure 32.5  Account Summary on the RightFax Internet Connector site

4. Specify a Fax System Name and enter the Registration Code in the Activation Code field.
5. If this Fax System will also be receiving faxes, click the **Enable Receiver** check box and indicate how the public access point of the receiver will be configured.

   - **Shared Receiver**: The public access point will be created using the OpenText Microsoft Azure Subscription.
   - **Dedicated Receiver**: The public access point will be created using your own Microsoft Azure Subscription.
   - **Intranet Receiver**: Faxes will be received through a selected TCP port on the RightFax Server.

6. After specifying the Fax System properties, click **Save**.

   ![Fax System receiver types](image)

   **Figure 32.6 Fax System receiver types**

7. Add one or more fax numbers to the system in one of the following ways:

   - Click **Single**, choose a country code from the drop-down box, and enter one fax number in the first text entry box. Click **Add** to display the number in the **System Summary** window.
   
   - Click **Range**, choose a country code from the drop-down box, and enter the lowest numeric fax number in the first text entry box and the highest numeric fax number in the second text entry box. The two entered numbers and all numbers between them will be added to the system. Click **Add** to display the range of numbers in the **System Summary** window.
   
   - Click **Import** and browse to a CSV file that contains the fax numbers you want to add. The CSV file must contain the fax numbers in the first column.

8. Click **Close** to save the modifications and return to the Account Summary screen.

   When first entered, each fax number appears as **Non Verified** and **Inactive**. After OpenText verifies and approves the fax numbers, the status will change to **Verified** and **Active**.

   **Note**: if your organization has purchased phone numbers for faxing but these numbers are not yet in use, please contact OpenText at FaxNumberVerification@OpenText.com. OpenText staff will keep these numbers in inactive status until you notify us that they are ready to be used.
Configuring the RightFax Internet Connector Transport

To configure the RightFax Internet Connector transport in the RightFax DocTransport module:

1. In Enterprise Fax Manager, double-click RightFax DocTransport in the list of Service Names.
3. Under RightFax Internet Connector, click Peer to Peer Device, and then click Select.
4. On the DocTransport Configuration dialog box, expand RightFax Internet Connector in the list, and then click Peer to Peer Channels.
5. Enter the Fax ID. The fax ID is transmitted to remote fax machines to identify the sender. Usually, this is set to your company name or general fax number.
6. The RightFax Internet Connector includes the destination fax number with each transmission. In the Number of Digits for Routing box, enter the number of digits from the end of the destination fax number that will be used for routing received faxes.

Enabling the Dialing Rule

After installing the RightFax Internet Connector, a dialing rule is installed that, when enabled, will route outbound faxes to the RightFax Internet Connector Transport. For more information about dialing rules, see Chapter 20, “Creating Dialing Rules and Least-Cost Routing Plans”

To enable the dialing rule:

1. Open the RightFax Enterprise Fax Manager and select Dialing Rules (beneath Dialing Plan).
2. Double click on the dialing rule with +P2P in the Routing column to edit it.
3. Click on the Other tab and deselect the Rule Disabled check box.
4. Click the OK button to close the dialing rule.
5. From RightFax Enterprise Fax Manager select File -> Save Dialing Plan.

Creating Additional Dialing Rules

The installed dialing rule will only work with 12-digit fax numbers. To support numbers of other lengths, you must create additional dialing rules. To create new dialing rules for the RightFax Internet Connector, copy the existing dialing rule and make changes as needed:

1. Open RightFax Enterprise Fax Manager and go to the Dialing Rules section.
2. Right-click on the P2P Dialing Rule and select Duplicate.

Figure 32.7 Editing Dialing Rules

4. Click the Number Adjustments tab and enter the appropriate country code (i.e. for United States, use 01) in the Prepend this text box.

5. Click OK to close the dialog box/

6. In the RightFax Enterprise Fax Manager, select File-Save Dialing Plan.

Configuring the RightFax Internet Connector Receiver

To enable the RightFax Internet Connector to receive incoming faxes, you must configure a receiver. The type of receiver was set when the Fax System was registered (see “Registering the Fax System” on page 292).

To configure the receiver:

1. In Enterprise Fax Manager, double-click RightFax Internet Connector in the list of Service Names. The configuration window appears with the selected receiver type displayed.

2. Enter the Service port number.

Figure 32.8 RightFax Internet Connector Configuration
3. Enter the appropriate information for your receiver type:
   - For an intranet receiver, no additional information is required.
   - For a shared cloud receiver, no additional information is required.
   - For a dedicated cloud receiver, enter the information for your Windows Azure account.

4. Click **Configure**.

5. When the configuration process is complete, a confirmation window appears. Click **OK** to close the confirmation window.
Chapter 33
Back up and Maintaining
the RightFax Software and Database

RightFax stores all of its data, including information on faxes, users, and dialing rules in a SQL database (although fax images are stored separately as graphic files in the RightFax\Image folder). This database may be installed directly on the RightFax server, or can be installed on an existing SQL server. You select where the SQL database is to be installed when you install the RightFax server software.

The SQL Express server that is provided with RightFax includes all of the SQL functionality required by the RightFax software. However, this version of SQL does not include all of the tools and administrative capabilities as the full version.

It is strongly recommended that you do not make any changes directly to the RightFax SQL database. A complete schema of the RightFax database can be viewed using SQL Administrator. An image of the schema is also available in the Docs folder on RightFax installation CD in the file RightFax Database Schema.pdf.

Changing the Connection to the SQL Server

RightFax creates and links to a SQL database during installation. However, the SQL database connection can be modified if at any time you need to make changes to your existing SQL installation.

To edit the SQL connection, you must change the connection string in one of three places:
- RightFax Server configuration
- DocTransport configuration
- RightFax Remoting service
To view your current SQL connection information, run the RightFax Server program from Windows Control Panel and click the Advanced tab. The SQL connection string is displayed in the SQL Connection box.

Figure 33.1 The Server Configuration Advanced tab

Changing the SQL connection
The steps for changing the SQL connection are the same in all three applications. Make sure that you set the same SQL connection properties in all of these applications before making the registry change described in the next section.

1. Open each application and locate the SQL connection string in the SQL Connection box.
2. Click the [...] button to the right of this box. This opens the RightFax Server Database Connection String Editor dialog box.

Figure 33.2 RightFax Server Database Connection String Editor
3. Click Modify to display the General SQL Connection String Editor.

Figure 33.3 RightFax General SQL Connection String Editor

4. Enter the Server name, choose the Authentication method, and specify a database type. Depending on the type of authentication you choose, you may also need to enter a User Name and Password.

5. Click OK to close the editor window and display the new string in the SQL box.

6. Optional: Repeat steps 1 through 5 to enter connection string information for a redundant SQL connection.

Enabling RightFax to Use SQL Server Database Mirroring

Database mirroring is primarily a software solution for increasing database availability. Database mirroring maintains two copies of a single database that must reside on different server instances of a SQL Server Database Engine. One server instance serves the database to clients (the principal server). The other instance acts as a hot or warm standby server (the mirror server), depending on the configuration and state of the mirroring session. You can enable RightFax 10.0 and later to use SQL Server database mirroring. Once you have enable mirroring, however, you can no longer use the RightFax interface to make changes to your SQL Server connection string.

Requirements

- You must be running RightFax 10.0 or later. Earlier versions of RightFax do not support this functionality.
- The Microsoft SQL Server Native Client (SNAC) must be installed on the RightFax server.
- Connections using the SNAC must be made to an instance of SQL Server that does not run on the same computer as RightFax.

**IMPORTANT:** In the following procedure, you must stop the RightFax services and validate that the SQL Server database mirroring is working before you change any RightFax settings.

**OpenText Customer Support cannot provide assistance with setting up SQL Server Database Mirroring.**

Complete the following steps to configure SQL Server database mirroring for RightFax:

1. Install the Microsoft SQL Server 2012 Native Client. It is a single dynamic-link library (DLL) containing both the SQL Server OLE DB provider and SQL Server ODBC driver. It also contains runtime support for applications using native-code APIs to connect to Microsoft SQL Server 2000, 2005, or 2008. You can download the version of the Microsoft SQL Server 2012 Native Client that is appropriate for your version of Windows at the Microsoft Download Center.

2. Stop the RightFax services and verify that SQL Server mirroring is working properly before proceeding to the next steps. Do not modify any RightFax settings until you have confirmed that the SQL Server mirroring is working.
3. Modify your connection strings to use the SQL Native Client and to specify the SQL Server mirror (failover) instance. Enter the appropriate connection strings for your configuration as described in the following sections. Enter each string as a single line with no carriage returns.

**Connection string for 64-bit Windows using ADO**

```
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\RightFax\ADO SqlConnection
Value Data Source=myServerAddress;Failover Partner=myMirrorServerAddress;Initial Catalog=myDataBase;Integrated Security=True;
Example:
Data Source=SEDONA;Failover Partner=Bisbee;Initial Catalog=RightFax;Integrated Security=True
```

**Connection string for 64-bit Windows using ODBC**

```
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\RightFax\ODBC SqlConnection
Value Driver={SQL Server Native Client 10.0};Server=myServerAddress;Failover_Partner=myMirrorServerAddress;Database=myDataBase; Trusted_Connection=yes;
Example:
Driver={SQL Server Native Client 10.0};Server=Sedona;Failover_Partner=Bisbee;Database=RightFax; Trusted_Connection=yes;
```

**Back-up and restoring the RightFax server and database**

This section provides instructions for backing up and restoring the RightFax server software and SQL database using Microsoft’s OSQL command-line utility. The OSQL utility is automatically installed on your SQL server when you install either the full version of SQL or the SQL Express database provided with the RightFax server software. Backing up the server requires a separate backup storage device or software utility. OpenText does not provide support for third-party backup tools, so you should be familiar with your organization’s software backup tools and protocols before scheduling regular backups.

**Backing up and restoring the RightFax server**

All of the RightFax server files can be backed up using any standard disk or tape backup system. A complete backup of the server can be performed at any time without shutting down the
Backing Up and Maintaining the RightFax Software and Database

server or stopping the RightFax services. However, to ensure that your backup software does not cause any disruption or slowdown of the RightFax server, you should schedule backups only at night or during off-peak hours.

To back up the RightFax server software, back up the \RightFax folder and all of its subfolders. Because several RightFax configuration settings are stored in the Windows Registry, you should also back up the following registry keys:

- HKEY_CLASSES_ROOT\RightFax
- HKEY_LOCAL_MACHINE\Software\RightFax
  (64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax)
- HKEY_LOCAL_MACHINE\Software\RightFax Client
  (64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax Client)

Refer to the documentation for your backup software and/or Microsoft Windows for information on scheduling and executing periodic backups of your software and the registry, and for information on restoring from the backup.

Caution Because licensed RightFax features are tied to the name of the computer on which the software is installed, you must call OpenText Customer Support for assistance if you restore the RightFax server to a machine other than the one on which it was originally installed.

Backing up the RightFax database

RightFax stores most of its data in a SQL database which is stored and maintained separately from the core server software.

Depending on how the RightFax server software was installed, this database may be on a separate SQL server on your network, or a SQL Express database installed directly on the RightFax server computer. To perform a backup of the RightFax database, you must know where this database is installed, and you must have a user ID and password with administrative access to the database.

Important If you have upgraded from MSDE to SQL Server 2005 Express, the MSDB database has not been upgraded. Consequently, you may see error messages when attempting to run OSQL backup and restore procedures. These errors are cosmetic and do not cause any loss in functionality. For more information, see Microsoft Knowledge base article 907284.

To back up the RightFax database using OSQL

1. Open a command prompt on the SQL server or on the RightFax server if you are using SQL Express.
2. Navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn
3. Enter the command:

   osql -U UserID -P Password -H ServerName

Where UserID is a SQL user ID with administrative access, Password is the password for the specified user, and ServerName is the machine name of the server where the database is located. (When SQL is installed, the default user ID is “sa” and the default password is blank.) Note that the commands and parameters are case-sensitive.
4. On the command line that follows, enter the following command set:

```
BACKUP DATABASE rightfax TO DISK = 'C:\Backup\rightfax.bak' [Enter]
go [Enter]
exit [Enter]
```

Where C:\Backup is the name of the folder where you want the backup file to be stored. This can be a local folder or a folder on any mapped drive on the network. The backup process may take several minutes, depending on the size of the database. Note that the commands and parameters are case-sensitive.

To create a batch file for automating the database backup

To automate the database backup at a scheduled time you can create a batch file which will execute the OSQL backup command, and then add the batch file to your Scheduled Tasks list in Windows Control Panel.

**Caution** This batch file will overwrite any existing backup file in the target folder without prompting for confirmation.

The batch file should contain only the following command:

```
osql -U UserID -P Password -H ServerName -Q"BACKUP DATABASE rightfax TO DISK = 'C:\Backup\rightfax.bak'"
```

Where UserID is a SQL user ID with administrative access, Password is the password for the specified user, ServerName is the machine name of the server where the database is located, and C:\Backup is the name of the folder where you want the backup file to be stored. (When SQL is installed, the default user ID is “sa” and the default password is blank.) Note that the commands and parameters are case-sensitive.

**Restoring the RightFax Database**

Follow these steps to restore the RightFax database from a backup:

1. Open a command prompt on the SQL server or on the RightFax server if you are using SQL Express.
2. Navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn
3. Enter the command:

```
osql -U UserID -P Password -H ServerName
```

Where UserID is a SQL user ID with administrative access, Password is the password for the specified user, and ServerName is the machine name of the server where the database is located. (When SQL is installed, the default user ID is “sa” and the default password is blank.)

4. On the command lines that follow, enter this command set:

```
RESTORE DATABASE rightfax FROM DISK = 'C:\Backup\rightfax.bak' [Enter]
going [Enter]
exit [Enter]
```

Where C:\Backup is the name of the folder where the backup file was stored. The restore process may take several minutes, depending on the size of the database.

**Purging Deleted Fax Records from the Database**

RightFax stores records of all faxes, even if users have deleted the faxes from their fax mailboxes. When a user deletes a fax the fax record is saved and marked as belonging to a deleted fax. This is how the fax server is able to run reports on fax activity even when the fax images have been deleted.
Removing deleted fax records from the database is called “purging.” To keep the fax database to a manageable size, RightFax purges deleted fax records after a set length of time. The length of time fax records of deleted faxes are saved before being purged can be customized for each RightFax group.

To change the length of time RightFax keeps deleted fax records
1. Run Enterprise Fax Manager and click Groups.
2. Select the group ID to modify.
3. Click the Basic Information tab.
4. In the Days to Keep Deleted Fax Records box, enter the number of days to keep deleted fax records.

Purging Fax Records using DBPurge

DBPurge is database utility designed to purge fax records from the RightFax database. The options are listed and explained below.
- Faxes Deletes records of all faxes in the system
- Deleted Faxes Deletes records of deleted faxes from the database
- Billing Codes Deletes Billing Code entries from the database
- Work Requests Deletes queued Work Requests (notifications, Conversion jobs, print jobs, retries) from the database
- SQL Table Orphans Deletes orphaned records from the SQL table.

Using DBPurge
1. Log in to the fax server as an administrator.
2. Open the \RightFax\SharedFiles folder and double-click DbPurge.exe.
3. On the Open Server dialog, enter the RightFax server name followed by your account name and password. This account must have administrative access. You may also choose the box to ‘Use NT Authentication’ if your RightFax account is linked to the account you are logged into your network with. Click OK.
4. On the left side of the DBPurge dialog, enter the records you wish to purge.
5. Select the Preview button to view the total number of records to be purged.
6. Click the Purge button to begin purging fax records.
7. Upon completion you can view a transaction log by clicking the Log tab.

Purging Faxes from Users’ Fax Mailboxes

RightFax includes a feature called automatic fax aging that you can use to delete fax images from users’ fax mailboxes after a certain length of time. This can prevent older fax images from occupying too much hard drive space on your server. Automatic fax aging is only available if you have a RightFax Enterprise or Satellite server. This feature is configured separately for each group (see “The Automatic Fax Aging tab” on page 114). Individual users can be excluded from automatic fax aging by checking the Excluded from Group Fax Aging permission in their RightFax user profiles (page 100).

Removing Orphaned Faxes

Orphan.exe searches the RightFax server for fax image files that do not have any references in the RightFax database. The image files are called “orphans” because RightFax has no record of their existence and cannot access them. Using Orphan.exe, orphan image files can be deleted from the server, or their records can be restored in the RightFax database.
Orphan.exe is located in the RightFax\Database folder on the RightFax server. The Database and RPC services must be running when executing this utility.

**Syntax**

```
orphan -fcomputer -i"path" -uuserID [-a] [-n] [-z]
```

Table 33a  Orphan.exe Command Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a</td>
<td>Restore all orphan image files to a specified RightFax user. Requires the -f and -u options.</td>
</tr>
<tr>
<td>-fcomputer</td>
<td>Specify the name of the RightFax computer that contains the user ID that will be assigned the recovered fax images.</td>
</tr>
<tr>
<td>-i path</td>
<td>Specify the full path to the RightFax\Image folder. You must include the double-quotes around the path if the path includes a space character.</td>
</tr>
<tr>
<td>-n</td>
<td>Skip all prompts.</td>
</tr>
<tr>
<td>-u userID</td>
<td>Specify the RightFax user ID that will be assigned the recovered fax images.</td>
</tr>
<tr>
<td>-z</td>
<td>Erase orphan file images from the disk.</td>
</tr>
</tbody>
</table>

**Example**

```
orphan -fjanescomputer -i\"c:\progra~1\rightfax\image\" -ujanedoe -a
```

**Supported Database Collation**

The RightFax database supports only the SQL Language collation. **Case sensitivity, Accent sensitivity** and **Kana sensitivity** collations are not supported and may prevent RightFax services from starting.
Appendix A
RightFax Embedded Codes

Embedded codes are special faxing instructions that you insert directly into fax-bound documents. You can use embedded codes to address faxes, include fax cover sheet information, attach library documents, add billing information, insert your signature, and more.

To add an embedded code to a document, type the code you want, along with any required parameters, between angle brackets. For example, an embedded code that tells RightFax the destination fax number is written as:

\(<\text{TOFAXNUM:555-1212}>\)

The fax server removes all embedded codes from a document when it converts the document to fax form, so they don't appear in your final fax. Embedded codes can be written in either upper or lower case. If you type an embedded code incorrectly, it will not behave as expected and the embedded code text itself will appear in your fax.

Embeded codes can be placed anywhere in the document that you will be faxing, and can be used in any document that accepts text characters. Embedded codes cannot line wrap and any embedded code statement that is so long that it wraps to a second line will be ignored.

Notes:
- Embedded codes that are followed by this envelope icon (✉) are compatible with RightFax email gateways.

**Note** If you send faxes via an SMTP gateway and plan to use embedded codes, then you must select the **Use PCL converter for text files** option in your email configuration.

**ADDDOC**

**Format**  \(<\text{ADDDOC:file}>\)

Adds a file to the end of the fax. The specified file is not deleted after conversion. This additional file can be in one of over 45 of the most popular IBM and Macintosh native application file formats. If you have licensed the RightFax PDF module, you can also attach PostScript and PDF files. For a complete list of supported formats, see **Appendix B, “File Formats that Convert to Fax Format”**.

Specify the complete file path, including file name, extension, drive, and directory, and ensure that RightFax has access privileges. You should use the UNC to specify the file location (instead of a drive letter), because the mapping or drive links may be different on the fax server and the computer where the fax originated.

**Note:** If the attachment is located on a client machine, ensure that the client directory allows sharing so that the server can access the remote file and copy it to the fax.
More than one ADDDOC code can appear in a document. Each file will be appended in the sequence that the embedded code appears in the document.

Maximum field length: N/A.

Examples:
- `<adddoc:x:\bin\xyz.tif>`
- `<adddoc:\server8\sys\bin\xyz.tif>`

**ADDDOC2**

**Format**
```
<ADDDOC2:file>
```

Replaces the document containing this code with the specified file. The original specified file is then deleted after it is faxed. This file can be in one of over 45 of the most popular IBM and Macintosh native application file formats. If you have licensed the RightFax PDF module, you can also attach PostScript and PDF files. For a complete list of supported formats, see Appendix B, “File Formats that Convert to Fax Format”.

Specify the complete file path, including file name, extension, drive, and directory. You should use the UNC to specify the file location (instead of a drive letter), because the mapping or drive links may be different on the fax server and the computer where the fax originated.

Note: If the attachment is located on a client machine, ensure that the client directory allows sharing so that the server can access the remote file and copy it to the fax.

Maximum field length: N/A.

Examples:
- `<adddoc2:x:\bin\123.tif>`
- `<adddoc2:\server8\sys\bin\123.tif>`

**ADDDOC3**

**Format**
```
<ADDDOC3:file>
```

Adds another file to the end of the fax. The original specified file will be deleted after conversion. This additional file can be in one of over 45 of the most popular IBM and Macintosh native application file formats. If you have licensed the RightFax PDF module, you can also attach PostScript and PDF files. For a complete list of supported formats, see Appendix B, “File Formats that Convert to Fax Format”.

Specify the complete file path, including file name, extension, drive, and directory. You should use the UNC to specify the file location (instead of a drive letter), because the mapping or drive links may be different on the fax server and the computer where the fax originated.

Note: If the attachment is located on a client machine, ensure that the client directory allows sharing so that the server can access the remote file and copy it to the fax.

Maximum field length: N/A.

Examples:
- `<adddoc3:x:\bin\xyz.tif>`
- `<adddoc3:\server8\sys\bin\xyz.tif>`
Maximum field length: N/A.

**Note:** If the attachment is located on a client machine, ensure that the client directory allows sharing so that the server can access the remote file and copy it to the fax.

**Examples**

- `<adddoc4:x:\bin\xyz.tif>`
- `<adddoc4:\server8\sys\bin\xyz.tif>`

### ATDATE

**Format**  
`<ATDATE:date>`

Schedules the fax to send on a specific date. Dates can be expressed as relative or absolute. Relative dates give the number of days from today’s date. For example, “+7” represents one week from today. Absolute dates specify the exact date to send the fax. Absolute dates must be written in one of these formats: MM/DD/YY, MM-DD-YY, or MM-DD-YYYY.

If no send time is specified with the `<ATTIME>` code (page 307), the send time defaults to “now” (the current time of processing). For example, if a fax is sent to the queue at 3:30 p.m. and it contains only an `<ATDATE:+1>` code, it will be scheduled to send at 3:30 p.m. tomorrow.

Maximum field length: 10 characters

**Examples**

- `<ATDATE:9-15-99>`
- `<ATDATE:+2>`

### ATTIME

**Format**  
`<ATTIME:time>`

Schedules the fax to send at a specific time. The time can be relative or absolute.

Relative time is the number of hours or minutes from the current time. For example, “+2” is two hours from now. You can enter fractions of an hour in six-minute increments. Valid fractions of an hour are 0.1 through 0.9. You must enter at least one digit before and after the decimal point. For example, 1.5 and 0.3 are valid, and 1.50 and .3 are not valid.

Absolute time can be entered in 12-hour or 24-hour format. A colon separating hours and minutes is optional, and an “a” or “p” can be used to indicate A.M. or P.M. The fax server does not send the fax at exactly the minute specified. Rather, the fax becomes eligible for scheduling within 15 minutes of the specified time.

Specifying a time between the current time and midnight will schedule the fax to send today. Specifying a time earlier than the current time will schedule the fax tomorrow.

Maximum field length: 9 characters

**Examples**

- `<ATTIME:10:00p>`
- `<ATTIME:+2>`

### BILLINFO1

**Format**  
`<BILLINFO1:code>`

Assigns a billing code to the fax. If the RightFax administrator has set up the system to require billing codes, you must enter a valid billing code or the fax will not be sent.

**Note:** In order for a fax to be sent, embedded billing codes must comply with the billing code verification rules as set on the RightFax server (see “Requiring billing codes on received faxes” on page 135). For example, if “Verify Billing Codes” is enabled and requires both billing codes, a document that embeds only BILLINFO1 would not be sent. You would need to include both BILLINFO1 and BILLINFO2 to send the fax.

Maximum field length: 15 characters

**Example**

- `<BILLINFO1:4444>`
BILLINFO2
Format  <BILLINFO2:code>
Assigns a second billing code to the fax. If the RightFax administrator has set up the system to require billing codes, you must enter a valid billing code or the fax will not be sent.

Note: In order for a fax to be sent, embedded billing codes must comply with the billing code verification rules as set on the RightFax server (see “Requiring billing codes on received faxes” on page 135). For example, if “Verify Billing Codes” is enabled and requires both billing codes, a document sent that embeds only BILLINFO2 would not be sent. You would need to include both BILLINFO1 and BILLINFO2 to send the fax.

Maximum field length: 15 characters
Example  <BILLINFO2:5555>

BROADCAST
Format  <BROADCAST>
Fine-tunes the server for sending fax broadcasts to multiple recipients. Include this embedded code in the fax to eliminate unnecessary server processes and increase the speed at which a broadcast is sent. Using the <BROADCAST> code increases the interval at which the server polls for and returns status information. In addition, the server will not process requests for notification or automatic printing of sent faxes. However, the server will still automatically print failed faxes, if that option is selected.

Maximum field length: N/A.
Example  <CHANNEL:3>

COMPLETEEVENT
Format  <COMPLETEEVENT>
Enables complete events that can be serviced via the RightFax API. The new events are useful when writing code to send the status of the fax to a user, to a database, or to a host application.

Maximum field length: N/A.

CHANNEL
Format  <CHANNEL:channel#>
Sends the fax only on the specified channel of the fax board. This code is useful if your organization uses one channel for priority faxing, and you want the fax to go out right away. You can also use this code to limit fax broadcasts to one channel only, leaving the other channels free for priority faxing.

Although your server’s first fax channel is listed as number 0 (zero) in the RightFax DocTransport module, a value of 0 in this embedded code indicates that the server should use any available channel. For this reason, any channel you specify in this embedded code must be numbered one higher than the channel as it is listed in the DocTransport (i.e., specify <CHANNEL:5> to use channel 4 as displayed in the RightFax DocTransport. The DocTransport’s channel 4 is actually the fifth channel since channels begin numbering at zero.)

Maximum field length: N/A.
Example  <CHANNEL:3>
COVER

Format  <COVER>

Generates a RightFax cover sheet for the fax containing the code. If the user sending the fax containing this code is configured to automatically generate a cover sheet, only one cover sheet will be generated.

Unless a cover sheet file name is specified using the <FCSFILE> embedded code (page 309), this code will use the default cover sheet file.

Maximum field length: N/A

DELETE

Format  <DELETE>

Deletes the fax from the user’s FaxUtil mailbox after it has been successfully sent. This code overrides the default RightFax auto-delete setting.

Note: If you’re using this code with multiple fax recipients, the <DELETE> code must precede the <NEWDEST> code for each recipient. See “NEWDEST” on page 311.

Maximum field length: N/A

DELETEALL

Format  <DELETEALL>

Deletes the fax from the user’s FaxUtil mailbox after it has been sent, whether or not the send was successful. This code overrides the default RightFax auto-delete setting.

Maximum field length: N/A

DELETEFIRSTPAGE

Format  <DELETEFIRSTPAGE>

Removes the first page of the fax. Use this code when you want to put all production embedded codes on the first page of a document, but not send that page to the recipient. This code is typically used when it is easier to add a page to the front of a document than to insert production embedded codes into the print stream coming from the host.

Maximum field length: N/A

DELETELASTPAGE

Format  <DELETELASTPAGE>

Removes the last page of the fax. Use this code when you want to put all production embedded codes on the last page of a document, but not send that page to the recipient. This code is typically used when it is easier to add a page to the end of a document than to insert production embedded codes into the print stream coming from the host.

Maximum field length: N/A

FCSFILE

Format  <FCSFILE:filename>

Uses the specified file as the RightFax-generated cover sheet. The cover sheet file must exist in the RightFax\FCS folder on the RightFax server and must end with the extension .pcl. Do not specify a directory path.

Maximum field length: 12 characters

Example  <FCSFILE:MYCOVER1.PCL>
FINE

Format `<FINE>`

Converts the body of the fax using “fine” resolution (200 × 200 DPI). This is recommended only for faxes with detailed graphics or faxes that will be OCRed. This code overrides the default fax resolution set in the user’s FaxUtil mailbox.

Maximum field length: N/A

Example `<FINE>`

FORMTYPE

Format `<FORMTYPE:formID>`

Overlays the fax onto the specified RightFax form.

Maximum field length: 15 characters

Example `<FORMTYPE:LETTERHEAD>`

FROMFAXNUM

Format `<FROMFAXNUM:faxnumber>`

Specifies the sender’s fax number on the RightFax-generated fax cover sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example `<FROMFAXNUM:(520)555-1234>`

FROMGENFAXNUM

Format `<FROMGENFAXNUM:faxnumber>`

Specifies the company’s general fax number to be placed on the RightFax-generated fax cover sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Note: The PCL Cover sheet code for this embedded code is `<GENERALFAXNUM>`.

Maximum field length: 31 characters

Example `<FROMGENFAXNUM:(520)555-2345>`

FROMGENPHONE

Format `<FROMGENPHONE:phonenumber>`

Specifies the company’s general phone number to be placed on the RightFax-generated fax cover sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Note: The PCL Cover sheet code for this embedded code is `<OPERATORNUM>`.

Maximum field length: 31 characters

Example `<FROMGENPHONE:(520)555-3456>`

FROMNAME

Format `<FROMNAME:name>`

Specifies the sender’s name to be placed on the RightFax-generated fax cover sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 59 characters

Example `<FROMNAME:Jane Doe>`

FROMPHONE

Format `<FROMPHONE:phonenumber>`

Specifies the sender’s phone number to be placed on the RightFax-generated fax cover sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example `<FROMPHONE:(520)555-4567>`
**IGNORE**

Format: `<IGNORE>`

Causes all subsequent embedded codes to be ignored.

Maximum field length: N/A

**LIBDOC**

Format: `<LIBDOC:documentID>`

Sends the specified RightFax library document instead of sending the document containing the code. Multiple library documents can be specified, each as a separate LIBDOC code.

*Important* When used with email gateways, this embedded code will function exactly the same as LIBDOC2.

Maximum field length: 21 characters

Example: `<LIBDOC:INFOPACK1>`

**LIBDOC2**

Format: `<LIBDOC2:documentID>`

Sends the specified RightFax library document in addition to sending the document containing the code. Multiple library documents can be specified, each as a separate LIBDOC2 code.

Maximum field length: 21 characters

Example: `<LIBDOC2:INFOPACK1>`

**NEWDEST**

Format: `<NEWDEST>`

Tells RightFax that you want to send this fax document to multiple recipients. The `<NEWDEST>` code must appear after each and every destination, including the last one. The `<NEWDEST>` code allows the following codes to be repeated in a document:

- TONAME
- TOFAXNUM
- TOCONTACTNUM
- TOCOMPANY
- TOCITYSTATE
- BILLINFO1
- BILLINFO2

If `<NEWDEST>` is not used, only the last occurrence of any of these embedded codes will take affect.

This code is not used to break one document into multiple faxes, but rather faxes one entire document to multiple recipients.

*Note:* If you’re using this code with either the `<SAVE>` or `<DELETE>` embedded codes, that code must precede the `<NEWDEST>` code for each recipient. See “DELETE +" on page 309 or “SAVE +" on page 314.

Maximum field length: N/A

Example:

```
<TONAME:JOHN><TOFAXNUM:555-1234><NEWDEST>
<TONAME:MARY><TOFAXNUM:230-5000><NEWDEST>
<TOFAXNUM:555-3006><SAVE><NEWDEST>
```

The above example will send the same fax to three different fax numbers. The ones sent to John and Mary will use their default save or delete preferences. The one sent to 555-3006 will override the preferences and save the documents after being sent.
NEWLIB

Format `<NEWLIB:libdocID,description>`

Automatically creates or updates a library document from the document containing the code. Specify a new or existing library document ID and description. If the specified document ID already exists, that library document will be replaced. If no matching document ID exists, a new library document will be created. The newly created library document will automatically be assigned LAN accessibility only.

Maximum field length: N/A.

Example `<NEWLIB:novpricesheet,november_prices>`

NEWLIB2

Format `<NEWLIBW:libdocID,description,LFWC>`

Automatically creates or updates a library document from the document containing the code. Specify a new or existing library document ID and description. If the specified document ID already exists, that library document will be replaced. If no matching document ID exists, a new library document will be created. In addition, you can assign accessibility attributes for each document. The library document will automatically be assigned accessibility rights based on the following flags:

- L = LAN
- F = Fax on Demand
- W = Web
- C = Catalog

Maximum field length: N/A.

Example `<NEWLIBW:novpricesheet,november_prices,LFWC>`

NOBODY

Format `<NOBODY>`

Tells RightFax to send only the cover sheet, and not include a fax body document. Any embedded codes in the document that are not used for the production of the cover sheet will be ignored.

Maximum field length: N/A

NOCOMPLETEEVENT

Format `<NOCOMPLETEEVENT>`

Disables complete events. For more information, see “COMPLETEEVENT” on page 308.

Maximum field length: N/A.

NOCOVER

Format `<NOCOVER>`

Turns off automatic RightFax cover sheet generation for the document containing this code.

Maximum field length: N/A

NORMAL

Format `<NORMAL>`

Converts the body of the fax using “normal” resolution (200×100 DPI). Normal resolution faxes can be transmitted much faster than fine resolution faxes, saving time and phone charges. This code overrides the default fax resolution set in the user’s FaxUtil mailbox.

Maximum field length: N/A

NOSMARTRESUME

Format `<NOSMARTRESUME>`

Disables the Smart-resume feature.

Maximum field length: N/A
**NOTE**

*Format*  `<NOTE:txt>`

Adds comments to your cover sheet. You can use as many as 21 `<NOTE>` codes in a single document if you want to enter multi-line comments. The comments will not be reformatted or line wrapped by RightFax.

Maximum field length: Up to 21 `<NOTE>` codes per document, each code having up to 69 characters.

*Example*  `<NOTE:THE QUICK BROWN FOX JUMPS OVER THE>`
`<NOTE:LAZY DOG.>`

**NOTIFY_ERROR**

*Format*  `<NOTIFY_ERROR>`

Notifies the sender when the fax is abandoned due to transmission errors using the Notification Info setting in the user's RightFax user account.

Maximum field length: N/A

**NOTIFY_OK**

*Format*  `<NOTIFY_OK>`

Notifies the sender upon successful transmission of the fax using the Notification Info setting in the user’s RightFax user account.

Maximum field length: N/A

**RETRYCOUNT**

*Format*  `<RETRYCOUNT:#>`

Specifies the number of times the fax will be retried after encountering transmission errors (such as a busy signal or human answered line). A value of 0 (zero) tells the fax server to use the system defaults.

Maximum field length: 2 numeric digits

*Example*  `<RETRYCOUNT:3>`

**PREVIEW**  

*Format*  `<PREVIEW>`

Holds the fax for preview in your FaxUtil mailbox. You must view the fax in FaxUtil and select **Release** from the **File** menu before it will send.

Maximum field length: N/A

**PRIORITY**

*Format*  `<PRIORITY:priority>`

Sets the priority of the outgoing fax. Allowed settings are: Low (L), Normal (N), and High (H). If a user specifies high priority and does not have the “Can use high priority” permission, the fax will be sent with “normal” priority.

Maximum field length: N/A

*Examples*  `<PRIORITY:HIGH>`
`<PRIORITY:N>`
`<PRIORITY:LOW>`
RETRYINTERVAL

Format  <RETRYINTERVAL:#>

Specifies the length of time in minutes between retry attempts when transmission errors (such as a busy signal or human answered line) are encountered.

Maximum field length: 2 numeric digits

Example  <RETRYINTERVAL:2>

SAVE 

Format  <SAVE>

Instructs RightFax to not delete the fax image from the user's FaxUtil mailbox after being sent. This overrides any default auto-delete setting.

Note:  If you're using this code with multiple fax recipients, the <SAVE> code must precede the <NEWDEST> code for each recipient. See “NEWDEST” on page 311.

Maximum field length: N/A

SIGNATURE

Note  Signature files are currently not supported in outbound PDF documents.

Format  <SIGNATURE:signatureID>

Specifies a signature image to place in the document. The signature will be inserted into the document at the exact location of the <SIGNATURE> embedded code. You can include an unlimited number of <SIGNATURE> codes in each document. If you are not listed as an authorized user of the signature file, the fax will be failed by the fax server. For information on creating and using signature files, see Chapter 11, “Creating Signatures”.

Maximum field length: 21 characters

Example  <SIGNATURE:BOB>

SMARTRESUME

Format  <SMARTRESUME>

Enables the Smart-resume feature.

Maximum field length: N/A

TOALTFAXNUM

Format  <TOALTFAXNUM:faxnumber>

Specifies an alternate fax number that will be tried if the server is unable to send the document to the primary fax number. This number will not appear on the fax anywhere, it is only used if the primary fax number fails. See “TOFAXNUM” on page 315.

Maximum field length: 31 characters

Example  <TOALTFAXNUM:520-555-1212>

TOCITYSTATE

Format  <TOCITYSTATE:city, state>

Specifies the fax recipient’s city and state information for display on the cover sheet. This code can include not only the city and state of the recipient, but the full street address as well.

Maximum field length: 59 characters

Example  <TOCITYSTATE:TUCSON, AZ>

TOCOMPANY

Format  <TOCOMPANY:company>

Specifies the fax recipient’s company name for display on the cover sheet.

Maximum field length: 59 characters

Example  <TOCOMPANY:ACME, INC.>
**TOCONTACTNUM**

Format: `<TOCONTACTNUM:phonenumber>`

Specifies the fax recipient's voice number for display on the cover sheet.

Maximum field length: 31 characters

Example: `<TOCONTACTNUM:520-555-1212>`

**TOFAXNUM**

Format: `<TOFAXNUM:faxnumber>`

Specifies the fax recipient's fax number for dialing and also for display on the cover sheet.

Maximum field length: 31 characters

Example: `<TOFAXNUM:520-555-1212>`

**TONAME**

Format: `<TONAME:name>`

Specifies the fax recipient's name for display on the cover sheet. If the name matches one of your individual or group RightFax phonebook entries, RightFax uses the corresponding fax addressing information to send the fax. To use an entry from another user's RightFax phonebook, use the syntax:

`UserID!Entry`

Only published entries of other RightFax users can be referenced this way.

Maximum field length: 59 characters

Example: `<TONAME:JANE DOE>`

**UNIQUEID**

Format: `<UNIQUEID:faxID>`

Specifies a unique ID for the fax instead of having one automatically generated by RightFax. Custom unique IDs can be used for external document tracking systems.

Maximum field length: 15 characters

Example: `<UNIQUEID:XYZ120396>`
Appendix B
File Formats that Convert to Fax Format

The following table lists the software applications and document file formats that can be converted to faxes by the built-in conversion engine on the RightFax server. These file types can be converted from their native format by sending as file attachments to a fax message or by using the Send To function in Windows.

Before conversion, RightFax checks the whitelist.txt file (in the RIGHTFAX/bin directory) to determine whether attachments should be converted to fax format or not. By default, this file contains all supported file types. To prevent a file type from converting, you can either delete the file type from whitelist.txt, or turn it into a comment by preceding the file type with a comma in the whitelist.txt file. Conversions handled through PCL will always be processed, regardless of the white list contents.

Table B1  Supported Document File Formats

<table>
<thead>
<tr>
<th>Application or file format</th>
<th>Supported versions</th>
<th>Common Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ami Pro</td>
<td>All versions</td>
<td>.SAM</td>
</tr>
<tr>
<td>ANSI text (7 &amp; 8 bit)</td>
<td>All versions</td>
<td>.TXT</td>
</tr>
<tr>
<td>ASCII text (7 &amp; 8 bit)</td>
<td>All versions</td>
<td>.TXT</td>
</tr>
<tr>
<td>Bitmap</td>
<td>Windows versions</td>
<td>.BMP</td>
</tr>
<tr>
<td>Multi-page PCX</td>
<td>Microsoft Fax</td>
<td>.DCX</td>
</tr>
<tr>
<td>EPS</td>
<td>If TIFF image is embedded</td>
<td>.EPS</td>
</tr>
</tbody>
</table>

Table B1  Supported Document File Formats (Continued)

<table>
<thead>
<tr>
<th>Application or file format</th>
<th>Supported versions</th>
<th>Common Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>G3</td>
<td>All versions</td>
<td>.G3, .BG3</td>
</tr>
<tr>
<td>GIF</td>
<td>All versions</td>
<td>.GIF</td>
</tr>
<tr>
<td>HTML</td>
<td>Versions through 4.0</td>
<td>.HTM, .HTML</td>
</tr>
<tr>
<td>JPEG</td>
<td>All versions</td>
<td>.JPG, .JPEG, .EXIF</td>
</tr>
<tr>
<td>Lotus 1-2-3</td>
<td>All versions</td>
<td>.123</td>
</tr>
<tr>
<td>Lotus Wordpro</td>
<td>All versions</td>
<td>.LWP</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>Versions 2000 through 2010</td>
<td>.XLS, .XLSX</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>Versions 2000 through 2010</td>
<td>.PPT, .PPTX</td>
</tr>
<tr>
<td>Microsoft Rich Text Format</td>
<td>All versions</td>
<td>.RTF</td>
</tr>
<tr>
<td>Microsoft Visio</td>
<td>2000 through 2010</td>
<td>.VSD</td>
</tr>
</tbody>
</table>
### Table B1  Supported Document File Formats (Continued)

<table>
<thead>
<tr>
<th>Application or file format</th>
<th>Supported versions</th>
<th>Common Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Word (see note below)</td>
<td>2000 through 2010</td>
<td>.DOC, .DOCX</td>
</tr>
<tr>
<td>Microsoft WordPad</td>
<td>All versions</td>
<td>.TXT, .WPC</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>Versions through 8.0</td>
<td>.WPS</td>
</tr>
<tr>
<td>Microsoft XML Paper specification</td>
<td>All versions</td>
<td>.XPS</td>
</tr>
<tr>
<td>MIME</td>
<td>All versions</td>
<td>.MHTML</td>
</tr>
<tr>
<td>PCX bitmap</td>
<td>All versions</td>
<td>.PCX</td>
</tr>
<tr>
<td>Portable Document Format (see note below)</td>
<td>All versions</td>
<td>.PDF</td>
</tr>
<tr>
<td>Portable Network Graphic</td>
<td>All versions</td>
<td>.PNG</td>
</tr>
<tr>
<td>Post Script</td>
<td>All versions</td>
<td>.PS, .EPS</td>
</tr>
<tr>
<td>Text-based configuration files</td>
<td>Varies by product</td>
<td>.FTP, .FRM, .WPC</td>
</tr>
<tr>
<td>TIFF CCITT Group 3 &amp; 4</td>
<td>All versions</td>
<td>.TIFF</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>UNI, UTF-8, UTF-8E</td>
<td>.TXT</td>
</tr>
<tr>
<td>UUEncode</td>
<td>No specific version</td>
<td>.TXT</td>
</tr>
<tr>
<td>vCard</td>
<td>All versions</td>
<td>.VCF</td>
</tr>
<tr>
<td>Visio</td>
<td>All versions</td>
<td>.VSD</td>
</tr>
<tr>
<td>XML</td>
<td>All versions</td>
<td>.XML</td>
</tr>
</tbody>
</table>

**Important**  Conversion of PDF attachments and Postscript requires the RightFax PDF Module.

Appendix C
Error and Status Messages

A new fax has arrived for (user ID) from remote ID: (remote ID)
Another user has designated you to be their alternate for notification and they have received a new fax.

A new fax has arrived for (user ID) which hasn't been viewed or printed
A member of the group for which you are the RightFax administrator or alternate administrator has received a fax and has not viewed or printed it within one hour of receipt.

A new fax has arrived from remote ID: (remote ID)
You have received a new fax. You will continue to be notified for one hour (or other period specified by your administrator). If you do not view or print the fax, your group's administrator will be notified. If he does not print the fax, your group's alternate administrator will be notified.

An outgoing fax is ready for previewing
The fax you requested be held for preview has been processed by RightFax and is waiting in your FaxUtil mailbox. You must select Release from the File menu to start the sending process.

Answer tone detected
RightFax could not connect with the remote (receiving) fax machine due to communication errors between it and RightFax.

Bad FCS information
Incorrect information was entered on the cover sheet (via the Fax Information screen or embedded codes).

Bad formtype
You have specified a form that does not exist or is corrupt in the Fax Information screen or through embedded codes.

Bad phone number
You entered an incorrect or nonexistent fax phone number.

Bad signature code
The signature code is not recognized as a valid signature identifier because it is corrupt or does not exist.

Call answered before one full ring
RightFax did not receive a normal length ring-back signal from the phone company's central office.
Can't access scans
RightFax can’t access the documents you scanned with the scanner.

Carrier not detected
RightFax did not detect a dial tone when it tried to dial out.

Command time exceeded
This is a timing related error, possibly when the fax card waits for or sends a command (T30 protocol handshaking commands) and doesn’t get a response within a required period of time.

Command time too short
This is a timing related error, possibly when the fax card waits for or sends a command (T30 protocol handshaking commands) and doesn’t get a response within a given period of time.

Command timeout
This is a timing related error, possibly when the fax card waits for or sends a command (T30 protocol handshaking commands) and doesn’t get a response within a given period of time.

Communications line failure
The fax card was unable to make a valid connection with the remote machine.

Conversion Error Record
Attachment type PARTTYPE_BINARY is not allowed. This error typically occurs when you try to attach executable or password-protected files, or attempt to add invalid file types to the white list.

Conversion failed
RightFax was unable to convert your document to Group III format.

Dial failure or no dial tone
RightFax cannot detect a dial tone because there is a problem with the phone line or the fax card is configured incorrectly.

Duplicate
The fax is a duplicate. It has been forwarded to you by another user.

Equipment busy tone detected
The remote (receiving) fax machine’s phone line is busy.

Fax blocked from dialing phone number
One or more dialing rules disallow sending faxes to the specified phone number.

Fax discarded
RightFax deleted your fax job. Contact your administrator.

Fax number busy
RightFax has tried to send your fax the required number of times (default=5 times) and each time the phone number was busy.

Fax to (name) abandoned, too many retries
RightFax will try to successfully send your fax a specified number of times (determined by the administrator) then stop trying. The default value is five tries.

Fax to (name), (error)
Your outgoing fax encountered the error listed. (See the error listed for more information.)
### FCS create failed
The cover sheet of your fax could not be created due to a corrupt or incompatible cover sheet format.

### Function not implemented
An operation was attempted that is not currently supported by your fax card software.

### G2 fax machine
You have attempted to send a fax to a Group II machine, rather than a Group III machine.

### Held for preview
You have specified in the Fax Information screen or through embedded codes that you want to preview this fax before sending it. You must select Release from the File menu in FaxUtil to start the sending process.

### Human answered
RightFax detected an unknown sound after it dialed the fax number. The unknown sound could be a human voice, recording, or line noise.

### Illegal line number
You have attempted to send a fax on a fax channel that does not exist.

### Illegal option in call
This error could occur if an invalid parameter is given for one of several different commands, including: LOG, DEBUG, XFER, SEND.

### Illegal parameter value
This error could occur if an invalid parameter is given for one of several different commands, including: LOG, DEBUG, XFER, SEND.

### Illegal sig. use
You have included a signature in your fax that you are not authorized to use.

### Imaging error encountered, fax abandoned
RightFax was unable to convert your document to Group III format for transmission.

### In conversion
RightFax is converting your document to fax format for transmission.

### In validation
The signature and/or billing codes in your fax are being validated against the RightFax database.

### Info not complete
You have not completed all the required fields (in the Fax Information screen or through embedded codes) for RightFax to send the fax.

### Initial processing
RightFax is checking your document for embedded codes and counting the number of pages in your fax.

### Invalid billing code
You have entered a billing code that is incorrect or does not exist.
Invalid embedded code
You have included a misspelled or nonexistent embedded code in your fax.

Line in use
RightFax was not able to send your fax because there were no outgoing phone lines available.

Loop current detected
When RightFax attempts to go off-hook to send a fax, it finds that the phone is already off-hook. This can occur when two devices are sharing a phone line and attempt to use it at the same time. It might also be a fax card configuration error.

Loop current failed
The fax card did detect current on the line, but did not detect a valid value for Loop Current.

Loop current not detected
The fax card was looking for Loop Current before it attempted to dial the fax number, but didn’t find any.

Network congestion detected
The network may be running inefficiently and causing traffic, or an invalid fax number may have been dialed.

Network high and dry (no ring)
The fax card does not detect any type of telephone interface available. This is a very serious error. Contact your RightFax administrator immediately.

No answer at fax #
The fax machine at the receiving end didn’t answer or a wrong number was dialed.

No answer tone detected
The phone is ringing at the destination, but the fax machine is not answering within the specified time. This is especially prevalent in international calling when it can take up to a minute to connect to the remote station.

Non-G3 modem detected
RightFax has detected a non-Group III fax modem on the remote (receiving) fax machine, and cannot communicate with it.

OCR error
An error occurred while a document was being sent to or was at the Optical Character Recognition module of RightFax.

OCR in process
Your fax has been queued and is being processed by the OCR module.

OK
RightFax has successfully sent your fax over the phone lines. This does not guarantee successful receipt of the fax at its destination.

One of your outgoing faxes needs attention
You have not completed all the required fields in the Fax Information screen or through embedded codes for the fax to be sent.

P2 was not detected at the end of training
This is a training error indicating a performance problem with the fax server and the number of fax cards that it contains.
Phone line problems
There is a problem with the phone lines at the fax server.

Poor quality
There was too much line noise for the fax to be transmitted correctly. The fax may have been sent, but it may be difficult to read.

Printing
Your fax is printing.

Printing error
An error occurred while printing.

Protocol reject message
This is a generic protocol error code that could have several meanings. In general, your fax card is having difficulty talking to the remote fax machine because it is getting the signals it expected.

Protocol timeout
This is a generic protocol error code that could have several meanings. In general, your fax card is having difficulty talking to the remote fax machine because it is not getting the signals it expected in the appropriate time frame.

Queued for OCR
The fax has been queued and is waiting for the OCR module to convert it.

Queued for printing
The fax has been queued and is waiting to be printed.

Ringback signal detected
A ring-back signal was detected when it should not have been. This may be due to interrupting a call in process on a shared line, or could be caused by a lot of noise on a T1 phone line.

Ringback, but no answer tone
The phone rang at the destination, but it was never answered. This might be because the receiving fax machine is off-line or unable to receive faxes.

Ringback, then busy condition
The fax number dialed went off-hook and then went on-hook very quickly, generating a fast busy signal.

Scheduled for send
Your fax was successfully converted to the RightFax Group III format and is now being sent to the fax card to await sending. If you specified a date and time to send the fax, RightFax will wait to send it until then.

Scheduling failed
Your fax was converted correctly, but it couldn’t be correctly queued to be sent.

Sending
RightFax is transmitting your fax.

Sending fax to (name) at (faxnumber)
Your fax is being sent to the name and fax number specified.

Sig needs authorization
You must be authorized to use the signature you have included in your fax.
**Thermal record**
You have recorded a fax that was sent or received on a conventional fax machine for database purposes only.

**Training algorithm detected FSK**
This training error indicates a performance problem with the fax server and the number of fax cards it contains.

**Training algorithm found on PN**
This training error indicates a performance problem with the fax server and the number of fax cards it contains.

**Tx/Rx error**
This transmission/reception error indicates that the receiving fax machine was experiencing difficulties or excessive line noise.

**Unknown error**
An error condition reported to RightFax from another device is not supported or not recognized.

**Unknown error code**
An error condition reported to RightFax from another device is not supported or not recognized.

**Unknown status code**
An unknown status code has been returned to RightFax from your fax card.

**Voice response to call**
RightFax detected a sound that it didn't expect after it dialed the fax number. The sound could be a human voice, recording, or line noise.

**Waiting for conversion**
RightFax is busy with another process and has queued your fax to be converted.

**Waiting to be sent**
The fax has not yet been scheduled for faxing.

**Your fax has been successfully sent to (name) at (faxnumber)**
Your fax was successfully sent over the phone lines. This does not guarantee successful receipt of the fax at its destination.

**Your outgoing fax contains an invalid billing code**
You have either not entered a required billing code, or entered one that does not exist.
The RightFax Alerting and Monitoring service (described in Chapter 18, “Using the Alerting and Monitoring Service”) lets you monitor and receive alerts about several statistics relating to your RightFax server. These statistics are divided into categories (described in “Editing Alert Properties” on page 163). This appendix lists each category (specified in the Category box on the Alert Properties dialog box), and the statistics you can select for each category (specified in the Statistics to monitor box on the Alert Properties dialog box).

Each category is listed below with its corresponding statistics, including the definition of each statistic and whether an alert can be generated for that statistic. The statistic categories listed in this appendix are:

- “Fax Server Statistics” (page 325)
- “Database Statistics” (page 326)
- “Workserver Statistics” (page 328)
- “Gateway Statistics” (page 329)
- “Local BoardServer Statistics” (page 330)
- “All BoardServers Statistics” (page 333)
- “RPC Server Statistics” (page 334)
- “Paging Server Statistics” (page 335)
- “Local Document Transport Server Statistics” (page 336)

### Fax Server Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newest activity index</td>
<td>The total number of activities since the RightFax Server module was last started. Activities can be viewed using FaxStat.exe.</td>
<td>No</td>
</tr>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the fax server.</td>
<td>No</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the Fax Server service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Maximum events in queue</td>
<td>The current maximum size of the internal event queue (described on page 15).</td>
<td>No</td>
</tr>
<tr>
<td>Events in queue</td>
<td>The number of events waiting to be processed by the fax server.</td>
<td>No</td>
</tr>
<tr>
<td>Events processed</td>
<td>The total number of events processed by the fax server since the Fax Server module was started.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Database Statistics

#### Table D2 Statistics available for the Database category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the RightFax database.</td>
<td>No</td>
</tr>
<tr>
<td>Number of database threads</td>
<td>Total number of threads that the Database module has managing database queries and changes.</td>
<td>No</td>
</tr>
<tr>
<td>Number of file I/O threads</td>
<td>Total number of threads that the Database module has managing files.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Table D2 Statistics available for the Database category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time running</td>
<td>The length of time since the Database service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Database server thread info</td>
<td>This statistic is reserved for future use.</td>
<td>No</td>
</tr>
<tr>
<td>File I/O thread info</td>
<td>This statistic is reserved for future use.</td>
<td>No</td>
</tr>
<tr>
<td>Current Database operation</td>
<td>The current database activity by thread.</td>
<td>No</td>
</tr>
<tr>
<td>Last Database command</td>
<td>Last RightFax API command performed on the database by thread.</td>
<td>No</td>
</tr>
<tr>
<td>Number of Database read failures</td>
<td>The total number of errors that have occurred during the read process since the Database module was last started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of Database write failures</td>
<td>The total number of errors that have occurred during the write process since the Database module was last started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Client Database I/O type</td>
<td>This statistic is reserved for future use.</td>
<td>No</td>
</tr>
<tr>
<td>Total Database bytes read</td>
<td>The total number of bytes read from the database since the Database module was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total Database bytes written</td>
<td>The total number of bytes written to the database since the Database module was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total Database commands processed</td>
<td>Total number of API commands performed by the database since the Database module was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Time last Database command took</td>
<td>The length of time for the last database command to be processed.</td>
<td>Yes</td>
</tr>
<tr>
<td>User ID of last Database command</td>
<td>The NT user account used for the last database command.</td>
<td>No</td>
</tr>
<tr>
<td>Current File I/O operation</td>
<td>The current file activity by thread.</td>
<td>No</td>
</tr>
<tr>
<td>Last File I/O command</td>
<td>The last file I/O API command performed on the database by thread.</td>
<td>No</td>
</tr>
<tr>
<td>Number of File I/O open failures</td>
<td>The total number of failed file open commands by thread since the database module was started</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of File I/O read failures</td>
<td>The total number of failed file read commands by thread since the database module was started</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of File I/O write failures</td>
<td>The total number of failed file write commands by thread since the database module was started</td>
<td>Yes</td>
</tr>
<tr>
<td>Client File I/O type</td>
<td>This statistic is reserved for future use.</td>
<td>No</td>
</tr>
<tr>
<td>Total File I/O bytes read</td>
<td>The total number of bytes read from files by thread</td>
<td>No</td>
</tr>
</tbody>
</table>
### Workserver Statistics

#### Table D2  Statistics available for the Database category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total File I/O bytes written</td>
<td>The total number of bytes written to files by thread</td>
<td>No</td>
</tr>
<tr>
<td>Total File I/O commands processed</td>
<td>The total number of API commands performed for file I/O since the Database module was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Time last File I/O command took</td>
<td>The length of time for the last file I/O command to be processed.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

#### Table D3  Statistics available for the WorkServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVL conversion requests processed</td>
<td>The total number of CVL things since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Delete requests processed</td>
<td>The total number of deleted faxes since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>File route requests processed</td>
<td>The total number of faxes routed to network directories since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>OCR requests processed</td>
<td>The total number of faxes that have been converted to text since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Overlay requests processed</td>
<td>The total number of overlay forms generated since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Print requests processed</td>
<td>The total number of printed faxes since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Postscript conversion requests processed</td>
<td>The total number of fax conversion using Postscript since the WorkServer module was started.</td>
<td>No</td>
</tr>
</tbody>
</table>

---

OpenText RightFax 10.5 Administrator’s Guide 328
#### Table D3 Statistics available for the WorkServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network broadcast requests processed</td>
<td>The total number of network messaging events using Postscript since the WorkServer module was started. Note that Network Broadcasts is no longer functional with any of the currently supported Windows operating systems.</td>
<td>No</td>
</tr>
<tr>
<td>InterConnect requests processed</td>
<td>The total number of faxes routed to other RightFax servers on the network via InterConnect since the WorkServer module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the WorkServer service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Activity records</td>
<td>The total number of activity records currently stored by the RightFax WorkServer module. Activities can be viewed using FaxStat.exe.</td>
<td>No</td>
</tr>
<tr>
<td>Last request</td>
<td>The last work request processed by the WorkServer.</td>
<td>No</td>
</tr>
<tr>
<td>Time for last command</td>
<td>The length of time required to complete the last command.</td>
<td>Yes</td>
</tr>
<tr>
<td>Queues being serviced</td>
<td>The services that are being managed by the selected WorkServer.</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Table D3 Statistics available for the WorkServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>The time and description of the specified WorkServer activity number.</td>
<td>No</td>
</tr>
<tr>
<td>Time spent on current command</td>
<td>The length of time that the WorkServer has spent processing the current command</td>
<td>Yes</td>
</tr>
</tbody>
</table>

#### Gateway Statistics

#### Table D4 Statistics available for the Gateway category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the gateway.</td>
<td>No</td>
</tr>
<tr>
<td>Gateway type</td>
<td>The type of email system that the gateway supports.</td>
<td>No</td>
</tr>
<tr>
<td>Newest activity index</td>
<td>The total number of activities since the RightFax Gateway module was last started. Activities can be viewed using FaxStat.exe.</td>
<td>No</td>
</tr>
<tr>
<td>Activity records</td>
<td>The total number of activity records currently stored by the RightFax Gateway module. Activities can be viewed using FaxStat.exe.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Table D4  Statistics available for the Gateway category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time running</td>
<td>The length of time since the Email Gateway service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Events processed</td>
<td>The total number of events processed by the fax server since the Gateway module was started.</td>
<td>No</td>
</tr>
<tr>
<td>Activity</td>
<td>The time and description of the specified activity number.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Local BoardServer Statistics

### Table D5  Statistics available for the Local BoardServer category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the local BoardServer.</td>
<td>No</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the local BoardServer service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Num channels</td>
<td>Total number of fax channels supported by the local BoardServer.</td>
<td>No</td>
</tr>
<tr>
<td>Send queue depth</td>
<td>Total number of faxes currently waiting to be transmitted.</td>
<td>Yes</td>
</tr>
<tr>
<td>Send pages depth</td>
<td>Total number of fax pages currently waiting to be transmitted.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table D5  Statistics available for the Local BoardServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability index</td>
<td>The relative availability of the server’s fax boards. The higher the number, the more available the server for sending faxes. RightFax uses this value when an outgoing fax number has two equally weighted dialing rules that send it to two different servers. In such a case, RightFax sends the fax via the server with the highest availability index.</td>
<td>Yes</td>
</tr>
<tr>
<td>Channel type</td>
<td>Displays whether the specified channel uses a loop-start or DID line.</td>
<td>No</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Displays whether the specified channel is set to send faxes, receive faxes, or both.</td>
<td>No</td>
</tr>
<tr>
<td>Routing code</td>
<td>The routing code of the fax currently being received on the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>State</td>
<td>The current sending or receiving state of the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current page</td>
<td>The page number of the fax currently being sent or received on the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Total pages sent</td>
<td>The total number of fax pages sent on the specified channel since the BoardServer was last started.</td>
<td>No</td>
</tr>
</tbody>
</table>
Table D5  Statistics available for the Local BoardServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total pages received</td>
<td>The total number of fax pages received by the specified channel since the BoardServer was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total calls answered</td>
<td>The total number of incoming calls picked up by the specified channel since the BoardServer was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total calls placed</td>
<td>The total number of outgoing calls placed by the specified channel since the BoardServer was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total hang ups</td>
<td>The total number of incoming calls on the specified channel that received a transmission error due to hang up since the BoardServer was last started.</td>
<td>No</td>
</tr>
<tr>
<td>ROM ID</td>
<td>The ROM ID of the fax board used by the specified fax channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current remote ID</td>
<td>The remote ID of the currently sending or receiving phone line.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently sending</td>
<td>Indicates whether the specified fax channel is currently sending a fax.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently doing TeleConnect</td>
<td>Indicates whether the specified fax channel is currently doing TeleConnect.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently receiving</td>
<td>Indicates whether the specified fax channel is currently receiving a fax.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently doing Docs on Demand</td>
<td>Indicates whether the specified fax channel is currently doing Docs-on-Demand.</td>
<td>No</td>
</tr>
<tr>
<td>Group threshold left</td>
<td>The number of fax pages remaining before a fax grouping will be sent.</td>
<td>No</td>
</tr>
<tr>
<td>Group faxes</td>
<td>The current number of faxes that are grouped for sending but have not yet reached the required number of pages.</td>
<td>No</td>
</tr>
<tr>
<td>Pages in call</td>
<td>Specifies the total number of fax pages queued to be sent during the current call.</td>
<td>No</td>
</tr>
<tr>
<td>Current rate</td>
<td>Specifies the transmission baud rate of the current call.</td>
<td>No</td>
</tr>
<tr>
<td>Current compression</td>
<td>Specifies the data compression type being used for the currently sent or received fax.</td>
<td>No</td>
</tr>
<tr>
<td>Estimated minutes left</td>
<td>The estimated number of minutes remaining for the specified channel to send the current fax.</td>
<td>No</td>
</tr>
<tr>
<td>Send info phone number</td>
<td>The sending phone number associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info user ID</td>
<td>The RightFax user ID associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Statistic</td>
<td>Description</td>
<td>Can trigger alert</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Send info pages in fax</td>
<td>The number of pages in the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info pages done</td>
<td>The number of pages that have already been transmitted for the fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info to name</td>
<td>The intended recipient’s name associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info to company</td>
<td>The intended recipient’s company name associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info bill code 1</td>
<td>The first billing code value associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info bill code 2</td>
<td>The second billing code value associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info secure CSID</td>
<td>The required CSID of the receiving phone line associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info unique ID</td>
<td>The unique RightFax ID associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current operation</td>
<td>The operation currently being performed by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Number of queued transmission checks</td>
<td>The number of Doc Plus faxes that need to have their status queried.</td>
<td>No</td>
</tr>
<tr>
<td>Activity counters start date</td>
<td>The start date that was set for the “all-time” statistics.</td>
<td>No</td>
</tr>
<tr>
<td>All time pages sent</td>
<td>The total number of fax pages that have been sent since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time send attempts</td>
<td>The total number of fax transmission attempts since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time pages received</td>
<td>The total number of fax pages that have been received since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time faxes received</td>
<td>The total number of faxes that have been received since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time pages sent remotely</td>
<td>The total number of fax pages that have been sent via remote fax servers since the activity counter start date.</td>
<td>No</td>
</tr>
</tbody>
</table>
### All BoardServers Statistics

#### Table D5  Statistics available for the Local BoardServer category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>All time send attempts remotely</td>
<td>The total number of fax transmission attempts via remote fax servers since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time pages received remotely</td>
<td>The total number of fax pages that have been received from remote fax servers since the activity counter start date.</td>
<td>No</td>
</tr>
<tr>
<td>All time faxes received remotely</td>
<td>The total number of faxes that have been received from remote fax servers since the activity counter start date.</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Table D6  Statistics available for the All BoardServers category (Continued)

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image directory</td>
<td>The directory used for storing fax images by the specified BoardServer.</td>
<td>No</td>
</tr>
<tr>
<td>Send queue depth</td>
<td>Total number of faxes currently waiting to be transmitted.</td>
<td>Yes</td>
</tr>
<tr>
<td>Send pages depth</td>
<td>Total number of fax pages currently waiting to be transmitted.</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of channels</td>
<td>The total number of hardware channels on the specified BoardServer.</td>
<td>No</td>
</tr>
<tr>
<td>Is server down</td>
<td>Indicates whether the specified BoardServer service stopped.</td>
<td>Yes</td>
</tr>
<tr>
<td>Down time</td>
<td>The time at which the specified BoardServer service was stopped.</td>
<td>Yes</td>
</tr>
<tr>
<td>Down error</td>
<td>The error code that was generated when the specified BoardServer went down.</td>
<td>No</td>
</tr>
<tr>
<td>Is server local</td>
<td>Specifies whether the specified BoardServer is local or remote.</td>
<td>No</td>
</tr>
<tr>
<td>Unique ID</td>
<td>The unique RightFax ID for the specified BoardServer.</td>
<td>No</td>
</tr>
</tbody>
</table>
**Table D6  Statistics available for the All BoardServers category (Continued)**

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability index</td>
<td>The relative availability of the specified BoardServer’s fax boards. The higher the number, the more available the server for sending faxes. RightFax uses this value when an outgoing fax number has two equally weighted dialing rules that send it to two different servers. In such a case, RightFax sends the fax via the server with the highest availability index.</td>
<td>Yes</td>
</tr>
<tr>
<td>Availability index time stamp</td>
<td>The time at which the Availability index was last reported.</td>
<td>No</td>
</tr>
</tbody>
</table>

**RPC Server Statistics**

**Table D7  Statistics available for the RPC Server category (Continued)**

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read failures</td>
<td>The total number of file read failures since the RPC server was started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Write failures</td>
<td>The total number of file write failures since the RPC server was started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Bytes read</td>
<td>The total number of bytes read since the RPC server was started.</td>
<td>No</td>
</tr>
<tr>
<td>Bytes written</td>
<td>The total number of bytes written since the RPC server was started.</td>
<td>No</td>
</tr>
<tr>
<td>Commands processed</td>
<td>The total number of API commands performed since the RPC server was started.</td>
<td>No</td>
</tr>
<tr>
<td>Time for last command</td>
<td>The length of time required to complete the last command.</td>
<td>Yes</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the RPC Server service was last started.</td>
<td>No</td>
</tr>
</tbody>
</table>
## Paging Server Statistics

### Table D8  Statistics available for the Paging Server category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the Paging server.</td>
<td>No</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the Paging service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Send queue depth</td>
<td>Total number of pages waiting to be transmitted.</td>
<td>Yes</td>
</tr>
<tr>
<td>Pages sent via modem</td>
<td>Total pages sent via modem since the Paging service was started.</td>
<td>No</td>
</tr>
<tr>
<td>Pages sent via SMTP</td>
<td>Total pages sent via SMTP since the Paging service was started.</td>
<td>No</td>
</tr>
<tr>
<td>SMTP failures</td>
<td>Total number of failed SMTP connections since the Paging service was started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Last SMTP fail code</td>
<td>The error code that was generated for the last failed SMTP connection.</td>
<td>Yes</td>
</tr>
<tr>
<td>Modem page failures</td>
<td>Total number of failed modem transmissions since the Paging service was started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Last modem fail code</td>
<td>The error code that was generated for the last failed modem transmission.</td>
<td>Yes</td>
</tr>
<tr>
<td>Current SMTP server</td>
<td>The computer name or IP address of the current SMTP (Push Proxy Gateway) server.</td>
<td>No</td>
</tr>
<tr>
<td>Last modem error description</td>
<td>The error message that was generated for the last failed modem transmission.</td>
<td>No</td>
</tr>
<tr>
<td>Last SMTP error description</td>
<td>The error message that was generated for the last failed SMTP connection.</td>
<td>No</td>
</tr>
<tr>
<td>Pages sent via SMS</td>
<td>Total pages sent via SMS since the Paging service was started.</td>
<td>No</td>
</tr>
<tr>
<td>SMS failures</td>
<td>Total number of failed SMS connections since the Paging service was started.</td>
<td>Yes</td>
</tr>
<tr>
<td>Last SMS fail code</td>
<td>The error code that was generated for the last failed SMS connection.</td>
<td>Yes</td>
</tr>
<tr>
<td>Current SMS server</td>
<td>The computer name or IP address of the current SMS (Push Proxy Gateway) server.</td>
<td>No</td>
</tr>
<tr>
<td>Last SMS error description</td>
<td>The error message that was generated for the last failed SMS connection.</td>
<td>No</td>
</tr>
</tbody>
</table>
## Local Document Transport Server Statistics

### Table D9  Statistics available for the Local Document Transport Server category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information version</td>
<td>A version number indicating the level of information being displayed for the local DocTransport.</td>
<td>No</td>
</tr>
<tr>
<td>Time running</td>
<td>The length of time since the local DocTransport service was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Num channels</td>
<td>Total number of fax channels supported by the local DocTransport.</td>
<td>No</td>
</tr>
<tr>
<td>Channel type</td>
<td>Displays whether the specified channel uses a loop-start or DID line.</td>
<td>No</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Displays whether the specified channel is set to send faxes, receive faxes, or both.</td>
<td>No</td>
</tr>
<tr>
<td>Routing code</td>
<td>The routing code of the fax currently being received on the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>State</td>
<td>The current sending or receiving state of the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current page</td>
<td>The page number of the fax currently being sent or received on the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Total pages sent</td>
<td>The total number of fax pages sent on the specified channel since the DocTransport was last started.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Table D9  Statistics available for the Local Document Transport Server category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total pages received</td>
<td>The total number of fax pages received by the specified channel since the DocTransport was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total calls answered</td>
<td>The total number of incoming calls picked up by the specified channel since the DocTransport was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total calls placed</td>
<td>The total number of outgoing calls placed by the specified channel since the DocTransport was last started.</td>
<td>No</td>
</tr>
<tr>
<td>Total hang ups</td>
<td>The total number of incoming calls on the specified channel that received a transmission error due to hang up since the DocTransport was last started.</td>
<td>No</td>
</tr>
<tr>
<td>ROM ID</td>
<td>The ROM ID of the fax board used by the specified fax channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current remote ID</td>
<td>The remote ID of the currently sending or receiving phone line.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently sending</td>
<td>Indicates whether the specified fax channel is currently sending a fax.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently doing TeleConnect</td>
<td>Indicates whether the specified fax channel is currently doing TeleConnect.</td>
<td>No</td>
</tr>
<tr>
<td>Is currently receiving</td>
<td>Indicates whether the specified fax channel is currently receiving a fax.</td>
<td>No</td>
</tr>
<tr>
<td>Statistic</td>
<td>Description</td>
<td>Can trigger alert</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Is currently doing Docs on Demand</td>
<td>Indicates whether the specified fax channel is currently doing Docs-on-Demand.</td>
<td>No</td>
</tr>
<tr>
<td>Group threshold left</td>
<td>The number of fax pages remaining before a fax grouping will be sent.</td>
<td>No</td>
</tr>
<tr>
<td>Group faxes</td>
<td>The current number of faxes that are grouped for sending but have not yet reached the required number of pages.</td>
<td>No</td>
</tr>
<tr>
<td>Pages in call</td>
<td>Specifies the total number of fax pages queued to be sent during the current call.</td>
<td>No</td>
</tr>
<tr>
<td>Current rate</td>
<td>Specifies the transmission baud rate of the current call.</td>
<td>No</td>
</tr>
<tr>
<td>Current compression</td>
<td>Specifies the data compression type being used for the currently sent or received fax.</td>
<td>No</td>
</tr>
<tr>
<td>Estimated minutes left</td>
<td>The estimated number of minutes remaining for the specified channel to send the current fax.</td>
<td>No</td>
</tr>
<tr>
<td>Send info phone number</td>
<td>The sending phone number associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info user ID</td>
<td>The RightFax user ID associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
</tbody>
</table>

Table D9  Statistics available for the Local Document Transport Server category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send info pages in fax</td>
<td>The number of pages in the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info pages done</td>
<td>The number of pages that have already been transmitted for the fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info to name</td>
<td>The intended recipient’s name associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info to company</td>
<td>The intended recipient’s company name associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info bill code 1</td>
<td>The first billing code value associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info bill code 2</td>
<td>The second billing code value associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Send info secure CSID</td>
<td>The required CSID of the receiving phone line associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
</tbody>
</table>
### Table D9  Statistics available for the Local Document Transport Server category

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
<th>Can trigger alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send info unique ID</td>
<td>The unique RightFax ID associated with the outbound fax currently being sent by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Current operation</td>
<td>The operation currently being performed by the specified channel.</td>
<td>No</td>
</tr>
<tr>
<td>Transport name</td>
<td>Name of the current transport.</td>
<td>No</td>
</tr>
<tr>
<td>Docs sent via transport</td>
<td>Number of faxes sent by the currently-selected transport</td>
<td>No</td>
</tr>
<tr>
<td>Docs received via transport</td>
<td>Number of faxes received by the currently-selected transport</td>
<td>No</td>
</tr>
<tr>
<td>Queue name</td>
<td>Name of the queue.</td>
<td>No</td>
</tr>
<tr>
<td>Queue depth</td>
<td>Total number of faxes currently waiting to be transmitted.</td>
<td>Yes</td>
</tr>
<tr>
<td>Queue availability index</td>
<td>The relative availability of the server’s fax boards. The higher the number, the more available the server for sending faxes. RightFax uses this value when an outgoing fax number has two equally weighted dialing rules that send it to two different servers. In such a case, RightFax sends the fax via the server with the highest availability index.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Some RightFax functionality is defined using the Windows Registry. To make changes to the registry, you'll need to use a tool such as regedit.exe to manually find the registry key and then add or modify the values in it.

The section "DocTransport Registry Entries" starting on page 340 describes the following values:

- "ANIStripCount"
- "BlockedNumbers"
- "BlockingFlags"
- "Change (in SFC Key)"
- "CheckDNISforNortelRouteCode"
- "DIDWhitelistFilename"
- "DisableDialingRuleOnTimeout"
- "DoDigitalChanRoute"
- "Entries (in ANI Key)"
- "Extensions (in SFC Key)"
- "ForceBlankBody"
- "HAF_CancelIfNoResponse"
- "TTI_IncludeToNumber"
- "UseISDNCallingParty"
- "ValidPatternChars"

The section "FaxServer Registry Entries" starting on page 344 describes the following values:

- "Allow MultipleGatewayNotifications"
- "DBRecovery_Post_CheckLookEvent"
- "DeleteImagesOnPurge"
- "Notify_Freq"
- "PrescanTimeoutSeconds"
- "QueueSize"
- "ReceiveStamp FontSize"
- "ReceiveStamp Format"
- "ReceiveStamp Location"
- "StampReceivedPages"
- "UseCompanyforCSID"
- "UseReceiveStampUnique"
The section “Gateway Registry Entries” starting on page 346 describes the following values:

- “AllowSubjectAsOwnAttachment”
- “DoNotStripPlusSign”
- “ExcludeHeaders”
- “ExtraHeaders”
- “IncludeHeaders”
- “SkipEmptyAttachments”

The section “RightFax Registry Entries” starting on page 347 describes the following values:

- “Image”
- “TeleConnect Registry Configuration”

The section “WorkServer Registry Entries” starting on page 349 describes the following values:

- “FileRouteRetryDelay”
- “FileRouteRetryDuration”
- “GSPostScriptCode”
- “InterconnectSetTZ”
- “KillServiceTimeout”
- “NativeDocControl”
- “PCL6_TwoPass”
- “PrintTimeReverse”
- “ShrinkToView”
- “UseReceiveStampUnique”
- “WordWrapTextLength”

or, for 64-bit:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\DocTransport\Transports\Brooktrout

**ANIStripCount**

By default, 31 characters of ANI data are stored in the database. In some cases, the information at the end of long ANI data strings may be truncated. Use this value to specify a number of digits you want to remove from the beginning of the string (allowing the end of the string to be stored).

Type: REG_DWORD

Default: 0 (does not strip leading characters)

**BlockedNumbers**

By default, DocTransports blocks outgoing faxes to any number that begins with 911 (the standard emergency number throughout the United States). To block additional numbers, edit the BlockedNumbers value to enter the prefix, full number, or partial number of each phone you want to block. Separate multiple entries with carriage returns.

This function can also be performed through the RightFax interface with Dialing Rules as described in “Editing Dialing Rules” on page 180.

Type: REG_MULTI_SZ

Default: blank (no numbers are blocked)

See also “BlockingFlags” to turn the blocking feature on or off.

---

**DocTransport Registry Entries**

HKEY_LOCAL_MACHINE\Software\RightFax\DocTransport\Transports\Brooktrout
BlockingFlags

If you’ve created a manual list using the “BlockedNumbers” registry entry, you can enable or disable the bloOpenText RightFaxcking function by setting **BlockingFlags** as follows:

<table>
<thead>
<tr>
<th>Data</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prevent transmission to anything starting with 911, and prevents transmission to all numbers listed in the “BlockedNumbers” list</td>
<td>0</td>
</tr>
<tr>
<td>Allow transmission to the “BlockedNumbers” list and allow transmission to numbers starting with 911</td>
<td>1</td>
</tr>
<tr>
<td>Allow transmission to the “BlockedNumbers” list and allow transmission to numbers starting with 911</td>
<td>2</td>
</tr>
</tbody>
</table>

**Table E1  ISDN Data String Options**

To force the DocTransport to read the Extensions value, set the Change value to “1” hex. Once read, the DocTransport returns the Change value to “0” hex. When you want RightFax to read the values again (if you’ve added, removed, or changed any of the stand-alone fax extensions), reset the Change value to “1” hex.

**CheckDNISforNortelRouteCode**

To parse DNIS digits from Nortel CS1000 SIP invites, set this entry to 1.

**DIDWhitelistFilename**

You can now restrict incoming fax calls to a specific list of fax numbers. If a call is received that is not on the list, that call will not be answered. Ordinarily, if a call is received for an unknown routing code, the fax is routed to the administrator.

To enable this feature, set the DIDWhitelistFilename to the UNC path and filename of a text file containing allowed numbers. You are responsible for manually maintaining this list of allowed fax numbers. It must be a text file with one DID routing code per line. Anything after a semicolon is considered a comment. Save this file in a location accessible to the DocTransport service account. A cache of the file will be maintained in case the file becomes inaccessible. If the time and date on the file changes, the server will automatically reload the new version.
Type: String
Default: blank (does not restrict calls)

**DisableDialingRuleOnTimeout**

This value enables Fax Over IP Failover in a multi-router environment. To configure FoIP, you must also set the dialing rules as described in "Configuring Fax over IP Failover" on page 60. To enable FoIP, set the DisableDialingRuleOnTimeout value to 1.

Type: REG_DWORD
Default: 0 (the Failover is not enabled)

**DisableP2Prules**

If a fax cannot be sent through the RightFax Internet Connector, the P2P rules will be disabled for 60 minutes. Faxes will be sent over the telephone lines. To change the length of time to wait before enabling P2P rules again, set this value to the desired number of minutes.

Type: REG_DWORD
Default: 60 (the number of minutes the P2P rules are disabled)

**DoDigitalChanRoute**

By default, channel routing (where incoming faxes are routed by the channel on which they arrive into the RightFax system) does not work with digital fax boards. To enable a digital fax board for use with channel routing, set this value to 1.

Type: REG_DWORD
Default: 0 (does not route faxes based on channel)

**Entries (in ANI Key)**

To specify the numbers you want to route to the user account set up for spam handling, enter the ANI or DNIS information and the RightFax user ID (where blocked faxes will be routed to) in the Entries value of the ANI subkey. There is no limit to the numbers you can add here. For example, 5551212, SpamAccount routes all calls with the ANI 5551212 to the RightFax user “SpamAccount”.

The Entries value is part of the Registry subkey ANI located at HKEY_LOCAL_MACHINE\Software\RightFax\DocTransport\ANI or, for 64-bit, HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\DocTransport\ANI). If this subkey does not yet exist, you may need to create it.

Type: REG_MULTI_SZ
Default: blank (faxes are not routed anywhere)

For more information, see “Spam Handling” on page 193.

**Extensions (in SFC Key)**

There are several ways to connect a stand-alone fax machine to your RightFax server. In each case, a RightFax user ID is created to host the Standalone Fax Connector and is assigned a unique Routing Code value (called the “Extension”). The user then dials into this extension from the fax machine (exactly how this is accomplished depends on your phone system) in order to access the RightFax server.

The Extensions value is part of the Registry subkey SFC located at HKEY_LOCAL_MACHINE\Software\RightFax\DocTransport\Transports\Brooktrout\SFC, or, for 64-bit, HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\DocTransport\Transports\Brooktrout\SFC). If this subkey does not yet exist, you may need to create it.
Within the SFC key, enter one value for each Extension, separating multiple entries with a carriage return. The values must match the Routing Code value set in each dedicated RightFax user ID.

Data Type: REG_MULTI_SZ
Default: blank, stand-alone fax is not enabled.

See the value for “Change (in SFC Key)” to specify when RightFax should read in new extensions, or “Connecting a stand-alone fax machine to the RightFax server” on page 131 for more information.

**ForceBlankBody**

IE conversion and subsequent deletion of blank email pages can cause delays in high-volume situations. Customers who are experiencing this problem should set this value to 1 to prevent conversion of email pages through Internet Explorer.

Type: REG_DWORD
Default: 0 (use default behavior)

**HAF_CancelIfNoResponse**

To cancel a fax transmission if a human voice is detected, set the HAF_CancelIfNoResponse value to 1. For more information, see “Configuring the Human Answered Fax feature” on page 55.

Type: DWORD
Default: 0 (does not cancel the fax)

**TTI_InclludeToNumber**

To include the "To" address on the TTI line without using quickheaders, set this value to 1. The headerID and the word "PAGE" will be removed. "TO:" and the fax number will appear (up to 32 characters). If the To address includes an "@" symbol, possible in FoIP configurations, everything after and including the "@" will be truncated.

Type: REG_DWORD
Default: 0 (does not change the TTI line)

**UseISDNCallingParty**

You can add data to the calling party number field of the ISDN string for each fax sent from the RightFax server. This data can be captured by some PBX systems for billing purposes. Before implementing this feature, verify that the PBX system can accept the data. If it does not, the PBX will reject the call.

Use the UseISDNCallingParty value to specify which information you want to capture. The data options for the string are described in the following table.

Type: REG_DWORD
Default: No data is captured.

Table E2 ISDN Data String Options

<table>
<thead>
<tr>
<th>Data</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax number dialed.</td>
<td>1</td>
</tr>
<tr>
<td>RightFax user ID of the sender.</td>
<td>2</td>
</tr>
<tr>
<td>The recipient’s voice number.</td>
<td>3</td>
</tr>
<tr>
<td>The recipient’s name.</td>
<td>4</td>
</tr>
<tr>
<td>The recipient’s company name.</td>
<td>5</td>
</tr>
<tr>
<td>Billing code 1.</td>
<td>6</td>
</tr>
<tr>
<td>Billing code 2.</td>
<td>7</td>
</tr>
<tr>
<td>Assigned unique ID for fax job.</td>
<td>8</td>
</tr>
<tr>
<td>CSID match code for secure send operation.</td>
<td>9</td>
</tr>
<tr>
<td>Name of the sender.</td>
<td>10</td>
</tr>
<tr>
<td>Source server IP address or name.</td>
<td>11</td>
</tr>
</tbody>
</table>
ValidPatternChars

Dialing rules are entered as a string of characters and wild cards. RightFax ignores any hyphens, parentheses, or spaces in the pattern string. By default, the pattern can include the digits 0–9, as well as the pound [#] and asterisk [*] keys, and the wildcard characters plus [+] and tilde [~]. See “Creating Dialing Rules and Least-Cost Routing Plans” on page 179 for more information on Dialing Rules. To add additional symbols such as a comma or period to the list of supported characters, add the characters to the end of the ValidPatternChars value.

Type: REG_DWORD
Default: 0123456789*#+~\n
FaxServer Registry Entries

FaxServer keywords are

HKEY_LOCAL_MACHINE\Software\RightFax\FaxServer
or for 64-bit:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\FaxServer

After adding the registry values, stop and start the RightFax server for the settings to take effect.

Allow MultipleGatewayNotifications

Each user can specify whether or not they want to received notifications about failed faxes. By default, only the sending user gets this type of notification. To send a second notification to the email address configured on the notifications tab of the default user, set this entry to 1.

Type: REG_DWORD
Default: 0 (does not send duplicate failed notifications)

DBRecovery_Post_CheckLookEvent

Set this value to “0” to prevent large databases with many documents from taking a long time to complete the DBRecovery cycle. A value of “1” generates notifications for each document. A value of “0” does not send notifications.

Type: REG_DWORD
Default: 1 (notifications will be sent).

DeleteImagesOnPurge

By default, RightFax will retain the image files of faxes that have been deleted from FaxUtil until all corresponding database records have been removed. To configure RightFax to immediately delete fax images, set this value to 0.

Type: REG_DWORD
Default: 0 (if the DWORD is in the key, the default is to delete images. If the DWORD is not in the key, the default system behavior is to retain the images.)

Notify_Freq

By default, the RightFax server sends periodic notifications to users every five minutes. The Notify_Freq value specifies the number of minutes between notifications. See “Notification settings” on page 18.

Type: REG_DWORD
Default: 5 (notifications sent every 5 minutes)

PrescanTimeoutSeconds

Prescanning very large Print-to-Fax files for embedded codes can cause the RightFax server to appear unresponsive. Use this entry to set the number of seconds after which the RightFax server will stop processing embedded codes.

Type: REG_DWORD
Default: 0 (no time out, processing continues as long as necessary)

**QueueSize**

By default, the RightFax internal event queue has a limit of 2000 events. If too many events require attention of the RightFax Server module, the server will generate an alert and stop running.

To increase the event queue size, change the QueueSize value to 3000. A modest increase to the event queue size will not have any adverse effects on the RightFax server itself.

Type: REG_DWORD

Default: 2000 (limit of 2000 events may be in the queue)

**ReceiveStamp FontSize**

This value specifies the font size (in points) for the text that displays on the optional RTI line. Set ReceiveStampFontSize to any decimal number. Use the StampReceivedPages value to turn the RTI on or off; use the ReceiveStampFormat value to specify which data displays.

Type: REG_DWORD

Default: 14 (RTI displays as 14-point type)

See Also:

- "StampReceivedPages" to turn the RTI on or off
- "ReceiveStamp Format" to specify which data displays
- "ReceiveStamp Location" to specify where the RTI displays

**ReceiveStamp Format**

This value specifies which information to display in the optional RTI line. The following table lists the variables that can be included in your RTI line text.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>The current page number.</td>
</tr>
<tr>
<td>~2</td>
<td>The total number of fax pages received.</td>
</tr>
<tr>
<td>~3</td>
<td>The date and time that the fax was received (as reported by the fax server).</td>
</tr>
<tr>
<td>~4</td>
<td>The name of the fax server that received the fax (up to 30 characters).</td>
</tr>
<tr>
<td>~5</td>
<td>The number of the fax channel that received the fax.</td>
</tr>
<tr>
<td>~6</td>
<td>The fax recipient’s DID number.</td>
</tr>
<tr>
<td>~7</td>
<td>The fax sender’s caller subscriber ID (CSID).</td>
</tr>
<tr>
<td>~8</td>
<td>Duration of the fax transmission in minutes and seconds.</td>
</tr>
<tr>
<td>~9</td>
<td>The fax recipient’s RightFax user ID (if applicable).</td>
</tr>
<tr>
<td>~0</td>
<td>The fax recipient’s RightFax user name (if applicable).</td>
</tr>
<tr>
<td>~A</td>
<td>The unique ID assigned to the fax by the fax server. This variable is case-sensitive.</td>
</tr>
<tr>
<td>~B</td>
<td>The current date formatted as a two-digit year followed by three digits for the absolute day of the year. For example, &quot;00001&quot; means January 1, 2000. This variable is case-sensitive.</td>
</tr>
<tr>
<td>~C</td>
<td>The total page count on the fax server. The number is reset each day at midnight and then increments by one for each received fax page. This variable is case-sensitive.</td>
</tr>
</tbody>
</table>
Example  The following ReceiveStampFormat entry:
  Page ~1 of ~2 received on ~3 on server ~4.
  might print as:
  Page 2 of 4 received on 02-01-01 12:11:59 [US Mountain Standard Time] on server RIGHTFAX

ReceiveStamp Location
  Specify where on the fax page to print the optional RTI line. Valid options are TOP, BOTTOM, LEFT, or RIGHT.
  TYPE: REG_SZ
  Default: BOTTOM (prints the RTI across the bottom of each page)
  See Also:
  "StampReceivedPages" to turn the RTI on or off
  "ReceiveStamp Format" to specify which data displays
  "ReceiveStamp FontSize" to specify how large the RTI will be

StampReceivedPages
  The RTI (Receipt Terminal Information) line is a line of text that can be printed on each received fax page. The RTI line includes information about the fax that supplements the TTI line such as the total number of pages received, the name of the fax server that received the fax, and the sender’s caller ID. To enable the RTI line, set StampReceivedPages to 1.
  Type: REG_DWORD
  Default: 1 (the RTI line is enabled)
  See Also:
  "ReceiveStamp Location" to specify where to display the RTI
  "ReceiveStamp Format" to specify which data displays
  "ReceiveStamp FontSize" to specify how large the RTI will be

UseCompanyforCSID
  The TTI (Transmission Terminal Information) is a line of text that is printed across the top of each sent fax page, usually containing the date, time, page number, total pages, and fax ID (or CSID). You can replace the CSID with the sender’s company name by setting the UseCompanyforCSID value to 1.
  Type: REG_DWORD
  Default: 0 (does not change the TTI)
  To add the Company Name for each user,
  1. Open FaxUtil.
  2. On the Tools menu, click Options and the User Options dialog box opens.
  3. On the User Information tab, in the Company field, enter the company name.

UseReceiveStampUnique
  To instruct RightFax to use the unique ID as the file name for the fax, set this value to 1. You must set the value in the registry for each WorkServer and for the FaxServer.
  Type: REG_DWORD
  Default: 0 (unique ID is not used as the fax file name)
  See “Assigning Unique ID Numbers to Fax File Names and Routing to a Network Folder” on page 218 for additional setup requirements when using this registry value.

Gateway Registry Entries
  The following registry keys can be added to further configure your SMTP/POP3 gateway. RightFax creates one overall key for the Gateways:
  HKEY_LOCAL_MACHINE\Software\RightFax\Gateway
or for 64-bit:
HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Gateway
There is also a subkey for each additional gateway, indicated by the
gateway number (such as Gateway1 or Gateway2) as follows:
HKEY_LOCAL_MACHINE\Software\RightFax\Gateway
\Gateway#
or for 64-bit:
HKEY_LOCAL_MACHINE\Software \Wow6432Node\RightFax\Gateway\Gateway#

**AllowSubjectAsOwnAttachment**
Set this to 0 to prevent Unicode email subject lines from appearing
as a separate fax page.
Type: REG_DWORD
Default: 0 (keeps Unicode email subject lines on same page.

**DoNotStripPlusSign**
Prevents the "+" character from being stripped from the dialing
string. 0=disabled, 1=enabled.
Type: REG_DWORD

**ExcludeHeaders**
Any headers listed here will be removed from the fax cover sheet
Notes area. Values in this field are not case-sensitive.
Type: REG_MULTI_SZ

**ExtraHeaders**
Text entered here will be added to the headers of all mail-bound faxes
going to the SMTP server.
Type: REG_MULTI_SZ

**IncludeHeaders**
Only the headers listed here will be added to the fax cover sheet
Notes area. Leaving this blank will allow all headers to be included.
Values in this entry are not case-sensitive.
Type: REG_MULTI_SZ

**SkipEmptyAttachments**
The gateway will scan the bodies of fax-bound mail attachments and
discard empty ones. This registry key prevents blank fax pages from
being sent. 0=disabled, 1=enabled.
Type: REG_DWORD
Default: 0 (disabled)

**RightFax Registry Entries**
RightFax keywords are
HKEY_LOCAL_MACHINE\Software\RightFax
or for 64-bit:
HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax
After adding the registry values, stop and start the RightFax server
for the settings to take effect.

**Image**
By default, RightFax stores fax images in the RightFax\Image folder
on the server. You can change the location of image storage by
entering a valid path name for the Images value. See "Critically low
disk space" on page 177 for more information.
Type: REG_SZ
Default: C:\Program Files\RightFax\Image
TeleConnect Registry Configuration

TeleConnect is configured primarily via multi-string (Reg_Multi_SZ) registry entries. Each channel dedicated to TeleConnect has its own configuration registry entry. The TeleConnect configuration registry entry is located at HKEY_LOCAL_MACHINE\Software\RightFax\Doctransport\Transports\Brooktrout\TUI\Extensions (64-bit: HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Doctransport\Transports\Brooktrout\TUI\Extensions).

The multi-string registry entries for TeleConnect use this format: `extension'keyword(value)'keyword(value)``...

Where `extension` is the phone number extension or DID channel assigned to TeleConnect, `~` is the “grave” character located on the same key as the tilde (~), `keyword` is one of the configuration setting keywords from the following table, and `value` is an optional value setting for the keyword. The phone number extension or DID channel assigned to TeleConnect is always the first entry. The extension and all keywords must be separated by an accent grave (`~`) character.

The following table lists all available TeleConnect keywords, and includes the default settings (if any) and descriptions.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>900Agree</td>
<td>N/A</td>
<td>900 caller agreement sequence.</td>
</tr>
<tr>
<td>900Enable</td>
<td>False</td>
<td>900 telephone processing.</td>
</tr>
<tr>
<td>AppType</td>
<td>0</td>
<td>Application type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = TeleConnect</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = One-call</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Two-call</td>
</tr>
<tr>
<td>AskAlphaNumeric</td>
<td>False</td>
<td>Ask caller for alpha-numeric</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sequence.</td>
</tr>
<tr>
<td>AskVoiceNumber</td>
<td>True</td>
<td>Ask caller for voice number.</td>
</tr>
<tr>
<td>CSID</td>
<td>N/A</td>
<td>CSID to use during a one-call</td>
</tr>
<tr>
<td></td>
<td></td>
<td>transaction. If blank, it uses the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>channel default.</td>
</tr>
<tr>
<td>DefaultBI1</td>
<td>N/A</td>
<td>Default billing code #1 for a two-call fax TeleConnect. If a fax is being forwarded from a user’s mailbox, the system will attempt to use the billing codes from the source fax. If no billing codes are present in the source fax, the value specified here, and that of DefaultBI2, will be used.</td>
</tr>
<tr>
<td>DefaultBI2</td>
<td>N/A</td>
<td>Default billing code #2 for two-call.</td>
</tr>
<tr>
<td>MaxErrors</td>
<td>3</td>
<td>Maximum number of errors allowed (timeouts, invalid doc numbers, etc.) If this number is exceeded, the caller will be disconnected.</td>
</tr>
<tr>
<td>MaxFaxes</td>
<td>32</td>
<td>The maximum number of faxes sent out in one call by TeleConnect.</td>
</tr>
<tr>
<td>Multilingual</td>
<td>False</td>
<td>Multilingual support enabled/disabled.</td>
</tr>
<tr>
<td>TransferSequence</td>
<td>N/A</td>
<td>PBX transfer sequence. If not blank, TeleConnect transmits this sequence just before hanging up. It is a standard Brooktrout* sequence (TP!F;WU%1234567890ABCD). 39 characters max.</td>
</tr>
</tbody>
</table>

Table E4  TeleConnect Registry Values (Continued)
WorkServer Registry Entries

RightFax creates one overall key for the workservers:
HKEY_LOCAL_MACHINE\Software\RightFax\Workserver
or for 64-bit:
HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Workserver

There can also be a subkey for each additional workserver, indicated by the workserver number (such as Worksrv1 or Worksrv3) as follows:
HKEY_LOCAL_MACHINE\Software\RightFax\Workserver\Worksrv#

or for 64-bit:
HKEY_LOCAL_MACHINE\Software\Wow6432Node\RightFax\Workserver\Worksrv#

FileRouteRetryDelay

By default, faxes that fail to route will be retried every 10 seconds for 10 minutes.

To change the retry parameters, set this value to the number of milliseconds to continue between each retry attempt.

Type: REG_DWORD
Default: 10,000 (10 seconds).

FileRouteRetryDuration

By default, faxes that fail to route will be retried every 10 seconds for 10 minutes.

To change the retry parameters, set this value to the number of milliseconds to continue between each retry attempt.

Type: REG_DWORD
Default: 600,000 (10 minutes).

GSPostScriptCode

Certain PDF files may not convert legibly. To correct this, you can include the following PostScript string in the GSPostScriptCode registry value on each Workserver that does conversion.

```
<</Install {{0.90 gt {1}{0} ifelse} settransfer}>>setpagedevice
```

Type: REG_SZ
Default: blank (does not improve PDF conversion quality)

InterconnectSetTZ

By default, faxes routed from one RightFax server to another RightFax server in a different time zone will have the time and date stamp from the originating server. To change this so that faxes have the time and date of the receiving server, set the InterconnectSetTZ value to ‘1’.

Type: REG_DWORD

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TUIReportPath</td>
<td>TUILOG</td>
<td>The path for TeleConnect reports. If a relative path-spec, it will be relative to the RFBoard folder.</td>
</tr>
<tr>
<td>VoicePath</td>
<td>MainApp\voices; voices</td>
<td>The path(s) for voice prompt files. One or more folders the system will search to play a voice file. Folders are separated with a semicolon. A relative folder specification is relative to the RFBoard folder. Any recorded message will be recorded to the first folder listed.</td>
</tr>
<tr>
<td>VoicePath0</td>
<td>N/A</td>
<td>Language #0 voice folder(s).</td>
</tr>
<tr>
<td>VoicePath2 – VoicePath9</td>
<td>N/A</td>
<td>Language #2 voice folder(s) – Language #9 voice folder(s).</td>
</tr>
</tbody>
</table>
Default: 0 (faxes keep the time and date stamp of the originating server)

See “Configuring RightFax for CSID routing” on page 216 for more information about this type of routing.

KillServiceTimeout

In case server-side application conversion fails, you can configure RightFax to automatically time out, stop the conversion, and set the fax status to “conversion failed.” Set the data value of KillServiceTimeout to the length of time in milliseconds that you want to attempt conversion before timing out. For example, set the data value to 600000 for 10 minutes.

This must be set for each workserver.

Type: REG_DWORD

Default: no time out. RightFax will continue to attempting to convert the fax indefinitely.

NativeDocControl

This entry controls how and when server-side application conversion is used for specific document types. The setting for this value is one or more lines each controlling a specific document type in the format:

\[ \text{DocType,Action} \]

Where DocType is the type of document to control, and Action specifies how the document type should be handled. DocType can be Word, Excel, PowerPoint, VSD, RTF, HTML, or PDF. The following table lists the actions you can specify.

<table>
<thead>
<tr>
<th>Value</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Attempt to convert the document using the native application on the server. If this fails because the application is not installed, because the application cannot be started, or because the application returns an error, then attempt to convert the document using the built-in RightFax conversion engine.</td>
</tr>
<tr>
<td>2</td>
<td>Only attempt to convert the document using the native application on the server. If this fails for any reason, abort the fax.</td>
</tr>
<tr>
<td>3</td>
<td>Attempt to convert the document using the built-in RightFax conversion engine. If this fails for any reason, abort the fax.</td>
</tr>
<tr>
<td>4</td>
<td>Do not attempt to convert this type document. Conversion will fail.</td>
</tr>
<tr>
<td>5</td>
<td>Attempt to convert the document using the built-in RightFax conversion engine. If this fails, attempt conversion with the native application.</td>
</tr>
</tbody>
</table>

PCL6_TwoPass

This value passes a fax through conversion twice in normal mode. Though this improves the quality of the output image, it also takes longer than a single-pass conversion. Set this value to 1 to pass faxes through conversion twice.

Type: REG_DWORD

Default: 0 (faxes go through conversion just once)
PrintTimeReverse
By default, a time strip is printed on the first page of each fax as black text. Set the PrintTimeReverse value to ‘1’ to cause the time strip to print in white text on a black background.

Type: REG_DWORD
Default: 0 (the time strip prints in black text)

ShrinkToView
By default, PDF conversion adds a small margin around the edge of each page. If the incoming fax images go to the edge of the page, part of the image may be cut off by this margin. Set this value to 1 on each Workserver to reduce the size of the page slightly before conversion so that the margin does not cut off any content.

Type: REG_DWORD
Default: 0 (does not shrink PDF pages)

UseReceiveStampUnique
To instruct RightFax to use the unique ID as the file name for the fax, set this value to 1. You must set the value in the registry for each WorkServer and for the FaxServer.

Type: REG_DWORD
Default: 0 (unique ID is not used as the fax file name)

See “Assigning Unique ID Numbers to Fax File Names and Routing to a Network Folder” on page 218 for additional setup requirements when using this registry value.

WordWrapTextLength
Text attachments that contain long lines of text can potentially be truncated. Set the data value of the WordWrapTextLength to the maximum line length before wrapping. For example, 150 will word-wrap anything over 150 characters.

The length must be set on each workserver.

Note: to use this value, you must configure all RightFax WorkServers to use the option ‘Use PCL Converter for Text Files’.

Type: REG_DWORD
Default: Rightfax does not wrap lines of text.
Appendix F
Web Services API

With the Web Services API, you can send and receive simple faxes from a web page. To use the Web Services API:

- Enable the SharePoint Web Services module. You do not need to have SharePoint to use the Web Services API.
- Write a program that starts the required services. These services are stored at:
  - /RFMOSS/SendingService
  - /RFMOSS/RightFaxAPIService
  - /RFMOSS/ImportService
- Create a web page that calls the program and accepts user input. User must enter at least the following information:
  - Server Name
  - RightFax User Name
  - Password
- Enable a Submit button on the web page that sends the web service commands to the server.

Starting the Web Services

In your program, you must start the three services. If you’re using a tool like Visual Studio, you can point to the services at:

- /RFMOSS/SendingService
- /RFMOSS/RightFaxAPIService
- /RFMOSS/ImportService

To test each service, you will need to create a client and use it to call the service. You can do this using the svcutil.exe tool from the command line with the following syntax:

```
svcutil.exe http://localhost/RFMOSS/servicename?wsdl
```

This will generate a configuration file and a code file that contains the client class. Add the two files to your client application and use the generated client class to call the Service.
For example, in C#, the code might be:

```csharp
class Test
{
    static void Main()
    {
        RightFaxApiServiceClient client = new RightFaxApiServiceClient();
        // Use the 'client' variable to call operations on the service.
        // Always close the client.
        client.Close();
    }
}
```

In Visual Basic:

```vbnet
Class Test
    Shared Sub Main()
        Dim client As RightFaxApiServiceClient = New RightFaxApiServiceClient()
        ' Use the 'client' variable to call operations on the service.
        ' Always close the client.
        client.Close()
    End Sub
End Class
```
Sample Web.config

The following sample was created using Visual Studio.

```xml
<?xml version="1.0"?>
<!--
For more information on how to configure your ASP.NET application, please visit
http://go.microsoft.com/fwlink/?Linkid=169433
-->
<configuration>
  <connectionStrings>
    <add name="ApplicationServices" connectionstring="data source=.\SQLEXPRESS;Integrated Security=SSPI;AttachDBFilename=|DataDirectory|\aspnetdb.mdf;User Instance=true" providerName="System.Data.SqlClient" />
  </connectionStrings>

  <system.web>
    <compilation debug="true" targetFramework="4.0" />
    <authentication mode="Forms">
      <forms loginUrl="~/Account/Login.aspx" timeout="2880" />
    </authentication>
  </system.web>

  <system.webServer>
    <modules runAllManagedModulesForAllRequests="true" />
  </system.webServer>

  </configuration>
</configuration>
```

requiresQuestionAndAnswer="false"
requiresUniqueEmail="false"
maxInvalidPasswordAttempts="5"
minRequiredPasswordLength="6"
minRequiredNonalphanumericCharacters="0"
passwordAttemptWindow="10" applicationName="/" />
</providers>
</membership>

<providers>
<clear/>
<add name="AspNetSqlProfileProvider" type="System.Web.Profile.SqlProfileProvider" connectionStringName="ApplicationServices" applicationName="/" />
</providers>
</profile>

<roleManager enabled="false">
<providers>
<clear/>
<add name="AspNetSqlRoleProvider" type="System.Web.Security.SqlRoleProvider" connectionStringName="ApplicationServices" applicationName="/" />
</providers>
</roleManager>

</system.web>
</system.webServer>
<modules runAllManagedModulesForAllRequests="true" />
</system.webServer>

Appendix F  Web Services API  355
<binding name="NetTcpBinding_ISendingService"
closeTimeout="00:01:00" openTimeout="00:01:00"
receiveTimeout="00:10:00" sendTimeout="00:01:00"
transactionFlow="false" transferMode="Buffered"
transactionProtocol="OleTransactions"
hostNameComparisonMode="StrongWildcard"
listenBacklog="10" maxBufferPoolSize="524288"
maxBufferSize="65536" maxConnections="10"
maxReceivedMessageSize="65536">
<readerQuotas maxDepth="32"
maxStringContentLength="8192"
maxArrayLength="2147483647"
maxBytesPerRead="4096"
maxNameTableCharCount="16384" />
<reliableSession ordered="true"
inactivityTimeout="00:10:00" enabled="false" />
<security mode="Transport">
<transport clientCredentialType="Windows"
protectionLevel="EncryptAndSign" />
<message clientCredentialType="Windows" />
</security>
</binding>

<binding name="NetTcpBinding_IImportService"
closeTimeout="00:01:00" openTimeout="00:01:00"
receiveTimeout="00:10:00" sendTimeout="00:01:00"
transactionFlow="false" transferMode="Buffered"
transactionProtocol="OleTransactions"
hostNameComparisonMode="StrongWildcard"
listenBacklog="10" maxBufferPoolSize="524288"
maxBufferSize="65536" maxConnections="10"
maxReceivedMessageSize="65536">
<readerQuotas maxDepth="32"
maxStringContentLength="8192"
maxArrayLength="2147483647"
maxBytesPerRead="4096"
maxNameTableCharCount="16384" />
<reliableSession ordered="true"
inactivityTimeout="00:10:00" enabled="false" />
<security mode="Transport">
<transport clientCredentialType="Windows"
protectionLevel="EncryptAndSign" />
<message clientCredentialType="Windows" />
</security>
</binding>

</netTcpBinding>
</bindings>

<client>
<endpoint address="net.tcp://rightfax1:9000/RFMOSS/SendingService" binding="netTcpBinding"
bindingConfiguration="NetTcpBinding_ISendingService"
contract="SendingServiceTester.ISendingService"
name="NetTcpBinding_ISendingService">
  <identity>
    <userPrincipalName value="username@domain.com" />
  </identity>
</endpoint>

<endpoint address="http://RFax1/RFMOSS/SendingService" binding="basicHttpBinding" bindingConfiguration="Http"
contract="SendingServiceTester.ISendingService"
name="Http" />

<endpoint address="net.tcp://righfax1:9000/RFMOSS/ImportService" binding="netTcpBinding"
bindingConfiguration="NetTcpBinding_IImportService"
contract="ImportService.IImportService"
name="NetTcpBinding_IImportService">
  <identity>
    <userPrincipalName value="username@domain.com" />
  </identity>
</endpoint>

<endpoint address="http://RFax1/RFMOSS/ImportService" binding="basicHttpBinding" bindingConfiguration="Http"
contract="ImportService.IImportService"
name="Http" />

<endpoint address="http://RFax1/RFMOSS/RightFaxApiService" binding="basicHttpBinding" bindingConfiguration="Http"
contract="RightFaxApiService.IRightFaxApiService"
name="Http" />

<!--<endpoint address="http://localhost/RFMOSS/RightFaxApiService"}
Sample Default.aspx

```html
<asp:Content ID="HeaderContent" runat="server"
ContentPlaceHolderID="HeadContent">
</asp:Content>
<asp:Content ID="BodyContent" runat="server"
ContentPlaceHolderID="MainContent">
<h2> Rightfax Server Information</h2>
<p>
<asp:Label ID="Label1" runat="server" Text="RightFax Server:"></asp:Label>
<asp:TextBox ID="RightFaxServerBox" runat="server"></asp:TextBox>
<asp:Label ID="Label2" runat="server" Text="RightFax User:">
<asp:TextBox ID="RightFaxUserBox" runat="server"></asp:TextBox>
<asp:Label ID="Label3" runat="server" Text="Password:">
<asp:TextBox ID="PasswordBox" runat="server"></asp:TextBox>
</p>
<h2>Send a Fax</h2>
<p>
Name:<asp:TextBox ID="NameBox" runat="server"></asp:TextBox>
Number:<asp:TextBox ID="NumberBox" runat="server"></asp:TextBox>
Comment: <asp:TextBox ID="CommentBox" runat="server" Width="295px"></asp:TextBox>
</p>
<h2>Check Fax Status</h2>
<p>
Fax Handle: '<asp:Label ID="lblFaxHandle" runat="server"></asp:Label'>
Fax Record Date and Time is: '<asp:Label ID="lblFaxRecordDateTime" runat="server"></asp:Label>'
</p>
<h2> Get a User’s Faxes</h2>

```
<p>
<asp:Button ID="GetUserFaxesButton" runat="server"
onclick="GetUserFaxesButton_Click" Text="Get User's Faxes" />
</p>

<div style="width: 750px; height: 300px; overflow: auto">
<asp:GridView CssClass="MyClass" ID="GridView1"
runat="server" BorderStyle="Solid">
</asp:GridView>
</div>

</asp:Content>
Index

Symbols
.
 trx files
 vox files

Numerics
911 calls

A
A4 paper
access TeleConnect
adding
alerts and monitors
billing codes
cover sheet to a fax
dialing rules
groups of users
library documents
overlay forms
pager services
printers
Short Message Services
signatures
signatures to a fax
users
users automatically
WorkServer modules

administrative mode
administrative permission, in user profile
administrator
approving outbound faxes
user group
administrator notification messages
pager
SMS
aging faxes
alert messages
all BoardServers down
critically low disk space
Exchange server is not responding
low disk space
one BoardServer down
probable line failure
send queue too deep
server improperly shut down
Alerting and Monitoring service
alerts
clearing
enabling and disabling
frequencies
in event log
pager
receiving
severity
troubleshooting
all BoardServers down
alphabetic data, entering via
telephone
alphabetic passwords
alternate administrator, user group
alternate routing tables
ANI (Automatic Number Identification)
data pattern match
routing inbound faxes with
Application Event Log level
Alerting module
BoardServer module
Database module
e-mail gateway
Server module
WorkServer modules
approve faxes
Approving Blocked Faxes
Approving Faxes Blocked by Dialing Rules
archiving sent faxes
assign channel to TeleConnect
auto-delete faxes
Automatic Number Identification See ANI
automatic OCR
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoReply service</td>
<td>221</td>
</tr>
<tr>
<td>configuring</td>
<td>129</td>
</tr>
<tr>
<td>inbound faxes</td>
<td>106</td>
</tr>
<tr>
<td>outbound faxes</td>
<td>106</td>
</tr>
<tr>
<td>Call blocking</td>
<td>193</td>
</tr>
<tr>
<td>Call TeleConnect</td>
<td>282</td>
</tr>
<tr>
<td>Call type</td>
<td>59</td>
</tr>
<tr>
<td>Caller subscriber identification</td>
<td>18</td>
</tr>
<tr>
<td>Captaris Conversion: Understanding</td>
<td>67</td>
</tr>
<tr>
<td>Channel, assigning to Fax-on-Demand</td>
<td>58</td>
</tr>
<tr>
<td>Channel, assigning to TeleConnect</td>
<td>276</td>
</tr>
<tr>
<td>CED tone</td>
<td>46</td>
</tr>
<tr>
<td>Central mailbox</td>
<td>210</td>
</tr>
<tr>
<td>Client applications</td>
<td></td>
</tr>
<tr>
<td>Enterprise Fax Manager</td>
<td>85</td>
</tr>
<tr>
<td>Enterprise Fax Manager, Web edition</td>
<td>93</td>
</tr>
<tr>
<td>Codechg.csv</td>
<td>134</td>
</tr>
<tr>
<td>Community Name</td>
<td>167</td>
</tr>
<tr>
<td>Compute disk usage</td>
<td>98</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Dashboard</td>
<td>285</td>
</tr>
<tr>
<td>Configure</td>
<td></td>
</tr>
<tr>
<td>Network monitor application</td>
<td>168</td>
</tr>
<tr>
<td>SNMP service</td>
<td>167</td>
</tr>
<tr>
<td>Configure Fax-on-Demand</td>
<td>57</td>
</tr>
<tr>
<td>Cover sheet codes</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td>198</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>198</td>
</tr>
<tr>
<td>PCL</td>
<td>199</td>
</tr>
<tr>
<td>Cover sheet fields, requiring</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td>198</td>
</tr>
<tr>
<td>Cover sheet name</td>
<td>58</td>
</tr>
<tr>
<td>Cover sheets</td>
<td></td>
</tr>
<tr>
<td>Adding to a fax</td>
<td>203</td>
</tr>
<tr>
<td>Default for users</td>
<td>86</td>
</tr>
<tr>
<td>validating by external program</td>
<td>21, 135</td>
</tr>
<tr>
<td>validation by RightFax server</td>
<td>21, 135</td>
</tr>
<tr>
<td>validation from e-mail gateways</td>
<td>20</td>
</tr>
<tr>
<td>Call type</td>
<td>59</td>
</tr>
<tr>
<td>Client applications</td>
<td></td>
</tr>
<tr>
<td>Enterprise Fax Manager</td>
<td>85</td>
</tr>
<tr>
<td>Enterprise Fax Manager, Web edition</td>
<td>93</td>
</tr>
<tr>
<td>Codechg.csv</td>
<td>134</td>
</tr>
<tr>
<td>Community Name</td>
<td>167</td>
</tr>
<tr>
<td>Compute disk usage</td>
<td>98</td>
</tr>
<tr>
<td>configuration</td>
<td></td>
</tr>
<tr>
<td>Dashboard</td>
<td>285</td>
</tr>
<tr>
<td>Configure</td>
<td></td>
</tr>
<tr>
<td>Network monitor application</td>
<td>168</td>
</tr>
<tr>
<td>SNMP service</td>
<td>167</td>
</tr>
<tr>
<td>Configure Fax-on-Demand</td>
<td>57</td>
</tr>
<tr>
<td>Cover sheet codes</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td>198</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>198</td>
</tr>
<tr>
<td>PCL</td>
<td>199</td>
</tr>
<tr>
<td>Cover sheet fields, requiring</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td>198</td>
</tr>
<tr>
<td>Cover sheet name</td>
<td>58</td>
</tr>
<tr>
<td>Cover sheets</td>
<td></td>
</tr>
<tr>
<td>Adding to a fax</td>
<td>203</td>
</tr>
<tr>
<td>Default for users</td>
<td>86</td>
</tr>
<tr>
<td>validation by external program</td>
<td>21, 135</td>
</tr>
<tr>
<td>validation by RightFax server</td>
<td>21, 135</td>
</tr>
<tr>
<td>validation from e-mail gateways</td>
<td>20</td>
</tr>
</tbody>
</table>
PCL 199-202, ??-202
permission to change 99
requiring fields 204
resolution 102
short 33
Word 198-199
critically low disk space 177
CSID
described 18
routing inbound faxes with 216
customer support 11

d
Dashboard
configuration 285
viewing 285
database backup and restore 300-302
Database module
Application Event Log level 20
database threads settings 20
query frequency 32
database threads settings 20
default
billing codes 103
fax send priority 102
RightFax user 96
user profile 96
delaying outbound faxes 18
deleting
alerts and monitors 162
billing codes 133
destination tables 189
dialing rules 179
faxes by age 114
groups of users 112
library documents 141
overlay forms 123
pager services 154
printers 127
Short Message Services (SMS) 154
signatures 119
users 97
WorkServer modules 38
desktop scanners 129
destination
deleting 189
destination tables
copying 189
defined 188
Dialed Number Identification Service  See DNIS
dialing rules
adding 179
copying 180
copying, defaults for 87
deleting 179
disabled 193
editing 180
eample 188
aving 180
testing 191-193
Dialogic OKI32 files 278
direct inward dial (DID) fax routing 213
disable alerts 169
disk space
fax image files 91
user faxes 98
disk space low 177
distinguished name, Microsoft Exchange 98
DNIS (Dialed Number Identification Service)
defined 19
recording 19
routing inbound faxes with 213
Do not Dial 190
DocTransport module
availability index 91
described 14
remote 63
document connector, external 21
DTMF (Dual Tone Multi-Frequency) routing for inbound faxes 54, 214
Dual Tone Multi-Frequency  See DTMF
E
editing
billing codes 134
dialing rules 180
library document properties 140
pager services properties 154
Short Message Services (SMS) properties 154
signatures 120
users 97
e-mail address, in user profile 98
e-mail gateways
configuring 259-263
custom notification messages 262
embedded codes 267, 268
fax notifications 267
installing 257
receiving faxes via 266
routing faxes to 216
running remotely 268
service account 263
starting and stopping service 263
troubleshooting 269
validating billing codes from 20
embedded codes
ADDDOC 305
ADDDOC2 306
ADDDOC3 305
ADDDOC4 306
ATDATE 307
ATTIME 307
Index

365

capability for Brooktrout fax boards 52
monitoring in Enterprise Fax Manager 91
routing inbound faxes with timed ability 54
Fax Connector, Standalone 130
fax cover sheets See cover sheets
fax database described 13
orphan cleanup 303
purging 302
Fax Distribution, Smart 116
fax ID for Brooktrout fax boards 52
fax image files disk space available 91
overview 13
re-naming 13
size 13
Fax Information dialog box customizing for users 117
using to send a fax 230-234
fax machine, connecting to stand-alone 130
fax mailbox purging faxes from 303
routing faxes to 216
fax over IP adding as a transport method 44
configuring in DocTransport 59
dialing rule destination 186
fax routing See inbound fax routing
fax routing information, requesting 278
fax server services DocTransport module 14
overview 14
Queue Handler module 15
RPC module 14
Server module 14
WorkServer modules 14
activating notification of sent or received 18
automatic forwarding 283
automatic notification 283
automatic printing 283
deleting by age 114
file formats for conversion 317
notification via e-mail gateway 267
printing time strip on 38-39
purging from database 302
purging from fax mailboxes 303
receiving via e-mail gateway 266
responding with AutoReply 221
sent as AutoReply 224
TeleConnect ID 282
Fax-on-Demand
assigning a channel to call type 58
configuring 57
maximum documents to send 59
password 58
user account 58
FaxUtil
contact information 10
overview 15
purging faxes from 303
FCC requirements 277
file threads settings 20
files, voice prompt 278
FoIP See fax over IP
forced scheduling of faxes 115
forward faxes, automatic 283
G
Gotdigit.ipk 55
groups See user groups

H
HAF_Cancelled.vox 57
HAF_MainMenu.vox 57
HAF_PressStart.vox 57
HAF_Source.vox 57
HAF_ThisisaFax.vox 57
header, quick 18
heartbeat, server 105
HP OpenView 168
HTML cover sheets 197-??
Human Answered Fax 55-57

I
image enhancement 236
importing billing codes 33, 134-135
contacts into phonebook 246-248
printers 129
users 109
inbound fax routing
ANI 215
configuring 100-101, 213-219
CSID 216
DID/DNIS 213
DTMF 54, 214
e-mail 216
fax channel 214
fax mailbox 216
InterConnect 218
network directory 217
OCR 218
routing code 100
telephony mailbox 218
to a network directory and assigning a unique ID 218
inbound faxes automatically forwarding 106
automatically printing 106
default billing codes 99
distributing to a group of users 116
optical character recognition 106
printing automatically 106
recording DNIS information 19
responding with AutoReply 221
Smart Fax Distribution 116, 218
inbound routing 210, 215
install
SNMP service 167
installing
AutoReply service 221
Microsoft Office applications for
server-side application conversion 68
RightFax server 15
integrating third-party scan-and-fax
devices 31
Integration Module
Enterprise 10
requirement for PeopleSoft 40
Small Business 10
InterConnect routing 33, 218
K
Kofax NetScan 39-40
L
language
 selecting in Enterprise Fax Manager Web edition 94
language support 276
LDAP phonebooks 251
Least-Cost Routing
call blocking 193
defined 179
Destination tables 188
dialing rules 179
examples 194-196
load balancing 188
testing 191-193
library documents
copying 141
creating 139
deleting 141
editing properties 140
permission to add usage statistics 141
line failure 177
load balancing 188
log
all fax activity 47-50
EquiTrac archive 36
fax audit 47-50
fax server alerts 157
Log files
configuring 150
log level fax audit log 47
log level, Application Event Log
Alerting module 160
BoardServer module 45
Database module 20
Server module 18
WorkServer modules 32
low disk space 177
M
mail merge 253
Main menu 283
MAPI phonebooks 248
maximum database I/O threads 20
maximum documents to send with Fax-on-Demand 59
maximum file I/O threads 20
maximum threads 20
Messages
plain text 143
SMS 143, 144
messages
error 319
notification 22-26
notification to groups of users 113
status 319
messages, recording multilingual 277
MIB 168
MIB tree 169, 170
MIB variables 170-175
Microsoft Exchange distinguished name 98
Microsoft Office applications, configuring for
server-side application conversion 68
module
Alerting 159
DocTransport 14
Queue Handler 15
RPC 14
Server 14
WorkServer 14
MSMQ Server 21, 46
multilingual support 276
N
name, in user profile 98
network directory
 routing a fax and storing with a unique ID 218
 routing faxes to 217
network monitor, configuring 168
Network Node Manager 168
notification messages
 activating 18
 customizing 22-26
method for groups of users 113
method for users 108
via e-mail gateway 267
via pager to administrators 25-26
via pager to users 24-25
via SMS to administrators 25-26
via SMS to users 24-25
notification of faxes, automatic 283

ODBC (Open Database Connectivity)
  billing codes 135
  phonebooks 249
OKI32 files 278
one BoardServer down 178
one-call faxing 59, 276
Open Database Connectivity See ODBC
Opening the PPG 145
operating systems 64
optical character recognition 106
Optical Character Recognition See OCR
Orphan.exe 303
outbound faxes
  adding a cover sheet 203, 231
  adding a signature 120
  adding an overlay form 126, 234
  adding billing codes 62, 230
  adding cover sheet 231
  adding TTI line 18, 50
  addressing 230
  approval and disapproval 239
  archiving 33-36, 99
  attaching files 232
  automatically deleting 234
  automatically printing 106
  broadcasting 252-255
  creating 227
  default resolution 102
  delaying 18, 231
  fine resolution 231
  force scheduling 231
  force sending 19
  Least-Cost Routing 179
  monitoring transmission 238
  number of pages queued for sending 91
  number queued for sending 91
  priority 234
  retry settings 19
  scheduling 231
  sending as PDF 231
  sending from SMTP/POP3 gateway 263
  short body pages 33
  short cover sheets 33
  smart resume 231
  stand-alone fax machine 231
  validating billing codes 20
  overlay forms
    adding to a fax 126
    copying 123
    creating 124
    deleting 123
    editing properties 124
    permission to add 99
    restricting use of 124
    using two in one fax 125-126
  overview 275

P
  pager ID 103, 104
  pager notification
    administrative alerts 104
    described 103
  pager services
    adding 154
    alert frequency 105
    copying 154
    deleting 154
  editing properties 154
  password
    user 98
  PCL (Printer Control Language)
    conversion for text files 32
    cover sheets 199-202, ??-202
  PeopleSoft system integration 40
  periodic server heartbeat 105
  phonebooks
    disabling import phonebook option 118
    fax broadcasting from 252
    importing contacts 246-248
    LDAP 251
    MAPI 248
    ODBC 249
    using 245
  ping server test 192
  preferences
    setting for views in Enterprise Fax Manager 88
  Prerequisites. See Requirements
  print faxes, automatic 283
  Printer Control Language See PCL
  printers
    adding 127
    copying 127
    deleting 127
    editing 128
    importing 129
    priority, default for outbound faxes 102
    privacy permissions 99
    probable line failure 177
    prompt, toll-number 277
  Prompt.lpk 54
  purge faxes from fax mailboxes 303

Q
  query RightFax status variables 170
WorkServer modules 36
services
Alerting and Monitoring 159
DocTransport module 14
e-mail gateway 263
monitoring 91
overview 14
Queue Handler module 15
RPC module 14
Server module 14
starting 29-30, 92
stopping 29-30, 92
WorkServer modules 14
Setting up
PPG 146
severity 169
short body pages 33
short cover sheets 33
Short Message Service See SMS
signatures
adding to a fax 120
authorized users 120
copying 119
creating 120
deleting 119
editing 120
Simple Mail Transfer Protocol See SMTP
Small Business Integration Module 10
Smart Fax Distribution 116, 218
Smart-Resume 102
SMS (Short Message Service)
See also Systems Management Server
adding as a transport method 44
adding services 154
alert frequency 105
copying 154
deleting services 154
dialing rule destination 186
editing properties 154
SMS, Two-way 144
SMTP (Simple Mail Transfer Protocol)
etTransport configuration 28
SMTP/POP3 gateway
configuring 257-259, 263
IETF addressing scheme 265
RightFax addressing scheme 264
sending a fax from 263
SNMP alerts 168
SNMP service
configuring 167
installing 167
SQL
configure connection 297
Standalone Fax Connector 130
start RightFax services 176
starting
Enterprise Fax Manager 85
Enterprise Fax Manager, Web edition 93
RightFax server 29-30
services 29-30, 92
statistics
event queue usage 89
Server module 91
statSERVICE_RUNNING 176
statSERVICE_STOPPED 176
status messages 319
status, RightFax 170
stop RightFax services 176
stopping
RightFax server 29-30
services 29-30, 92
support, customer 11
supported
operating systems 64
synchronizing
server with external systems 93
users with external systems 95
system overview 9, 13
system password 58
system requirements 275
T
TeleConnect 283
TeleConnect ID assigned to fax 282
TeleConnect Module 98
TeleConnect user, setting up in RightFax 276
telephony mailbox, routing faxes to 218
telephony server integration 33
testing
dialing rules 191-193
text file, converting with PCL 32
threads
maximum database I/O 20
maximum file I/O 20
TIFF-G3 101
TIFF-G4 101
time strip 38-39
toll-number
prompt 277
support 277
trace fax route test 192
Transaction log. See Log
Transmit Terminal Identification See TTI
trap definitions 168
Trap Destination 168
troubleshooting
AutoReply service 225
troubleshooting alerts 176
Troubleshooting the Conversion Engine 74
TTI (Transmit Terminal Identification) line
adding second line 18
changing the company name 50
configuring 50
TWAIN32 129
two-call faxing 59, 276
Two-way SMS 144
<table>
<thead>
<tr>
<th>Unique ID, assigning to a fax and routing to network directory</th>
<th>218</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account, for Fax-on-Demand</td>
<td>58</td>
</tr>
<tr>
<td>User group administrator</td>
<td>112</td>
</tr>
<tr>
<td>User group profile administrator</td>
<td>112</td>
</tr>
<tr>
<td>Alternate administrator</td>
<td>113</td>
</tr>
<tr>
<td>Cover sheets</td>
<td>113</td>
</tr>
<tr>
<td>Customizing the Fax Information dialog box</td>
<td>117</td>
</tr>
<tr>
<td>Days to keep deleted fax records</td>
<td>113</td>
</tr>
<tr>
<td>Deleting faxes by age</td>
<td>114</td>
</tr>
<tr>
<td>Mandatory cover sheets</td>
<td>113</td>
</tr>
<tr>
<td>Mandatory fax preview</td>
<td>113</td>
</tr>
<tr>
<td>Notification messages</td>
<td>113</td>
</tr>
<tr>
<td>Smart Fax Distribution</td>
<td>116</td>
</tr>
<tr>
<td>User groups adding</td>
<td>111, 162</td>
</tr>
<tr>
<td>Assigning user to</td>
<td>98</td>
</tr>
<tr>
<td>Copying</td>
<td>112, 162, 205</td>
</tr>
<tr>
<td>Deleting</td>
<td>112, 162</td>
</tr>
<tr>
<td>Routing a fax to all in group</td>
<td>116</td>
</tr>
<tr>
<td>User ID</td>
<td>95</td>
</tr>
<tr>
<td>User notification messages pager</td>
<td>24-25</td>
</tr>
<tr>
<td>SMS</td>
<td>25</td>
</tr>
<tr>
<td>Via e-mail gateway</td>
<td>267</td>
</tr>
<tr>
<td>User permission administrative</td>
<td>99</td>
</tr>
<tr>
<td>Approve faxes</td>
<td>99</td>
</tr>
<tr>
<td>Approve sent faxes</td>
<td>100, 239</td>
</tr>
<tr>
<td>Automatic fax deletion</td>
<td>100</td>
</tr>
<tr>
<td>Change cover sheets</td>
<td>99</td>
</tr>
<tr>
<td>Delete faxes</td>
<td>100</td>
</tr>
<tr>
<td>Edit billing codes</td>
<td>99</td>
</tr>
<tr>
<td>Edit overlay forms</td>
<td>99</td>
</tr>
<tr>
<td>Library documents</td>
<td>99</td>
</tr>
<tr>
<td>Look up billing codes</td>
<td>99</td>
</tr>
<tr>
<td>Mandatory password</td>
<td>100</td>
</tr>
<tr>
<td>OCR faxes</td>
<td>99</td>
</tr>
<tr>
<td>Privacy</td>
<td>99</td>
</tr>
<tr>
<td>Run reports</td>
<td>99</td>
</tr>
<tr>
<td>Send high priority faxes</td>
<td>99</td>
</tr>
<tr>
<td>User profile allow to view first page only</td>
<td>100</td>
</tr>
<tr>
<td>Allow users to view mailbox</td>
<td>100</td>
</tr>
<tr>
<td>Automatically deleting faxes</td>
<td>102</td>
</tr>
<tr>
<td>Billing code validation default</td>
<td>96</td>
</tr>
<tr>
<td>Default</td>
<td>99</td>
</tr>
<tr>
<td>Default billing codes</td>
<td>99</td>
</tr>
<tr>
<td>Default fax resolution</td>
<td>102</td>
</tr>
<tr>
<td>Editing</td>
<td>97</td>
</tr>
<tr>
<td>E-mail address</td>
<td>98</td>
</tr>
<tr>
<td>Microsoft Exchange distinguished name</td>
<td>98</td>
</tr>
<tr>
<td>Name</td>
<td>98</td>
</tr>
<tr>
<td>Password</td>
<td>98</td>
</tr>
<tr>
<td>Voice mail subscriber ID</td>
<td>98</td>
</tr>
<tr>
<td>VOX files</td>
<td>278</td>
</tr>
<tr>
<td>Warning re-naming fax image files</td>
<td>13</td>
</tr>
<tr>
<td>Web EFM. See Enterprise Fax Manager, Web edition</td>
<td></td>
</tr>
<tr>
<td>Web server, certified delivery</td>
<td>28</td>
</tr>
<tr>
<td>WebUtil overview</td>
<td>15</td>
</tr>
<tr>
<td>Windows Event Log</td>
<td>169</td>
</tr>
<tr>
<td>Windows NT security</td>
<td>97, 108</td>
</tr>
<tr>
<td>Windows registry entries</td>
<td>281, 348</td>
</tr>
<tr>
<td>Word cover sheets</td>
<td>198-199</td>
</tr>
<tr>
<td>WorkServer modules</td>
<td></td>
</tr>
<tr>
<td>Validating billing codes configuring for external application</td>
<td>135</td>
</tr>
<tr>
<td>Configuring for RightFax server</td>
<td>135</td>
</tr>
<tr>
<td>From e-mail gateways</td>
<td>20</td>
</tr>
<tr>
<td>From external programs</td>
<td>21</td>
</tr>
<tr>
<td>Variables, MIB</td>
<td>170-175</td>
</tr>
<tr>
<td>Variables, query</td>
<td>170</td>
</tr>
<tr>
<td>Viewing</td>
<td></td>
</tr>
<tr>
<td>Viewing Dashboard</td>
<td>285</td>
</tr>
<tr>
<td>Voice mail subscriber ID</td>
<td>276</td>
</tr>
<tr>
<td>Voice mail subscriber ID, in user profile</td>
<td>98</td>
</tr>
<tr>
<td>Voice prompt files list</td>
<td>278-280</td>
</tr>
<tr>
<td>Voice prompts recording for DTMF fax routing</td>
<td>54</td>
</tr>
<tr>
<td>Recording for Human Answered Fax</td>
<td>57</td>
</tr>
<tr>
<td>VOX files</td>
<td>278</td>
</tr>
</tbody>
</table>
adding 38
Application Event Log level 32
configuring 31-36
configuring Kofax NetScan
   services 39-40
configuring PeopleSoft services 40
database query frequency 32
deleting 38
described 14
remote 41-42
service account 36